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Radio and television interference 

The equipmenr described in this manual generates, uses, and can radiate 
radio-frequency energy. If it is nOt installed and used properly- that is, in strict 
accordance with Apple's instructions- it may cause inrerference with mdio and 
television reception. 

This equipment has been tested and found to comply with the limtts for a 
Class B digital device in accordance with the specifications in Parr 15 of FCC 
rules. These specifications are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no 
guarantee that interference will not occur in a particular installation. 

You can detem1ine whether your compmer system is causing interference by 
turning it off. If the interference stops, it was probabl)' caused by the computer 
or one of the peripheral devices. 

If your computer system docs cause interference to radio or television 
reception, uy to correct the interference by using one or more of the following 
measures: 

• Turn the television or radio antenna until the interference stops. 

• Move the compmer to one side or the other of the television or radio. 

• Move the computer farther away from the television or radio. 

• Plug the computer into an outlet thar is on a different circuit from the 
television or radio. (!'hat is, make certain the computer and the television 
or radio arc on ci rcuits controlled by different circuit breakers or fuses.) 

If necessary, consult the service and support information that came with your 
computer for instructions on how to conraet an Apple-authorized service 
provider or Apple for assistance. Or comact an experienced radio/television 
technician for additional suggestions. You may find helpful the following 
booklet, prepared b)' the Federal Communications Commission: lntelference 
Handbook (stock number 004-000-00493-1). This booklet is available from the 
U.S. Government Priming Office, Washington, DC 20402. 

!::::. Important: Changes or modifications to this product not authorized by 
Apple Computer, Inc., could void the FCC Certification and negate your 
authmity to operate the product. 

This product was tested for FCC compliance under conditions that included 
the usc of shielded cables and connectors between system components. It 
is importam that you use shielded cables and connectors to reduce the 
possibility of causing interference to radios, television sets, and other 
electronic devices. 

For Apple peripheral devices, the proper shielded cables are available 
through an Apple-authorized dealer. For non-Apple peripheral devices, 
contact the manu fan urer or de-Jicr for assistance. 

This equipment has been rested and found to com pi)' with the limits for H 

Class l3 digital device in accordance with the specifications in Part 15 of FCC 
nrles. See instructions if interference to r<ldio or television reception is 
suspected. 

DOC Class B Compliance This digital apparatus does nor exceed the 
Class B limits for mdio noise emissions from digital apparatus set out in the 
radio interference regulations of the C;maclian Department of 
Communications. 

Observation des normes-Classe B Le present appareil numerique 
n'emet pas de bruits radioelecrriques depassant lcs limites applicables aux 
appareils numeriques de Ia Classe B prescrites clans les reglerncnts sur le 
brouillage raclioelectrique edictes par le Ministtre des Communications du 
Canada. 6 
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Preface 

How to Use This Book 
This book has two parts. Part I, Learning Macintosh, covers 
everything you need to know to begin using your Macintosh 
computer. Part II, Macintosh Reference, contains information 
that you may want as you become more proficient in using 
your Macintosh. 

Go through Part I first if you are new to computers or new to the 
Macintosh. Read the chapters in sequence, from Chapter 1 to 

Chapter 7. When you're done with Part I, you can start learning 
the programs that you intend to use with your Macintosh. 

Use Part II as you would a dictionary or encyclopedia: turn to it 
when you need specific information, and then read only those 
parts that give you that information- so you can go on with your 
work. 

To find information in this book, use the index and the table of 
contents. Also, use rhe glossary and the summary, "Working on 
the Macintosh Desktop" (on the green pages after Chapter 16), 
if you're looking for short definitions or brief summaries of 
concepts and procedures. 

If you need information on setting up your Macintosh or on 
features specific to your particular model, go to the setup book 
that came with your computer. 

Use this book in combination with the setup book and the books 
and disks that came with your application programs ro find the 
information you need. You can also find useful information 
through Balloon Help, a feature of your Macintosh system that 
is explained in Chapter 7. 

Welcome to Macintosh. 

XV 





Learning Macintosh 
Chapter 1 Turning the Macintosh On and Off 

Chapter 2 Understanding the Desktop 

Chapter 3 Setting Up Your Programs 

Chapter 4 Creating a Document and Saving Your Work 

Chapter 5 Changing a Document and Printing Your Work 

Chapter 6 Organizing Your Work 

Chapter 7 Learning More About Your Macintosh 

Co through Learning Macintosh ij)'ou are new to comjJuters or 

new to the Macintosb compute~: Read the cbapters in sequence, 

from Chapter 1 to Chapter 7. Eue1ytbing you need to know to 

begin using tbe i\1/acintosh productively is covered in this part of 

the book. 

Before you usc LeamirtR Macintosb, you should have already 

• set up your Macintosh according to the instructions in the 

setup book lhat came with your com puler 

• gone through the Macintosh 8asics rour, supplied on disk 

with your computer 

When you're done with this parr of the book, you can stan 

learning the programs that you intend to usc with your 

Macintosh. (Turn Lo the materials rim came with the 

programs-ai!Lhe skills you learn in Learning Macintosb 

will prove useful in any Macintosh program.) 

For information that you may need as you become more 

proficient in using your Macintosh, go to Pan II, Macintosh 

Reference. 



To find information in this book, use the index and the table of 

comenrs. Also, use the glossary and the summary, "Working on 

the Macintosh Deskrop" (on the green pages after Chapter 16), 

if you 're looking for shore definitions or brief summalies of 

concepts and procedures. 

If you need information on setting up your Macintosh or any 

information on feaLUrcs specific to your panicular model, go to 

the setup book that came with your computer. 

2 

Use this book in combination with the setup book and the books 

and disks that came with your application programs to find t.he 

information you need. You can also find useful information 

through Balloon Help, a feature of your Macintosh system that is 

explained in Chapter 7. 



Chapter 1 

Turning the Macintosh 
On and Off 
In this chapter 

You'lllcarn how to 

• turn the Macintosh on and off 

Also, you'lllearn aboul 

• the startup disk 

• the Macintosh desktop 

IL will take about five minutes LOgo through this chapter. 

Before you begin 
You should have already 

• set up your Macimosh according to the insLrucLions in the 
setup book that came with your compu ter 

• gone through the Jl!lacintosb Basics Lour, supplied on disk 
with your computer 

• read the introduction ro this section of the book (page 1) 

3 



Turn your computer on 
How you turn on your Macintosh depends on which model it is. 
For specific information, go to the setup book that came with 
your computer. 

6 Important: If an external hard disk or other external devices 
are connected to your MacintOsh, turn on those external 
devices before you turn on the Macimosh. 6. 

• If your Macintosh is the Macintosh LC or it does not have a 
separate monitOr (like the Macintosh Classic) , press the on/off 
switch on the back of your computer. 

__ j 

·:· if the Macintosh LC monitor doesn't turn on, make sure 
that the moniwr's on/off switch is on. (If you don't know 
where the switch is, go to the manual that came with your 
monitor.) ·:· 

~ Chapter I: Turning the Macintosh On and Off 

• If your computer is one of the Macintosh II models (such as 
the Ilci or the Ilfx), press the Power On key on your keyboard. 

Power On key 0 
0 00:0 00:0 ITllJ ITO 0 

l"i"";;T ~~-1 :/ : r: I: I: I: l: : : : : r: 

D Power On key .. . . . . .. . 

[ii¥h·::::::::::: IE] 
·:· If the monitor doesn't tum on, make sure that its on/off 

switch is on. (If you don't know where the switch is, go tO 
the manual that came with your monitor.) ·!· 



When you turn on your computer 

The Madmosh looks for a startup disk, which is a disk that 
contains the information it needs to "stan itself up." In your 
case, the startup disk is a hard disk that's inside or connected 

~ 
to your computer. \XIhen the Macintosh finds a startup 
disk, it displays the icon shown at left and proceeds 
to start itself up. 

When your computer is done starring itself up, the screen 
displays the Macintosh "desktop." The desktOp is a field of gray 
(or another color) with 

• a menu bar across the top (comaining the names and icons 
of menus) 

• an icon near the upper-right corner representing the 
startup disk 

• a Trash icon near the lower-right corner 

Chapter 2, "Understanding the Desktop," gives you more 
information on these features. 

1
Menu bar 

I I 

- ... , Srarrup 
ma : disk 

icon 

"!rash icon 

{f the Macintosh doesn't find a startup disk, it displays this icon 
instead. In this case, you may neecl to prepare a startup disk 
~~ or connect one to your computer. Go to Chapter 8 
li..1JJ (in Part II of this book) or your setup book for 

• instructions. 

Chaprer 1: 'Jtu·ning rhe Macimosh On and Off 5 



Turn your computer off 
Before you can turn off your computer, you need ro know how 
to use the mouse ro choose a command from a menu. 'l11e 
Macintosh Basics LOU!· lets you practice choosing commands. If 
you need more practice, go through the next chapter (Chapter 2) 
and then come back to this section to turn off your computer. 

1. Point to the Special menu name in the menu bar. 

2. Press and hold down the mouse button. 

3. Drag through the items in the menu until the Shut 
Down command is highlighted, then release the mouse 
button. 

Clean Up Desktop 
E:ml)t!J'fmsh ... 

Ej•~c'f [li~k :•:E: 
Erase Disk ... 

Restart 
Shut Down 

Some models turn themselves off automatically after you choose 
Shut Down. If yours does not, turn it off using the on/off switch 
after you choose the Shut Down command. 

6 Chaprer 1: 'lurning rhe Macintosh On and Off 

.._ Warning: It is very important to always use the Shut Down 
command before you turn off your computer. The Shut Down 
command prorecrs your software and prepares your hard disk 
for the next rime you start up. .& 

• If your Macintosh does nor have a separate monitor (like the 
Macintosh Classic) , press rhe on/off switch on the hack of the 
computer when a message on screen indicates that it's safe to 

do so. 

• If your Macintosh is the Macintosh LC, press the on/off switch 
on the back of the computer when a message on screen 
indicates that it's safe to do so, and switch off the monitor 
as well. 

• If your computer is a Macintosh II or a portable model, the 
computer and the monitor turn off by themselves. 

6. Important: rf an external hard disk or other external device 
is connected to your Macintosh, turn off those external 
devices after you turn off the Macintosh. 6 

Turn off your computer at rhe end of your work day or when you 
know you won't be using it for several hour:;. 

What next? 

Go ro Chapter 2, where you'lllearn how to work on the 
Macintosh desktop. 



Chapter 2 

Understanding the Desktop 
In this chapter 

You 'II review how to 

• use the mouse 

• choose a command 

• open an icon 

• look ar the conrenrs of a window 

• close a window 

(The Macintosh Basics rour inrroduced you ro these skills.) 

You'll learn how to 

• move a window 

Also, you'll learn about 

• using the keyboard 

It will rake about 30 minutes to go through this chapter. 

Before you begin 

You should have already 

• gone through Chapter 1 

If you turned off the Macinrosh at the end of Chapter 1, turn it 
back on now. 

7 



Use the mouse 
You use the mouse ro control the movements of a pointer on 
screen. Usually. the pointer is an arrow that's set at an angle. 

~ 

= 
~ 

1m 

Much of the work you do on the J'vlacimosh uses four mouse 
actions: pointing. clicking, pressing, dragging. 

8 Chapter 2: Understanding the Dcskrop 

Point 

You poim ro an object on screen by moving the mouse so that the 
pointer is positioned on that object. When the pointer is an arrow, 
the ve1y tip of the arrow must be exact~)' on the object. 

y 

~ 

!iii 

Practice by pointing ro different objects on the Macintosh 
desktop, such as the startup hard disk icon near the upper-right 
corner, the Trash icon near the lower-right corner, and the Help 
menu icon near the right corner of the menu bar. 

I iii 

CD~ 

~~!:~;;:~; 
?.) ~ 

::::::::::: : : :::::: :::::::: :~:::::::::::::::::::: 

·:::t:::::::::::::::r :::':':'::'':l:::t :::: 

::::::::::::::::wt?W~,,m::::: 
:::::::::::::::;:::::::::::::::::::::::::::::::;::: 



Click 

You click an objecr on screen by pressing and quick!~' releasing rhe 
mouse burron while the poinrer is on rim objecr. 

~ 

Iijj 

Practice by clicking differenr objecrs on rhe ~lacintosh desktop. 
such as rhe sranup hard disk icon ncar the upper-righr corner and 
the Trash icon near rhe lower-right corner. 

cv~ :~~ji~[~~~~~~~~~~~~~j~~~~~~~ii~i~~~i~ii~~j~~~ j ~~ j~~~~ 

I 
:::::=:::=::::::::::::::::mmr :::::::: 
··:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·· 

· ,1.1 
:::::::::::::::::::::::::::::::::::::::::::::::::::: 

When you click an icon, it becomes bigbligbted (the icon is 
darkened). ,,·hich means that it is selected. A selecrecl icon is the 
object of whatever action you choose next. 

Press 

You press by holding down rhe mouse but ron \\'ithout moving the 
mouse. Don't bear dmm on rhe mouse itself. 

= 

[ 

--
Practice b,· pressing the menu names :tnd menu icons in rhe menu 
bar (sran wit h the Apple menu icon in the lcftwrncr. through the 
menu names, and across to the Help and Appl ication menu icons 
in the right corner). Pressing a menu name or icnn "pulls clown·· 
rhe menu. Read rhe items in each menu vou pull dmm. 

~About This Macint osh ... 

~ Alarm Clock 

mill Calcul at or 
'P Chooser 
@B Contro l Panels 

(@) Key Caps 
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Drag 

You drag an object on screen by poinring ro rhar objecr and 
holding clown rhe mouse burron while you move rhe mouse. 

I 

= 

J] " 
I 
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How to hold the mouse 
• You can use the mouse with either hand. Most people 

prefer to use ir wirh their dominant hand (the right if 
they're right-handed, the left if they're left-handed) . If you 
want to switch mouse positions, go to the setup book that 
came with your computer. 

• Keep rhe heel of your hand on your desk. (Your arm will 
tire quickly if you hold your hand up in the air.) 

• Lightly rest your index and middle fingers on the mouse 
button. 

• Make sure that the mouse cable is pointing away from you. 



Practice by dragging the sranup hard disk icon and the Trash icon 
around the Macinrosh deskrop. Make sure you return the icons 
close ro their original positions. 

• r ile £dit IJiew L utu~ l Spcclul 

When you drag an icon, an outline of the icon follows the pointer 
on the screen. When you release the mouse burton, the icon itself 
moves. 

When you move the mouse 

• Glide the mouse over the surface of your desk. Don't press 
down on it. 

• If you run out of room on your desk as you're moving the 
mouse, pick it up and put it down where there's more 
room. When you pick up the mouse, the pointer on screen 
does not move, or does so only slightly. 

~ 

= 

ffij 

"-- ... .... , 
' 
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Choose a command 
Choosing a command involves a combination of the mouse 
actions you've reviewed. 

1. Point to the Special menu name in the menu bar. 

2. Press to pull down the Special menu. 

3. Drag to the first item in the menu (the Clean Up 
Desktop command) so that it is highlighted, then 
release the mouse button. 

E:jf~!:1 m~k :•:E: 
E:mse m~k ... 

Restart 
Shut Down 

\Xfhcn you choose the Clean Up Desktop command, the 
srarrup hard disk icon and the Trash icon return exactly to 

the positions they occupied when you first turned on the 
computer (as long as they're already close to their original 
positions) . 

12 Chapter 2: Understanding the Desktop 

When you talk to your Madntosh 
Talking Macintosh always involves two steps: 

1. selecting an object on the screen, and 

2. choosing the action you want to perform on the object. 

An icon or a window on the Macintosh desktop, text in a 
word-processing program, a picture in a graphics program­
all of these are objects that you can select. 

The actions you choose to perform on a selected object are 
usually commands (like the Open command), but you can also 
perform actions directly using the mouse (like dragging an 
icon). 

When you select an object, you' re telling the Macintosh to act 
upon that object. 

Talking Macintosh is like using a very simple language with 
only two kinds of words: 

• nouns (the objects), and 

• verbs (the actions) 

and with only one rule to remember: 

• First the noun, then the verb (to this object, do that 
action). 



Open an icon 
Opening an icon is your first exercise in "talking Macintosh": 
telling your computer what you wanr il to do. 

1. Click the startup hard disk icon (unless it's been 
changed, it should be named "Macintosh HD") near 
the upper-right corner of the screen to select it. 

Make sure that the icon is highlighted (darkened), which 
means that ir's selected. 

2. Point to the File menu name in the menu bar. 

3. Press to pull down the File menu. 

4. Drag to the Open command (the second item in the 
File menu) so that it is highlighted, then release the 
mouse button. 

t !use Win<low 

Get Info 3€ 1 

When you choose the Open command, the selected icon (in 
this case, the Macintosh HD icon) opens into a window (the 
Macintosh HD window). The icon it.-;elfbecomcs filled in with 
a pattern of dots, indicating that it has been opened. 

~0- . M acintosh HD -0~ 

"3 items 3.6 MB in dl:i:k 34.4 t-\8 .w ailab 1~ 

~p,z-, a 
~ tJl!J ~ 

Rud Me System Folde-r Tt-achText 

1¢1 

0 

10 
-!01121 
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Look at the contents of a window 
Every window has several features that help you view the 
window's contents. You can 

• make the window bigger or smaller 

• move any hidden comenrs inro view 

Before you work with the contents of a window, you need to 
make that window the active window. 

Make a window the active window 

You can have several windows on screen, but only one window at 
a time can be the acrive window. 

The Macintosh HD window should already be on your Macimosh 
deskwp. (The window appeared when you opened the 
Macintosh HD icon.) 

1. Click the Trash icon near the lower-right corner of the 
screen to select it. 

Make sure that the icon is highlighted, which means that it's 
selected. 

I 
11m 
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2. Point to the File menu name in the menu bar. 

3. Press to pull down the File menu. 

4. Drag to the Open command (the second item in the 
File menu) so that it is highlighted, then release the 
mouse button. 

1: los<~ lllindmt• 

Get Info ~ I 

When you choose the Open command, the selected icon (in 
this case, the Trash icon) opens imo a window (the Trash 
window). The icon itself becomes filled in with a panern of 
dots, indicating that it has been opened. 



You should now have rwo windows on your Macintosh 
desktop: the Macintosh HD window ancl the ·n·ash window. 
The 1hsh window is the active window because you opened 
the 'Ji'ash icon most recenrly. 

Macintosh liD 
3 it(lmS: 3 .6 f"IB in disk 34.4MB availabl~ 

;;J[}JJ ~ 
Ru d M~ Sy:<t(lm folder h.achTex t 

SO Trash ~ll: 
@' 0 i t~ms 

~ 

to 
¢ 1 ¢~ 

Active 
window 

;. Click anywhere in the Macintosh HD window to make it 
the active window. 

The act ive window is the one with solid lines across the rap 
(the rille bar), on either sicle of irs ri rie. When winclo\vs 
overlap, the active window is the one that's on top. 

1 Wl 0 .~ 

~D ' Macintosh HD 0!: 
3 1 t~ms 3 .6 f"lB in disk 34 .4MB av.t~i11blY 

IRl w' i] riD ~' 
13 

iO 

Read Me Sy:::tem Folder Teaohlex l 

II: 

0 
l¢iT T¢1~ 

I-----Active 
window 

conti11ues ~ 
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Make a window bigger or smaller 
You can change a windmY's size by dragging its size box or by 
clicking irs zoom box. 

1. With the Macintosh HD window the active window, 
point to the size box in the lower-right corner of the 
window. 

i!D c Macintosh HD E!JE 
3 it.·ms :5.6 MB lO d1sk 34 4 1·8 ........ nab~ 

~ r;;.-, a. o 
~ ~ <(/ 

Rnd t-1.. Sqsh•m Fold"r Tu cMt-xt 

l7i 
§ _ ____15: 1211- Size box 

16 Chapter 2: L'ndcrstanding rhe Ocskrop 

2. Drag the size box in any direction, then release the 
mouse button. 

An outline indicates the \Yindo"·'~ new size. The ourline 
follows the poinrcr as you drag. You can drag in any direction 
to make the window bigger or smaller, wider or narrower. 

lEO MacintoshTiiD Eli: 
; it~mf> 5.6 MB in di~k ! 3 4 .4MB Avalla bl! 

~ F.;;;r ~ i 
l!mJ ~ ~~ 

R; 4d f~e Svstem Folder TeachT~xtJ 
·-·--------------t-· 
- ~ ~ 

li2 

iO 
1<51 1¢112! 

3. Click the zoom box near the right end of the title bar. 

liD . Macintosh 110 -- Zoom box 
3-itt ms: 3.6 MB m duk 34.4 M8 avad.abl~ 

fil llJ ~ ~ 
. 

Ru dl-19 StJ Zttm Fold("r TNohTtxt 

0 
1¢1 1<:! 12! 

The window ··zooms" ro a size that sho,,·s all uf its cumenrs. 



4. Click the zoom box again. 

The window zooms back to irs previous size (Ll1e size rhar you 
changed it to in step 2). 

Clicking rhe zoom box is a quick \vay tO view as much of a 
window's contellls as your screen size allows. 

Move the hidden contents of a window into view 

Without changing the size of rhe window, you can view any 
conrenrs that are currently our of sight by using the window's 
scroll ban; and scroll arrows. 

1. With the Macintosh HD window the active window, 
click the System Folder to select it. 

ISO Macintosh liD 0i: 
3H9ms 3 .6 MB in disk 34.4 t-18 .iV.ailib~ 

1¢ 

~ - ~ 
~ R '(:y 

Rud Mt ~ TuchTe><t 

0 

I<> 
-1¢1'21 

.Make sure rhar the icon is highlighted, "·hich means that it's 
selected. 

2. Point to the File menu name in the menu bar. 

3. Press to pull down the File menu. 

4. Drag to the Open command (the second item in the 
File menu) so that it is highlighted, then release the 
mouse button. 

When you choose the Open curnrnand, the selected icon 
(in this case, the System folder) opens into a window (the 
System Fulcler window). 

You should now have three windows on your Macintosh 
desktop: the Macintosh I ID window, the Trash \\'indow, and 
the System Folder window. The System folder ,,·indow is the 
active winclo\\· because you opened the System Folder last. 

5. Point to the size box in the lower-right corner of the 
System Folder window. 

COIIfillliC!S .... 
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What's on the desktop? 

The Macinrosh deskrop is a field of gray (or another color) with 
a menu bar across the top, an icon near the upper-right corner 
representing the stanup disk, and a Trash icon near the lower­
right corner. 

The desktop is your work space on the computer-as the top 
of a wooden desk is a work space. It gives you a familiar way of 
thinking about how w use the Macintosh. 

Aside from the field of gray (the "surface" of your work space), 
the Macintosh desktop has icons, windows, and menus. 

• Icons represent containers. 

• Windows let you view the contents of containers. 

• Menus offer you actions thar you apply w selected 
containers (or their contents). 

Icons represent containers 

You can think of icons as containers. Icons can comain other 
icons, or they can contain information. 

For example, the stanup disk icon near the upper-right corner of 
the desktop contains the System Folder icon. The System Folder 
icon contains the programs and other files (more icons) that 
contain the information the Macinrosh needs w start 
itself up. 

18 Chap1er 2: Unders~anding the Desktop 

Seve raJ types of icons represent differem rypes of containers. 

Hard dL'iks and floppy disks are like filing cabinets. You use disks 
w store files- programs you use and documents you create. 

[. I bJ 
Hard o;sk Floppy o;sk 

Shared disks are like filing cabinets containing office supplies or 
records that you share with others in your work group. Your 
Macintosh needs to be connected to a network before you can 
use shared disks. 

~ ~ 
Nett1art Commun;ty Commun;que 

~ ~ 
Shal"ed o;sk Iduna Stacks 



Folders are like folders in a file drawer. You use folders to 
organize your files. 

~ 

I~ I LJ 
System Folder Manila Folder 

LJ LJ LJ 
,.June Letters House P lans Mailing L ist.s 

Programs are files containing insu·uctions to the computer that 
let you do cenain types of work. 

1;~ 
~(/ 

Teach Text. 

~~; ~ 
~ ·~ 

SketchPad 1'"1emol'1aker BeanCount.er 

Documents are files containing words, pictures, numbers, 
sounds- whatever you create using programs. 

s ~ B -

Kitchen plans Rough sketch Sandino 

s 
Invitation 

Q 
D 
Memo 

~ 
~ 

State Budget 

The Trash is a container for files that you no longer want 
or need. 

I 
Trash 

Windows let you view the contents of containers 

Windows let you see what's "inside" all of these containers. 
When you open a disk icon, the window that appears shows you 
what's on the disk. When you open a document icon and the 
document is a memo, for example, the window that appears lets 
you see the memo. 

Menus offer you choices 

Like the menus in a restaurant, Macintosh menus let you 
choose. You choose among different actions that the computer 
can perform on containers (icons) or the contents of containers 
(words in a memo) that you've selected. 
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6. Drag the size box diagonally to make the window 
smaller (about half its current size), then release the 
mouse button. 

:;o sys tem f older r:Jl~ 

: 10 tttnu 3.6 MB V) dt:k J31.4 1'13 av.atlab~ 

I I ' IQ 
~ ~ [Q] em~ ~ 
IApplto ~r.u ltCf1"1z: EKttn!O'ion~ S\l!ittm Control P.a.j"'fll 

I ' I 
i Ul ~ ~ ! 
: 8 i£J mm il ! Flndtr Prtftrtnc+J Sor<)?book Ftlf J j 
i (gD ---~ -----r, I <D ---- -L§.J --- -·· It ~o :ti(tup lttms PnntMonltor DocUfl"'offltS: 0 
61 lotQJ 

- - System folder . E!l~ 
10tt-ms 36MB1ndisk 34 4 11lava1lab~ 

~ [Q] em 
Applf, r-~nu ltHnS Ext~m:ion"C St.Jshm 

-~~ Control P , 

~ (§ ~ 
Flnd<r Pnf~tnCH S<roobook FO. 

0 
<:>L_l ·'-.' '.-.-:-:.c:---:-:-: ... . ....... , .. , .. , ..... 

'' :' It;) Q] 

The bars across the bottom (the horizonral scroll bar) and 
along the right (the verrical scroll bar) of the System Folder 
window should now be gray, indicating thar the window has 
conrenrs rhar you cannor see ar its current size. 
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7. Press the right scroll arrow at the right end of the 
horizontal scroll bar. 

·D Syst em Folder E!l: 
10 noms '3 .6 NB in dis~ 34 .; r"'B •ull.b1-

w 
Appl> Monu lltms 

LQ] 
Extensions 

1.0 

Lml ~-
Systtm Con~:(i 

9 
fmd..-

.~:· 

~ 
Pre-ftrt nc.ts 

~ 
Scrapbook Ftlt .\ 

10 
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The contents of rhe window scroll pasr, bringing inro view rhe 
icons thar had been our of sighr and m the right. 

The scroll box moves ru rhe righr across rhe bar, showing what 
pan of Lhe window's comenrs you're looking ar. 

8. Press the left scroll arrow at the left end of the 
horizontal scroll bar. 

The contems of the window scroll past, bringing hack into 
view the icons that had been ouL of sight ancltu rhe left. 

The scroll box moves to the left across the bar, showing whar 
parr of the window's cunrenrs you're looking ar. 



9. Drag the scroll box toward the middle of the horizontal 
scroll bar, then release the mouse button. 

. ~D 
IOit~ms 

m 
,Je~nu ltens 

e 
f-r 

System Folder :tJJ: 
5.6 f1S in disk 

LQ] 
ExttnslOOs 

~ 
Prtfif'iOCU 

54 A MO i •uihblf 

LID 
0 

~~ 
S<)sttm Contto1 P.snt~ 

~ 
Scr)pbook F n.- f..,: 

0 

Now you see the icons near the midclle of the window. 

10. Press the down scroll arrow at the bottom end of the 
vertical scroll bar. 

m syst em Folder 1:!13 
101\em~ 3.6 M8 fn dU:k 3A.4 M8 ~valbblt 

tJ 
lliJ \\('to: 

LQ] 
(xt~SIOOS E

o 
rm ~ 
5\I.StHn Control PaM-ls . . , 

~ ~ 
flndE-1"' Pnft>f'Hle~S 

~ 
Set ~pbook flit ~ ,{'1 

. TI¢1121 

The contents of the windo~\· scroll past, bringing into vie\\. the 
icons that had been our of sight and rowarcl rhe borrom. 

The scroll box moves clown along the bar. 

11. Press the up scroll arrow at the top end of the vertical 
scroll bar. 

The comems of the window scroll pasr, bringing inro view the 
icons that had been out of sight and toward the top . 

The scroll box moves up along the bar. 

12. Drag the scroll box toward the middle of the vertical 
scroll bar, then release the mouse button. 

~ .... :::·::.,.•: IOII:!l 

~ow vou sec rhc icons ncar rhc middle oft he window. 

6 Remember: Changing the size of a window or moving the 
contents of a ~Yindow does not change its conrenrs. The 
conrenrs remain the same; only \\'har ~'OU see of the conrenrs 
changes. 6 
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When to use the keyboard 

You use the keyboard to type text and numbers, of course, as 
you would on a typewriter. (For touch typists, Macintosh 
keyboards have raised dots in the middle of the D key and the 
K key to help position your fingers on the home row.) 

Dependjng on the program you're using, you can use special 
keys on the keyboard to give commands to the computer and to 
replace or change the effect of certain mouse actions. Macintosh 
keyboards have three types of special keys: modifier keys, arrow 
keys, and function keys (Chapter 5 gives you examples of how to 
use these spedal keys). 

Modifier keys 

All Madntosh keyboards have four modifier keys: Shift, 
~(Command) , Option, and Control. 

Pressed by itself, a modifier key does nothing. You need to press 
it in combination with another key (or while using the mouse). 
The modifier key "modifies" the other key or the mouse action, 
giving a different result. 

You type a capital letter, for example, by pressing the Shift key 
with a letter key. Most programs let you give commands by 
pressing the ~ key with certain letter keys. 
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Arrow keys 

All Macintosh keyboards have four arrow keys: Up Arrow, 
Down Arrow, Left Arrow, and Right Arrow. 

Many programs let you use the arrow keys as well as the mouse 
to control the movements of the pointer on screen. 

Function keys 

Extended Macintosh keyboards have a row of function keys 
across the top of the keyboard. 

Some programs let you give commands, or a sequence of 
commands, by pressing certain function keys. 

(~I 

0 

0 IUIUIUIUI UUIUIUIUuiUIU IUiuiU - - - [i] 
0 

D Modifier ke)'S LJ FuncLion keys [_] Arrow keys 



Close a window 
When you no longer need to see the contents of a window, you 
can close it by clicking the close box. 

1. With the System Folder window the active window, 
point to the close box near the left end of the title bar. 

Close box -f!J syst em Folder · eEl 

2. Click the close box. 

The window closes, ancl the System f-older icon is no longer 
filled in with a panern of clors, indicating that ir is not open. 

You should have two windows on rhe Macintosh desktop: the 
Macintosh liD window, which is now the active window, and 
rhe 'lbtsh window. 

Move a window 
You can move a window anywhere on screen by dragging irs 
title bar. By changing the position and the size of windows, you 
can arrange windows in any way that works best for you. 

1. Point to the title bar of the Macintosh HD window 
(anywhere on the title bar except the close box or the 
zoom box). 

j=D · Macintosh no ·eJED-- Title bar 
31l~Hn:s 3 6 M8 io db k 34.8MB av~ibblt 

riD 
Sy~tt"m Fo~r 

~ 
~ 

Rt-adMt 
~ 

~ 

Tuohlr-xt 

2. Drag the title bar in any direction, then release the 
mouse button. 

When you drag a window's Li tle bar, an outline of the window 
follows the pointer on screen. When you release the mouse 
button, the window itself moves to the position of the outline. 

l:O · Mlltin tosh li D 0: 
3 items 32MB m dtsk 34.8MB av a11ablt 

~ ~ a _ 11! 
LJ:jU I ~--~ ··-~---- -•--••••••ool 
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I : 
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Q i 1.::1121 ! 
! Trash ! 

no it~ms ! t 

I II 

r 
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3. Click anywhere in the Trash window to make it the 
active window. 

4. Point to the title bar of the Trash window (anywhere on 
the title bar except the close box or the zoom box). 

5. Drag the title bar in any direction, then release the 
mouse button. 

Notice tim the 1b sh window, because it is the active window, 
stays on top of the Macimosh HD window if the two windows 
overlap. 

Macintosh liD 
3 iffoms 3 2 NB in dbk 34.8MB .availi~ibl~ 

LID 
S~Jstem Fcalder 
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24 Chapter 2: Understanding the Desktop 

6. Click anywhere in the Macintosh HD window to make it 
the active window. 

7. Close the Macintosh HD window by clicking the close 
box near the left end of the window's title bar. 

Macintosh HD 0~ 

31tems 3 .2 MB m di.sJ; 34 _g M9 avallab~ 

~ 
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~ h 
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The window closes, and the Macintosh liD icon is no longer 
filled in wi th a pattern of dots, indicating that it is nor open . 

The Trash window (the remaining windmv on the Macintosh 
desktop) becomes the active window. 



8. Close the Trash window by choosing Close Window 
from the File menu. 

You choose Close Window by poiming to the File menu name, 
pressing to pull down the menu, dragging to the Close 
Window command, and, with the command highlighted, 
releasing the mouse huuon. 

Of course, you can also close the window by clicking its close 
box. 

What next? 

Go ro Chapter 3, where you 'II learn how to set up your programs, 
or rake a break. Remember ro turn off your Macintosh if you'll be 
away for more than a few hours. 
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Chapter 3 

Setting Up Your Programs 
In this chapter 

You 'I! learn how to 

• insen a floppy disk 

• initialize a disk 

• copy the contents of a disk 

• take a floppy disk out of its drive 

• safeguard the cuments of a disk 

• use the 'lhtsh 

You'll also learn about 

• rypes of floppy disks 

• the difference between hard disks and floppy disks 

• caring for floppy disks 

And you'll learn more about 

• the stanup disk and the System Folder 

It will take about 40 minutes lOgo through this chapter. 

Before you begin 
You should have already 

• gone through Chapters 1 and 2 

Also, you need 

• a new floppy disk 

If you turned off the Macintosh at the end of Chapter 2, turn it 
back on. 
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Insert a floppy disk 
You should be able to ger floppy disks from wherever you got 
your Macintosh. The 3.5-inch (89-millimeter) floppy disks that ftt 
in your Macintosh computer 's SuperDrive come in two types: 
high-density and double-sided. Your Macintosh uses either type. 

IJouble-siclecl (800K) 

High-density 
disk symbol 

High-density (1.4 MB) 

Some older Macintosh models, however, do not have the 
SuperDrive 11oppy disk drive and cannot properly use high­
density disks. 
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1. Write "Practice" on a blank disk label. 

2. Afftx the label onto your new floppy disk. 

How the label goes onto the floppy disk is apparent from the 
molding of the disk's protective plastic case. Do not affix the 
label over the metal shuucr. 

3. Hold the disk between thumb and forefinger, with your 
thumb on the label and the metal shutter pointing 
away from you. 

4. Push the disk into the computer's SuperDrive, label 
side up and metal shutter first. Mter a moment the 
floppy disk's icon appears on your screen. 



Why a floppy disk isnJt floppy 
A floppy disk is made of thin, flexible material with a magnetic 
coating. 'lb protect it and to make it easier r.o handle, the floppy 
disk itself is enclosed in a rigid plastic case, which gives the 
floppy disk its "non-Aoppy" character. 

A metal shutter on the plastic case allows access to the floppy 
disk, which carries information in the form of magnetic signals. 
The shutter moves our of the way when you insert the floppy 
disk in a disk drive. 

You can use either of two types of 3.5-inch (89-millimetet) 
floppy disks in your computer's SuperDrive: high-density and 
clouble-siclecl. 

·:· {(JIOU use anotber Jl!Iacintosb: Some older Macintosh 
computers may not have d1e SuperDrive floppy disk drive 
and therefore cannot use high-density disks. Use only 
double-sided disks on these older Macimosh computers. ·:· 

High-density disks can hold 1.4 megabytes (MB) of information 
(about 300 typewritten pages). Double-sided disks can hold 
800 kilobytes (K) of information (about 200 typewritten pages). 
(One d1ousand twenty-four kilobytes make a megabyte.) 

I page 
~?:---._ 
~ 

4K 

200 pages 

~ 
SOOK 

300 pages 

~~~ 
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Floppy disks 

5,000 pages 
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1 
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~ ?ie:3; 
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Hard disks 

Floppy disks are also called diskettes. 
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Initialize a disk 
Before you can usc a new floppy disk, you must be sure it is 
initialized; that is, prepared so that the computer knows where 
to store and retrieve information on the disk. Initializing a disk is 
like drawing the lines on a newly paved parking lot: you don't know 
what fits where until you figure out how much room you have. 

Many stores sell disks that arc already prepared. These disks are 
called "preformarred." If you have preformatted disks, skip ahead 
to "Copy the Contents of a Disk." 

1. Mter you insert your practice disk into the SuperDrive, 
read the dialog box that appears on screen. 

If you inserted a high-density disk, this dialog box appears: 

1· - ,I This disk Is unreodoble: 

Do you want to Initialize it? 

(( Eject )J { Initialize) 

If you inserted a double-sided disk, this dialog box appears: 

lfFil This disk Is unreadable: 

9 Do you want to Initialize it? 

(( Eject J) {One-Sided) {Two-Sided) 
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2. Depending on which dialog box appears, click Initialize 
or Two-Sided. 

Another dialog box appears: 

Ji\ This process will erase all 
ill information on this disk. 

{ Cancel ) f[ Erose B 

This dialog box gives you one last chance to cancel. It alerts 
you that you're about to erase- and therefore lose- any 
information that may be on the fl oppy disk. In rhis case, 
because the floppy disk is new, you have no information 
to lose. 

3. Click Erase. 

A third dialog box appears: 

n 
9 

Please name this disk: 

u OK u 



4. Type "Practice". 

If you make any typing errors, press the Delete ke}' ro 
backspace over them. 

When you name a disk, you can type up ro 27 charaGcrs, 
including spaces. You cannot usc a colon (:) in the name. 

5. Click OK. 

The computer takes about a minute to initialize the disk. A 
series of messages appears on the ::;creen to let you know hmv 
the process is going. 

When the computer is done initializing the floppy disk, the 
disk's icon appears on the Macin tosh desktop directly below 
the Macinro::;h HD icon (the startup hard disk icon) near the 
upper·right corner. 

Copy the contents of a disk 
Most programs you get arc supplied on one or more floppy disks. 
You can more efficiently use a program if you fi rst install it on 
your hard disk (copy it from its floppy disk to your hard disk). 

To practice copying the contents of a floppy disk w your startup 
disk, use your practice disk (even if there's nothing on it). 

1. Make sure that the Practice floppy disk icon is selected. 
If it isn't, click the icon (not its name). 

(1)~ 

·:· By tbe way: l f you inserted a preformatred floppy disk, your 
disk icon will be named "Untitled" instead of"Practice." To 
rename the disk, d ick itS name and type "Practice': ·:· 

COiilillliC:S Ill> 
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Floppy disks, hard disks, and startup disks 

Both floppy disks and hard disks funnion like filing cabinets: 
you srore flies in them. The differences he tween floppy disks 
and hard disks arc in how much informalion they can store, how 
quickly you can retrieve information from them, and how easily 
you can carry them around. 

You can store much more information on a hard disk and 
retrieve it much faster than you can on a floppy disk. 

And while you can carry a floppy disk in your shin pocket, a 
hard disk is sealed in a hard disk drive, which is installed inside 
the computer or enclosed in a plaslic box that's connected to 
the computer. 

D 
' ' '- ---------· 

lmcmal 
hard disk 

[--- J ~ 
External 
hard disk 

Floppy 
disk 
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You can tell whether a disk is a floppy disk or a hard disk by 
looking at its icon on the desktop. 

1. I 
Hat·d Disk 

[d 
Floppy Disk 

The disk whose icon appears ncar the upper-right corner is the 
startup disk, which contains the information that the Macintosh 
uses ro mrr itself up. 

Tllal "startup" information is contained in programs and other 
files that are in rhe System Folder on the stanup disk. The 
startup disk must have only one System Folder. If it has more 
than one, the computer becomes confused about where to get 
the information it need<; to start up and run, with unpredictable­
and undesirable- results. 



2. Drag the Practice floppy disk icon to the Macintosh HD 
icon until both icons are highlighted, then release the 
mouse button. 

Hot h icons are highlighted when the tip ofrhe arrol.\· poi mer 
reaches the Macinrush HD icon as you drag the Practice 
lloppy disk icon. 

(1)~ 

::::::::::::::::::::::::::::···· ······· 
... 

' 'lllll'~llmRIIIalU'' ... ~:~~~::: 

~ : ~: ~ : ~ : ~: ~: ~: ~: ~: ~: ~: ~: ~ : ~ : 

•••••••••••• ••••••••••••••••••••••••••• 

When you release the mouse button, the Macimosh copies 
the contents of the Practice tloppy disk omo Macimosh HD 
(your scartup hard disk) . The copy is in a folder named 
Practice, which is now on Macintosh HD. 

3. Click the Macintosh HD icon to select it. 

4. Choose Open from the File menu. 

You choose Open by pointing ro the File menu name, 
pressing to pull clom1 the menu. dragging to the Open 
command so that it's highlighted, and releasing the mouse 
button. 

The Macintosh HD w·inclow appears, showi11g you the 
contents of the stanup hard disk. The conrems should 
include a new folder called Practice, which the computer 
created when it copied the contents of the Practice floppy 
disk ro Macintosh HD. 

You may have to make the window bigger or use the scroll 
bars to find! he Practice folder. 

5. Click the Practice folder to select it. 

6. Choose Open from the File menu. 

You choose Open by poiming to the File menu name, 
pressing to pull down the menu, dragging to the Open 
command so that it's selected, and releasing 1 he mouse 
button. 

The folder holds the conrems of the floppy disk you've copied 
(in this case, the folder coma ins nothing because there's 
nothing on the Practice disk). 

7. Close all the windows you have on the Macintosh 
desktop. 

You close a "\\·indo,,· (\\·hen it's the acrire window) h~' either 
cl icking irs close box or choosing Close Window from the File 
menu. 
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Take a floppy disk out of its drive 
While there's only one way ro insen a floppy disk into the 
SuperOrive, there's more than one way to rake it out. Here is the 
best way: 

1. Make sure that the Practice floppy disk icon is selected. 
If it's not selected, click it. 
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2. Eject the floppy disk by choosing Put Away from the 
File menu. 

New Folder 3€N 
Open xo 
Print :)(:!> 

1: lose Window :)[<!H 

··········-········-·-
Get I nfo X I 
Oupli!:<11 e :)[:!) 

Make Alias 
Put Away ' X 
·························································-· .. 
Find .. . X F 
Find Again X G 
····························· 

Page Setup .. . 
Print Desktop ... 

You choose Put Away by pointing to the File menu name, 
pressing ro pull clown rhe menu, dragging ro the Put Away 
command so that it's highlighted, and releasing the mouse 
button. 

Pur Away puts the object you've selected hack in it<; place (in 
this case, it allows you to remove the floppy disk from the disk 
drive and put it away) . 



Safeguard the contents of a disk 
You can lock a disk so that irs contents cannot be changed in any 
way. When a disk is locked, you cannot change the Ales that are 
on it, delete any files, or store additional files. 

To practice locking and unlocking a floppy disk, use your practice 
disk. 

1. Hold the practice disk between thumb and forefinger, 
with your thumb on the label and the metal shutter 
pointing away from you (as if you were going to insert 
the disk into a drive). 

2. Find the square hole in the near-left corner of the 
floppy disk. 

A moveable rah on the back side of the disk should be 
blocking the hole, indicating that the disk is unlocked. 

·:· {[you're using a bigb-densi~y jloppy disk: You'll notice an 
addi tional square hole, across the label from the first hole. 
This second hole has no moveable tab and is always open. ·:· 

3. Turn the disk over and lock the disk by sliding the tab 
on the back side of the disk so that the square hole is 
open. 

••• • • • ••• . . . . . . . . . . .. • • 

Locked Unlocked 

Use your thumbnail or a push pin to move the tab. 

4. Unlock the disk by sliding the tab back so that the 
square hole is blocked. 

Your practice disk should be unlocked so you can use it ro 
store files in the next chapter. 
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Taking care of floppy disks 
Follow the instructions about care and maintenance that came 
with your disks. At minimum, remember these Lhree points: 

• Keep the disks away from magnetc;. Information on the 
disks is in the fom1 of magnetic signals, so a magnetic field 
can destroy that information. 'Ielevisions and monitors, 
Lelephones, loudspeakers, and certain kinds of lighting 
fixtures all have magnet<;. 

• Protect disks from extremes of temperature and humidity. 

• Do nor open the disk's metal shutter. Touching rhe disk 
inside the shutter could damage it. 

.)6 Chapter 3: Setting Up Your Prog1~1ms 

Use the Trash 
When you no longer need or want a ftle or folder, you throw it 
away by dragging irs icon ro rhe ·n·ash. (A file can be either a 
document or a program.) Practice using the Trash by throwing 
away the Practice folder, which you created when you copied Lhc 
contents of vour Practice disk onto Macintosh HD. 

1. Click the Macintosh HD icon to select it. 

2. Choose Open from the File menu. 

You choose Open by pointing to the File menu name, 
pressing to pull clown Lhe menu, dragging Lo Lhe Open 
command so Lhat ir 's highlighted, and releasing the mouse 
huuon. 

The Macintosh liD window appears, showing you the 
contents of Lhe sLanup hard disk. The coments should 
include the Practice folder. 

You may have to make the window bigger or use the scroll 
arrows to find the Practice folder. 

3. Click the Practice folder icon to select it . 



4. Drag the Practice folder icon to the Trash icon until 
both icons are highlighted, then release the mouse 
button. 

!3oth icons are highlighted \\'hen the tip of the atTO\Y poinrer 
reaches the Trash icon. 

~ 
~l r'Jii 

When you release the mouse button, the PraGice folder 
''disappears .. into the 'li"ash. When you pur a file or folder in 
the Trash. the Trash icon bulges to indicate that it is no longer 
empty. 

; . Open the Trash icon. 

You open an icon by clicking it ro select it and then choosing 
Open from the File menu. 

\Vhen rou open the Trash icon. the 'li·ash window appears. 
The Practice folder vou·ve just thrown mray is in the window. 
Annhing you pu t in the 'Ji·ash stays there until you empty the 
Trash. 

You can put anything that"s in the ·n·ash back where it was by 
clicking it ro select it an cit hen choosing Put Away from the 
File menu. (Or you can drag it back where iL was.) 

6. Choose Empty Trash from the Special menu. 

A dialog box appears asking you ro confi rm that you wanr ro 
permanently remove the contents of the 'lbtsh. If you change 
your mind, you can cl ick the Cancel bunon. 

Clicking OK empties the 'Ii·ash, and you lose anything that's 
in it. 

7. Click the OK button. 

Notice that the ·n·ash icon no longer bulges, indicat ing that it 
is empty. 

8. Close the Trash window by clicking its close box. 
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On your own: Install your programs 
If you have any disks containing programs (such as word 
processing or graphics) that you plan to use on your Macintosh, 
install the programs now on your hard disk. If you do not have 
any program disks yet, go to the next chapter. 

6 Important: Some programs need Lo be installed in a 
specific way, so follow the instructions that came with each 
program. !:::. 

If a program didn't come with specific installation instructions, 
these general instructions tell you how to copy the comenrs of a 
program disk to your startup disk: 

1. Lock the program disk. 

The program disk contains your master copy of the program. 
Locking the disk protects its contents but doesn't keep you 
from copying the comems omo another disk. 

2. Insert the program disk into the floppy disk drive. 
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3. Drag the program disk icon to the Macintosh HD icon 
(your startup hard disk icon) until both icons are 
highlighted, then release the mouse button. 

Both icons are highlighted when the Lip of the poi mer arrow 
reaches the Macintosh HD icon a~ you drag the program disk 
icon. 

When you release the mouse button, a series of messages 
briefly appears on screen ro let you know that the computer 
is copying the comenLc:; of the program floppy disk onro 
Macintosh HD. The copy is in a folder on Macintosh HD with 
the same name as the program disk. 

4. Eject the program disk by making sure it's selected and 
then choosing Put Away from the File menu. 

;. If the Macintosh HD window is not on the desktop, 
open the Macintosh HD icon. 

\Xlhen you open the Macintosh HD icon, the Macintosh liD 
window appears, showing you the contents of your stan up 
hard disk. Among its contents is the program folder holding 
the contents of the disk you've copied. 

6. Click the program folder to select it. 



7. Choose Open from the File menu. 

The folder window appears, showing the contents of the 
program folder. The folder has Lhe same contents as the 
program disk. 

8. Look for a System Folder in the program folder. 

Sorne program disks have a System Folder (so they can be 
used as startup disks) . If the program disk you've copied 
has a System Folder, you now have rwo System Folders on 
MacinLOsh HD. 

Throw away extra System Folders 

Your startup disk must have only one System Folder. Whenever 
you copy the contents of a program disk to your sLarLUp hard disk, 
check to see that you have nor copied an extra System Folder. If 
you have, throw away the extra System Folder. 

1. Drag the extra System Folder to the Trash in the lower­
right corner of the screen until both icons are 
b.ighlighted, then release the mouse button. 

2. Choose Empty Trash from the Special menu. 

A dialog box alerts you thaL you're about w throw away­
permanemly- the conrenrs of the 'Ii·ash (in this case, the extra 
System Folder). 

3. Click OK to confrrm that you want to throw away the 
contents of the Trash. 

4. Close the program folder window by clicking its 
close box. 

What next? 

Go to Chapter 4, where you'lllearn how to creare a document. 
Or take a break. Remember to turn off your Macintosh if you'll 
be away for more than a few hours. 
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Chapter4 

Creating a Document and 
Saving Your Work 
In this chapter 

1'llu'll review how to 

• open a program 

• create a document in a program 

• save your vmrk 

• switch programs 

• dose a document 

(The Macintosh Basics rour disk inrroclucecl you to these ski lls.) 

You'll also learn about 

• \vhm happens when you open a program icon 

• why it's imj)orra nr w save your work 

• the difference between application programs and system 
software 

It will rake about 30 minutes to go through this chapter. 

Before you begin 

You should have already 

• gone through Chapters 1 through 3 

If you turn eel off the Macintosh ar the end of Chapter 3, turn it 
back on. 

-!1 



Open a program 
'Io practice using a program to create a documenr and save your 
work, you can use TeachText, a simple word-processing program 
that comes wiLh your computer. 

1. If you closed the Macintosh HD window at the end of 
Chapter 3, open the Macintosh HD icon. 

To open the icon, click it to select it and then choose Open 
from the File menu. 

The .Macintosh HD window appears, showing you the 
contents of your startup disk. The conrenrs include a program 
called ·reachText. 

2. Open the TeachText icon. 

~ '<!;:/ 
Teach Text 

'lb open the icon, click it to select it and then choose Open 
from the File menu. 
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\Xt'hen you open the TeachText program, 

• an untitled window appears 

• the menu bar shows TeachText menu names 

• rhe Application menu icon in the right corner of the menu bar 
becomes the Teach Text icon 

Teach Text menus 

* 1 rile [dit 

1!0' 

Application menu 
('leachk"\t 

Untitled 'Jeach'lexr window 

The untitled window contains nothing because you haven't 
written anything in it. It remains untitled until you save 
whatever you've written and give it a name. The file that you 
create and name is called a document. 



Create a document 
The umitled window is like a blank sheet of paper, a document 
waiting to be created. In the upper-left corner of the empty 
document is a blinking vcnicalline. The line is called the 
insertion point, because it marks the place where the text you 
type will be insenecl. 

As you type, you usc the Macintosh keyboard as you would a 
typewriter keyboard , except: 

• If you make a mistake, press the Delete key to backspace 
over it. 

• Don't press the Return key ·when you get to the end of a line. 
Keep typing. The text will continue on the next line 
automatically. 

Type the following text: 

Sail i ng across an unknown sea , we saw the 
lights of a city in t he distant hori zon . Was 
it ano t her strang e l and, with strange a nd 
cruel people s peaking differ e nt l anguages , 
ealing different f ood , wearing diffe r e n t 
clothes? We wished it were home . 

You will be changing this text in the next chapter. 

Save your work 
Until you save your work, it exists only in the computer's 
memory-like thoughts that are lost unless you write them down. 

1. Choose Save from the File menu. 

N<Hl' :)[(N 

Opt~n ... :)((0 

Close 3Cl1J 

&tHr az 
Saue Rs ... 

Page Setup ... 
Print... 3CP 

Quit 31:0 

The dialog box that appears lets you name the document and 
decide where you want the computer to store it. 

continues ~ 
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2. Type "Opening Lines". 

I= M acintosh HOY) = Macintosh 110 

D U!?llll :vii? ( £j!?l:1 ) 
D System Folder 
0. h>ncl!f(;l<l ( Desktop ) 

( New 0 ) 

( Cancel ) 

I IQ! (( Saue )J 

Saue this document as: • Q r:J 
I Opening lines) I ® D 0 Q 

Because the word "UntiLled" is selected (it 's highlighteu) 
when the dialog box appears, all you have to do is start typing. 
Whatever you type replaces the selected text. You 'lllearn 
more about selecting text later. 

3. Click Save. 

'.ED Openino lines 0~ 
Sailing across on unknown see, we saw the l ights of a city 1n the 10 
di stont horizon. Was it another strange lend, with strange and 
cruel people speaking different languages, eating different food, 
w earing different cl othes? We wished It were home) 

The \Vindow is now rirlecl ··opening Lines" and the document 
has been stored on Macintosh HD. 
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Save it or say so long 
You need to save your document before you turn off the 
computer. 

Using a Macintosh may seem like using a typewriter, pencil and 
ledger, paintbrush and canvas, or pen and drafting paper-
but a compULer is unlike those orher tools in one imponant 
aspect: anything you create on a computer exists only 
temporarily in the computer's memory until you save 
your work. 

That is, until you tell the computer to record your creation 
on a disk, your finest work is no better than a memal note­
forgorren faster than you can turn off a switch. 



Switch programs 
The Opening Lines window is rhe acrive window ancl 'leachTexr is 
rhe acrive program, bur Teach'lexr is nor rhe only program rhar's 
open. 

The Finder-rhe program thar displays rhe Macinrosh desktop­
is also open, bur righr no\\' ir is nor acrive. (The Finder is ahuc~)'S 

open when your Macinwsh is on.) 

You can have several programs open ar one rime (hoi.\· many 
programs depends on how much memory your compurer has), 
bur only one program ar a rime can be the acrive program. The 
acrive program is rhe one that's ·'on rop" of other open 
programs-just as the active window is on top of mher windows. 

1. Make the Opening Lines window smaller by dragging 
its size box and releasing the mouse button. 

Afrer you resize rhe window, you should be able ro sec rhe 
Macinrosh HD icon in the upper-right corner of the Macintosh 
deskrop. 

2. Make the Finder the active program by clicking the 
Macintosh HD icon or anywhere on the desktop. 

The finder becomes the active program. Norice that 

• rhe \1acinrosh HD window appears on top of the Opening 
Lines window 

• rhe menu bar shows Finder menu names 

• the Application menu icon in the right corner of rhe menu 
bar becomes the finder icon 

fi f ile Ell1 t U1cw Lobel Special 

Openlnn line ~ 

Snlllng ncross M unknown seo. we sow the light s of o clly 1n the 
dls l tmt honzon Wos ll another ~ lrcnge lond, with s trange end 
cruel people speokl ny c.llflerentlangueQeS, ectm~ dll lcrcnt looo, 
weartng 110-- Mud ntush 110 1!!-!!!!I!I!IEl!l 

411•rnl l7M81ndls>. lo4-4t1J.t'<'.t11W.loo 

~cru 0 B 
Ru:tt-1. S111hmhld•r Tu,hh ... t OpMWjllnu 

""'('iJ8 ,: ,. 
I 

I P' 
1
91'4

1 JJ!i 
J Trutt 

Notice rhc icon in the Macinrosh HD window represenring rhe 
document Opening Lines, which \'Ou·ve just created and 
saved on i\lacinrosh HD. 

continues ..,. 
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Two types of programs 
Programs that you usc to do your work on the computer are 
called application programs, or applications, because they're 
ways of app~J'ing computer technology to the work that you do. 

Word-processing programs, for example, are applications 
because they enable you to write memos, reports, papers, 
theses, novels-wharever you need or wam to write. And if 
your work involves creating graphics, calculating numbers, 
composing music, or keeping track of large amounts of 
data- there arc application programs for your work as well. 

Most Macimosh programs work in similar ways, so most of 
what you learn using one application you can use in other 
applications. 

Programs that d1e computer uses ro operate, on the other 
hand, are called system software (or "rhe operating system"). 

And then there's the Finder 

Between you and system software is an application called the 
Finder, which is the program that displays the Macintosh 
desktop. It's called the Finder because, like the viewfinder in a 
camera, it gives you a view of all the objects- disks, programs, 
documents- that you have in your computing work space 
(your "desktop"). 

Using the Finder, you can tell system soft'i¥are whar you want it 
to do for you: which disks you want to use, whid1 programs and 
documents you want to open, where you want files lObe stored. 
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3. Make the Opening Lines window active by 
clicking anywhere in it. It's partially hidden by the 
Macintosh HD window. 

The Opening Lines window comes back to the top. It's now 
the active \Vindow, and Tcach'Jexr becomes the active 
program. 

You make a window active by clicking any part of it. The 
program that "owns" rhe window becomes active as soon as 
the window becomes active. 

4. Make the Finder the active program by choosing Finder 
from the Application menu in the right corner of the 
menu bar. 

You choose Finder by pointing to the ApplicaLion menu icon, 
pressing to pull down the menu, dragging tO the item 
"Finder" so that it's highlighted, and then releasing the mouse 
button. 

The Finder becomes the active program, and the 
Macimosh HD window becomes the active window. 



5. Make TeachText the active program by choosing 
TeachText from the Application menu. 

Hide Finder 
Hide Others 
Show fill 

../ ~ Finder 
1!} TeachTeHt 

" 'tt 

TeachText becomes the active program, and the Opening 
Lines window becomes the active window. 

f rom the Application menu, you can choose the open 
program that you want tO make the active program. All open 
programs are listed in the Application menu. The icon at the 
top of the Application menu is the icon of the active program. 

Close a docun1ent 
When you close a document, you do not close the program that 
you used to create it. (Closing a program is cal led quilling ) The 
program remains open and remains the active program until you 
quit the program or make another program the active program. 

1. If the Opening Lines window is not the active window, 
click anywhere in it to make it the active window . 

2. Close the Opening Lines window by clicking the close 
box near the left end of the title bar, or by choosing 
Close from the File menu. 

The Opening Lines window closes bur 'leachText is sti ll the 
active program. Notice that 

• the menu bar sti ll shows 'leach'Iext menu names 

• the Application menu icon in the right corner of the menu 
bar is still the 'leachText icon 

What next? 

Go to Chapter 5, where you'lllearn how to revise your document 
and then print it. 
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Chapter 5 

Changing a Document and 
Printing Your Work 
In this chapter 

You.lllearn ho\r to 

• open a document 

• change a clocumenr 

• choose a primer 

• print a ducumem 

• quit a program 

• make a backup copy of a ducumem 

You·ll also learn about 

• double-clicking a!i a way 10 open icons 

• using keyboard shoncuts 

It \rill take about ~0 minutes ro go through this chapter. 

Before you begin 

You should have alreadv 

• gone through Chapters 1 through 4 

Also. make !iure rhat 

• your computer is connected to a primer 

A printer can be connected directly to ~~our computer. or it can be 
conneCLed through a net\\'Ork. 

Go ro rhe inst run ions 1 hat came with your primer if you neecl ro 
connect it to your compu ter. 

If your computer is connected to a network. find out from your 
network aclminbtrawr (or the person \\'hO set up your computer) 

• which printer on the network you Gill use 

• where it is on the nwvork (irs .. zone ... if the network has 
zones) 

• what its name is (every printer on a nenrork has it!i o\rn 
name) 

If you turned off the ~lacinrosh at the end of Chapter -f . turn it 
hack on. 
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Open a document 
When you open a documem, the program that you used m create 
that documem becomes the active program. 

1. If you closed the Macintosh HD window at the end of 
Chapter 4, open the Macintosh HD icon. 

'lo open the icon, click it to select it and then choose Open 
from the File menu. 

The Macintosh HD window appears, showing you the 
conrents of your stan up hard disk. The contents include the 
Teach Text program and the 'Ieacll'lext document called 
Opening Lines, which you created in Chapter -1 . 

2. Open the Opening Lines icon. 

g 
D 

Opening Lines 

You can open an icon by double-clicking it: click the icon 
twice in rapid succession, without moving the pointer. 
Oouble-clicking an icon has the same effect as selecting the 
icon and then choosing the Open command. 
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When you open Opening Lines, 'leach Text becomes the active 
program. ('leachText is the program that you used to create 
Opening Lines.) Notice that 

• the Opening Lines window appears 

• the menu bar shows Teach Text menu names 

• the Application icon in the right corner of the menu bar 
becomes the Tcach'lbt icon 

'* rue [dll (1) <!' 
iO Opentn lines 

e111ng ecross en unknown see, we sow the ltght s of o c1ty In the c::J 
di s tent hortzon Wes ll ano ther strenge lend, w lll'l ~ t renge> end Hvdt>U\. 
cruol poople spec"lng Olfferenl 1engueges, eet mg dllferent fooa, 
weenng Glfhrent clothes? We wished i l were home 

Change a document 
The Opening Lines window shO\\'S you the text you typed in 
Chapter '1 . You will be making some changes to Lhe text using 
techniques that work in most Macintosh programs. 

Keep rwo d1ings in mind: 

• The insertion point-the blinking vertical line-is where 
anything you type appears. 

• The !-beam pointer replaces the arrow pointer when you're 
dealing with text. You control the !-beam pointer with the 
mouse as you would the arrow pointer. 

I 



1. tocate the insertion point. It should be in the upper­
left corner of the document. 

2. tocate the 1-beam pointer. If you don't see it, move the 
mouse slightly. The pointer moves as the mouse moves. 

:.low you're ready to insert some text. 

3. Move the 1-beam pointer to the immediate left of the 
word "an" (after "Salling across") . 

4. Click. By clicking, you put the insertion point where 
you were pointing with the 1-beam pointer. Anything 
you type is inserted at that point. 

'eO Opcninq Lines - 0 3 
Soil ing acr oss Jan unknown see, we sew the l i ghts of o city m the IO 
dlstont horizon Was It anot her strange land, w1t h strange and 
cruel people speaking different languages, eatmg di fferent food, 
wear ing different clothes? We Wished 1t were home 

5. Type the words "the blackness of space, adrift in". 

If you make any typing errors, press the Delete key to 

backspace over them. 

:o 

:.Jexr. you·ll change some text. 

6. Move the 1-beam pointer to the immediate left of the 
word "lights" (after "we saw the"). 

7. Drag horizontally, selecting the word "lights", then 
release the mouse button. 

'Jo clrag, hold the mouse buuon clown as you move the 
mouse. The selecLed word is highlighted (surrounded by 
black or another color) . 

=o · Openinq Lines · 0;:; 
Sa1llng across t he blackness of space, adnftm on unknown see, 10 
we sew the ill!ll1ll of o city 1n the distant honzon Was It anot her 
strange lend, w i th strange and cruel people speaking different 
languages, eotmg different food, weari ng :llfferent clothes? We 
wished 1l were home. 

8. With "lights" selected, type the words "clear blue". 

Whatever you type replaces the Lext you selectee!. If you make 
any ryping errors, press the Delete key to backspace over 
them. 

9. Now move the 1-beam pointer to the immediate left of 
the word "city'' (after "of a"). 

!;O · Opening Lines 0! 
Sei l i ng across t he blackness of space, adrlrt In an unknown sea, 10 
we sew the clear blue of el;lly in the distant honzon. Was 1l 
another strange lend, with strange and cru21 people speaking 
differ ent languages, eating different food, weonng different 
clothes? we wished It w ere home. 
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10. Drag horizontally, selecting the word "city'', then 
release the mouse button. 

liiD Openlno lines 
Selling across the blackness of space, adrift men unknown sea, 
we saw the clear blue of a Ill in the distant honzon. Was It 
another st range land, w1th strange and cruel people speakmg 
dl ffer entlengueges, eo ling different f ood, weonng different 
clothes? We wished it were home. 

11. With "city'' selected, type the word "planet". 

\Vhatever you type replaces the text you selected. 

E!l= 
k} 

12. Move the 1-beam pointer between the letters "n" and "t" 
in the word "distant" (after "in the"). 

::o Opening Lines E!l~ 
Se111ng across the blackness of space, adrift in an unknown see, I{? 
we sow the clear blue of o plenet i n the dlstanjt horizon. Was it 
another strange lend, with strange end cruel people speaking 
dlfferentlonguoges, eollng different food, wearing different 
clothes? We wished it were home 
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13. Drag horizontally, selecting the letter "t" and the word 
"horizon", then release the mouse button. 

1m Opening lines E!J~ 
Seiling across the blackness of space, adrift in en unknown see, fO 
we sew the cl ear blue of o planet in the distenllll!liB!Iil Was it 
anot her strange lend, Wlth strange ond cruel people speaking 
different languages, eotmg di fferent food, weari ng different 
clothes? We w1shed 1l were home. 

14. With "t horizon" selected, type the letters "ce". 

If the period is missing after "distance", type one now. 

liD Upemns lines · -0: 
Soi ling across the blackness of space, adri ft In on unknown seo, 1-0 
we sew t he clear blue of e planet In t ile d l stonc~. Was 1t another 
strange lend, wi t h strange and cruel peopl e speokmg di ffer ent 
languages, eating different f ood, weonng different clothes? We 
wished it were home. 

If you make any typing errors, press rhe Delete key to 

backspace over them. 



Save your work so far 
The changes you·re made so far are not pan of Opening Lines 
umil you save them; that is, you need ro tell the computer to 

record the changes in the clocumcm th;n's stored on Macinrush 
HD (~'our starrup hard disk). 

Umil you save them, the changes arc in a very temporary, 
electronic state. You could lose them if power w the computer 
\\·ere interrupted or if a problem with a program caused the 
computer to stop working properly. 

Choose Save from the File menu. 

Or hold clo\\·n the~ (Command) key on the keyboard as you 
press the S key. Pressing :l€-5 is a keyboard shortcut ror choosing 
Save rrom the File menu. 

Save regularly. and save often. 

Taking a shortcut 
Many commands that you choose from menus can also be 
given using keyboard shortcuts. A keyboard shortcut is a 
combination of keys that you press at the same time ro get 
the same result as choosing a command from a menu. One or 
the keys is always the :l€ key or another modifier key. 

For example, instead of choosing Save rrom the File menu, 
you could press the ~ key and the S key together. 

You can find our the keyboard shortcuts for commands by 
pressing a menu name and looking at the commands in the 
menu. Any keyboard shortcuts are shown in a column next to 

the commands. 
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Make more changes to a document 
You've sa,·ed Lhe changes you've made so far: Lhe changes are 
nmY pan of the documenr rhat's sLored on Macintosh HD. You 'll 
be making a few more changes before you're done. 

You continue by moving some text to anmher place in the 
paragraph. 

1. Move the 1-beam pointer to the immediate left of the 
words "We wished" (the start of the last sentence). 

2. Click. By clicking, you put the insertion point where 
you were pointing with the 1-beam pointer. 

3. Move the 1-beam pointer between the letter "e" in 
"home" and the period at the end of the last sentence. 

4. Hold down the Shift key on your keyboard and click to 
select the words "We wished it were home". 

Ilolding clown the Shift key as you cl ick selects the text 
between rhe inscrrion point and wherever you click. 

!D OpeninQ lines Em 
Seil ing acr oss the blockness of space, odrlft ln en unknown see, 
we sew the clear blue of a planet In the distance. Wes it another 
strange lend, w1th strange end cruel people speaKing different 
languages, eating different food, weorlng different clothes? 
®ffitiDI.i§ijM 
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5. With "We wished it were home" selected, choose Cut 
from the Edit menu. 

Choosing Cm removes whatever you·ve seleCLed from the 
document and stores the selected material in a temporary 
clecrronic space called the Clipboard. 

Copy 
Paste 
Clear 

" 
))((2 

Select All 3€ A 

Show Clipboard 

6. Move the 1-beam pointer to the immediate left of the 
words "Was" (in "Was it another strange land"). 

7. Click to set the insertion point. 



8. Choose Paste from the Edit menu. 

Select All :!€A 

Show Clipboard 

The words "We wished it were home" appear at the location 
of the inserrion point When you choose Pa:,te, the Macinrosh 
takes wha1ever 's in the Clipboard and puts it in the document. 

Nexr, you 'II delete a sentence. 

9. Drag the 1-beam pointer across the words "Was it 
another strange land" to select them, then release the 
mouse button. 

If rhe words are on rwo lines, drag down to the second line 
and release the mouse bunon when the pointer is to the 
immediate right of the word ·'land". 

l:;n Op ening lines 0: 
Selling across the Dleckness of space. adrift in an unknown see, IO 
we sew the clear blue ore planet in the distance. we wished it 
were homeWas •l another strange land, With strange end cruel 
people speaking different languages, eating di fferent food, 
weanng dl ffe rent clothes? 

10. With "Was it another strange land" selected, choose 
Clear from the Edit menu. 

When you choose Clear, the Macintosh removes the selected 
1ex1 from rhe document. (Pressing the Delete key once has 
the same effccr.) 

>)[:2 

:I€H 
3€C 
:1€U 

Select All 3€A 

Show Clipboard 
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11. Select the word "cruel" (after "strange and") by double­
clicking it. 

)bu can select a word by double-clicking it: poim ro it with the 
!-beam poimer and click twice in rapid succession, without 
moving the pointer. 

';o Opemnq lines PJ; 
Selling across the blackness of s pace, edrif t in en unknown sea, 10 
we sew the cleer blue or a planet 10 the distance We wished it 
were home, with strange and Si!l!ll people speeklng different 
lengueges, eating different food, weari ng different clothes? 

12. With "cruel" selected, type ''wonderful". 

Whatever you type replaces t.he text you selected. 

13. Drag the 1-beam pointer across the question mark 
(after "different clothes") and the stray period at the 
end of the paragraph, then release the mouse button. 

:: Ope ning line s Pl~ 

Selling across the blackness of space, odnfl in en unknown see, Kr 
we sew the cl ear blue or o planet 10 the d1stonce. We wished it 
were home, with s trange and wonderful people speaking different 
longueges, eetmg different food , weor ing different clothes, 
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14. With the question mark and the period selected, type 
a period. 

You may have left extra spaces or no spaces between words. 
If you did, position the 1-beam poinrer where you need w 
delete or add a space, click to set the insertion poinr, and 
press the Delete key or the Space bar as necessary. 

Openinq lines PJ: 
Soiling across the bleckness of s pace, adrift In on unknown s ec, Kr 
we sow the clear blue of e planet in the distance We wished It 
were home, with strange end wonderful people speaking different 
languages, eating different rood, weari ng different clothes) 

1;. Choose Save from the File menu (or use the keyboard 
shortcut :Jt:-S). 



Choose a printer 
Before you can print a clocumem, you have ro tell the Macintosh 
~·hich primer to use by choosing a primer in a program called the 
Chooser. 

You don't need w choose a printer every time you print. You need 
to choose one only when you wam to use a printer for the first 
time and whenever you decide ro change printers. 

How }'OU use the Chooser depends on whether your Macintosh is 
connected directly to the printer or connected to a network. 

If your printer is not on a network 

J\tlakc sure that you've connected the printer according to the 
instructions that came with it and that you know which port you 
used (on the back of the computer) to connect the printer. 

1. Choose the Chooser from the Apple menu. 

The Chooser window appears. 

COIIIilllleS ~ 
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2. Click the icon representing the printer you want to use. 
Make sure the icon is selected. 

- Chooser 

~ ~. 
0 1 Select o port: 

I 

jQ 
AppltShar"i App~T.o~1k. .. ge'w'dter 

~ 
··-· ~ 

ml!!mll Lu•r'Writtr 

~ ~ I II 
1 

LO ApploT qt'llntor LO~"'fnt!r 

I 
I IJ I lo 

i ; P.rscw"1 Yr1ttr SC 

I 
----- - -

lo AppleTolk 
0 Active 
® lnecl1Ye 7 ( 

·!· lfyou bave a Personal f.aser\\lriter SC, go to step 5 after you 
click the Personal LaserWriter SC icon. ·:· 

3. Click to select the icon representing the port that you 
used to connect the printer. 

You have two choices: the primer port or the modem parr. 
The primer pon is automarically selected. Click the icon that 
matches the icon of the port (on the back of the computer) to 
which you connected the primer cable. 

4. Click the word "Inactive" ne~1 to the word ·~ppleTalk". 
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5. Close the Chooser by clicking the close box near the 
upper-left corner of the Chooser window. 

The Opening Lines window should now be the active windmr. 
(If it isn't, click an)'\rhere in it to make it the active window.) 

If your printer is on a network 

Find out from your network administrator (or the person who set 
up your computer) which printer you can usc, which zone it's in 
(if your network has zones), and what its name is (every printer 
on a network has its own name). 

1. Choose the Chooser from the Apple menu. 

The Chooser window appears. 



2. Click the word ')\ctive" next to the word ')\ppleTalk". 

If Active wasn't already selected, a dialog box appears. 
Click OK 

!!iD Chooser 

,g., -o.. Select alaserWrlter: 
d. Backside 

Apple-hlk.. . .IJ~'w'nttr ~~~ FeV 
~ 

App1tSh¥t 
'~:;·: I I • I 

Ifill ~ :_,:!' Jaunt (LW plus) 
~ ~ ;;; Marathon (LW NTX) 

lrn;ogo\idt..- llmlZm QMS ColorScrlpt 100 
Sojourn (LW NTX) 

AppleTelk Zones: Trek (NTX) 

' • • Tum me off when you're Clone. 
loading ~ 
No Parking 

jQ -
0 ~~~. 
Taxi .;::; Background Printing: @ On 0 orr 
Tesung :m•! -· ------------·---
Twilight ·:::;; @Active 
Unloading {) AppleTelk 0 lnecttve 

7.0 

3. Click the icon representing the type of printer you want 
to use. 

4. If you see a list of AppleTalk zones, click the zone 
where the printer is located. 

You may have to click the up and down scroll arrows to find 
the zone. The zones arc listed alphabetically. 

5. Click the name of the printer you want to use, even if 
it's the only one that appears. 

6. Click the close box near the upper-left corner of the 
Chooser window. 

If you changed printers, a dialog box appears. Click OK 

The Opening Lines window should now be the active window. 
(If it isn't, click anywhere in it ro make it the active windm,·.) 

Print a document 
Once a primer has been selected in the Chooser, printing 
becomes a rwo-srep process. To pracrice prinring, usc the 
Opening Lines clocumenr you creaLecl. 

1. Make sure that the Opening Lines window is the active 
window, then choose Print from the File menu. 

N{Htl >)(:N 

Opt~!L. :)(:!) 

Close :l€W 
s <n> {~ :)(: s 
SaueRs ... 

Quit :l€0 
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If the Opening Lines window is not the acrive window. click 
annd1ere in it to make it the active windO\\'. 

The dialog box that appears \vhen you choose Prim offers you 
many options. depending on the program and the primer 
you're using. You can learn more about these options from 
the instructions that come "·ith your programs and from 
Macintosh Reference. Parr II of this book. 

LascrWrite r " Isadora Duncan NTH" I~J 

Coples:lllll Pages: ® Rll 0 From: CJ To: D ( Cantel ] 

Coue r Page: ®No 0 Firs t Pa ge 0 Last Page 

Paper Source: ® Paper Cassette 0 Manua l Feed 

Print: ® Blocle & While 0 Color/ Grayscale 

Des tination: ® Printer 0 PosiStri11l® File 

2. Click the button labeled Print. 

The primer you chose prints your Opening Lines document 

Quit a program 
Quirring a program closes the program as well as any documems 
you may have open thai were created using that program. 
Quirring a program is not rhe same as closing a clocumem (\\'hich 
you clicl ar rhe end of Chapter 4) . Closing a document leaves the 
program open and acti,·e. 

(10 Ch~p1er ): Changing a Dowment :mel Priming \our \\ork 

• Make sure that the Opening Lines window is the active 
window, then choose Quit from the File menu. 

New :Jr:N 
Bp.-n ... :)(:I) 

Close 3€ W 
S<ll'(~ :Jr:S 
Sau e Rs ... 

Page Setu p ... 
Print.. . aG P 

Ouit 3€0 
·~ 

Or press the ~ key and the Q key together. 

·:· If a dialog box asks nhetberyoutcantto sa/'e any cbanges. 
click Save. ·:· 

The Opening Lines document and the Teach'lext program 
are closed, and rhc Finder, the program rhar displays the 
J'vlacinrosh desktop, becomes rhe active program. 



Make a backup copy 
Storing a copy of your \\'ork on another disk is wise pran ice, like 
saving regularly and saving often. In case a file or an enrire disk is 
damaged, you have a copy of the file on another disk as a backup. 
(It seldom happens, bur if it happens once to you, it's happened 
once roo often.) 

To practice making a backup copv. put a cop~' of Opening Lines on 
your practice disk. 

1. Make sure your practice disk is unlocked. 

A moveable rab on the back side of the case should be 
blocking the square hole near the lower-left corner (when \ 'OU 

hole! the disk as if to insert ir), inclicaring rhar rhe disk is 
unlocked. 

2. Insert the practice disk in your computer's floppy disk 
drive. 

The Practice disk icon appears on the desktop. directly bclmY 
the \ !acintosh HD icon. 

3. Drag the Opening Lines icon to the Practice disk icon 
until both icons are highlighted, then release the 
mouse button. 

CD I~ ' 

:~: ~:~: ~:~:~:~ :~:~:~:~:~:~:~:~:~:~:~:~:~:~:~:~ : ~ :~~ ~~~~~~~~~~~~~~~~~ ~ ~~~ ~ ~ ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ ~~~~ ~~~~~~~~~~~~~~~~~ 
t!: 

Both icons arc highlighted \Yhen rhc tip of the pointer arrow 
reaches the Practice disk icon. 

\Vhen you release rhe mouse burron. the Macintosh copies 
the contents of the Opening Lines icon to the Practice disk. 

You copy an icon \\·hen you drag it to a d([f'erenl disk. When 
you clrag it elsewhere on the same disk, you arc merely 
moving the icon. 
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4. Open the Practice disk icon. 

You open the Practice disk icon by clicking the icon to select it 
and then choosing Open from the File menu, or you can 
double-click the icon. 

The Practice disk window appears, showing that a backup 
copy of the file, also called Opening Lines, is srored on the 
floppy disk. 

5. Eject the Practice disk from the disk drive. 

You eject the disk by clicking the Practice disk icon ro select it 
and then choosing Put Away from the file menu. 

New Folder 3€N 
Open 3€0 
t>rln t >)(:f> 

[los(~ Window :)(:UJ 

Get Info 3€ 1 
Ouplica1 (~ >)(<0 
Make Rtias 
Put Rway 3€Y 

Find... 3€F 
Find Rgain 3€G 

Page Setup .•. 
Print Desktop ... 
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What next? 

Go to Chapter 6, where you'lllearn how to organize your work. 
Or take a break. Remember to turn off your Macintosh if you'll be 
away for more than a few hours. 



Chapter 6 

Organizing Your Work 
In this chapter 

You'lllearn how to 

• make a copy of a document 

• change the name of an icon 

• save another version of a document under a differenr name 

• open a documenr while its program is the acrive program 

• organize icons in a folder 

• use an alias for a document or program 

• create stationery 

• throw away files you no longer want or need 

You'll also learn about 

• the difference between Save and Save A5 

• whar an alias is 

It will take about an hour to go through this chapter. 

Before you begin 

You do nor need to go through this chapter before you start 
learning how to use your Macintosh programs. 

You should have already 

• gone through Chapters 1 through 5 

If your Macintosh is off, turn it back on. 
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Make a copy of a document 
In the course of your work, you'll often want ro make a copy of a 
document so you can preserve the original while rnaking changes 
to the copy. To practice making a copy of a documem, first create 
a new document, as you did in Chapter 5. 

1. If you closed the Macintosh HD window, open the 
Macintosh HD icon. 

'lo open rhe icon, click it to select it and then choose Open 
from the f ile menu. Or clouble-click the icon. 

·rhe ~1acintosh HD window appears, showing you the 
conrenrs of your srarrup hard disk. 

2. Open the TeachText icon. 

To open the icon, click it ro select it ancl then choose Open 
from the File menu. Or double-dick the icon. 

\\'hen you open the 'leach'lext program, 

• an untitled window appears 

• the menu bar shows Teach Text menu names 

• the Application menu icon in the right corner of the 
menu bar becomes the TeachTe.'\t icon 

The untitled window contains norhing because you haven't 
wrirren anything in ir. I t stays untitled until rhe first rime you 
save your work (name the document and srore it on a disk). 
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3. Type the following text: 

Dear Morn and Dad, 

This leLLer is ove r due , T know, but u nt i l I 
sa t down t o wri te , I had no idea how l ong 
ove rdue it is . Time sure flies when you 
don ' c have enough of i L. 

Jul i e and I are doing we ll . The dog is 
getting bcr_tcr all t::he time . How are you 
all? 

Remember: 

• If you make a mistake, press rhe Delete key to backspace 
over it. 

• Don't press the l{eturn key when you get to the end of a 
line. Keep typing. The text will continue on the next line 
auwmarically. 

• Press the Return key only when you want to stan a new 
paragraph. 

• The insertion point-the blinking venical line- is where 
the text you type will appear. 

• The !-beam pointer replaces the arrow pointer when 
you're dealing with rexr. You control the I-beam pointer 
with the mouse as you would the arrow pointer. 



4. Choose Save from the File menu. 

The dialog box that appears lets you name the document and 
decide where you wam the computer ro store it. 

5. Type "Letter to Parents". 

I= Macintosh HD'"' I = Macintosh HD 

D Oppomg lme• .0 [ Ejl'ct I 
D llelltJMe 
0 Syst em Folder ( Desktop I 
Q. lP.IlchTel!l ( New CJ I 

( Cancel ) 

L_ ______ ----'-v.:::.J R saue B 

Soue this document as: Q [,JJ 
! t eller to Parent~ I @ 0 ° 01 

Usually you need ro select text or set the insertion poim 
before you type text. In this case, because "Untitled" is 
selected when the dialog box appears, all you have ro do is 
stan typing. Whatever you type replaces the selected text. 

6. Click Save. 

The window is now titled "Letter to Parents" and the 
document has been stored on Macintosh HO (your startup 
hard disk) . 

7. Close the Letter to Parents window. 

To close the window, cl ick the close box near the left end of 
the title bar, or choose Close from the File menu. 

The window closes, ancl 'leachTexr remains the active 
program. 

8. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The finder becomes the active program. Among the contents 
of the Macintosh l iD \vindow is the Letter to Parents icon, 
representing rhe document you created and saved. 

9. tocate the Letter to Parents icon in the Macintosh HD 
window. 

You may have to make the windo\V· bigger or usc the scroll 
arrows to find it. 

10. Click the Letter to Parents icon to select it. 

I 
Letter to ~arents 

··~ 
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11. Choose Duplicate from the File menu. 

New Folder 
Open 
Print 
Close Window 

3C N 
3€0 
3CP 

Put Humy ;J~V 

Find... 3CF 
Find Rgain 3CG 

Page Setup ... 
Print Window ... 

Anorher icon, labeled "Letter Lo Parents copy", appears in the 
Macintosh HD window. Notice LhaL Lhe icon (as well as its 
name) is selected and that the Letter LO Parents icon is no 
longer selected. 

Letter to P at·ents co l.l 
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Change the name of an icon 
You can change the name of any icon to anything you like, using 
spaces, capital and lowercase letters, numbers, and any other 
characters except a colon(:). If you open the icon, you'll see that 
the name of its window has also changed. 

1. Drag the "Letter to Parents copy'' icon away from the 
original icon so that the two icons do not overlap. 

2. Click the name (not the icon) "Letter to Parents copy" 
(even if the icon is selected). 

When the name is selected, it is highlighted and a box appears 
around it. Notice that when you roim to the selected name, 
the arrow pointer becomes an !-beam ['JOinter. 

3. With the name selected, type "Letter to Sister". 

Or drag the !-beam pointer over the words "Parents copy" to 
select them, and then type "Sister" to replace them. 

Another way to select a word is to double-click it: cl ick 
anywhere inside the word twice in rapid succession, without 
moving the pointer. 

Whatever you type replaces the selected texl. 



4. Press the Return key. 

[JI 
D 

L~tter to P ar~?nts 
I 

L~Het· to Sist~r 

Now you have rwo documents. One is a copy of the other bur 
they have different names. You can revise one without 
changing the other. 

; . Open the Letter to Sister icon. 

lo open the icon, cl ick it ro select it and then choose Open 
from rhe File menu. Or double-cl ick the icon. 

TeachText becomes the active program. 

6. Drag the 1-beam pointer over the words "Mom and 
Dad" to select them. 

Dear 'l(l]feFWi11iN 
This Jetter ts overdue, I know, but unti l I sat down to wri t e. I had 
no ideo how long overdue i t Is. Time sure flies when you don't have 
enough or tt. 
Jul ie and I ere doi ng wel l. The dog i s getting better all t he time. 
How ore you all? 

7. Type "Sis". 

Whatever you rype replaces the selecrecl text. 

I~D . Letter to Sis ter · E!li: 
Dear Si~. 10 
ThiS letter is overdue, I know, but unti l I set down to wri te. I had 
no idee how long overdue lt IS. Time sure Illes when you don't 
have enough of it. 
Jul ie and I ar e domg well The dog Is getting bett er el l the time. 
How are you all? 

8. Choose Save from the File menu. 

9. Choose Close from the File menu. 

Or cl ick the close box near the upper-left corner of the Letter 
to Sister window. You now have two slighcly different versions 
of your letter: one fc>r your parents, and the other for your 
sister. 

'TeachTcxr remains the active program. 

Chapter 6: Organizing 'lbur Work 6-



Save another version of a document 
There is another way LO make a different version of a document. 
You can stay in rhe program you're using to create rhe documenr 
and save a differem version under a different name. 

1. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The Finder becomes rhe acrive program. 

2. Open the Letter to Parents icon. 

'HJ open the icon, cl ick it to select it and then choose Open 
from the File menu. Or double-click the icon. 

l each Text becomes the acrive program. 

3. Drag the 1-beam pointer over the words "Mom and 
Dad" to select them. 

4. Type "Juan". 

\\'harcver you type replaces the selected texr. 

m letter to Parents = En; 
Dear Jua.1, 

Thi S letter Is overdue, I know, out unt il I sat down to wn te, I had 
no Ideo how long ovcrduo 1t 1s. T1me sure fllos when you don't have 
enough of 1l 
J ulie ena 1 ere doing wel l The dog IS getting Octter ell the time. 
How ere you ell? 
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5. Choose Save As from the File menu. Do not choose 
Save. 

N<Htl :)(<N 

O!H~IL.. :)[: !} 

Close 3€W 
Saue 3€S 

&ii!ilj;t • ~ 
Page Setup ... 
Print... 3€P 

Quit 3€Q 

Choosing Save \\'Ould change the original letter (so that the 
lerrer ro your parents would read "Dear] uan'') . 

Choosing Save A<:., in contrast. lets you create a new documem 
based on the original documem, bur including rhe changes 
\U U made. 

The dialog box that appears lets you name the new document 
and decide where you want the computer to srorc it. ·'Letter 
ro Parenrs," the name of the otiginal document, is already 
selected and ready to be changed. 



6. Type "Letter to juan". 

I=Macin t oshiiD•I c::J MacintoshHD 

Q I elle•· to f'<lnmh .0 ( [jl'cl ) 
D lclle•· to Siste•· 
Q Opt•nill i.JI. irt <J ~ ( Desktop J 
D Hf•ntf l'-1e 
a System Folder ( New CJ ) 
<l\ ll'llChTel!t 

( Cancel ) 

I !Qj (( Saue D 

Saue this document as: ~ Q 
I t etter t o Jua~ I ® 0 O C£!1 

Whatever you rype replaces the selected text. 

7. Click Save. 

The new document, .. Letter ro juan ,·· now appears in the 
active window, replacing the original document, "Letter to 
Parenrs." Notice that the winclmY's title bar no\\· says, "Letter 
to juan". 

The original document is set aside, unchanged (if you open it, 
you' ll And thar the first line is still "Dear Mom and Dad"). 

Save?- or Save As? 

Choosing Save stores the changes you've made to the active 
document (the document in the active window) since you 
opened it or since the last time you chose Save. 

Choosing Save As, on the other hand, creates a new 
document that includes the changes you've made. Save As 
sets aside the original document without storing the changes 
(in other words, the original document remains unchanged 
from when you opened it or last chose Save). 

After you give the new document a name, it replaces the 
original document in the active window. The title bar of the 
active window shows the name of the new documenr. 
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Open a document while its program is the 
active program 
You can open a documenr without making the Finder the active 
program and then opening irs icon on the Macintosh desktop. 
You can open a document while the program that you used to 
create it remains the active program. 

1. Close the document "Letter to Juan." 

Click the close box near the upper-left corner of the 
document window or choose Close from the File menu. 

"feachText remains the aClive program. 

2. Choose Open from the File menu. 

The dialog box that appears lets you lind the document you 
wam to open. 
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3. Click "Letter to Parents." 

lc= Moclntosh HD ... I 
D letter to Juon 0 .. . =Macintosh 110 

D letter to Sist er [ £j~ct ) 
D Opening lines 
D Re11d Me [ Oesl:top ) 
CJ System folder -----

[ Con eel ) 

t Open J 
l!i 

4. Click the Open button. 

The "Letter to Parents .. document window appears. 

Organize icons in a folder 
Sooner or later, in the course of your work, you'll have roo many 
documenLc; and programs to keep track of easily. The Macimosh 
offers numerous tools and techniques (all of them explained in 
'\tfacintosb Reference, Parr II of this book) ro help you organize 
your work. Creating a folder and putting files in it is the simplest 
way. 



1. If "Letter to Parents" is open and 1eachText is the active 
program, choose Quit from the File menu. 

The Finder becomes the active program. 

2. If the Macintosh HD icon is not open, open it. 

The Macintosh HD window should be the active window. 

3. Choose New Folder from the File menu. 

An icon named 'ltntitled folder" appears in the !Yiacimosh I ID 
window. The icon, including its name, is already selected. 
(The name is highlighted and has a box around it.) 

4. Type "Letters to Family". 

Whatever you rype replaces the selecrecl text. If nothing 
happens when you type, click rhe name so that a box appears 
around it and then try again. 

5. Drag the Letter to Parents icon to the new folder icon 
until both icons are highlighted, then release the 
mouse button. 

I 
Lett.:-t- to P an;onts 

Q 
D 

Lett.:-r to Juan 

! ........ '-.. 

, ............ J .L . . .. . . . . 
:......... : 

Letters to F .amil 

Q 
D 

Letter to Sister 

continues ..,. 
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6. Drag the Letter to Sister icon to the Letters to Family 
folder icon until both icons are highlighted, then 
release the mouse button. 

Lettet" to Sistet" 

r······~ 

r.-.·.·.·.·.·.·.·.·II·.·.·.·.·.·.·.·.J 
Lettet"s to F amilll 

The Letters ro f amily folder now comains Lerrer to Parems 
and Letter to Sister. You GIIl open the Leuers to Family folder 
icon if you want LO make sure thal they are there. 

Use an alias 
As you work, you may find it handy ro have the same program or 
documem stored in more than one folder, so you can open it 
quickly when you're in a panicular folder. 

1. If the Macintosh HD icon is not open, open it. 

The Macintosh HD window should be the active window. 
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2. Choose New Folder from the File menu. 

An icon named "untitled folder" appears in the Macintosh HD 
window. The icon, including its name, is already selecLecl. 
(The name is highlighted and has a box around it.) 

3. Type "October Letters". 

Wtharever you type replaces the selecreci LCXL 

4. Open the Letters to Family folder icon. 

5. Click the Letter to Sister icon to select it. 

I 
LeHet" to Si:::tet" 



What's an alias? 

An alias is a way to represent a program or document in any 
folder without having to make a copy of the file. An alias 
merely "points" to the original file that it represents, so when 
you open an alias, you're actually opening rhe original file. Any 
changes you make and save are stored with the original file, 
so you see them when you open any or the aliases for the 
original file (you can make as many aliases for a program or 
document as you need). 

~EJ 
.4 ha·s CWi·~in.~ l 

~EJ 
A n:..s Origin.~ l 

You could make copies of a program or document and put 
them in separate folders, but the copies would take up much 
more room on your disk than a single copy. And if you want 
the copies to be always exactly alike, you'd have to make the 
same changes to each copy if you make any changes to one 
copy. 

Using aliases instead of making copies of a program or 
document lets you save space on your disks. 

6. Choose Make Alias from the File menu. 

New Folder :X:N 
Open 3€ 0 
Print 3€P 
Close Window :X:W 

Get Info 

An icon named "Letter ro Sister alias·· appears on top of the 
Lerrer 10 Sister icon. The icon and its name are already 
sclecred. 

Letter to S~sw- .a~~s 

Note that the name of the alias appears in italics. The name of 
an alias appears in ita lics so ~~ou have a ~Yay to tell which icons 
are aliases. 

COIIfilllleS .... 
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7. Drag the Letters to Family window to the right. You 
should be able to see the October Letters folder in the 
Macintosh HD window behind it. 

8. Drag the Letter to Sister alias to the October Letters 
folder in the Macintosh HD window, then release the 
mouse button. 

You may have to change the size and position of the Letters to 

Family window so you can see both icons. 

9. Open the October Letters folder icon. 

10. Open the Letter to Sister alias icon. 

The document Letter to Sister opens, and leach Text becomes 
the active program. 

The insertion point (the blinking venical line) should be at 
the beginning of the document, to the left of f) in "Dear". 
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11. Type "16 October 91" and press the Return key once. 

ro letter to Sis te r -~ 
16 October 9 I 10 

joeor Sis, 
This letter is overdue. I know, but until I sat down to write, I hod 
no ideo how long overdue It Is Time sure fli es when you don't hove 
enough of 1t. 
Julie and I ore doing w el l. The dog is getting better oi l the lime. 
How ore you all? 

12. Choose Save from the File menu. 

13. Choose Close from the File menu. 

The Letter to Sister document closes, and Teach Text remains 
the active program. 

You can open the original Letter to Sister icon (in the Letters 
to Family folder) and see that it is now dated 16 Ocrober 91. 

Lerrer to Sister is now available in both the l.errers to Family 
folder and the Ocrober Letters folder. By keeping the original 
in one folder and an alias in the other folder, you have access 
to the same letter from either folder. 

14. Close all the windows on the desktop. 



Create stationery 
In your work, you may find it convenient to have a documem that 
serves as the computer equivalent of stationery, like a memo pad 
or "While You Were Out" form. Each time you need a sheet, you 
take one from your endless supply of stationery and fill it in. 

'lo practice creating stationery, create a clocumem in 'leach Text 
that works like a memo pad. 

1. With TeachText the active program and no TeachText 
window open, choose New from the File menu. 

Open ..• • ago 

[ IOSH 
S<lll(~ :)(<S 

I fTcachlext is not the active program, open the 'JeachTcxt 
icon in the Macintosh I-ID window, or choose 'leach Text from 
the Application menu. 

An untitled Teach'lext window appears. 

2. 'IYPe the following text: 

Dl\TE : 

TO : 

FROM : [Type your name here . ] 

RE : 

3. Choose Save from the File menu. 

The dialog box that appears lets you name the document and 
decide where you want the computer to store it. 

.:- If Macintosh HD does not appear above tbe list, dick 
Macintosh HD above the Eject burton. ·:· 

4. Type "Memo Pad". 

[c:::> Macint osh HD• I = Macintosh HD 

D teller to .Juon [ E fP.ct I 
D l etters to Family ~-·--~ 
D Oct ober letters [ Deskt op I 
D Di>l'nlng tine~ [ J 
0 RIJIUl MP. . New CJ . 
D Syst em Folder 
~ Tl'ochTeBI [ Cancel I 
I toJ n Saue n 
Saue this documen t as: Q g 

JMemo Pa~ I ®[] O[]J 

continues ~ 

Chapter 6: Organizing Your Work 75 



Because .. umitlcd" is selected \\·hen the dialog box appears, 
all you have to do is start typing. Whatever you type replaces 
the selcCLecl texr. 

;. Click Save. 

The window is no\\· titled '";\·lemo Pad'' and the documem has 
been stored on Macinrosh Hf). 

6. Close the Memo Pad document. 

'lo close the window, click the close box near the left end of 
the title bar, or choose Close from the File menu. 

The window closes, and TeachTexr remains the active 
program. 

7. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The Finder becomes the active prograrn, anclthe Macintosh 
HD window becomes the active windo\\·. Among irs conrenrs 
is the Memo Pad documem icon. 

8. Click the Memo Pad icon to select it. 
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9. Choose Get Info from the File menu. 

3CN 
3CO 
3CP 
3CW 

The Info window that appears contains information on the 
selected icon. 

10. Click "Stationery pad" near the lower-right corner so 
that an X appears in the checkbox. 

~o- Memo Pad Info 

E] MHnoPoc 

Kind: TuehT•xt s1atl0Mf"\l pid 
Sh:e: UC on duk (19 b!J\H ustd) 

Yhere : M acintosh HO: 

Cr~ated : Tut', Stp 3~ 1991, 6:S7 AM 
Modtffed : Tut,Stp3, 1 99 1 , 6~ AM 
Ve rs i on: not ~v~ibobW 

Comments: : 

r I 
0 Lockod I8J Stationery p.ad 



Clicking "Stmioner~' pad'' convcrrs Memo Pad from an 
ordinary document to a stmionery pad. When you open a 
stationer~' pad, an untitled window appears showing a blank 
"form" from thar stationery, or a dialog box appears asking 
rou to name the new document. 

You can nor change rhc stationery pad itself unless you rurn 
it back into a regular document. You do rhis by opening the 
stationery pad's Info window and clicking "Stationery pad'' 
again to remove the X. 

11. Close the Info window. 

'lo close rhe windO\\·, click the close box ncar rhe left end of 
the title bar. or choose Close \Xlinclnw from the rile menu. 

Note that the Memo Pad icon has changed from an ordinary 
document icon to a stationer~· pad icon. 

g 
Q 

t-·1E'rno Pad 

On your own: Fill out son1e stationery 
Open the Nlemo Pad stationer)' pad icon and rype a shon memo. 

Remember to click the 1-hcam poinrer where vou want your texr 
to appear before ~~ou srarr typing. Clicking in this \\·ay sers the 
insertion point (rhe vertical blinking line). 

Choose Save from the Fi le rncnu, name your memo, cl ick the 
Save button. and choose Quit from the file menu. 

Note that the Memo Pad stationery icon remains in rhe 
Macintosh HD window. The icon for the memo you created 
(an ordinary documem icon) should also be in the windO\Y. 

What next? 

Go to Chapter 7, where you'll lcarn hO\\' ro nne! our more about 
your Macintosh. Or rake a break. 

Remember ro wrn off your Macintosh if vou 'II be away for more 
than a fe\\' hours. 
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Chapter7 

Learning More About 
Your Macintosh 
In this chapter 

You'll learn how to 

• usc the Balloon Help system 

• usc Macintosb Reference, Part II of this book 

YOLt"ll also learn about 

• the comcms oLllacintosb Reference 

It will take about 20 minutes w go through this chapter. 

At the end of this chapter, you'll be ready to start learning the 
programs that you intend rouse on the Macintosh. 

Before you begin 

You should have already 

• gone through Chapters 1 through 6 

If you turned off the Macintosh at the end of Chapter 6, wrn it 
back on. 



Use Balloon Help 
Balloon Help explains the function or significance of icons, 
menus, commands, and other fearures on the Macimosh screen, 
using balloons similar ro those vou see in comic strips. The 
balloon poims to the object iL explains. 

Many Macintosh programs have Balloon Help. 

1. Point to the Help icon near the right end of the menu 
bar. 

2. Press to pull down the Help menu. 

3. Drag to the Show Balloons command (the second item 
in the Help menu) so that it is highlighted, then release 
the mouse button. 

Finder Shortcuts 

After you choose Show Balloons, balloons containing explanatory 
text appear next to objeCLs that you point to on screen. 
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4. To show a balloon describing the Wastebasket, point to 
the Wastebasket icon. 

Except for the fact that balloons appear next ro objects rhat 
you poim LO, the way you work is the same: you can select 
icons, choose commands, and so on. 

; . Point to the Macintosh HD icon (your startup hard 
disk). 

A balloon appears next to the icon. 

6. Click the Macintosh HD icon to select it. 

You can select rhe icon even with the balloon showing. 

7. Point to the File menu. 

A balloon appears next to the menu name. 

8. Press to pull down the File menu. 

The balloon disappears when you pull down the menu. 

9. Slowly drag to the Open command so that it is 
highlighted, then release the mouse button. 

Notice that a balloon appears next to a command if you pause 
briefly as you drag past it. 

The Macintosh HD window becomes the active window. 'l<> 
see more balloons, you can point ro clifferem parts of the 
window and to differem icons in the window. 



10. Choose Hide Balloons from the Help menu. 

Finder Shortcuts 

To choose Hide Balloons, point to the Help icon in the menu 
bar, press w pull clmn1 the Help menu, drag w the Hide 
Balloons command so I hat the command is highlighted, and 
release the mouse burton. 

Hide Balloons and Show l3alloons replace each orher in rhe 
Help menu (after you choose one, rhe other appears in irs 
place). 

Use Macintosh Reference 
Macintosb Reference, Pan II of this book, conrains all the 
information you need w use your computer effectively and 
efficienrly. Unlike Parr I, 'vhich is meant robe read from beginning 
ro end, Parr II is meanr to be used like a dictionary: you turn w ir 
when you need ro look up some information, and then you read 
only that information. 

To help you ~Inc! the information, this book has a table of 
conrents, an index, a glossary, and a summary after Chap1er 16 
(on the green pages). To pracrice using the reference, look up a 
few ropics that you'll probably need ro know about in the near 
future. 

1. Find "Cleaning the mouse" under Chapter 15 in the 
table of contents. 

2. Go to the page that you're referred to and read about 
how to clean the mouse. 

3. Use the index to find information on erasing floppy 
disks. 

Erasing a disk is the same as initializing. Initializing a new disk 
is explained in Chapter 3 of this book. 

Several index enrries refer you to the information you need. 

• You could look under "floppy disks" and find "erasing." 

• You could look under "erasing·· and find ··floppy disks.'· 

collli11ues .,.. 

.... 
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What's in Macintosh Reference 
Parl ll of this book, Macintosh Reference, has almost no 
information on using application programs. Your best source 
of information about a particular program is the set of books 
and disks that came with that program. 

Macintosh Reference has detailed information on 

• setting up your system software 

• using hard disks and floppy disks 

• organjzing your files 

• adapting your Macintosh to your own use 

• printing 

• using your Macintosh on a network 

• expanding your computer system 

• care and maintenance 

• tips and troubleshooting 

The setup book that came with your computer has 
information on the features specific to your particular model. 

82 Chapter 7: Learning More About Your Macintosh 

4. Go to the pages that you're referred to and read about 
erasing disks. 

Some of the pages arc about initializing disks. 

5. Find "Glossary" in the table of contents. 

6. Look up "keyboard shortcuts" in the glossary. 

Using keyboard shortcuts as a way of choosing commands is 
explained in Chapter 5. 



W'bat ne:rt? 

Congrawlarions. You've gone through the .Hacintosb Basics tour 
and you're done with Learning Jl,lfacintosb, Parr I of this book. 
You've been introduced to and practiced everything you need to 
know to start using the Macintosh in a produclive way. 

There is more to learn before you're using your computer in the 
most effective and most efficient ways-but you'll be learning 
those ways as you use your programs and gain more experience 
with the Macintosh. 

At this point, you could 

• stan learning how to use your Macintosh programs 

• go to Chapter llto learn about ways to adapt your Macintosh 
ro your specific needs or preferences 

• go to Chapter 13 to learn about using your Macintosh on a 
network with primers and other computers 

• take a break 

To help you find information in this book, use the table of 
contents; the index; the glossary; or the summary, "Working on 
the Macimosh Desktop," on the green pages after Chapter 16. 
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Macintosh Reference 
Chapter 8 Setting Up Your Macintosh System 

Chapter 9 l-Iard Disks and Floppy Disks 

Chapter 10 Organizing Your Files 

Chapter I 1 Adapting Your Macintosh to Your Own Usc 

Chapter 12 Printing 

Chapter 13 Using Your Macintosh on a Network 

Chapter I 4 Expanding Your Macintosh System 

Chapter 15 Care and Maintenance 

Chapter 16 Tips and Troubleshooting 

Summary Working on the Macintosh Desktop 

Use this part oft be hook as you would a dictionmy or 

encyclopedia: 'fitm to it wbe11 youl!eed spec(flc il?furmatirm, 

and tbe11 read onlp tbose parts that giueyoutbat iJ?fonllatioll­

SoJ'o/1 ca11 go 0/11{/ifb your1uork. 

tHacintosb Reference contains little or no information on how to 

use your applicalion programs. If you need information un a 

pan icular program, go to the huoks and disks that came ,,·irh thai 

program. 

lf you· rc new to computers or new to the Macintosh, go through 

the .\lacilltosb 15asics tour and Pan I of this book. LeamillR 

Macilltosb. to learn basic .\bcintosh skills before vou usc 

. \1acintosb l?~ference. 

il) 



lo help you find information in this book, use the index and the 

table of contents. Also, usc the summary, "Working on the 

Macintosh Desklop," on the green pages after Chapter 16 and 

the glossary at the back of the book if you're looking for short 

definitions or brief summaries of concepts and procedures. 

If you need information on setting up your Macintosh or any 

information on features specific to your particular model, go to 

the setup book that came with your computer. 
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disks that came with your application programs, and Balloon Help 

to find the information you need. 



ChapterS 

Setting Up Your 
Macintosh System 
In tbis chapter 

• Setti ng up your computer hardware 

llealth concerns associated with computer usc 

Musculoskeletal cliscomfon 

Arranging your ofnce 

Avoiding farigue 

What about electromagnetic emissions? 

Adjusting your keyboard 

• Setting up your system software 

Install ing, reinstalling, or updating system software 

Starring up with a floppy disk 

• Setting up your programs 

Installing a program 

Working with several programs at a time 

Setting up your computer hardware 
For information on assembling the hardware components of 
your computer system, go to the set up book that came with 
your Macintosh. 

If you're connecting your Macintosh to a printer, a modem, an 
external flopp}' disk drive, an external hard disk drive, or orher 
external devices, go to the instructions that came with the device. 
or sec Chapter 1-1, ''Expanding Your Macintosh System:· 

If you're conneCiing your compurer to anmher ~!acimosh or to a 
printer on a nerwork, see Chapter 13. "Using Your Macintosh on a 
Network." 

s-



Health concerns associated with computer use 

Muscle soreness. eye fatigue, and other discomforts and injuries 
sometimes associated \\'ith using computers can actually occur 
from performing any number of activities. In faCL, misuse of the 
same muscles during mulLiple acriviries can crcaLe a problem rhat 
might nor otherwise exist. For example, if you engage in non work 
activities that involve repetitive stress on 1 he wrist- such as 
bicycling-and also use your computer's keyboard improperly, 
you may increase your likelihood of developing wrist problems. 
Preventing health problems is a multifaceted t.ask that requires 
careful attention to the way you usc your body every hour of 
every clay. 

The most common health e!Tens associated "·ith using a 
computer are musculoskeleral discomfort and eye fatigue. We'll 
discuss each area of concern beiO\Y. 

Musculoskeletal discomfort 

As with any activity that involves siuing for long petiods of time, 
using a computer can make your muscles sore and sti ff. To 
minimize these effects, set up your work cnvironmem carefully 
(using the guidelines that follo1Y) and take frequent breaks ro rest 
tired muscles. 
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Anorhcr type of musculoskeletal concern is repetitive stress 
injuries (RSls), also known as cumulative trauma disorders 
(CTDs). These problems can occur ,,·hen a certain muscle or 
tendon is repeatedly overused and forced into an unnatural 
position. The exact causes of RSis are nor totally understood, but 
in addition to an awkward poswre, such facLOrs as the amounr of 
repetition, the force used in t.he activity, and the individual's 
physiology and lifcsryle may affect the likelihood of experiencing 
an RSI. 

RSis did nor suddenly arise when computers were invented; 
tennis elbow and writer's cramp, for example, are two well-known 
RSls rhar have been with us for a long rime. One RSI discussed 
more ofren today. however. is a wrisr problem called carpal LUnnel 
syndrome, which mar be aggravated by improper use of 
com purer keyboards. This nerve disorder results from excessive 
pressure on the median nerve as ir passes through the wrist w the 
hand. 

This section offers extensive advice on setting up your desk, chair, 
and keyboard to minimize the possibility of developing an HSI. As 
mentioned earl ier, however, the effects of repetitive movements 
associated with using a computer can he compounded by those of 
other work and leisure activities to produce or aggravate physical 
problems, so proper use of your computer system must be 
considered as jusr one clement of a healthy lifestyle. 

No one, of course, ccm guarantee thar you won't have problems 
even when you follow the most expert advice on using computer 
equipment. You should always check \Yith a qualified health 
specialist if muscle, joim, or eye problems occur. 



·1b prc\·enr discomlcm and eye fatigue: 

• Arrange ~'ou r work space so that the furnirure is properly 
adjusted for you and doesn·r contribute roan a\\'kward, 
inappropriate working posture. 

• 1:1kc frequenr shun breaks ro give your muscles and eyes a 
chance to rest and refresh. 

The suggestions that follow should make your work more 
comfortable. 

Arranging your oftke 

I !ere are some guidelines for adjusting the furniture in your office 
to accommodate your physical size and shape. 

• An adjustable chair that provides firm, comfortable support is 
best. Adjust the height of the chair so your thighs arc 
horizontal , your feet nar on the noor, ami the backs of your 
knees slightly higher than the seat of your chai r. 

The back of the chair should support your lower back (lurnhar 
region). follow the manufacturer's instructions li1r adjusting 
d1c backrest to fir ~~our body properlv. 

• When you use the computer keyboard. your shoulders should 
be relaxed. You upper arm and forearm should form a right 
angle. \Yith your wrist and hand in roughly a straight line. 

You may ha\·e to raise ~~our chair sn your forearms and hands 
are at the proper angle to the keyboard. If this makes it 
impossible to rest your feet Aaron the Aoor, you can use a 
fomrest to make up /()r any gap between the Aoor and your 
feet. A<:, an alternative, if you have a modular desk system, you 
can lower the desktop ro eliminate the need for a foorresr. 
Another option is to use a desk \Yith a keyboard tray that's 
lower than the regular work surface. 

• If you use a mouse, position the mouse aL the same height as 
~·our keyboard. When you slide the mouse around, move your 
entire arm; avoid resting your arm on the desk and simply 
bending your wrist as you move the mouse. 

• Arrange the computer so the rop of the screen is at or slightly 
below your eye level \\'hen you·rc sitting at rhe keyboard. The 
best distance from your eyes to the screen is up to ~~ou , 

although most people seem to prefer 18 to 28 inches (-15 to 
110 em). Position the computer ro minimize glare and 
reAecrions on the screen from m·crhcacl lighrs ancl windows. 

If your ~laci nrosh comes \r ith a separate monitor. you may 
want to usc a riltable monitor stand. The stancllers vou set the 
monitor at the best angle for vie\ring, helping ro reduce or 
eliminate glare from lighting sources you can't move. 
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Avoiding fatigue 

These rips ,~vi ii help you get the most out of your work sessions 
with the computer. 

• Change your seated position, stand up, or stretch whenever 
you start w feel tired. Frequent shun breaks are helpful in 
reducing fatigue. 

• Use a light touch when typing and keep your hands and 
fingers relaxed. 

Some computer users may develop discomfort in their hands, 
wrists, or arms after intensive work without breaks. If you 
begin to develop chronic pain or discomfort in your hands, 
wrists, or arms, consult a qualified health specialist. 

• Eye muscles must work harder to focus on nearby objects. 
Occasionally focus your eyes on a distam object, and blink 
often while you work. 

• Clean your screen regularly. Keeping the screen clean helps 
reduce unwanred refteclions. 
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What about electromagnetic emissions? 

There has been recent public discussion of the possible health 
effects of prolonged exposure tO extremely low frequency (ELF) 
and very low frequency (VLF) electromagnetic fields. Such fields 
are associated with electromagnetic sources such as television 
sets, electrical wiring, and some household appliances-as well as 
computer monitors. 

Apple Computer has reviewed scientific repom and sought the 
counsel of government regulatory agencies and respected health 
organizalions. Based on the prevailing evidence and opinions, 
Apple believes that the electric and magnetic fields produced by 
computer monitors do not pose a health risk. 

In response ro those customers who wish to reduce their 
exposure to electromagnetic fields, Apple is taking steps to lower 
the emission levels of its products. Apple is also actively 
encouraging fwther scientific research so it can cominue to 

promote rhe health and safety of its customers and employees. 



Adjusting your keyboard 
lf you boughL Lhc Apple Extended Keyboard II wiLh your 
Macintosh, or if you have the Apple Keyboard II, you can adjust 
rhe angle of the keyboard so rhar your hands and wrists arc 
rcla,xed and you're comfonable as you type. 

The Macintosh Classic or Macinrosh LC standard keyboard has 
rabs on either side that swing our under the keyboard, changing 
the angle of the keyboard on your desk. 

I I 
c 

The Apple Extended Keyboard li has a sliding tab in the back that 
conrrols how much a bar extends under the keyboard, changing 
the angle of the keyboard on your desk. 

Apple Extended Keyboard II 

A bar extends 
as the slide is moved, 
increasing the 
keyboard angle. 
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Setting up your system software 
Your J\llacinrosh cannor operate wid1out system software-the 
programs and other files that the Macintosh needs to starr itself 
up and w run the application programs you use. When you turn 
on your Macintosh, it looks for a disk that contains the system 
software (in a folder called the System folder). Any disk that 
contains the system software is a startup disk. 

Almost ahYays, the sramtp disk is a hard disk that's inside or 
connected to your computer. A floppy disk can also be a srarrup 
disk. 

If your Macinrosh can nor find a startup disk, it displays this icon in 
the middle of the screen: 

lrnl 
If you sec this icon, you have to install system software on your 
computer's imernal hard disk (or an external hard disk that you 
rurned on before you turned on your Macimosh). 

·:· lfyou'ue alreadp installed :,ystem software and you see this 
icon, you may need to reinstall system software. See "Starring 
Up With a Floppy Disk" later in this chapter. ·:· 
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Installing, reinstalling, or updating system software 

You use the Installer program to install, reit1S[all, or update system 
software on a hard disk that ~~ou want ro be able ro usc as a 
startup disk. 

~ Important: Before you install a new version of system 
software, make a backup copy of the old version on another 
disk in case you need it at a later time (to run a program that 
is incompatible with the new version, for example) . 6. 

When you use the installer to update your system sofr"·are, you 
keep any fonts, sounds, drivers, and other flies you may have 
installed in addition w standard system software. (You could 
throw away your currcm System Folder and replace it wiLh the 
newer one, bur then you'd lose those special files.) 

·:· Do you bave a set of/v/acintosb .~)'stem so.fituare disks? Some 
Macinrosh computers, including those with built-i n CD-ROM 
drives, come without a set of Aoppy disks. If your computer 
came without disks, and you need ro install or reinstall sysrem 
software, see the separate backup book ur the Gelling Started 
book that came with your computer. ·:· 

Before you begin 

'lo install. reinstall , or update system software, you need 

• an initialized hard disk 



• the set of Macintosh system software disks that came with 
vour computer or that you purchased as a separate system 
software kir. If your disks came \\·ith your computer, the 
Installer program is on the disk named install Me nrst. I f you 
purchased the System 7 upgrade kit, the Installer program is 
on the disk namecl lnsta/1. 

If your Macintosh is connected to a network and you have access 
ro rhe Installer program and system software on a file server or 
another com purer. you don't need rhe system software disks. You 
can open the Installer program and then follow the procedure 
below, beginning with srep 4. 

If you have a hard disk thar hasn·t been initialized (thar is, irs 
icon doesn't even appear on the Macinrush desktop), go to 
Chapter 9, "Hard Disks and floppy Disks,·· for instructions on 
initializing a hard disk. 

A Warning: If you purchased a hard disk with the i\/llX 
operat ing svsrem installed on it. do nor initialize that disk: 
doing so \\"ill erase NUX. Sec the instructions rhar came with 
rhe i\/UX operating system. _.. 

Installing a standard system 

The Installer program ·s Easv Install dialog box lets you install the 
standard svstem software on vnur Macintosh. . . 

1. Turn off your Macintosh. 

2. Insert the Install Me First disk into the internal floppy 
disk drive. (Or, if you are using disks that came with 
the System 7 upgrade kit, insert the Install disk. You 
don't have the Install Me First disk.) 

If your Macintosh has two floppy disk drives, you can use 
ei ther one. 

3. Turn on your Macintosh. 

The lnsLaller program opens automatically. 

4. Click OK or press the Return key on your keyboard. 

The Eas\' Install dialog box appears. 

Pan!> of the svstem 
soft\\'are to be installed 

.~~~st~~------ --·-··------
i Click Install to upda te t o Uerslon 7.0 of 

HMaclntosh II System Software 
Rny EHistlng Pr inting Software 
File Sharing Software 

i on the hard disk named 

i c:;:> Hord disk 112 

[ llelp ) 

Disk on 1rhich SI'Stem 
soft\rare 11·ill be ·installed 

Button to switch 
to a cl ifferenr disk 
for instal !:trion 

, ___ --, 
! 

n Install a ! 
I 

' 

I 
i 
i 

- J 

' [ f. )e<t Disk J 

"---(Switch Disk] 

Butron ro change to a 
customized installation 

COIIfi llues ~ 
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5. Make sure that the hard disk indicated in the box is the 
one you want to install system software on. If a 
different disk name appears, click the Switch Disk 
button until the correct disk name appears. 

6. Click Install or press the Return key on your keyboard. 

The lnstaller begins ro install system software for your 
Macintosh model. 

7. Follow the instructions that appear on screen. 

When a disk is ejected and you see a message instructing 
you to insert another system sofrware disk, insert the disk 
specified. 

8. When you see a message reporting that the installation 
was successful, click Quit or press the Return key to 
quit the Installer program. 

lf a message reports that installation was not successful , follow 
the instrucLions on screen to try installing again . 

9. Click Restart in the dialog box that appears when you 
quit the Installer. 

The Macintosh restarts using the newly installed system (or 
using your currenr startu p disk if you already have one). If you 
want to change your startup disk, see "Designating a l-Iard 
Disk as the Startup Disk" in Chapter 9, "Hare! Disks and 
Floppy Disks." 
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Installing a customized system 

Custom installation allows you to select the combination of 
system l1les, drivers, and other files you want for your own specific 
needs. You can also usc custom installation to install or update a 
single system sofrware component or ro save space on your 
startup disk by not installing files that you don't need. 

1. Turn off your Macintosh. 

2. Insert the Install Me First disk into the internal floppy 
disk drive. (Or, if you are using disks that came with 
the System 7 upgrade kit, insert the Install disk.) 

lf your Macimosh has two floppy disk drives, you can use 
either one. 

3. Turn on your Macintosh. 

The installer program opens automatically. 

4. Click OK or press the Return key on your keyboard. 

The Easy Install dialog box appears. 

5. Make sure that the hard disk indicated in the box is the 
one you want to install system software on. If a 
different disk name appears, click the Switch Disk 
button until the correct disk name appears. 

6. Click the Customize button. 

The custom insrallarion box appears. All pans of the system 
software are lisred, and you have a choice of standard or 
minimal sysrem software for each model of the Macintosh 
computer 



7. Scroll through the list of items and hold down the Shift 
key as you click the items you want to install. 

Click the items you want to select; 
Shift-click to select multiple items. 

Software ror lmageWriter LQ 
So ftware ror AppleTelk lmageWriter LQ 

1- - ~
0 

AppleShore (workstation software) : 
File Sharing Software ·" 

1:@ 

Token Tulle sortwore 0 

I ~--;~~ ElhorTalk s uflv.ro I 
I @Oo· 22K I 
I 

- 'o'.O,Oot1 6, t991 
Y~rs 1on : 7.0 . 1 

I This pa<:kJ9t .ontains th• soft;w.llrt- ,..dtd to us~ your- I 
1 Maeintos:h in n EtherT.tlk n•twork. An £therTalk o.wd must be 
1 1nstalltd in y Maointosh ~o us• this soft'w'<!rt-. 

I I 
·---- _ ____j 

Information about the item selecrc.:d 

([ Install B 

= Wallhrop 

( [_fl't1 Di~k ) 

( ~wncll m~k ) 

( Eosy Install J 

( Quit J 

·•· {/"you wal/l to i11stall a sl7lallsystem to conserve space on 
your stanup disk, click Lhe "Minimal software·· opLion. ·:· 

~ Important: Re sure ro install the system software files that 
your i'vlacinrosh uses to communicate with the primers and 
any other devices you use. ~ 

8. Click Install or press the Return key on your keyboard. 

The Installer hegins to install system software fur your 
J'vlacimosh modeL 

9. Follow the instructions that appear on screen. 

When a disk is ejected and you sec a message instructing 
you to insen another system software disk, insen the disk 
specified. 

10. When you see a message reporting that the installation 
was successful, click Quit or press the Return key to 
quit the Installer program. 

If a message reports thm installation was not successful, follow 
the instrun ions on screen ro Lry installing again. 

11. Click Restart in the dialog box that appears when you 
quit the Installer. 

Make a backup copy or Lhe System Folder or its contents on one 
or more floppy disks (or on anmhcr hard disk), and keep the 
disks in a safe place. 

·:· !fyo11r lvlacintosb is running S)!stem 6, you cannot use desk 
accessories and TrueType fonts supplied \\"ith SysLem 7. Also, 
you may nnrice extra or missing folders on any disk that 
comains System 7. The contents of the System 7 disk will 
appear normally when you resume running System 7. ·:· 

.A Warning: Your startup disk must have only one System 
Folder. Having more than one Sys1en1 Folder on your sLartup 
disk can cause your Macimosh to malfunction and cause you 
LO lose informaLion. Use the Find command (in rhe Finder's 
File menu) to see if Lherc is more rhan one Srstcm Folder on 
your hard disk. • 
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Starting up with a floppy disk 
You need a hard disk as the sranup disk ro usc Macinrosh system 
soft\\'are version 7, bu t if you're unable ro use your hard disk, you 
can stan up your Macintosh by inserring the !Jisk Tools disk in 
rhc internal floppy disk drive and then turning on your com purer. 
This disk conrains programs that you can use to initialize, test, and 
repair disks. 

If your starrup hard disk has malfunctioned, see "Testing and 
Repairing Disks" in Chapter 9, "Hard Disks and Floppy Disks." 

Setting up your programs 
In addition to setup information. this section describes how to 
\York with more than one program at a time. 

Installing a program 
You can install many application programs simply by copying 
them from the original disk to your hard disk. (Some programs 
have specific installation procedures. See the instructions that 
came with your program.) 

Be sure you're acting within the terms of the software license 
agreemem before you install programs on a computer. The 
license agreement specifies how many copies of the program you 
can make for yourself and others. 
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~ Important: Some program disks conrain a System Folder. 
Whenever you copy the comcms of a program disk to your 
srarrup hard disk, check that you have nor copied an extra 
System Folder. If you have, throw away the extra System 
Folder. ~ 

Pur only one copy of each program on your hard disk. Having 
more than one copy of the same program on the disk can lead to 
problems when you're using the program. 

lf you want to open a program automatically when you sran up 
your Macintosh, go to "Specifying Which Items You Want Opened 
at Startup" in Chapter 11. 'Adapting Your ~lacimosh ro Your Own 
Use" for instructions. 

You Gill also put a program or an alias for it in the Apple menu, so 
you can open the program more com·enicnrly. Sec "lnsralling an 
Item in the Apple ~ lenu" in Chapter 11. 

~ Important: Keep the original program disk in a safe place as 
a backup copy. I f the program on your hard disk malfunctions 
consistently, you can replace it with a fresh copy from your 
backup disk. ~ 

lf a program malfunctions consistently, aml installing a fresh copy 
of the program does not correct the problem, you may need to 

find our from the software manufaCturer \Yherhcr the version of 
the program you have is compatible with rhc Macintosh system 
software you·re using. (You can often upgrade ro the latest 
version of a program at no charge or for a modest fcc.) 



Checking for computer viruses 

In recent years, "viruses"-malicious programs that damage Illes 
or erase disks-have become a significam probl<.:m for people 
who use computers. A virus can be introduced into }'Our 
Macintosh system from a disk you or someone else puts in a disk 
drive, from a nerwork device such as a file server, or from an 
electronic bulletin board service. 

You can usc any of several virus-detection and -elimination 
programs to check your Macintosh disks for viruses. Such 
programs are available from user groups, computer bulletin 
hoards, and dealers. 

Even if ~'OU don't notice problems with your compu ter's operation 
or with the informaLion on your disks. you should check for 
viruses frequcmly if you exchange disks or informaL ion with other 
users. 

• Whenever you get a disk from anyone-even if it 's commercial 
sofLwarc-check it for riruses before using it or copying 
anyth ing from it to your hard disk. 

• Check your stan up disk and other disks regularly with a virus­
detection program and correct any problems it finds. 

• If your ~lacintosh is on a net\\·ork or you use a modem to 

connect wiLh in forma Lion ser\'iccs or bulletin boards, check 
for viruses as often as it's practical-ideal!~', each time you 
copy any information from an outside source. 

• If you are part of a work group that includes a number of 
Macintosh users, seL up a "virus-deLeCLion station .. that 
everyone can usc to check disks (and to copy Lhc latest 
version of the virus-cleLcction software your group uses). 

• If ~~ou give information to other 1\lacinrosh users on disks or 
send information electronically, make certain Lhat there are 
no viruses on your computer system before distributing the 
information. 

• Since ne\\' \·iruses appear regular!~·. make sure you have the 
Ia rest version of any virus-detection software. 

• To avoid compatibil ir~· problems. be sure to use only one 
virus-detection program at a rime. 
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Working with several programs at a time 

You can keep as many programs and desk accessories open at the 
same time as your computer's memory allows. 

All open programs arc listed in the Application menu, which 
appears at the right end of the menu bar. The acrive program 's 
name has a checkmark next to it, and its icon appears in r.he menu 
bar as the Application menu icon. 

, ... w:,-- The Finder icon 

StHHlJ flU 

Commands used to hide or 
display windows currently 
open 

Open progmrns 

Checkmark indicates th<.: 
program curremly in usc. 
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Switching programs 

You switch between open programs or desk accessories by 
choosing their names from the Application menu in the right end 
of the menu bar. 

If a program's icon is dimmed in the menu, that means its 
windows are hidden. You can choose it from the Applicalion 
menu to display its windows. 

You can also click in a window that "belongs" to an open program, 
or double-click a program icon (or the icon of a document that 
was created in the program) to make tim program the active 
program. 

Finding out what programs are open 

If you have several programs and windows open, you can find out 
\\·hich program is active and what other programs are open by 
pulling down the Application menu. 



l liding and showing windows on the desktop 

You can hide all rhe open windows except Lhose of 1 he an ivc 
program by choosing the Hide Others command in the 
Applicmion menu. Though hidden, the orher windows remain 
available. 

When the command rakes effect, all windows except those 
belonging to rhe acLivc program arc hidden. 

The windows remain hidden until you switch to another open 
program, at which time that program 's open windows arc 
displayed. If you want to see Lhe windows of all your open 
programs, choose Show All from the Application menu. 

Changing the amount of memory a program uses 

All open programs use a certain amount of your computer's 
random-access memor~· (l{J\.\1). Each program sets aside rhe 
amounr of memory ir needs. (For more informaLion, sec "Tips for 
Using Memory Efficiently" in Chapter 11.) 

On rare occasions you may need ru increase or decrease rhe 
amount of memory a program seLs aside for itself. You might want 
ro increase the amount so you can open more documents at 
once, or you might want to decrease it so you can open more 
programs at once. You adjust rhe program's memory size in its 
Jnfo window. 

1. Quit the program if it's open, and then click the 
program's icon to select it. 

COIIIiiiiii!S .... 
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2. Choose Get Info from the File menu. 

The Info window appears. 

!:u . TenchleHt Info 

~ Tuc-hT•xt 
~s-ttm Softw¥t 7 1 

Kind: .tpplte.ltion program 
S iu· : 36K on difk (36 ,603 tM,I tts w:td) 

Vht'n· : Cuptrtw'IO Drw~ 

Cre•te-d : Thu, Apr 25, 1991 , 12:00 PM 
Hodif it'd : Thu, ~25, 1991 , 12:00PH 

Version: 7.0,€> AppltComputw-,lnc 
1995·1991 

Comm.nb : 

ProgrammaiHtfauurcr's suggested 
~minimum m<.:mory 

11 l 
,-H~m•r'J re-qu1r~ments J-. 
i Suc)9tost~ S\Z.f' 192 K , ! ,.,.,....,.. .IZ., U2L:] K : 'lo define th<.: minimum memory 

0 l ocked ! Pr•f•rr.O so:• · U2L:J K j 1'011 re(]lllrC, type the IIUI'DbCr here. 
~ -' The progi~IIll won't open unless 

To define ho11 much 
m<.:mory you prefer the 
program to u~e. type a 

number here. \\'hen extra 
memorv is available. the 

program L;ses this amounl. 

this much memory is :tvailable. 

'lbu cannot use a number larg<.:r 
than th<.: "Pr<.:ferred size.'· ' 

You can use a numh<.:r smaller than 
the "Suggested size ... 
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3. Drag across the box containing the number you want to 
change (either "Minimum size" or "Preferred size"). 

"Preferred size'' can't be smaller Lhan '·M inimum size," buL 
some program manufacturers set the ''ivlinimum size" smaller 
than ·'Suggested size." I f you are not satisfied with a program's 
performance, type the ··suggested size" in the "Minimum size" 
box. 

4. Type the number of kilobytes (K) of memory you want 
the program to set aside for itself. 

• If you find that the program frequently runs out of 
memory. Lry increasing both Lhe "Preferred size .. and the 
''Minimum size." 

• If you don't have much extra RA.l'vl on your computer, rry 
lo\\·ering the "Minimum size.'' If you type a size smaller 
than "Suggested size, .. some programs will perform 
acceptably. Others may ~·ark more slowly. show other 
performance problems, or noL work at all. 

5. Close the Info window. 

If you typed a number smaller than the "Suggested size,·· 
you'll see a message asking you to confirm your decision. 



Chapter9 

Hard Disks and 
Floppy Disks 
In this chapter 
• Initializing disks 

• Erasing a disk 

• Designating a hard clisk as the startup disk 

• Protecting rhe information on a disk 

Locking a floppr disk 

Locking a file 

Backing up your fi les 

• If you can't save Oleson a floppy disk 

• Ejecting a disk 

• Disk care 

Hard disk precautions 

• '!bring and repairing disks 

Lsing Disk First Aiel 

'lesting a hard disk 

Initializing disks 
Before ~'ou can use a ne\r disk, it must be initialized- to prepare 
ir so that the computer knows where ro store and retrieve 
information on the disk. 

A Warning: You lose any information you may h;l\·e on a disk 
when you initialize or reini tialize it. • 

Mosr hard disks designed for usc wi th the Macintosh are already 
initialized (that is. ready to srore information) \\·hen rhcy leave the 
factorv. 

When new, some 3.5-inch (89-millimeter) floppy disks that your 
Macintosh uses need robe intialized. You can intialize these 
yourself, follm\·ing the instructions under .. Initial izing a Floppy 
Disk'' later in this chapter. 

Some new 3.5-inch floppv disks arc .. preformatrccl, .. or already 
initialized. You can use these right a\\·av. wi thout inrializing them. 
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Initializing a hard disk 

If you have a hard disk that hasn't been initialized, its icon does 
not appear on screen when you stan up your Macintosh using 
another hard disk or a floppy disk as a startup disk. (See 
Chapter 14, ··Expanding Your Macinrosh System,·· if you need 
instructions on connecling a hard disk to your computet: Sec 
Chapter 8, ··setting Up Your Macintosh System,·· if you need to 
create a startup disk.) Make sure that you turn on the hard disk 
before you LUrn on your .Macimosh. 

If your hard disk's icon docs not appear on screen, use the 
Apple HD SC Setup program, on the system software floppy 
disk labeled Disk Tools. lO initialize and name the disk. 

A Warning: If you purchased a hard dbk with the NUX 
operating system installed on it, do nor initialize that disk; 
cluing so will erase A/UX. Sec the instructions that came with 
the A/UX operating system. A. 
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1. Locate the Apple HD SC Setup icon and open it. 

Apple HD SC Sewp is on the system software floppy disk 
labeled Disk Tools. If you're already using a hard disk as a 
startup disk, you can copy the program to your startup disk 
and open the program from there. 

~ 
1. I 

App 1~ HD SC SetJJp 

A dialog box appears. The name of the hard disk currently 
selected for initialization is shown as the ·'volume name.·· The 
SCSI ID number of lhe selected hard disk is displayed above 
lhe Orive button. (The ID number of an internal hard disk 
is 0. The ID number of an external hard disk is usually preset 
to 5.) 

Apple HU SC Setup 

( I nlllallze J I 
I 

( Update ) i 

( Partition J I 
( Tes l J 1 

R Oull l) I 

SCSI Deulce: o SCSIID number 

~ 
of !he current 
hard disk 

~ "!!'e uolume nnme Is Hard dislc + The name of the 
~ 2 curn:nr hard disk 



2. If the ''volume name" or the SCSI ID number shown 
does not belong to the hard disk you want to initialize, 
click the Drive button until the hard disk you want to 
initialize is the selected hard disk. 

You cannot initialize your cut-rem stan up disk or the disk thar 
the Apple HD SC Setup program is un. 

3. When the SCSI ID number (and name, if any) of the 
hard disk you want to initialize is shown, click the 
Initialize button. 

A dialog box appears in which you must confirm or cancel 
your decision. 

4. Click the Init button to initialize the hard disk. 

Messages appear to update you on the initialization process. l f 
a message reports that initialization failed, begin the process 
again. 

;. In the dialog box that appears asking you to name the 
disk, type a name and then click OK. 

6. Click Quit when the message reports that initialization 
was successful. 

Initializing a floppy disk 

Unless a new floppy disk is preformarred, before you can use it, 
you need to initialize it-prepare it so that the computer knows 
\\·here to store and retrieve information on the disk. 

1. Insert your new floppy disk into the floppy disk drive. 

If you inserred a high-clensit~' disk, this dialog box appears: 

)· -•1 This disk Is unreodoble: 

Do you wont to Initialize it? 

R Eject ~ [ Initialize I 

If you insenecl a double-sided (SOOK) disk, this dialog box 
appears: 

fi¥l1 This disk is unrendoble: 

\m Do you wont to Initialize it? 

R Eject D [One-Sided I ~Bt;d) 

COillilllleS ~ 
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2. Depending on which dialog box appears, click Initialize 
or Two-Sided. 

Anorher dialog box appears: 

1.\ This proceu will er ase oil 
ill in f onnalion on this dlslc. 

( Cancel ) fi Erase B 

This dialog box gives you one last chance to cancel. It alerts 
you that you're about to erase-and therefore lose- any 
information that may he on the floppy disk. 

3. Click Erase. 

A third dialog box appears: 

fE'll Please name this dislc: 

5I IIIGJHI@ I 

n OK )J 
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4. Type the name you want for the disk. 

If you make any ryping errors, press the Delete key ro 
backspace over them. 

When you name a disk, you can rype up to 27 characters, 
including spaces. You cannot use a colon in the name. If you 
don't name the disk, iL will have the name "Untitled." 

5. Click OK or press the Return key on the keyboard. 

The computer rakes about a minute to initialize the disk. A 
series of messages appears on the screen to let you know how 
the process is going. 

When initialization is complctecl, the floppy disk's icon 
appears on the desktop. You can rename the disk by clicking 
its name and typing a new one. 



Erasing a disk 
Erasing a disk acwally in it ializcs it. 

.6. Warning: You lose any in formation you may have on a disk 
when vou erase it. • 

1. Click the icon of the disk you want to erase. 

2. Choose Erase Disk from the Special menu. 

!\dialog box appears, giving you a chance to cancel the 
procedure. 

3. Depending on the type of disk you're erasing, click 
Initialize or Two-Sided. 

Designating a hard disk 
as the startup disk 
lf \ 'OU usc more than one startup disk 1\'ith your ~!acinrosh , you 
can specify which hard disk you want used as the stan up clisk the 
next rime vou turn on vour com purer. 

1. Choose Control Panels from the Apple menu and then 
open the Startup Disk control panel. 

:;o=:::: Startup Disk .............., 

Sfole-c.t a Startup Disk: 

@ - ~ Walthrop 

2. Click the icon of the disk you want to use as the startup 
disk. 

COIIIilllleS )llo 
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3. Close the Startup Disk control panel. 

When you turn on your Macinrosh, it looks for a stanup disk (a 
disk containing a System Folder) in the following sequence: 

1. inrernal floppy disk drive 

2. second imernal floppy drive (if any) 

3. external floppy drive (if any) 

4. startup device selected in the Startup Disk control panel (if 
any) 

5. internal SCSI hard disk (the computer waiLc; a few seconds for 
the internal hard disk w warm up) 

6. external SCSI hard disk (if there is more than one, it looks for 
the hard disk with the greatest SCSI ID number) 

7. internal hard disk (the computer returns ro this drive and 
waits another few seconds) 
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If no starrup disk is found, the computer displays a blinking 
question mark in the middle of the screen. 

·:· Ifyou wall/to f~)!fJass tbe internal bard disk as a startup disk, 
press :1€-0pLion-Shift-Delete when the computer starts up. ·:· 

6 Important: If you use any external hard disks, turn them on 
and wait a few seconds before you turn on your Macintosh; 
otherwise, the computer will not recognize them. ~ 

Protecting the information on a disk 
You can protect all the information on a floppy disk and you can 
lock individual clocumenrs and application programs. Another way 
to protect your work is to keep backup copies of all your files. 

TI1e information in a locked clocumenr or on a locked disk can't 
be changed or thrown away, but it can be opened or copied. 



Locking a floppy disk 

To luck a floppy disk: 

• Slide the tab on the back side of the disk so that the 
square hole is open. 

Use your thumbnail to move the tab, or a push pin inserted 
into the notch next lO the tab. 

• • . . •• • • •• • • • . . • • 

Sliding the tab back so that it covers the square hole unlocks 
the disk. 

Locking a tile 

You usc the Get Info command to lock a document or program. 
Locking a program may affect its operation. 

1. Click the icon of the file you want to lock. 

2. Choose Get Info from the File menu. 

The file's Info window appears. 

3. Click the Locked box in the lower-left corner so that an 
X appears in the box . 

1!:0 From nmy Info a F<orn-., 

teind : TuchTtxt doe~.&tnent 
Stz~ : 1Kondlsk(161 byli"sustd) 

Yher~ : J"s disk: From Arnv 

Cr~~ trd :Mon, Oct 8, 1991 , 10:33 PM 
Hodifitd :Mon, Oc:.t 8, 1991 , 10:.35 PH 

Yto rsion: not ~v.o~iliblt 

Comments: 

~ -· I 
ij;} Lock•d 0 Sbtion•ry p:ad 

COillillUeS ~ 
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4. Close the Info window. 

·!· Lockingfo/ders: You can't lock a folder, but you can lock the 
items in a folder. Also, you can protect the conrenrs of folders 
that ~~nu 're sharing on a network. (See Chapter 13, "Using 
Your Macinrosh on a Nem·ork,'" for more information.) ·:· 

·!· !.ocking em alias: You can lock an alias, hut doing so docs nor 
lock the original ftle. Locking an alias merely proteCLS it from 
being thrown away. ·:· 

Backing up your files 

You can back up the work you store on a hard disk by copying 
individual files onto anorher disk in the usual way (dragging their 
icons w the icon of the mher disk). You can back up the contems 
of an entire Aoppy disk by dragging irs icon to another Aoppy disk 
icon or a hard disk icon. 

You can also use a commercial backup program to copy some or 
all files from a hard disk ro another hard disk, to a tape drive, or to 

a series of Aoppy disks. 
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If you can't save ftles on a floppy disk 
If you can't save files on a floppy disk, rhen the disk is damaged or 
locked, it 's roo fu ll ro store more information, or the disk drive is 
nor working properly. 

• Make sure the locking tab on the back of the disk is in the 
unlocked position (so that the square hole is closed). 

• lf you sec a message reponing that the disk is nor initialized, and 
you know that il has been initialized, eject the disk and carefully 
insen it again. If the same message appears, the disk is probably 
damaged. (You may be able to recover the information on it 
with Disk First Aiel or a disk-recovery program; see "Testing 
and Repairing Disks·' later in this chapter.) 

• If you see a message reporting that the disk is full, eject that 
disk and insen anorher that has adequate space for your 
documem, or erase unneeded files from the disk. 

• Check the disk for obvious damage to the plastic case or the 
sliding metal shutter. 

• Insert a different disk and try saving again. If you can't save on 
the second disk, the problem may be \Vith the disk drive. 

• Before concluding that the disk drive is the problem, save 
your files on a disk in a different drive, if you have one, and 
then restart the Macintosh. ·n·y using a disk that you know is 
not damaged in the suspect drive. If you still can't save any 
fi les using that drive, consult the service and support 
information that came with your computer for instructions on 
how to conract an Apple-authorized service provider or Apple 
for assistance. 



Ejecting a disk 
You can eject a floppy disk by doing one of the follmring: 

• Click the disk icun tO select it and choose Pur A\\·ay from the 
rile menu. The icon disappears from the desktop. 

• Drag rhe disk icon to the 'Ii·ash icon. The disk icon disappears 
from the desktop. (Dragging a disk to the Trash does 1101 

erase the disk's contents.) 

• Click the disk icon to select it and choose Eject Disk from the 
Special menu. The disk's icon remains on the desktop, bur it's 
dimmed. 

You can use the first two methods to remove a hard disk icon 
from the ~lacinrosh desktop (or to remore an icon for a disk that 
vou 'rc connected to over a network). 

All three methods also work \\'ith CD-ROM discs. 

If you can't eject a floppy disk 

The signal to eject the disk is nor reaching the computer or d1e 
disk or drive is damaged. 

1. Hold down the :1€ and Shift keys and press the 
number 1 key in the top row of the keyboard to eject 
a disk in the internal drive; press :!€-Shift and the 
number 2 to eject a disk in an external floppy drive 
or the second internal drive. 

2. If step 1 doesn't work, turn off the Macintosh. If the 
disk isn't ejected, then hold down the mouse button 
when you turn the computer on again. 

3. If step 2 doesn't work, locate the small hole near the 
disk drive's opening, and carefully insert the end of a 
large straightened paper clip into it. Push gently until 
the disk is ejected. Do not use excessive force. 

-d ----

4. If step 3 doesn' t work, consult the service and support 
information that came with your computer for 
instructions on how to contact an Apple-authorized 
service provider or Apple for assistance. 
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Disk care 
For information on floppy disk care, see Chapter 3, "Setting Up 
Your Programs," or read the instructions that came with your 
floppy disks. 

Hard disk precautions 

Ilard disk drives are very delicate mechanisms and should be 
handled with care. 

• Do nor roughly handle a hard disk or a computer wirh an 
imernal hard disk. Never move either when it's turned on and 
the hard disk drive is operating. 

• Do nm place your Macimosh on its side unless it is designed 
ro operate this way; ir could damage the hard disk. See your 
setup book ro check if your Macintosh model can be placed 
on irs side. 

• Always keep the hard disk on a sturdy, level surface. 

• Operate a hard disk at temperatures between 10 and 
40 degrees Celsius (50 and 104 degrees Fahrenheit) and at 
a relative humidity of 20 ro 80 percent. 

• Do nor spill any liquids on or ncar the drive. 

• Do nor expose rhe drive to hazardous vapors, such as those 
from cleaning solvcms. 
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Testing and repairing disks 
Both floppy disks and hard disks can become damaged from 
repeated use and handling. If you sec a message reporting that a 
disk is damaged or unreadable, Disk First Aid or Apple HD SC 
Setup (borh programs are supplied with rhe system software) may 
help diagnose and correct the problem. 

If you can't starr up from a hard disk or don' t see irs icon on the 
desktop, the com purer docs nor recognize the disk or the disk 
drive is not working properly. 

• If the hard disk drive is an external one, make sure it is rurned 
on and irs cable is connected fi rmly, then resran the 
Macintosh. 

• If rhe disk drive is an imcrnal one, rum off the Macinrosh, wait 
at least 10 seconds, then turn ir on again. 

• lf the hard disk is your srarrup disk, srarr up with a differcm 
disk and, if the disk's icon appears, reinstall rhc system 
software on the hard disk. 

• If you have more than one hard disk in your J\llacinrosh 
system, check rhe SCSI lD number of each external hard disk 
and all other SCSI devices connected t.o your computer. If rwo 
devices have rhe same ID number, or if any external device 
has the ID number 7 or 0, rhe com purer will not recognize 
one of rhe devices. 



Using Disk First Aid 

You can test Aoppy disks and hard disks with the Disk f irst Aiel 
application. Disk First Aid also repairs some rypes of disk damage. 

1. Locate and open the Disk First Aid icon. 

Disk first Aid is on the system software disk labeled 
Disk 7ools. 

~~ 

~ 
Disk First Aid 

A dialog box appears. 

2. Click the Drive or Eject button as necessary until the 
name of the disk you want to test appears. You may 
have to insert the damaged floppy disk. 

3. Click Open or press the Return key. 

The name of the disk you selected appears, and a message 
reports that Disk First Aiel is ready. 

4. Choose Repair Automatically from the Options menu, 
or click the Start button to begin testing the disk. 

( Sta!CJ Lj . 
. 

5. When testing and repair are completed, choose Quit 
from the File menu. 

·:· {j'you wanr to test another disk, choose Close from the File 
menu, then select and open the mher disk (as in step 2). ·:· 

If Disk first Aid doesn't correct the problem: 

• Use Disk first Aid one or two more times with the disk. 
Occasionally, repeating this process con·ecrs the problem. 

• Usc anorher disk repair or recovery utility. Some disk repair 
utilities let you recover information from a damaged disk. 

• Consult a technician or other specialist for help. 

• Once you have recovered all the information you can, erase 
(reinitialize) the disk. If reinitializing doesn't work, discard the 
damaged disk. 
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Testing a hard disk 

You can te.sr a SCSI hard disk \\'ith rhe Apple HD SC Setup 
program. 

1. Locate and open the Apple HD SC Setup icon. 

Apple HO SC Serup is on the system software disk labeled 
Disk Tools. 

~~ ,-_- , 
Apple HD SC Set1Jp 

A dialog box appears. 

Apple HD SC Setup 

~e) 
[ Update ) 

[ Partition J 

[ Tes t J 

([ Quit D 

SCS I Deulce: o ' The disk"s SCSIID number 

~ 

~~ ~2e uolume nome Is Hs>ll disk~ lhe disk·s name 
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2. Click the Drive button until the name of the disk you 
want to test appears as the "volume name." 

I 3. Click Test. 

A dialog box appears asking you to confirm that you want to 
rest the disk. 

4. Click OK 

5. When a dialog box appears telling you that testing is 
complete, click Quit. 

If the rest reveals a problem, you may be able to correct it b)' 
using Disk first Aiel or another disk repair mility, or you may 
have ro reinirialize the disk. Consult a technician or other 
specialist for assisrance if necessary. 



Chapter 10 

Organizing Your Files 
In this chapter 
• Straightening up your files 

• Using folders to organize your Ales 

Creating and naming folders 

• Saving your files where you want to 

• Making items easier to And 

Using an alias 

Installing an item in the Apple menu 

Moving an item to the desktop 

• Finding a Ale or a folder 

Finding an item br name 

Finding an item hy other characteristics 

Finding items through a two-stage search 

Uses of the find command 

• Creating a template 

• Getting information about your files 

Using 1 he Info " ·indo,,· 

Using the View menu 

Straightening up your ftles 
Choose 1 he Clean Up command from the Special menu to 
straighten up the icons in the active \\·incJm,· or on the desktol). 
(The form of the Clean Up command changes depending on 
\rhich items are active or seleCLccl .) 

IIolcl down the Option key while choosing Clean Up \Xiindow to 
arrange icons alphabetica ll~' br name or according ro the list vic\\· 
displayed most recently in that window. Holding down the Option 
kev also moves the icons ro the top left portion of the " ·in dow. 

l lolcl down the Option key while choosing Clean Up Desktop ru 
line up icons near the right edge of the screen. 

If one or more items are selected, holding down the Shift key 
while choosing the Clean Up command rearranges the selected 
items only. 

IU 



Using folders to organize your files 
Like paper filing systems, the Macintosh uses folders tO store and 
organize documents. You can place one folder inside another ro 
create a hierarchy of fi les that has many levels. 

~·~~~<16~ 
• . . . . . . . . . . . . . . . . . 

• • 

Budgets Proposals 

. . . . . . . . . . . . . . . . . . . . . . . . . . . 
~ 

Feasibility 
studies 

. 
Resumes 

.... ·• ..................... . . . . 
Comments IDmfr ~ I Drnn ~ lomfr 3] 
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Creating and naming folders 

Must programs let you create and name a new folder in the 
direcrory dialog box that appears when you first save a document, 
or when you choose Save As from the File menu to save another 
version of a clocu mem. 

When you're working on the desktop (when the Finder is the 
active program), you create and name a new folder as follows. 

1. With the Finder the active program, choose New Folder 
from the File menu . 

A nc,,· folder named "untitled folder'· appears in the active 
window (or on the desktop if no window is active). The name 
is already selected . 

2. Type a name for the folder and press Return. 

You move, copy, and remove folders in the same way that you do 
any other icons. (See the summary, "Working on the Macintosh 
Desktop," on the green pages after Chapter 16, for instructions.) 



Saving your files where you want to 
The Arsttirne you save a document rhar you're creating in an 
application program (or whenever you choose Save As from the 
file menu to create another version of a document), a directoiJI 
dialog hox appears. A directOIJI is the list of flies and folders 
contained in a folder or a disk. 

You usc the directory dialog box to name your document and 
decide where to store it. Directory dialog boxes vary slightly from 
program to program, bur every directory dialog box has certain 
features. 

The current directon·: 
a list of the Ales and · 
folders in the folder 
or disk that '~ nalllcd 
in rhc pop-up lllenu 
above tiH.: directorY 

I 

Usc this pop-up 
menu 1o choose 
a ilight:r-level 
directory 

I 

The name 
nfthe 
currem 
disk 

1- !=Macintosh HO•l = Macl~tosh HO 

Click to list the 
disks on the 
,\!acimosh desktop 
in the currem 
directorv. 

D flnnual •·cpol'1 'II 
D App. programs 
D aJ11Glm -
D art samples 
D ll!'tst1 u:z7:'fJO 
0 Boot li~t 

-
Snue this document as: 

l .P 
of the document 
here. 

Q ( [ji'C1 ) 

:t [ Desktop )--
.·· 
:~~~ [ Netu LJ j- Click ro create a 

ne1Y folder. 0 -·----~-M 

( Cancel 

(( Soue 

\\ ' p 
a folder, its 
content.-; an: 
listed in tile 
curn::m directon·. 

) 

)I 

Oick ' when you have 
named the document and the 
directory you want to put it in 
is the currem directory. 

A similar dialog box appears when you choose Open from the File 
menu to open a document that was created in the program you·re 
currently in (the "active·' program). The dialog box lets you find 
the document and open ir. 

]= Walthrop •I 
iiiW:hll-1 

D art - 10/ 4 
D Car Info 
D Caspar maps 
D Enuelopes 
D Glossary 
D JH Status reports 
D Matching Deuel. 
D old backups 
D Paint pies 
D Picture 0 

1-o 

f~l: 
·~~ 

::t 

~
rt· 
~ 
' 

' 
0 

= Walthrop 

[ qe<t 1 
( Desk top 1 

[ Open 1 
[ Cancel 1 
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Making items easier to find 
Your Macinrosh offers several ways to make a Die, folde1~ or other 
irem easy ro find and open. You can 

• create aliases for the irem and pur rhe aliases wherever ir 's 
convenienr for vou 

• install the item in the Apple menu 

• move the item ro the J\11acimosh desk10p so rhar it's in 
plain sight 

Using an alias 

An alias serves as a signpost ro a Die, a folder, a disk, or another 
item (even a shared item that you access over a nerwork) . You can 
make as many aliases for an item as you want. See Chapter 6, 
··organizing Your Work, .. for more information on aliases. 

Creating an alias 

1. Click to select the item that you want to make an 
alias for. 

2. Choose Make Alias from the File menu. 

The alias appears on rop of rhe original. Irs name is in italics 
and ends with "alias." The name is already selected. 

3. If you wish, change the name of the alias, then move it 
to wherever you want to put it. 
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Uses of aliases 

Alias of 

Anv document or 
folder that could be 
stored in scvcr:~l 
places 

Apple ~lenu 
Items folder 

A program 1ha1 
must be located 
with assut:iat<:d fib 

A document or folder 
stored 011 a scpar~nc 

archive disk 

A program. docum<:nt, 
or folder on a file 
server 

Location 

Every pan of your 
filing svstem where 
rhat item logically 
fits 

On the desktop 

On the desktop; in 
the Appl<: menu 

Anywhere on your 
primary disk or 
disks 

An)"''·hcrc on your 
primar)' disk or 
disks 

Purpose 

Access to key information 
from sercral places 

Easy wav ro pw ircms into or 
rake items out of the Apple 
menu 

Starting rhc program wirhmn 
opening rhe folder or disk in 
which the original and i t~ 

associated 11lcs arc locared 

When opened, the alias 
displays a message with rhe 
name of rhe disk needed, then 
opens the original when the 
disk is inserted. 

\\'hen opened. the alias 
auromarically finds and 
opens its original on the 
server, essentially creating an 
automatic server connection. 

·:· 1inuble? If you open an alias and nothing happens, or you sec 
a message reponing rhar the original file isn't available, rhen 
the alias is clamagecl or the original has heen clelerecl. Open 
the alias's Info window LO find our where irs original is. ·:· 



Locating the original of an alias 

You can locate the original of an alias by opening the alias 's Info 
window. 

1. Select the icon of the alias whose original you want 
to find. 

2. Choose Get Info from the File menu. 

The alias 's Info window appears. 

;;o~ JH memos alias Info ~ 

u JH FMmoS 41;_;s 

Kind :.<~lias 

Siz:@: 1 K on disk (521 biJlu us~) 

Yher.: sE backup •2 :choos.,·2 • Hos Locarion of rh<.: original-includes 

Cre.lt•d : Mon,Oct 7 , 1~9 1 ,8 :4 1 AM 
Hodi fi ~d:Mon,Oct 7 , 1991, 8 :41 At-1 
Original : SE backup • z :choos('r2 

Comments : 

l l 
0Loclce-d [ Find Origin~iJ 

folder levels and disk name (if rhe 
original is on a diffcrcnr disk) 

3. Click the Find Original button. 

The window containing the original item opens, with the 
item's icon highlighted. 

If you cleletecl the original, you'll sec a message reporting that 
the original can'L be found. Aliases are not deleted when the 
original files are deleted. 

Installing an item in the Apple menu 

You can install a file or other item in the Apple menu so you can 
open it by choosing it from the menu. 

1. Open the System Folder icon and locate the Apple 
Menu Items folder. 

2. Locate the item you want to install in the Apple menu 
and drag it (or its alias) into the Apple Menu Items 
folder inside the System Folder. 

The item appears immecliaLely in the Apple menu. 

You remove an iLern from the Apple menu by opening the Apple 
Menu Items folder and dragging iLs icon (or its alias) out of the 
folder. 

·:· 7i·oub!e? If the Apple menu does not contain the items it 
should, make sure that the Apple Menu Items folder is in the 
System Folder of your stanup disk. Also, open the Apple 
Menu Items folder LO check that all the items that you want in 
the menu are in the folder. ·:· 
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Moving an item to the desktop 

You can make an item easy to find by dragging irs icon to the 
deskrop. The icon stays there until you remove the disk on which 
the item is actually stored. 

If you·ve placed an icon on the deskrop, you can put it back in its 
original localion by using the Pur Away command. 

1. Click to select the item you want to put back in its 
original location. 

2. Choose Put Away from the File menu. 

Finding a ftle or a folder 
When the Finder is the active program, you can usc the Find 
command in the File menu to find a Ole or folder on any disk 
whose icon is on the desktop. (The Find command cannot locate 
items inside the System file, such as fonts and sounds. You must 
open the System file w see irs contents.) 
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Finding an item by name 

1. Choose Find from the File menu, or press ~-F. 

The dialog box that appears lets you find a file or a folder by 
searching for its name. 

Find 
You rype the name 
(or partial name) you 

""' I ~ '"'"' 10 fiod he" 

) [ cancel ] R Find Clicking this button 
starts a search. 

[ More Choices ) 
I 

Clicking this bunon displays a larger 
dialog box with more choices of 
search characteristics. 

If the dialog box has more items in it than shown here, click 
the Fewer Choices button in the lower-left corner. 

2. Type the name (or part of the name) of the file or folder 
you want to find. 

It doesn't matter whether you capitalize any letters, as long as 
the letters or numbers you type are in the name of the item 
you're looking for. 



3. Click the Find button. 

The first item that marches the name (or panial name) you 
typed is shown highlighted in a Finder window. If no item is 
found, your Macinrosh makes the alert sound. 

4. 'Ib see the ne:\.'1 matching item, choose Find Again from 
the File menu, or press ~-G. 

If no more items are found, your Macintosh makes the alen 
sound. 

Finding an item by other characteristics 

You can use the f ind command to find a file or a folder by 
searching for its size, its label, the date it was created or modified, 
ur other characteristics. 

1. Choose Find from the File menu. 

The Find dialog box appears. 

2. Click the More Choices button. 

I 

I 

I 

The dialog box rllal appears lets you set c.lifferem search 
characteristics through pop-up menus that together form a 
search order. 

Pop-up menus 
of search 
characteristics 

'type text (whcn 
searching for rcxt) 
or set a date here 

Find 

Oprion to displav 
search results all 
at once (instead 
of one at a time) 

Find and select items whose 

I name ·I I contains ... II I 

Search 1 on oil disks 

------ -~--

[ Fewer Choices J 

b >Ut!Oll 

displays a smaller 
dialog box. 

... J Oallotonce -

~--·-------··------

( Cancel ) I( 

p·llp 
search locations 

Find )I 

g til lS bunon 
hcgins the search. 

The content of the middle pop-up menu and the text area vary 
according to the item selected in the left pop-up menu. 

3. Press the pop-up menu on the left to open it, drag to 
choose an item, and then release the mouse button. 

4. Press the pop-up menu in the middle to open it, drag to 
choose an item, and then release the mouse button. 

COIIIilllleS .... 
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;. Adjust the date, choose an item, or type text in the 
upper-right area of the dialog box. 

Clicking a number selects it; clicking the up or 
down arrow changes the selected number. 

Find 

Find and select items whose 
I 

I dnte modified .... j [ Is before .,..I I O/ l]/ 90 

Senrth I on alflil$i($u .... , 0 all at once 

I 
00 
II; 

( Fewer Choice-s) [ Cancel I fi Find n 

6. Choose a search location from the pop-up menu 
labeled "Search." 

You can choose ro search all disks, a specific disk. or the acri,·e 
Finder \\·indow. 

Find 

Find and select items whose 

I date modified •I I is before .... , 1 0/1]/ 90 [;) 

search .;'On all dlsl:s 01111 n t once 
0 0 

on "SE bocl:up #2" 
( Cnncel ) ~ ~ l Fewer Cho Find 

Jnnunry folder 

Disk sci en cd for sea ;; 
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7. If you want all found items displayed at once, click the 
checkbox labeled "all at once" so that an X appears. 

8. Click the Find button when you've finished setting your 
search characteristics. 

ll1e first item that marches your search characteristics is shown 
highlighted in a Finder \\·indow. 'lo see the ne.\t item found, 
choose Find Again from the File menu (or press ~-G) . 

When the items found are displayed all at once, they are sho\vn 
highligh1ed in one or more Finder windows. 

m 

A list 1·ie" shows the 
mntents of folders at 
alllcl'cls on the disk. 
in outline form. 

!9!!!1 

D ...,, ~ mmm 
D ·Xt -:··:·:=··;·;':···:·-:·:=.=.·,-.•:·.· ····:(1·'·'· 

Item~ found in the se:1rch 
are highlighted. 

J Os disk -Ell: 
Sll:• L.a.st Mochfl6d 

3K Ytd, Oet10, 1990, II 13 PM p,! 
15K rn.,Stp29,1989,10S9 N'1 

7K Tho, Oel<, 1990, 8:50 PN 

- Mon,Oet8,1990,2.04PM 

29IC ThJ, .b\22, 1'J89, 2 49 PM 

34K Thu,...lll'\22, 1989, 251 PM 

382t< Mon, Aug 7, 1989, 7 : 1~ AM ;;:;; 

- Mon Oet 8 1990 2 .05PM 0 
::::=:'';·::,.,; .... , .. •.i:";;,::.;i:. 12! 

Indentation indicates rhat the item 
located is inside a folder. 



Finding items through a two-stage search 

You can use t'i\·o sets of characteristics and locate the items that 
meet both sers of characteristics. 

1. Choose the first set of characteristics you want to 
search for. 

2. Click the "all at once" box so that an X appears. 

Checking "all ar once" displays the items found highlighted in 
a list. 

3. Click the Find button. 

The items found are shown highlighrecl in a Finder window. 

4. Choose the Find conunand again, before you click or 
take any other action. 

You choose Find before raking any orher acrion so the items 
located in the first stage of the search remain highlighted. 

; . Choose the second set of characteristics you want to 
search for. 

6. Choose "the selected items" in the Search pop-up 
menu. 

7. Click Find to begin the second stage of your search. 

The search is limited to the items found in rhe firsr stage, 
and on!~' those marching both sets of characteristics arc 
highlighted. 

Uses of the Find command 

The find command can help you locate files quickly, organize 
large quant ities of clocurnenrs, and develop an effkiem system for 
backing up and archiving your work. 

Search characteristic 

Name 

Kind 

Sit.t: 

Label 

l.ork 

.\lodification date 

Creation date 

Can be used to locate 

1. Files \Yhose names you can·r recall exacrlv 
2. All items for which you usc a standard name, 

such as status reports or expense n:pons 

I. .-\JI applicarion programs 
2. All aliases 

Large files. to make space available on a disk 

All the files ro which you acldeclthc same label 
(such as ··rop st:ud' ) 

Locked Illes. 10 unlock them for editing 

All Ales changed since a certain date, lex regular 
backup of ne\r and changed files 

All tiles created before a et:rtain dare, for 
archiving or erasing outdated material 
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Creating a template 
Most clocumenrs can be saved as or converted into a statione1y 
pad, which is a rem plate form of the document. The template 
retains rhe format and content it had at the rime you made it into 
stationery, and you can use it repeatedly as a master for similar 
documents. 

Many application programs let you save a document as a 
stationery pad when you first save the document or choose Save 
As from the File menu. If the directory dialog box that appears has 
a stationery pad option, you can click it to save your new 
document as a remplare. 

I= Wallhrop ..- j 
D flnn11al repoJ1 '' 1 
CJ App. program s 
D <Srt fmrn 

CJ ar1 samples 
n llehy ll!.l7!91 
D !look ll~t 

=Wallhrop 

Ol ( EJ•~cl J 

( Desk top ) 

(New D ) 

CJ car Info ( Cancel ) 
CJ casper mops 

Regular 
documt:lll icon 

D l' indntl' rPtlnrt 0 f Sn~ 
saue this document as: @ ~9 EiJL S1a1ionery pad U•mnt . . I 

When this button is selected, the 
dommt:nr is savt:d as a stationery pad. 
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If the program you're using does not offer a stationery pad 
option, you can usc a document's Info window to create a 
stationery pad. 

1. Click to select the icon of the document you want to 
use as a template. 

2. Choose Get Info from the File menu. 

3. Click "Stationery pad" near the lower-right corner so 
that an X appears in the checkbox. 

eO · Memo Pad Info 

[3 Mtm0 Pid 

Kind : Tt~hTtxt st•ttontrv p.ad 
Sb:e- : tK on disk ( 19 b!Jtes un d) 

Y here : M.t~clntosh HD: 

Cre11ted : Tut,S.p 3, 1991,6:.57 AM 
Modifie-d : Tut-,~3, 1 991,6157 AM 
Version : not infliblt 

Comments : 

r 1 

0 Lock•d f8J Sbtionerg p • d 

Clicking "Stationery pad" converts the document from an 
ordinary document to a stationery pad. 

4. Close the Info window. 

The document icon has changed into a stationery pad icon. 



\\'hen you open a stationery pad, an untitled \Yindo"· appears 
showing a blank '·form" from that stationery, or a dialog box 
appears asking you to name the new clocumcm. 

You cannot change the stationery pad itself unless you turn it back 
into a regular document. You do this by opening the stationery 
pad·s Info " ·indow and clicking ··srationery pad'. to remore the X. 

Getting information about your files 
When you're working on the desktop, you can choose the Get 
Info command from the f ile menu to get information about a file, 
such as when a document was created or ho\\· much rnemory a 
program needs. 

You can also use the View menu to sec cert ain types of 
information about the files listed in a f<inder window. 

Using d1e Info window 

The Get Info command displays information about a selected item 
in a window. 

1. Click to select the item you want information about. 

2. Choose Get Info from the File menu, or press 3€-1. 

IE~ Reod M e Info 

~ RndMt 
~ 54Jsttm Softwv• 

Ki nd: docuntnt 
s lu: 31< on db!< ( 1 ,622 boj lH us.d) 

Yh~rr: J•s disk : Rud Mt 

Cr•at ed :Thu,Jultj I I , 1991,1 1 :13PH 
Modified: 'w'f'd, Nov 6, 1991. 12 ;()()PM 
Ytr~ion : not ~v~ flibJ.t 

Commtnt.!: : c- 1 

0 Locked 0 Stationer'=' p.ld 

!3csicles getting information, you can usc the Info window to 
lock a nle (so it can·t be changed or thrown away). turn a 
document into a stationery pad, change a program·s memory 
allocation, and change the me·s icon. (See Chapter 11, 
"'Adapting Your Macimosh LO Your Own lJse," for information 
on the last two procedures.) 

You can type commcms in the Info window and later search 
fur them \\"ith the Find command. 

3. Click the close box. 
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Using the View menu 

You can use the Vie"· menu to display the contents of a window 
by icon or small icon, or you can list them according to name, 
size, kind, date, or label. (See Chapter 11, ·Adapting Your 
Macintosh to Your Own Use,·· for information on using the Views 
control panel to change how Ales are listed and what information 
is included.) 

Winclo\vS are set to show items in the icon view. One of rhe list 
views (name. size, kind, label, or clare) is useful when you have 
roo many files ro see easily as icons or if you wam your files 
arranged according to a particular attribute. For example, listing 
documents by the dare and rime of their most recent modification 
makes backing up files an orderly task. 

Tht: ry1x: of list dis11lal'nl is umblint:d. I . . 
JH data/2 CJ:i 

!!J!!!t St:• KW'Id l*1 Last Modlfitd 

I> D .VI><Itu - foldw b S+nll•l S.t , Mioj 5 , 1f0 

I> D c..p..- mops - foldott" Hot ~.Nov 2 , 1 

:::~: ~,~~~~9'.R1 D crt<ln umon ~t 17K ~nt 
D dsktt!dWM CMt' rlnr.t 

.:::. ' "''·'· :'!:':"', ,:,:::;,\::;':':\'::::: •. 1 ¢1Q] l¢n : .,.,,:'':'::,:;:,:.:,,,,,,,,,,,,,,,,!·:?''''' ·::=:=::::,..,.,.,. ,. .. .. " . .... 
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\Xfhen rhe coments of a window are clisplayecl as a list and you 
want them arranged in another list view, you don't have to use the 
View menu. You can click a column heading (such as Size or the 
l.asr ~ lod ified dare) to rearrange the list according to that 
heading. 

See the summary, "Working on the Macintosh DesktOp," on the 
green pages after Chapter 16 for information on using a list view 
to select items in different folders. 



Chapter 11 

Adapting Your Macintosh 
to Your Own Use 
In this chapter 

• Specifying which items you wanr opened at starrup 

• Installing an item in the Apple menu 

• Install ing files in the System Folder 

• Changing the items in the Label menu 

• Setting the date and time 

• Chousing formats fur displaying the clare and rime 

• Setting a rime for rhe Alarm Clock ro go off 

Turning the alarm off 

• Adjusting the way the mouse works 

• Adjusting the way the keyboard works 

Controlling the pointer from the keyboard 

Making keyboard shortcuts easier to rypc 

Adjusting the keyboard for very slow typing 

• Choosing flmmts for displaying numbers and currency 

• Setting the alert sound 

lnsralling a sound 

l{emoving a sound 

Recording sounds 

• Changing rhe desktop pattern 

• Adjusting the blinking of a menu item 

• Adjusting the blinking of rhe insertion point 

• Changing the way the contents of windows appear 

• Changing the appearance of icons 

Changing an icon 

Assigning a label and a color roan icon 

• Changing the highlight color 

• Changing the color of windows 

• Displaying colors or grays 

• Configuring multiple monitors 

• Adjusting screen brightness 

• Magnifying the screen image 

• Turning off rhe Empty Trash warning 

• .\1anaging memory 

!)­_ ) 



Specifying which items 
you want opened at startup 
To have a file (a program or a document) open automatically 
\\·hen you stan up your Macintosh. drag the file's icon or irs alias 
LO the Startup Items folder, which is inside the System folder. 
Any programs or documents (or their aliases) that you put in 
the Startup Items folder arc opened when you start up your 
Macintosh. You can have as many files open automatically as 
your com purer's memory allows. 

If you no longer want a Ale to open automatically when you stan 
up your Macintosh, remove the nle's icon or its alias from the 
Startup Items folder. 

Installing an item in the Apple menu 
To have a program, document, or other item appear in the Apple 
menu, drag the item's icon or irs alias ro the Apple Menu Items 
folder, which is inside the System folder. 

You remove an item from the Apple menu by opening the Apple 
Menu Items folder and dragging the item's icon (or irs alias) our 
of the folder. 
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Installing flies in the System Folder 
Certain types of programs and other files need to be installed in 
the System folder so your Macintosh can use them as part of the 
system software. These files include 

• ~)'Stem extensions and control panels (also called !NITs and 
CDEVs) 

• files of preferences for application programs 

• drivers for printers, scanners, and other devices 

• sounds (instructions for installing sounds are in this chapter) 

• fonts (see Chapter 12, "Printing," for instructions on installing 
fonrs) 

Usually, you install these files by dragging their icons ro the 
System Folder icon (not the System Folder window). Sometimes 
these nics arc installed using an installer program that comes with 
the files. Check the instructions that came with the files for any 
specific installation procedure. 



These files are stored in specific folders inside the System Folder. 
\\ihen ~'OU drag a file's icon ro rhe System folder icon, your 
Macintosh recognizes which type of Ole it is and stores the file in 
the appropriate folder. 

This folder holds nel\I'Orking 
software, printer software, ;md 
or her s~·srem exrensions. 

,Eo~ 

8itll'ms 

w 
Applt Mfnu lttms £xttns1011s 

[Q] 
St.lrtup ltt"ms 

This foldcr holds scll ings 
for applicar ion programs. 

The Sl'st<.:m file holds fonrs, 
sounds. keyboard layouts, 
and othcr resou rccs. 

&Jsttm 

~ 
Control PMI~b 

11 ~ This program 

Findtr-

[@.) 
&r•pbook F'ilt IO 

<:> 

manages the 
J\llacintosh 
desktop. 

This filc holLis items vou 
put in Lhe Scrapbook. 

If you drag one of these files to the System Folder window instead 
of the System folder icon, the file is nor stored in the appropriate 
folder automatically. Items you want in the Apple Menu I tems 
folder or the Startup Items folder inside the System Folder need 
to be dragged ro either folder directly. (See the instructions in this 
chapter for installing Apple menu items and speci~1ing the files 
you wanr opened at startup.) 

Removing files from the System Folder 

You remove a llle from the System Folder hy dragging its icon our 
of the System Folder. 

Depending on the external devices you use, whether or nor 
you're on a network, and hmv you use your Macintosh, you can 
remove the following types of files from your System Folder if you 
want to conserve space on your startup disk: 

• 

• 

• 

drivers for printers or or her devices you don't use (for 
example, the AppleTalk ImageWriter driver) 

networking drivers, if you are nor on a network (such as 
AppleShare software) 

Apple menu items you don't use (you need the control 
panels, but you may not need the Calculator or the Puzzle, 
for example) 

• extra fonts, sounds, or keyboard files you have installed 

I3e sure you have backup copies of the flies on noppy disks before 
you remove them from your System f-older. 
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Changing the items in the Label menu 
You can change rhc labels (and colors, if your monitor displays 
colors or shades of gray) available in rhe Label lll<.:nu. You 111ake 
these changes in the Labels conrrol panel (choose Control Panels 
from the Apple menu and open rhe Labels conrrol panel). 

~ 
Labt?ls 

~D~ Labels~ 

s~~mlul D 
~ ~,Ho=t =======:1 
~~lnPr"9f"m I 
~]cool I Labels 
~ JP•rsonol I 
~ IProj•ct I I 
~ 1Projoct2 I 

Colors 

To change a label , drag across it to select ir and rhen rype your 
new label. 
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'lo change a color: 

1. Click the color you want to change. 

The color wheel dialog box appears. 

i\e11· color or gray is in lOP llalt. 
current color or grar in bottOm half 

Color fort Essentia l· 

Hue 

Sntura tion 

Brightness 

Numbers correspond ro 
the selected color or 

gt-a)' on the wheel. 

rnF".. V.l 11 Circle 
indicates 
selected 
color. 

Brightness 
control 

Wheel shows colors or grays available. 
(When four colors or grays are 
selected, letters appear in the 11·heel 
indicating color values.) 



2. Click a color on the color wheel to select it. 

The new color is displayed in rhe rop half of the color square. 
The currcm color remains in the bmrom half of the square for 
comparison. 

3. To experiment with other colors or shades, drag the 
pointer around the wheel or click at another point on 
the wheel. 

The new color is displayed in the upper half of the color 
square as you clrag or click. 

4. Click OK when you have selected the color you want. 

The color wheel dialog box closes. 

5. Close the tabels panel. 

The labels and colors vou choose remain in effect until you 
change them. 

Setting the date and titne 
Your Macinrosh has a clock that keeps track of the date and time 
(a battery keeps il running when the computer is turned off). 

Many programs rely on the clock to enrer rimes ancl elates in 
documents you creare or prim. The Date & Time control panel 
also lets you decide how ro display the date and time of clay on 
vour J\1acintosh. 

1. Choose Control Panels from the Apple menu. 

2. Open the Date & Tune control panel. 

lj -
==0::= 

Date 8:. Time 

;o Dote &Time 

l!j] Current date @ Current t ime 

'R> change the d~rc, I 1 1/ il]/ 92 I~ i I 1:55: 16 PM I 
dirk the dar, monrh. or I 1 

vcar to se.lecr it. Then 
'rwc rhe number you 

\\'ant or click the up or 
ci0\\'11 atTm\· u ntil rhe 

numlx:r appcars. 

[ Date FormotL. ) 1 

' 

COilfilllleS ll> 
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I:D Dote & Time 

l?j] Current date 0 Current lime 

@4192 . J [ t :m.s9 PM I k 

~ormats;l (Tiinerormais ... ) 

'Jb change the time, dirk 
the hours. minmes, or 
seconds to select them. 
Then type the number 
vou \ranr or click the up 
or down arrow umilthe 
number appears. 

·:· Anotber /Ut~JI to cba11ge tbe date and time: You can also usc 
the General Comrols panel to change the date and time. The 
Date & Time conrrol panel offers the aclvamagc of a variery of 
ways to display elates and rimes. ·:· 
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Changing the format for dates 

1. To change the way the date is displayed, click Date 
Formats. 

I~D Date & Time 

l!{y Current date 0 Current time 

r 4/ 14/ 92 1 [!:11:39 PM~ 

[ Onte Formats ... J [ Time Formats ... ] 

2. In the Date Formats dialog box that appears, make the 
changes you want. 

Ar rhe bottom of the dialog box you can see samples of rhe 
formats you choose. 



'lo attach a prcfL\ w a long dare 
or change the separators 

between elemems in the date, 
trpc the rharaners you want in 

these text boxes. 

To change the elemems in __ 
a long elate format. choose 

the ones rou \ram from 
these PoP-UP menus. 

The ''Long date'' and "Shon date" formats shown 
are standard in the United States. If you change 

1 

anything. you create a "Custom" format. 

~ Date Formats: I U.S. ...I 'lb change the order of 
elements in a short date. 

r- Long date ................................................. - ....................... 
1 

!"' Short da t• ......... - ......... _ .................... - ..... 
1 

use this pop-up menu. 

! PrefiH: ~ i ! Month/ Day/ Year .,.. ! 
r.- ' ' ' ' I Weekday .,..I I, J ' ' 

, I Month .,..I I ! 
! I Day .,.. I 1. J 

J_l Year .,..I I ! 
I 0 l eading zero for day i 
i ........................................................................................ _ ............. .l 

I : II To ch'"getheseprumm 
i between month. da\', 
! and rear in a shnn date. 
! type the character here. 
! 

Separator: I I 

0 leading zero for day 

0 leading zero for month 

0 Show century 
! 
i 
! 
i 

L ......................................................................... -................ .1 
Samples o.f the formats you Itt; ... Samples .................................................................................................................................... 1 
choosc appear hen:· in long : Tuesday , April 14, 1992 ! 
elate, abbreviated long date, i Tue, Apr 14, 1992 ! 

and short date stl'ies. ! 4/14/92 I . '··········-······················~·····~··········· .. ···-··~····· ...................................................................................... i 

~ 'li> close the dialog box 
~ II without changing the 

n OK u 
I 

way dates arc displayed. 
dick Cancel. 

'I(> usc the changes you·\'e made 
to thc way dates are displayed, 

dick OK. 
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Changing the format for times 

1. To change the way the time is displayed, click Time 
Formats. 

2. In the Time Format dialog box that appears, make the 
changes you want. 

At the bottom of the dialog box. ~~ou c;m see samples of the 
formats you choose. 

':o Dele ll' Time 

!?{y Current da te Q) Current time 

[47i?i/92 1 I 1: 11 :39 PM I 
~mats ... ) 

The formats shO\\ n are 
standard in the Cnired Stares. 
If you change alll'thing. you 

l
rrcatc a "Custom" format. 

r-----------~~ II Q) Time Format: I U.S. ,..I 'lo change the text that identifies 

1- Clock ·-·-----·-.. - .. 1 1- Format ----------1 II times bcf(>n.! noon and :tfrer noon. 
Choose rhe 1+hour or 11-hour dock. II ' 0 24 hour ! ! I =r ' t\'J)e the text here. 

! ; ' Before noon: AM · · 
! ® 12 hour ! i \X'hen mu choose the 11-hour clock. 

mu r:m al:,o choose either 0:00 or 12:00 
· to represem noon ~nd rnidnighr. 

. Noon & midnight: j j After noon: I PM I 
0 0:00 i i -
® 12:00 j j Separator: ~ i II 

! .......................................................................... ! i .............................................................................. .J 
D Use leading zero for hour 

'lo change the separator between 
hours. minutes. and seconds. rype 
rhe r llararll:r here. 

, ... Samples ·-............... - .................. _ .... _,_ ....... , 

S:1111ples of the form:us you II ! 12:34 AM 4:56 PM ' 
choose appear here representing '~--·-·----· ........... - ...... - ........ _ ...... . 

[ Cancel~ 'Io close the dialog box 1\·irhmn 
changing rhe \\':tr rimes arc n OK » displayed. click Cancel. 

I 

before-noon and after-noon times. 
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'li> usc the changes you've made to the 
\\ ay times are displayed. dick OK. 



Setting a time for the 
Alarm Clock to go off 
You can ser rhe Alarm Clock to alen you when ir's rime for an 
appoinrmcnt or a meering. 

1. Choose Alarm Clock from the Apple menu. 

The Alarm Clock opens. 

2. Click the upward-pointing lever near the upper-right 
corner to expand the Alarm Clock. 

I D 3:52: 1 o PM ·~) l.c:H:r lo rmkc: I he: Alarm Clock 
brggc:r < )r ~m:r l lt: r 

The lever points clown ward, ancl 1 he Alarm Clock expands to 

its fu ll size. 

I "" tii,:W.i ~ _ 1 The highligluc:cl icon indicmc:s what ·s 
clisplavecl in the middle .~c:nion-1hc 
date. in thi~ ~::-.ample. 

3. Click the alarm clock icon in the lower-right corner to 
select it. 

The alarm clock icon is llighlighred when you sclccr it. The 
rime thai appears in the middle seer ion is rhe current alarm 
rlnck serring. 

4. Click the hours, minutes, or seconds in the alarm clock 
setting to select them. 

Up and clown arrows appear ro rhe righr of the time display. 

5. Click the up or down arrows repeatedly until the hour, 
minute, or second when you want the alarm to go off 
appears. 

6. Repeat steps 4 and 5 as necessary. 

COIIIilllleS .... 
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7. Click the button to the left of the alarm clock setting to 
turn the alarm on. 

\\/hen you click, the bunon moves up and the alarm clock 
icon changes to indicate that the alarm is turned on. (Clicking 
again turns the alarm off.) 

Buuon in the upper position 
indicates that the alarm is on. 

I---- leon shm;-ing ringing alarm 

8. Click the close box to dose the Alarm Clock. 

The alarm will nm go off unless you close the Alarm Clock or 
click the lever to make the alarm clock smaller, click 
elsewhere in the clock, or make another window active. 

Turning the ala1m off 

When rhe system clock reaches the time set for rhe alarm, the 
alert sound plays twice (the menu bar nashes once if the speaker 
volume is set ro zero) ancl an alarm clock icon blinks over the 
Apple icon at the left end of the menu bar. 

'lo rurn off the alarm, choose Alarm Clock from the Apple menu 
and cl ick the button to the left of the alarm clock serring so that 
the bunon moves clown. 
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Adjusting the way the mouse works 
You can adjust two aspects of mouse operation in the ~louse 
control panel: tracking, v;hich is the relation bet'i'•een mouse 
movement on your desk and pointer movement on the screen, 
and double-clicking speed. 

1. Choose Control Panels from the Apple menu. 

2. Open the Mouse control panel. 

~ 
Mouse 

1:0 · Mouse 

Moos" TrtckWlCJ 

[1J ~ k1 
0 000®00 

Ytf"y Slow Slow F'.ut 

.. .. .. 
• o • o + ® 

Doublt -Cht.k Spt~ 



3. Click the tracking speed you want. 

If }'Oll cl ick Fast, the pointer moves more than twice as fast as 
you move the mouse. The Very Slow option is useful for 
drawing with Lhe mouse or a graphics rablet because rhe 
poimer moves ar a consranr speed relat ive to mouse 
moremenr. 

Your choice takes effen immediately and remains in effecr 
unril you choose a differenr tracking option. 

4. Click the double-clicking speed you want. 

)tJu may hare to adjust the double-clicking speed if your 
Macintosh often inrerprets rwo clicks as a double click, or a 
double click as two single clicks. 

+ + :o-1 The sp:Ke betii'Cen arroll's 
+ 0 + ® 0 t:<!rrcspond-; to the inttwal between 

Doubl•-Click Sp••d t ht b. 

,\louse button highlights tll'ice at the 
intetTal selected when you click a huuon. 

'tour choice remains in effect until mu choose a different 
double-cl icking :, j.Jetd. 

Adjusting the way the keyboard works 
You c;m adjust the rate aL which a charaCLer repeats when its key 
is held clown as well as the delay before Lhe character begins 
repeat ing. You can also change the keyboard layout. 

1. Choose Control P.,mels from the Apple menu. 

2. Open the Keyboard control panel. 

= . 

~ 

Kt-•Jbo.:wd 

Option' for the speed at 
which a character repeats 

;o~ :1 Key boord 

Kt\IR~.I R•t• Dt1~ Unh1 Rf'P't'•l 

1000®0 1 0 10®001 
Slow rut Off Long Short 

Ktybo¥dl>yout 

GZJOvorok 0 ·-
'{} 

Options for delay before :1 
character begins repeat ing 

Options for kerboarcl layout 
(if more than one kerboarcl 
layout is installed) · 

conlhtlleS ..,. 
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3. lb adjust the rate at which a key repeats when it is held 
down, click the button for the rate you want. 

AfLer you close the conrrol panel. your choice remains in 
effen until you change ir. 

4. To adjust the delay before keys repeat, click the button 
for the delay you want. 

If the keys repeat when you don't wam them to. you should 
acljusL rhc keyboard's sensi tivir~· to your LOuch by seLLing a 
longer delay before a character begins repeating. (If you click 
the Off button, the keys clon·L repeat ar all.) 

After you close Lhe control panel, your choice remains in 
effect umil you change it. 

5. To change the keyboard layout, click the name of the 
keyboard layout you want to use. 

Depending on which counu-r you bought your Macintosh in, 
you may hare a choice of more than one keyboard layout. 
(:\dclitional keyboard layout.s are m·ailablc from various 
sources. and you install them in the System Folder as you 
''uulcl fonts or sounds.) 

After you close Lhe conrrol panel, your choice remains in 
effecL umil you change iL. 

6. Close the Keyboard control panel. 

1:\(l Chaprcr II: Adapr ing )(1ur \lacinrosh 10 \bur 011n Use 

Controlling the pointer from the keyboard 
\\.irh a ,\lacimosh system sofrware feature called ~ louse Keys. you 
can use rhe numeric keypad on the righr side of the keyboard 
(instead of rhe mouse) ru comrol Lhe movement of Lhe pointer on 
the screen. 

To rurn Mouse Keys on, press :!€-Shift-Clear (the Clear key is on 
the numeric kevpad). 

To rurn Mouse Keys off. press Clear. 

\\.ith ~ louse Keys on. ~uu Gill click. drag. and perform all the 
usual mouse actions from the numeric keypad. The 5 key serves 
as the mouse button: press once ru click: press m·ice ru double­
cl ick. The 0 key locks the mouse burton down for dragging. The 
decimal poim key (Lo Lhe right of 0) or rhe 5 key unlocks the 
mouse huuon. 

I ,~ 
.\•rt 

l clear 

lCJ 
t J 
~~' 
lo 

l~- l/_~ l~J 
LL J llb l±J 
l / 1 1- 1 I I 
5 J l6 J L:-J 

~·--- G'J v 
I / 1 

'l_· J [enter , 

u-
Press once 10 

dirk; prc~s lll ice 
ro douhlc·rlick. 

Press either key 
1 o n:lc:Lo;c the 
mouse huuon. 

Press to lock 
11tou~c hull on 
down for drauujnu. ,,.., ,-, 



You ran adjust how quickly the poimer moves on the screen and 
how long the delay is before the pointer starts moving when you 
press a mouse key. You make these acljtistments in the Easy 
Access comrol panel (choose Comrol Panels from the Apple 
menu and open Easy Access). 

Making keyboard shortcuts easier to type 

With the ,\\acinrush system soff\\·are feature called Sticky Keys. 
you can type keyboard shoncuts (such as ~-S for the Sm·e 
command) 1rithout actuall~· pressing the ke~·s simultaneously. 

'I(> turn Sticky Keys on or ofT, press the Shift key live times without 
moving the mouse. 

\\lith Sticky Keys on, you can type a keyboard shorrcu t by llrst 
pressing the Jnodifler ke~· (~ , Option, Control, or Shift) and then 
pressing the character key. An icon in the right end of the menu 
har (to the right of the Application menu icon) chang<.:s 10 

inc.liGite whether Stickv Ke~·s is on and ,,·hether a modifier key has 
bee11 pressed or locked. 

S1ickr .\modifier .\modifier ker is locked 
Keys· key has (pressing Ihe.key lll"ice 
is on. been pressed. locks il fr1r repeated use). 

< ~JJ ~ ~)~ 

l'<>u can hm·e Stickr Kevs make an alert sound when a modifier 
key is pressed. l'<>u set this option in the Easy Access comrol 
panel (choose Control Panels from the Apple menu and open 
Easy Access). 

Adjusting the keybocu·d for very slow typing 

The ~lacinrosh system software feature called Slcm· Keys lets ~uu 
t\-pe ver~· slo\\'1~ · and ignores accidental keystrokes b~· delaying the 
acceptance of the next key~truke. 

'lo turn Slmr Ke1·s on or off. hold down the Ret urn ker for about . . 

four seconds. until an alert sound indicates that the feature is on 
or off. 

You can adjust how long ~'<HI want Slow Keys ro delay acceptann: 
of the nexr keystroke. You can also set Slow Keys m make an 
audible cl ick each time a key is presst:d. You make these 
adjustments in the Easy Access comrol panel (choose Control 
Panels from the Apple menu and open Easy Access) . 
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Displaying numbers and cun·ency 
You can choose from several different formats for displaying 
numbers and currency. 

1. Choose Control Panels from the Apple menu. 

2. Open the Numbers control panel. 

Numbet-s 

The formats shown here arc 
standard in the United States. 
If you change anything, you 
create a "Custom" forrnm. 

~0 Number 
'lo change the decimal separator, 
rypc the character in this box or 

press the arrow and choose a 
separator from the pop-up menu. 

'to change the thousands separawr, 
type the character in this box or 

press the arrow and choose a 
separator from the pop-up menu. 

~ Number Format: I U.S. · I 'lb change the currencv 
symbol, t ypc the 
character(s) you want. , .. Separators ....................................... , 

~E} ! 
r· Currency ....... , ... : .............. ;('" ... l 

I 
Thousands: l• JE} 0 Rfter number i S)•mbol before or after 

'·---·---.. -----........ - .. .! the number, click the : .. ·-·-····---····--··-·····-····-···-··-; 

® Before numbeltl! '!()place Lhc currency 

r Sample - ............................. _ ....... ""] appropriate button. 
1 $1,23] 4.56 i 
:·-····-.. ······-··~······· ·······--······-··-···-·; 

Samples of the formats you 
choose appear here. 
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Setting the alert sound 
Many programs have the Macin tosh make a sound, called the alen 
sound, when your auention is required or when you're giving a 
command or arrempring an acrion rhat the com purer cannot 
recognize or perform at that rime. 

You can choose among several sounds that you want the 
!\ilacimosh to make. You can also set the sound's volume. 

1. Choose Control Panels from the Apple menu. 

2. Open the Sound control panel. 

c:J~ 
==0=­

Sound 

The Sound window appears. The alen sound thar your computer 
is currently using is already selected. 

I 3. Click the alert sound that you want the Macintosh 
to use. 

m· Sound 
Sptoaktr Altr't SovndS-
Volum• Oro l• t {} ,, . " 
6 . Ou•ck ,: Simpl• B••P 

Sosumt 4 - ,• 
\r"ild Etp s-' 

2 •. 
1 
0 . 

~ 

When you click a sound to select it, it's played at the current 
volume setting. 

Your Macintosh may have sounds installed in addition to those 
shown here. It may also have additional features in its Sound 
control panel, such as controls for recording sounds. See 
"Recording Sounds" later in this chapter for information on 
recording sounds. For information on any additional features, go 
to the setup book that came with your Macintosh. 

4. Drag the slide control up or down to set the volume 
level. 

·:· !fyou want to be alerted silently: Drag rhe slide conrrol ro 
zero. Instead of hearing an alen sound, you'll see the menu 
bar flash. ·:· 

S. Close the Sound control panel. 
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Installing a sound 

The .\!acintosh comes with a standard ser of alen sounds. You can 
get aclclilional sounds from various sources. To inswll a sound. you 
drag irs icon to the System Folder icon (not the System folder 
window). The sound is auLomaLically installed in the System file, 
where it belongs. 

~ 
Oom-pah 

Once you add a sound to the System file, it is listed in the Sound 
control panel. 
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Removing a sound 

You can remove sounds in the Sound comrol panel. .\ lake sure 
you have a backup copv of the sounds on floppy disk before you 
remove them from your Macintosh systelll. 

1. Choose Control Panels from the Apple menu. 

2. Open the Sound control panel. 

3. Click to select the sound you want to remove. 

A lake sure vou select rhe correct sound. You cannot undo the 
next srep. 

4. Choose Cut or Clear from the Edit menu. 

;. Close the Sound control panel. 

You can also remove a sound by dragging its icon out of the 
System file and our of rhe Sysrem Folder. If your Macinrosh can 
record sounds, ~~ou can remove a sound by clicking to select ir 
and then clicking the Remove button. 

Recording sounds 

Some Macimosh models (such as the JVI<Kintosh I.C) can accept 
and process sound input. 111ese computers come wirh a sound 
input pon, lO which you can connect either a microphone (to 
record sounds that you create) or a phono jack adapter (to record 
sounds from anorher audio source such as a compact disc or an 
audio casserre). 



\hu can record a sound and add it to ~·our arailable alcn sounds in 
the Sound conrrol panel. ~lake sure you·\'e connected a 
microphone to your ~lacimosh as described in the setup book 
that came with your com puLer. 

1. Choose Control Panels from the Apple menu. 

2. Open the Sound control panel. 

The Sound conrrol panel appears. Icons represenring the 
available sound input devices appear near the lmnorn of the 
\\'inclow. 

3. Click the icon that represents the sound input device 
you want to use. 

Microphonos (options ... ) 

........ 

' ~< 
~ 

l?l!DlU 
·~ 

Recorder 0 

4. Click the Add button. 

A dialog box that looks li ke the controls of a tape recorder 
appears. 

;. To record your new sound, click the Record button. 

Recording begins immeclimcl~·: you ha,·e ten seconds to 
record your sound. There is no recording mlume control. 

[!;] ~ CD] [8 <J 
Record Stop Pause Play 

:00 
0 seconds :10 

6. Click Stop to stop recording. 

[camel] 

[ SntH~ l) 

7. To listen to the sound you recorded, click Play. 

8. To save the sound you recorded, click Save. 

t\ dialog box appears in \rhich you name your ne"' sound. 

9.1ype a name for the sound. 

10. Click OK. 

Giue this sound a name: 

I Andrea 's fi rs t wor~ I 
( Cancel J { OK- ~] 

The ne\\' sound appears in the Alcn Sounds list in the Sound 
control paneL 

\\'hen ~uu·re finished recording ne"· sounds. close the Sound 
control paneL 
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Changing the desktop pattern 
You can change the pattern Lhat appears on the Macin tosh 
desktop in the General Controls panel. 

1. Choose Control Panels from the Apple menu. 

2. Open the General Controls panel. 

~ -
~ 

Genera 1 Controls 

:a~ General conlrols ====:: 

MttouB!dmg 

~ 
EJ 

000® 
orr 1 2 5 

10·27·51 AM 

@t2hr 024 ... 

O•tt l'iiJ 
3/28/90 
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You can choose from a variety of patterns provided for the 
Macintosh desktop, or you can create your own design by 
editing one of the patterns supplied. If your Macintosh can 
display colors or shades of gray, you can also select your own 
colors to use in the pattern. 

I I Pauern-editing area 
.,.......J;T; ' • ' ' (magnified view of pan ern) 

Miniature desktOp 

Color bar for selecting 
colors or shades of gray 

3. To see the patterns available, click either of the small 
triangles at the top of the miniature desktop on the 
right side of the Desktop Pattern area. 

The pattern changes each time you click. 

4. To choose a pattern, click the miniature desktop to see 
the new pattern on your desktop. 

The new pattern replaces the current pattern for the desktop. 
The desktop pattern remains in effect until you change it. 



5. To edit a pattern, click in the square to the left of the 
miniature desktop. 

Each clot in the square changes color when you click ir. Your 
changes are displayed in the miniature desktop. 

6. To use another color, click the color in the color bar 
(under the words "Desktop Pattern") to select it, then 
click the dots you want to change. 

You can also change the color of an existing panern by 
double-clicking a color in the color bar and chousing a new 
color from the color wheel in d1e dialog box that appears. 

7. When you've finished creating your new pattern, click 
in the miniature desktop to display the pattern on your 
desktop. 

13~' double-clicking in the miniarure desktop, you can save the 
new pattern. Otherwise it is lost when you display another 
pattern in the miniature desktop. 

Adjusting the blinking of a menu item 
You can change the number of times a menu item blinks when it's 
chosen. You make this adjustment in the General Controls panel 
(choose Control Panels from the Apple menu and then open the 
General Controls panel). 

To adjust menu blinking, click the button for the number of times 
you want the menu item ro blink. Clicking the Off button prevents 
a menu item from blinking. 

Menu Blinking 

~ 
~ 

0 00® 
Off 1 2 3 

The option you selected remains in effect until you change it. 
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Adjusting the blinking of 
the insertion point 
You can adjusr how quickly the insertion poim blinks (rhe 
insertion poilll indicates where any text you type will appear) . You 
make this adjustment in the General Comrols panel (choose 
Comrol Panels from the Apple menu and then open the General 
Controls panel). 

'lb adjust the blinking of the insertion point. click the hut ton for 
the blinking rare you ,,·am. 

Rat~ of lns~rhon 
Point Blinking 

.... , .... . ·· · .. 
0®0 

Slow Fast 

\\'hen you click. the insenion poim in the control panel shmYs the 
rare of blinking you selected. 

The option you sclened remains in effect unril you change it. 
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Changing the way the contents 
of windows appear 
You can change the way the comems of Finder windows are 
displayed in t.he different views available from the View menu 
(icon view, small icon view, and the list views by name, size, kind, 
label, and dare). You make these changes in the Views conrrol 
panel (choose Comrol Panels from the Apple menu and open the 
Views mmrol panel). 

rn 
Vie·•1lS 

Use the Views comrol panel to change 

• Jhe fonr and fonr size used in all viC\YS (press ro open the 
pop-up menu. then drag to choose a font or a size) 

• the arrangemem of icons or small icons in icon and small icon 
views 

• the size of icons used in list vic\\·s 

• what information is included in list views, including folder 
sizes and the amounr of available space on disk 



" 

Oplion~ for 
Ia rotH of icon~ 

Pop-up menu of fonls for 

1 

iron n:unt~ anclli~l 1·icw~ 

Uicws 
.....-:::-:-:-----ll'-----. 

1 

Pop-up menu of fom 
1ront r..- . .. ~, I Geneua •I ~EJ Sli'C~ _for !COil names 
iaeon v .. ._, and Its! llt'lls 

r5D DD @ Sif>"tlt..-ld r· () . . I 0 Alv.¥JS sn>p to.,.... • puon to ~nap ICOn~ 
, LEo D o 0 s••"''"" oyld i to an inrisible grid 

1 List v~o._. ---- - . - i 1rhcncrcr they arc 
i ~41 q, ~ l2$l Shov ,., . l moved 
l ~ 12$] Show kond I 
i ® 0 0 12$] sho" t o~>ol 1 
i 12$] Show dol• ! 
: 0 C~kul1ti foldi,. st:is ~Shov .,.,..sion I 
i 0 Sl>ov dts• VIIO VI,....,.._ 0 Shov COfiVI\tnts I 
L 

Options li1r the sire 
of icons displayed in 
lis1views 

Options fi1r inli1rm:uion 
displayed in list riews 

The options you select remain in effect until you change them. 
(Sec Lhc summary, "Working on the Macintosh Desktop,·· on the 
green pages after Chapter 16 for more information about using 
windows and list views.) 

Changing the appearance of icons 
You can customize icons by changing the irons themseh·es. If your 
!.lacimosh displays color or shades of gray. ~uu can hare icons 
appear in a specific color that's associated " ·ith a label. 

Changing an icon 

In a graphics program, ~'ou can creme or copy the picture you 
wam to use as an icon, and then pa~te it into an icon·s Info 
window. 

Some icons can·t be changed. including those for conrrol panels 
and or her pans of Lhe sysLem s< >ft ware. Every icon fits inside a 
32-pixel square. (A pixel, or picture element, is the smallest elm 
you can draw on Lhc screen.) 

1. In a graphics program, select the picture you want to 
use for the icon. 

i ~ A """i"g dashed hoc 
1 I indicates the selected an:a 
: __ . __ : in man~· graphics programs. 

COIIIillllf!S ... 
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2. Copy the picture by choosing Copy from the Edit menu. 

3. Switch to the Finder, then click to select the icon you 
want to change. 

4. Choose Get Info from the File menu. 

The icon's Info window appears. 

5. Click the icon at the upper-left corner of the Info 
window to select it. 

A box appears around the icon when ir"s selected. If no box 
appears when you click, rhe icon can·r be changed. 

1,;~ ouerseas accounts I nfo ~ 

IDJ ................ ~. 
K1nd : foldfr 
Stz•: ztro K on dt.sk Co be.ltts ustd),. for 0 

t1tmS 
Vh•r•: .J's <rt..'k : w.Utltd foldft' 

Cr• • t•d: Ytd# Oet 9 , 1991 ,9:25 AM 
Modtfi•d: Y'~1 Oet 9 1 1991 1 9-25 AM 

Comm•nls: 

r m un -1 

i\ box around rhe icon 
indicares rhar ir's selected. 
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6. Choose Paste from the Edit menu. 

The picture you copied replaces the selected icon in the Info 
windo\r. If the picrure is bigger than the icon, it automatically 
shrinks ro fir. 

~=-= ouerseos occounts Inf o --

1 ~ I ovtrsm .... oot. 

7. Click the close box to close the Info window. 

You can change an icon back to irs original by clicking the 
picture in the upper-left corner of the Info window and 
choosing Cu t from the Edit menu. 

Assigning a label and a color to an icon 

You can add a label and its associated color to each icon. A label is 
different from the icon's name. The label is visible only when the 
contents of a windo'i\· are displayed as a list. The associated color 
is visible whenever the Macintosh is ser to display colors or grays. 

Labels provide a way to group related Hies (choose By Label from 
the View menu). If you have a color monitor, you can identi~' 

related icons by assigning a label and its color to each group. 

To assign a label and color to an icon, click the icon ro select it and 
then choose the label (and its color) that you wanr from the Label 
menu. 



Changing the highlight color 
If your 1\ lacintosh displays colors or shades of gray, you can 
change the color your Macintosh uses to highlight selected rexr 
on the screen. You make this adjusm1cnr in the Color control 
panel (choose Control Panels from the Apple menu and npcn the 
Color control panel). 

A(:~ 
IT~ 
Color 

:o 
lllghllght color. 

IDMJC»MI 

Window color: 

Color 

• Bleck If White ..,.. 

D Standa rd ..,.. 

Pop· up menu of choices for 
highlight color 

Pop·up menu of rhoires for 
\\·in dow rolor 

You can also usc the Color conrrol panel to change the color of 
\\·indow borders (go to .. Changing the Color of Windows .. in this 
chapter). 

1. Press the "Highlight color" pop-up menu to open it and 
drag to choose a color or choose Other. 

I f you choose a color, it appears in rhc ··sample text" box 
when you release the mouse button. 

If you choose Other, the color wheel dialog box appears. 

Ne1r color or gray is in rap half, 
current color or gray in bnunm half 

highlight color • 

\umbers correspond w 
the selected color or 

grav on 1 he wheel. 

~.. fi 11 Circle 
indicmes 
selected 
color. 

Brightness 
control 

\X'hccl shows colors or gra~·s a1·ailable. 
(\X'hcn four colors or grars arc 
selected, leuers appear in the " ·heel 
indicating color values.) 

cnulimws ~ 
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2. To change the brightness of the color wheel, drag the 
scroll box up or down. 

3. Click a color on the color wheel to select it. 

The new color is displa~'ecl in rhe rop half of rhe color square 
ir your monitor is set to display 16 or more colors or grays. 
The currem color remains in the bottom half of the square for 
comparison; you can cl ick rhere 10 go back to it. 

4. To experiment with other colors or shades, drag the 
pointer around the wheel or click at another point on 
the wheel. 

The ne\v color is displayed in rhe upper half of rhe color 
square as you drag or click. 

;. Click OK when you have selected the color you want. 

The dialog box closes. The new highlight color is displayed in 
the "Sample te.\1 .. box in the Color comrol panel. 

The highlight color you specified takes effect immediately and 
remains in effecr unril you cha nge ir. 
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Changing the color of windows 
If your ~lacinrosh displays colors or shades of gray, you can 
change rhe color of winclm,· borders. You make this adjustmem in 
the Color control panel (choose Control Panels from the Apple 
menu and open the Color control panel). 

Co lot· 

[;0 Color 

ll ighllghl co lor: ~Pop-up menu of choices 
l!:'tiiMffliMI ~ I for highlight color 

Windouo en lor. I D Standard ... ~ Pop-up menu of riloir<:~ 
for window color 

You can also use rhe Color cunrrol panel ro change rhe color your 
!vlacinrosh uses to highlight selecred rexr on the screen (go ro 
·'Changing the Highlight Color" in this chapter). 

To change the color of window borders, press the pop-up menu 
labclccl "\'\Iindo\\' color'' to open ir and rhcn clr::~g 10 choose a new 
color. 

The color you choose rakes effect immediarcl~· and rem;~ ins in 
effect unril you change it. 



Displaying colors or grays 
If your ;\·lacinrosh clispla~·s colors or shades of gray. you can 
designate the number of colors or shades of gr:l\· vou 11·anr 
displayed. (Hm1· man~· colors or shades your ;\lacinrosh can 
clisplar depends on the video capabilin· it has. See the setup book 
that came with mur ~ lacintosh and the instructions that came 
11·ith your monitor for more information.) 

You set the number of colors or grays in the :Vlonitors conrrol 
panel (choose Conrrol Panels from the Apple menu and open the 
Monitors control panel). 

~o. 

H 
~ 

t-·1o n i teo t·::: 

Monitors 
Chara.:;t~nsties of ult<.te-d morutor · @Gray.,DI 
0CoJo•·s: ~ (options ... : 

Dr~ momtor-s. and nwnu bw to reo¥r~nq~ the-m. 

~ 
I ( Identify : 

You also usc the Monitors cont rol panel to contlgure vour 
monitors if you have more than one (go to ··conOguring Multiple 
.\lnnirors ... the next sen ion in this chapter) . 

1. If you have more than one monitor, click the icon of 
the monitor whose colors you want to adjust. 

A dark border appears around the icon to sh011· that it is 
selected. 

2. Click the Grays or the Colors button. 

Some moniwrs can displa~' only shades or gray, even if you 
click the Colors button. 

3. Click the number of colors or shades of gray you want 
displayed on the selected monitor (or click Black & 
White). 

Your changes rake effect immediately. The number of colors or 
shades of gray ~~ou spcciOcd remains in cffccr unril you change iL 

·:· (/)•ozn· Jlacintosh bas bni/t-in/1/onitor support (you cl icln't 
have to inst::rll ::r video card in ~-our Macintosh before you 
could connecr a moniwr), increasing the number of colors or 
grays you wam displayed increases the amount of memory 
rour .\lacintosh uses for its Yideo display and decreases the 
amount of mcmorv available to run your programs. Your 
programs· performance may suffer as a result. If you IYant to 
change the amount of mcmon· set aside for video, click the 
Options button in the ,\lonitors control panel and click the 
appropriate buttons in the dialog box that appears. ·:· 
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Configuring multiple monitors 
If you use more than one monitor \rith your Macimosh. you need 
to indicate the monitors' positions and designate one as the main 
monitor (the one that displays the menu bar). 

You make these acljusunems in the Monitors comrol panel 
(choose Control Panels from the Apple menu and open the 
Monitors conrrol panel). 

[g . 
<:::::::0:= 

Monitors 

I Monitors 
Char".c:t•ris1ic-s of nltcttd monttef" . 

Clicking Options opens a dialog 
box that lists the type of video 
card lO which the selected 
monitor is ronnencd. 

@o.....,. :~ 
oeo .... .,U 1opuons ... 

Dr~ mon1tors .,cj r1'ltrn bit' to r••rii'IQf thtm Drag the tinr white menu bar to 
the monitor you ''"anr to display 

___ r .:; ...... -...... ,...1 11 the menu bar_ 

~T'l~~W"J:;:t:q II The clark line around a monitor icon 
' indicates that it is selected. 

Colors in this box 
correspond 10 the 
number of colors 
the selected 
monitor is set to 
db play. 

Clicking Idemify displays each 
monitor's lD number on its screen. 

Icons for the monitors 
connected to the ~tacintosh, 
sho11 ing 1 heir ID numbers and 
their relative posit inns 
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You also use the Monitors control panel to set the number of 
colors or shades of gray you \Yant displayed (go ro .. Displaying 
Colors or Grays'' in this chapter). 

1. Check the 10 numbers of your monitors by clicking the 
Identify button. 

A large number appears in the center of each monitor 's 
screen; it corresponds to the number of the icon in the 
control panel. 

The ID numbers help you iclenti~' which icon belongs to 
which monitor. 

2. Decide which monitor is your main monitor and drag 
the menu bar to the top of that monitor icon. 

The menu bar snaps to the top of that monitor icon when you 
release the mouse button. 

If one of your monitors displays colors or shades of gray, you 
may want to make it the main monitor so you can use the 
color capabilities of your programs and of the Finder. 

If your monitors are different sizes, you may want to make the 
largest one the main monitor because some programs limit 
their window size to the size of the main monitor. 



3. Drag the icons of the other monitors to their positions 
relative to the main monitor. 

'H> avoid becoming disoriented when you're using the 
monitors, position the monitor icons so that they correspond 
to their acrual positions on your desk. 

The pointer can cross from one screen to another where the 
monitors· icons touch in the control panel. 

4. Choose Restart from the Special menu. 

The positions you specified remain in effect until you change 
them and restan your computer. 

Adjusting screen brightness 
Most Macintosh models have brighrness and contrast dials on the 
monitor or a brightness dial on rhe computer itself. See the setup 
book that came with your computer or the instructions that came 
with vour monitor for more information. 

Brightness 
control 

Conrrasr control 

A few models do not have brightness and contrast dials. I f your 
Macintosh does not have such dials, you adjust screen brightness 
in the Brightness control panel (choose Control Panels from the 
Apple menu and open the Brightness control panel). 

~ 
Brightness 

To adjust screen brightness in the Brightness control panel, drag 
the slider control to the left or the right. 

·:· 'flp: lf an image is left on the screen for several hours or 
more, it may begin to "burn in" and damage the screen. You 
can use "screen saver" programs, available from various 
sources, to dim the screen automatical ly or display a moving 
image after a set period of inactivity. ·:· 
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Magnifying the 
• screen Image 

The CloseView control panel lets you magnify 
the image on your Macintosh screen up to 
sixteen times. It is supplied on one of the 
Macintosh system softvvare disks. 

CloseView is not automatically installed by 
the Installer program when you install systen1 
software. 
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To install CloseView: 

1. Locate the CloseView control panel. 

~ 
~ 

CloseView 

2. Drag the Close View icon to the 
System Folder icon (not the System 
Folder window) on your startup 
disk. 

3. Choose Restart from the Special 
menu. 

To turn CloseView on or off, press 
~-Option-0. 



To turn the magnification on or off, press 
~-Option-X. (When CloseView is on and 
the magnification is off, a rectangle on the 
screen indicates which area will be n1agnified. 
You can move the rectangle by moving the 
pointer.) 

To increase or decrease magnification, press 
~-Option-Up Arrow or ~-Option-Down 
Arrow. 

You can set additional options in the 
CloseView control panel (choose Control 
Panels from the Apple menu and open the 
CloseView control panel): 

0 CloseUiew 

Cl~e 
Vie'¥ 
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@ Black on \•/hite 

0 \'/hite on Black 
-
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Keyboard @ on 
Shortcuts QOff 
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r · ···~·· ····;;;·· 

~ ....................... .'?.'P..~.i'?.~·.·.·.·.] 

© 1988- 199 er, Inc. Apple Compu 
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screen shortcuts 
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~ ~~0 @Off 
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. .......................... 

.. ~.~r.~ r.~~.~~ .... ] 
developed by 
Systems , Inc. 

Arrows cha g 
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ClostYiew 
on or off 

Turns 
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on or off 

Keyboard 
shortcurs 
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Turning off the Empty Trash warning 
When you choose Empty Trash from the Special menu, a dialog 
box appears warning you that you will nOL be able to recover the 
contents of the Trash once it's emptied. (The warning helps you 
avoid throwing away items unintentionally.) 

You can turn off this warning in the Trash's Info box. 

1. Click the Trash icon to select it. 

2. Choose Get Info from the File menu. 

3. Click the checkbox labeled "Warn before emptying" to 
remove the X. 

To turn the warning back on, click the checkbox so that an X 
appears. 

You can also override the Empty Trash warning when it is on by 
holding down the Option key when you choose the Empty Trash 
command. 

Unril you choose the Em pry Trash command, items in the Trash 
continue to occupy space on your disk. 
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Managing memory 
Occasionally you may need to make adjustments in how your 
Macintosh uses its random-access memory (RAM) in order to 

work efficiently with large programs or with several programs 
at once. 

Checking memory use 

You can find out how much memory your Macintosh has, how 
much of it is nor being used, and how much memory is being 
used by each program you have open. You find this information 
by making the Finder the active program and choosing About This 
Macintosh from the Apple menu. 

About This Macintosh PJ; 

svst.m sonw..ro7.0 
I --I Hadatuh llf" ~API' I< Comport..-' lno. ' 963- ' 991 

Tot.t HflnonJ : S,tz..r:Ji' Lar9~st UaasH Blodc: : 3,519K 

Tmal memory 
in this 
Macinrosh -e So;sttm Soft, .... ·~ 

~ TuchTtxt - 19~ 

- .. 
1grarns Memory 

currently allocated for 
open each program 

-=:J 

~ 

-(} 

'21 

ow much memory a 
program reserves for its own usc. The dark 
porrion is the amount it is actually using. 

Your Macintosh must have at least2 megabytes (MB), or 
2048 kilobytes (K), of RA.t'vl to use System 7. 



You can adjust how much memory a program sets aside for itself 
when you open it. For instructions, go to "Setting Up Your 
Programs" in Chapter 8. 

Tips for using memory efficiently 

With System 7 you can have two or more programs open ar the 
same rime, bur only one program can be active at a rime. Closing 
a window does not quit the active jJro[!,ram or free much 
memory. You must choose Quit from the f ile menu to quit the 
program and make more memory available. 

If there is nor enough memory available to open a new program, 
the Macintosh prompts you to quit other programs. The 
Application menu at the top-right corner of the screen shows you 
which programs arc open. 

rq 
Hide Finder 
Hide Others 
Show fill 

../ 1£1 Finder 
~TeachTeHt 

If you have opened and closed several programs. your computer's 
memory can become fragmented so that you can't open a large 
program. You can solve this problem bv quiuing all open 
programs and restarting the computer. 

If you do nor use any local area network services, such as an 
elcmonic mail program, a file server, or a shared printer, you can 
make more memory (about 1 OOK) available by turning off 
Apple'lalk in the Chooser. Select Chooser from the Apple menu, 
click the Inactive bunon ar the lower right, close the Chooser, and 
then choose Res tan from the Special menu. 'lo turn AppleTalk 
back on later, click the Active button, close the Chooser, and then 
choose l{estarr from the Special menu. If your printer is 
connected directly to your computer's printer port, you need to 
reselect the primer in the Chooser every time you turn AppleTalk 
off, and again when you turn it back on. 

I f you aren't using fi le sharing, you can make more memory 
available by turning off this feature. To turn off file sharing, open 
the Sharing Setup control panel. (Choose Control Panels from the 
Apple menu, then open the Sharing Setup icon.) In the File 
Sharing section of the control panel, cl ick Srop. A message 
appears asking how many minutes the computer should wait unti l 
file sharing is turned off. Type a number and then click OK. 

If your System Folder contains system extensions you don't need, 
you can make more memory available by removing them. For 
instance, if your Macintosh won't be connected to a host database, 
you can remove the DAI. (Data Access Language) extension. 
Likewise, if your Macintosh won't be connected to a network , you 
can remove the AppleShare exrension. 'lo remove a system 
extension, drag its icon out of both the Extensions folder and the 
System folder to another location on your hard disk. Then choose 
Restart from the Special menu. 
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Adjusting the disk cache 

The disk cache is memory ser aside lO help programs work more 
quickly and efficienrly. The memory in the disk cache is nm 
a,·ailable for opening more programs or documents, so rhe size of 
rhe disk cache affem how many files you can have open ar rhe 
same time. 

The preser and maximum sizes of rhe disk cache depend on rhe 
amounr of memory your Macintosh has. If you often wanr ro open 
more programs rhan memory allows, set rhe disk cache to a 
smaller size- such as 32K or 64K. 

You ser rhe size of rhe disk cache in the ~!emory control panel 
(choose Control Panels from the Apple menu and open the 
Memory control panel). 

~ 
Mf?mory 
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To ser rhe size of the disk cache, click the up or down arrow nexr 
ro rhe Cache Size box. The new size takes effect after you choose 
Restart from rhe Special menu. 
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Depending on your Macintosh model, you also use the Memory 
control ranel to adjust how virtual memory is used and to turn 
32-bir addressing on or off (see "Using Hard Disk Space as 
Memory" and "Turning On 32-bir Addressing" in rhis chapter). 



Using hard disk space as memory 

Some Macintosh models can use space on a hard disk to increase 
the computer's memory. The disk space, called virtual mem01y. 
is not available for storing information \vhen it is being used for 
this purpose. 

Your Macintosh should contain enough built-in memory for your 
regular needs-that is, for the programs you frequently have open 
simultaneously. You can use virrualmemory when you want ro 
open aclditional programs or to work with extremely large 
documents that can't be opened while using only the built-in 
memory. 

Virtual memory is more effective when you are using several small 
programs simultaneously. lr is less effective when using one very 
large program. 

I f your Macintosh can usc virtual memory, you can adjust irs usc 
of virtua l memory in the Memory conrrol panel (choose Control 
Panels from the Apple menu and open the Memory control 
panel). 
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You also use the ~ I emory control panel to adjust the size of the 
disk cache and (depending on your !'vlacinrosh model) to turn 
32-hit addressing on or off (see '~djusting the Disk Cache" and 
··Turning On 32-bit Addressing" in this chapter). 

1. Click the On button to turn on virtual memory. 

The SeleCL llard Disk pop-up menu becomes active (black) 
when you click On. 

2. Press the pop-up menu to open it and drag to choose 
the hard disk on which space will be allocated for 
virtual memory. 

3. Click the up and down arrows to adjust the amount of 
disk space to be used as virtual memory. 

The Memory control panel is preset to allot the same amount 
of vinual memory as the amount of RAJ\ l installed in your 
~lacinrosh. Choosing a larger amount of rinual memory is 
likely to slo\\' the computer's performance. 

It is recommended that you accept the preset size. The 
numbers for 'Available on disk" and "After restart" change as 
you adjust the amount of disk space. 

4. Choose Restart from the Special menu. 

After you restart, your computer's total memory (as indicated in 
the windo'i\· that appears when you choose About This Macintosh 
from the Apple menu) includes the virtual memory you set aside 
on the hard disk. 
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~ Important: \Xil1en you turn on virrual memory, the system 
software creates a file named VM Storage in your System 
Folder (if the startup disk is used for virtual memory) or on 
the desktop (if anmher hard disk is used for virtual memory) . 
This file is large-the size of the computer's RAM and the 
designated amount of virtual memory combined. f or 
example, if your Macintosh has 4 MB of RA.!'vl and you add 
2 MI3 of virrual memory, the VM Storage file will occupy 
6MB of space on your stanup disk. 6 

Turning on 32-bit addressing 
Some ~ lacintosh models can use very large amounts of memory 
(more than 8 megabytes) by taking advantage of a feature called 
32-bit addressing- the use of very long (32-digit) binary numbers 
to comrol the way data is manipulated. 

If your ~lacinrosh can use 32-bit addressing, you can turn the 
feature on or off in the t\lemory control panel (choose Control 
Panels from the Apple menu and open the Memory control 
panel) . 

To turn 32-bir addressing on or off, click the appropriate buttons 
in the control panel, then choose Restart from the Special menu. 

[£] 
Memory 



io 

g} 

@) 

DU1c c..ho 
Alw>oJs On 

Yrtu.l f1tmor1j 

QOn 
@orr 

"--~---·--~-

~ 
32-Bit Addttuin9 

Oan 
@ Off 

Memory 

c..ho Sit• !illD[ID 
S.ltct H>rd DISlc 

1\Yi llitltt on dtsk : 16M 
Avalbbt. bunt-tn rn.tmonJ · 16M When rou turn on 

32-bit itddressing, 
a ~tat u~ message 

32-btt 6ddrm ts on appears here. 
(wm bt off .afttr r'tStlft) 

---------- Ptr otnt of a'fafiKI·~ mtrfiOI"\I 

RAM Disk 

~ ~~( 
to ust (or- I RAM dtsk : 

~ ~ 
0\11 5000 10000 

RAM Disks~. !3360K I 

( Use Defaults ] 

You also use the Memory comrol panel to adjust the size of the 
disk cache and (depending on your Macintosh model) lO set aside 
hard disk space for use as memory (see '1\.djusting the Disk 
Cache'' and "Using Hard Disk Space as Memory" in this chapter). 

Using a RAM disk 
The Macintosh includes sofrware for a RAJ\1 disk, a portion of 
random-access memory that you set aside for use as a temporary 
storage device. Using a RANI disk is faster and more energy­
efficient rhan using a hard disk or floppy disk, panicularly for 
very large documents or complex operations. 

Memory assigned to a RAM disk is not available for opening 
programs, so it may nor be practical to create or use a RAM disk 
when you are using many programs unless you have expanded 
the memory in your Macimosh. 

It's a good idea to observe a few precautions if you use a RAM 
disk: 

• Before using a program on a RAl\11 disk, rest the program on 
your hard disk or a floppy disk to make sure that it works 
properly with your computer. 

• Don't store your only copy of a file on a RAM disk. Keep an 
extra copy on your hard disk or a floppy disk. 
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Creating a RAM disk 
1. Open the Memory control panel and click On in the 

RAM Disk section . 

The Memory control panel is in the Control Panels folder in 
the Apple menu. 

2. Drag the slider to choose the percentage of available 
memory you want to use for your RAM disk. 

~ 
RAMD!<Ic 

@ On 
Ooff 

Ptr,tnt of '"'"l.bl+ mtmOnJ 
to U$.fto tor .a RAM d1st · 

ld[t.:... ... 
0\11 SOlO 100$ 

RAM Disk S lu 13360!< I 

The size of the Rfu\1 disk you selecr appears in the RAJ\ I Disk 
Size box. 

3. Close the control panel. 

4. Choose Restart from the Special menu. 

A RAM disk icon appears on the desktop when the computer 
restarts. 
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Erasing a RAM disk 

There arc two ways w erase the comenrs of a RAM disk. They do 
nm remove the RA.\1 disk itself or make more memory a,·ailahle 
for opening programs. 

• Select the RAM disk icon and choose Erase Disk from 
the Special menu. 

• Drag everything on the RAM disk to the Trash and 
choose Empty Trash from the Special menu. 

Resizing or removing a RAM disk 

1. Copy any programs or documents that you want to save 
onto the internal hard disk or a floppy disk. 

To resize or remove a RAM disk, you must remove the items 
on it. 

2. Drag everything in the RAM disk to the Trash and 
choose Empty Trash from the Special menu. 

3. Open the Memory control panel. 

'Jb resize the RAlvl disk, drag the sl ider LO choose a new 
percentage. To remove the RAlvi disk, click OFF in the RAM 
disk section. 

4. Close the control panel, then restart the computer. 

l f you resized the Rfu\•1 disk, a new RAM disk icon appears on 
the desktop when the computer rcstall S. If you removed the 
RAM disk, no icon appears. 



Chapter 12 

Printing 
In this chapter 

• Before you print 

Choosing a primer 

Selecting Page Setup options 

Updating printer drivers on networked computers 

• Priming your work 

Priming rhc conrenrs of a windmv 

If rhe primer doesn't prinr your document 

• Printing while using rhe computer for other work 

• \\forking with fonrs 

Outline fonrs and birmapped fonrs 

Installing fonrs 

Removing fonrs 

Transferri ng fonts ro a laserWrirer primer 

Finding our about available foms 

Using the LaserWriter Fonr Utility 

Before you print 
Before vou can print , your Macintosh musr be connecrecltu a 
primer, either directly or over a network. See the insrrucrions rhar 
came \"\'ith your primer if you need information about connecting 
it ro your computer. 

Then, vou must rell your lvlacinrosh ~·hich primer ro usc by 
cboosing the primer. 

Choosing a printer 

You rell rhe Macinrosh which printer rouse by choosing rhe 
printer in a program called the Chooser. You don't need to choose 
a printer every rime you print. You need ro choose one on I)' when 
you're using a printer for the first rime and whenever ~'OU cleciclc 
ro change primers. 

Ilo~· vou usc rhe Chooser depends on ~·hcrher your Macintosh is 
connected directly ro the printer or connected to a net\\·ork. 
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If your printer is not on a network 

Make sure tim you've connected the printer according to the 
instructions that came with it and that you know which port you 
used (on the back of the computer) to connect the printer. 

1. Choose the Chooser from the Apple menu. 

The Chooser window appears. 

2. Click the icon of the printer you want to use. Make sure 
the icon is selected (highlighted). 

:0 Chooser 

~ ~l ~ 
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·:· Ifyour printer's icon does not appear in the Chooser; then 
the appropriate printer driver- the program that 
communicates with, or "drives," the printer-has not been 
installed in your System Folder. Close the Chooser and install 
the driver you need. You can use the Customize option in the 
Installer program (see Chapter 8, "Setting Up Your Macintosh 
System"), or you can install the driver directly by dragging its 
icon imo the System Folder. If your printer is not an Apple 
printer, review the instructions that came with it for 
information on installing irs driver. ·:· 

If you have a Personal LaserWriter SC, close the Chooser window 
after you click the Personal LaserWriter SC icon. 

3. Click the icon representing the port that you used to 
connect the printer. Make sure the icon is selected. 

You have only two choices: the printer port or the modem 
port. Click the icon that matches the icon of the port (on the 
back of the computer) to which you connected the printer 
cable. 

4. Click the Inactive button next to the word ''AppleTalk." 

If the Inactive wasn't already selected, a dialog box appears. 
Click OK. 

5. Close the Chooser window. 



If your printer is on a network 

Find our from your network administrator (or the person who set 
up your computer) which printer you can use, which zone it's in 
(if your network has zones), and what its name is (every printer 
on a network has its own name). 

1. Choose the Chooser from the Apple menu. 

The Chooser window appears. 

2. Click the Active button next to the word ''AppleTalk." 

If Active wasn't already selected, a dialog box appears. 
Click OK. 

'1\rpcs of devices available ~ames of individual printers 
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including network printers. 

3. Click the icon representing the type of printer you want 
to use. 

You may have to click the up and down scroll arrows to find 
the icon. 

·:· Ifyour printer 's icon does not appear in the Cboose1; then 
the appropriate printer driver- the program that 
communicates with, or "drives," the printer- has not been 
installed in your System Folder. Close the Chooser and install 
the driver you need. You can use the Customize option in the 
Installer program (sec Chapter 8, "Setting Up Your Macintosh 
System"), or you can install the driver directly by dragging its 
icon into the System Folder. (If you install the LaserWriter 
driver, be sure to install the PrintMoniror program also.) If 
your primer is not an Apple primer, review the instructions 
that came with it for information on installing its driver. ·:· 

4. If you see a list of AppleTalk zones, click the zone 
where the printer is located. 

You may have to click the up and clown scroll arrows to find 
the zone. The zones arc listed alphabetically. 

;. Click the name of the printer you want to use, even if 
it's the only one that appears. 

COIIIilllleS ~ 
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6. If you want to be able to use your Macintosh for other 
work while it's printing documents, click the On 
button next to Background Printing. 

The background priming option is available only if both the 
PrintMoniwr program and the LaserWriter driver have been 
installed in your System Folder. (See "Priming \X~1ilc Using Lhe 
Computer for Other Work" in Lhis chapter for in formation 
about using PrintMonitor.) 

7. Close the Chooser. 

Selecting Page Setup options 

You use the Page Setup dialog box when you've selected a new 
printer in the Chooser or when you want to use a different paper 
size or printing option. 

• Choose Page Setup from the File menu and select the options 
you want. 

164 Chapter 12: Printing 

When a LaserWrirer primer is chosen, this Page Setup dialog 
box appears: 

Pop-up menu of special paper sizes 

LaserWriter Page Setup T (OD) 
Paper: ®us Letter 0 A4 Letter 

0 US Legal 0 85 Letter 0 r Tabloid .,.. l [ Cancel ) 
- . 

Reduce or lllil!ll% Pnnter Effects: 
_ [nlarge: 181 Font Substitution? 

I Options ] 

Orientation 12?J TeHt Smoothing? 

Ul~ 
I2?J Graphics smoothing? 
181 Faster Dltmop Printing? 

g u1eup n I. 
percentage of original opens a dialog box for 

selecting enhancements 
to the printed image. 

When an ImageWriter printer is chosen, this Page Setup dialog 
box appears: 

l mogeWrller [QD) 
Paper: ® us Letter 0 A4 Letter 

0 US Legol 0 lnterno tionol Fanfold (Cancel ) 
0 Computer Paper 

Orientation 

-~ 
Special Effects: D Tall Adj ust ed 

0 50 '7o Reduction 
0 No Gops Between Pages 



You can choose Show Balloons from the Help menu to get 
descriptions of the enhancemenrs provided in rhe Options dialog 
box, or check your printer's manual for details. 

You'll see different options for each rype of prinrer you use. Some 
programs provide additional options. Options you set in rhe Page 
Setup dialog box remain in effect until you change them. 

Updating plinter dlivers on networked computers 

All computers on a network that share one or more primers must 
have the same version of the primer driver software that 
communicates with (or "drives") the printers. When someone on 
the network sends a document to the primer using a version of 
the printer driver that 's differenr from the last version the printer 
recognized, the printer restarts itself (which takes rime and clears 
any fonts from its temporary memory). 

~ Important: All computers on a net\vork must have the same 
version of printer drivers in their System Folders. ~ 

If your Macintosh is parr of a network, you or your network 
adminisrrawr should update the primer drivers on any Macintosh 
computers on your network that are running any system sofrware 
version earlier than version 7.0. You do not have ro update other 
components of the system software; version 7.0 printer drivers 
work with earlier versions of the system software. 

To update printer driver software, you use the Installer program 
and the accompanying Printer Update document (both files are 
on one of the system software disks that came with your 
computer). 

/!> 
~·· 

Installer 

[1J 
Print.er Update 

You can srore these flies on a file server or a shared disk on the 
network and install the update from there. 

1. Locate the Installer and Printer Update files (supplied 
on one ofthe system software disks), and then open 
the Installer icon. 

A dialog box appears, showing the printer driver icons and 
explaining your installation options. 

continues ..,. 
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2. Click OK. 

The Easy Install dialog box appears. 

Drivers to be updated 

E11sy lnst11ll 
r- I 
j Cl clc Install to update to Uersion 7.0 of ! 
i • Any EHistlng Printing Sortwore I 
I l I R Install D I 
1 on the hard disk named I 
L= Hord disk #2 -----·-- _j 

( (je< t l}(sk J 

( Switch Oisk J 

--------·----
( Customize ] 

( Help ) ( Quit ) 

[ p 

3. Make sure that the hard disk indicated in the box is the 
one you want to update the printer drivers on. If a 
different disk name appears, click the Switch Disk 
button until the correct disk name appears. 

166 Chapter 12: P1iming 

4. If you want to install different printer drivers in 
addition to those already on your disk, click the 
Customize button, then click the names of the drivers 
you want to install. 

If you wam Lo updaLe only the drivers that are already 
installed on your disk, go to step 5. 

When you click Customize, the custom installation dialog box 
appears, showing a list of the plimer drivers available. Press 
the Shift key while you click if you want to select more than 
one primer driver. 

Printer drivers available 

Click the Items you wont to select; 
Shirt-click to select multiple Items. 

Softwore for LoserWrlter p! ( ltlst.111 ) 
~oftware for Personal l aserWriter SC 

= H11rd disk # 2 
0 

[ £ject tli~k ) 

[ Switch Disk ) 

-----
[ E11sy lnst1111 ) 

( Quit l 



5. Click Install. 

6. Click Quit when you see a dialog box reporting that 
installation was successful. 

If a dialog box reports that installation was not successful, try 
the update again. 

Printing your work 
The most common way to print a document is while it's open and 
while its window is the active window. You can also prim 
documents while the Finder is the active program. 

1. Make sure that the document you want to print is in 
the active window. 

·:· If you're printing from tbe Finder, click the icon of the 
document you want to print (or cl ick several document icons 
while holding down the Shift key) . ·:· 

2. Choose Print from the File menu, or press ~-P. 

A dialog box appears, in which you can set printing options. 
The options vary depending on the printer you have chosen 
and the program in which the document was created. 

If a Laser\Xfriter printer is chosen in the Chooser, this dialog 
box appears: 

Paper-feed Number 
method of copies 

Page range (clicking All prinrs the enrire 
document; entering page numbers in the 
,From and 1o boxes prints those pages only) 

laserWrlt r "laserWrlter" n Print D 
copies:. P11ges: <• Rll 0 From: D To: D [ Cancel J 
Couer Page: @No 0 First Pnge 0 Las t Page 

Paper Source:@ P11per C11sselle 0 Manual Feed 

Print: @ Black & White 0 Color/ Grayscale 

Des tination: @Printer 0 PostScrlpt6l File 

·:· Printing color or gray-scale documents. You can print color 
or gray-scale clocumen1s on any color prin ter that can use the 
Laser\Xfriter driver. If you print a color document on a printer 
that prints only in black and white, the document will be 
produced in a halfmne format; that is, it will be composed of 
parterns of clots. ·:· 

Some programs offer additional printing options, such as the 
order in which a document"s pages are printed. See the 
manuals rim came with your programs for more information 
on their printing features. 

3. Click the Print button in the upper-right corner. 

After a moment, a status box appears. If background printing 
is turned on in the Chooser, the status box disappears after a 
few seconds, and you can do other work while printing 
continues. 
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Printing the contents of a window 

You can piint the contenLc; of the active window when you're 
working in the Finder. 

1. Make sure that the window whose contents you want to 
print is the active window. 

2. Choose Print Wmdow from the File menu. 

A dialog box appears. 

3. Select the options you want. 

4. Click the Print button. 

The window's contents are printed in the format currently 
displayed, including items nor visible on the screen. 

When no window is active, you can print rhe contents of the 
MacinLOsh desktop by choosing Print Desktop from the File 
menu. 
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If the printer doesn't print your document 

The Print command isn't reaching the p1inter, the primer is 
geuing conflicting signals, or the printer isn't working properly. 

• Check that the primer is turned on and warmed up (i f it 's a 
LaserWriter, it should have printed a sample page). 

• Check the cable connections to the primer. 

• If your printer is an ImageWlritet~ make sure tim the Select 
light is on. (Press the Select button to turn the light on.) A 
dialog box on the screen may inform you that the primer is 
not responding. 

• Check that the printer (and its name, if it's a LaserWrirer) is 
selected in the Chooser. 

• Make sure that you are using the same version of the printer 
driver as all other people on your network. 

• If an error message stares that the primer could not prim your 
document, turn off the primer for at least 10 seconds, then 
turn it on again and wait for the primer to warm up before 
trying to print again. 



Tips for improving printing 

There may be times when your Macimosh does not have enough 
memory available to prim a documem properly. If this happens, 
the primed output may not look correct. 13itmapped fonts may be 
substituted for True'l),pe fonts, or characters or lines may be 
missing. To l1x this problem, try the follo\ving: 

• Immediately after you select the Print command, quit the 
application program from which you're printing. (Save your 
work, choose Print from the File menu, click Print in the 
dialog box that appears, and quit the program.) 'lo make more 
memory available, you need ro rake these steps before 
printing begins, and you shouldn't open a program again until 
printing is finished. You must be printing in the background 
to do this. (See "Printing Wh ile Using the Computer for Other 
Work" fur more information about background printing.) 

• If possible, simplify the design of your document by using 
fewer type styles or sizes. Simpler documents require less 
memory to print. 

You may also notice that programs rhat can print several views of 
the same document (such as some presentation programs) 
display the same Prim dialog box more than once while priming. 
If you reselect the same options each rime the dialog box appears. 
printing will proceed normally. 

Printing while using the computer 
for other work 
You can use your Macintosh for other work while you're printing 
on a LaserWriter primer if the background priming option is 
turned on in the Chooser. (See "Choosing a Primer" in this 
chapter for information about turning on background printing.) 

You can control background printing with Prinu'vlonitor, a program 
that's installed automatically when you install system software 
using the Installer program's Easy Install option. 

continues .,... 
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1. Mter you have started printing a document, choose 
PrintMonitor from the Application menu. 

When background printing begins, PrinrMonitor opens 
automatically and its name appears in the Application menu at 
the right end of the menu bar. 

When you choose its name from the Application menu, the 
PrintMonitor window appears. 

Name of the document being ptinted 
and primer currently in use 

Docu mems to be 
printed next (a 
selected item can 
be removed from 

IlL! 1 the list) 

Clicking this 

~~~~~~Qt(~~~~~s~'"'~~~- button lets you --{ Cllntel Printing ) I Set Print Time... ) set the print time. 

Clicking this button cancels 
the current printing job. 
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--+-- Description and 
status of t.he 
current job 
appear here. 

You can use PrintMonitor to 

• monitor the status of printing 

• cancel a document currently printing or waiting to print 

• set the time you want a document to print (date and 
hour) or postpone a job indefinitely 

• monitor paper supply (PrintMonitor's icon blinks at the 
right end of the menu bar when the printer is out of 
paper; you can change the notification method with the 
program's Preferences command in the File menu.) 

• signal when to feed paper manually (PrintMonitor's icon 
blinks at the right end of the menu bar to signal that you 
must confirm the manual operation; you can change this 
notification with the program's Preferences command in 
the File menu.) 

2. Select the options you want, and then click the close 
box. 



Working with fonts 
A font is a collection of letters, numbers, and symbols in a 
distinctive typographic design. 

When you install Macintosh system software, several fonts are 
installed in the Fonts folder, which is in the System Folder on your 
stanup disk. You can install additional foms and remove fonrs. 

Additional fonts arc supplied on one of the system software disks. 
Fonts are also available from independent manufacturers, user 
groups, and computer bulletin board services. 

Outline fonts and bitmapped fonts 
Your Macintosh uses two types of fonts : 

• omline fonts 

• bitmapped fonts 

Both types of fonts are installed in the Fonts folder in the System 
Folder of your startup disk when you install system sofnvare. 

Outline fonts (also called scalable or variable-size fonts) describe 
each letter, number, or symbol as a mathematical formula that 
defines the character's shape and adjusts itself to make the 
character's size larger or smaller. Your Macintosh, therefore, needs 
only a single outline font in a panicular typeface (such as Times) 
to be able to print or display that typeface in different sizes. 

The outline fonts supplied with Macintosh system software are 
called 1i·ueType foms. 

~ 
CoUt·iet· 

·:· V?ben your Jl!lacintosb is running S)!stem 6, you cannot use 
TrucType foms supplied with System 7. ·:· 

continues ..,.. 
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13itmapped fonts (also called flxed-size fonts), on the other hand, 
describe each character as a grid of black and white dots (called a 
bit map), which is a rendering of the character's shape in a 
specific size. 

Your Macintosh needs a separate bitmapped font of a typeface in 
each size it prints or displays, such as 12-point Times® or 10-poinr 
I Ielvetica@J. 

~ 
Monaco 9 

An Oll[linc font character is like a cookie recipe that you can use 
w make as big or as small a batch of cookies as you need. A 
bitmapped font characrer is like a cookie cutter: it gives you one 
size-that's all. 

For information on how the system software finds rhe fonts it 
needs, sec "Getting the Best-Looking Fonts" in Chapter 16, "Tips 
and Troubleshooting." 
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Installing fonts 

To install a font: 

1. Quit all programs that are open. 

Pull down the Application menu to make sure that the Finder 
is rhe only open program. Choose any other open program 
from the Application menu and then choose Quit from the 
File menu. 

2. Locate the icon of the font you want to install and drag 
it to the System Folder icon (not the System Folder 
window) on your startup disk. 

You can click multiple font icons while holding down the Shift 
key to select more than one icon. 

A dialog box appears, lening you know that the fonts will be 
stored in the Forl[S folder, where they belong. 

3. Click OK. 

Removing fonts 

'lo remove a fom: 

1. Open the System Folder on your startup disk. 

2. Locate the Fonts folder and open it. 

3. Locate the icon of the font you want to remove and 
drag it out of the Fonts window and out of the System 
Folder window. 

4. Close the Fonts window and the System Folder window. 



Transferring fonts to a LaserWriter printer 

If you're using a Laser\Xfriter printer that's equipped r.o handle 
PostScript("> and you want to print using PostScript outl ine fonts 
that are nor built into your printet; you can transfer, or download, 
outline fonts from your System Folder to the printer. (PostSrript is 
a programming language that describes the characters, symbols, 
and images appearing on each page of a document.) 
Downloading foms saves you printing time if you plan to print a 
batch of documents that use those fonts. 

When you download a font, it's stored in the printer's memory or 
on a hard disk anached to the p1inter. You can download as many 
outline fonts as the primer's memory and hard disk space allow. 

You download a font using the Laser\Xfriter Font Uti lity, which is 
supplied on the system software disks. 

1. Locate and open the LaserWriter Font Utility icon. 

~ 
Laser'w'riter Font Utilit y 

2. Choose Download Fonts from the File menu. 

A dialog box appears. 

Download to 
® Printer 
0 l'rintN's di~kh) 

Fonts to download: 
cour ier IQ 
Cour ier-Bold 
Cour ier- BoldDbl ique 
C<tur ier -Oblique 
Helue t lco 
Heluetico-Bold _ 

lo 
,----{ Rd ll ... [ lll!move ) 

---- . --------
0~ ~ Download J) 

lr ,g tillS bull on clisptays a ct1 recrory etta tog 
box for locating and selecting additional fonts. 

Foms currently 
available for 
clown loading 

Clicking this 
huuon removes 
any foms sclcctecl 
in the list. 

Clicking this 
buuon downloads 
all foms listed to 
the primer. 

3. If the font you want to download is not listed, click the 
Add button to add fonts to the list. 

A directory dialog box appears, which you use ro locate the 
fonts you want. 

cominues ..,. 
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4. Click the name of the font you want, then click Add. 

You can press the Shift key while you click to select more than 
one fonr. 

le~ Condensed Garamond ..,.I 
•• rF.TV:o1 1 GaramBollta 
D Garamug 
D Garamliglta 
CJ GC Printer Fonts 
D GC Screen Fonts 

01 = Hard dlsl: 

( E j<~<t ) 

[ Desl:top ) 

n Add u 
~I _______ @@ [ Done J 

5. When you've added all the fonts you want to download, 
click Done. 

The directory dialog box closes and the fonts you added are 
listed in the Font Utility dialog box. 

6. Click the Download button to send all the fonts in the 
list to the printer or its hard disk. 

A status box appears. You can click Cancel to swp the process. 

7. Click OK when the status box reports the results of 
downloading. 

8. Choose Quit from the File menu. 
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Finding out about available fonts 

Most application programs have a Font menu that lists the fonts 
installed in your Fonts folder, though some programs do not list 
them all (you can open the Fonts folder icon, inside the System 
Folder, to see all the fonts stored there). 

The Laser\Xfriter Font Utility program (supplied on the system 
software disks) provides three ways to see the fonts available for 
printing on a LascrWritcr. You can display a list of fonts on the 
screen, print a catalog of fonts, or print a set of font samples. You 
choose the method you want from the Laser\Xfriter Font Utility's 
File menu. 

Download Fonts ... ~D 

Display Auailable Fonts ... ~L 

l ni Hulin~ t>rin tN's Ili~l< .. . 

Displays a window 
listing all fonts 
currently available to 
the printer 

Prints a lisr of rhe 

Print Font Catalog... ~P rhe printer 
Page Setup ... --±fonts available to 

Print Font Samples ... Prints a sam pit: of 
each font available 

Quit 3€Q to the printer 



Using d1e LaserWriter Font Utility 

\Vhile the LaserWriter Font Utility is most useful for transferring 
(or downloading) fonts from your System Folder to a Laser Writer 
printer and finding out about available fonts, you can abo use the 
program to 

• initialize a hard disk attached to a printer 

• control whether a printer prints a sample page when you turn 
it on 

• restart a printer 

• send PostScript files to a printer 

The Laser\Xfriter Font Utility program is supplied on the system 
software disks. 

Initializing a hard disk attached to a printer 

Some printers let you attach a hard disk so you can store fonts on 
it (in addition to the fonts stored in the printer's memory). See 
the manuals that came with your printer if you need information 
about connecting a hard disk. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Initialize Printer's Disk from the File menu. 

A dialog box appears. 

3. Click the Drive button until the hard disk that's shown 
is the one you want to initialize. 

4. Click the Initialize button. 

Turning the printer's sample page on or off 

The LaserWriter prints a sample page each time it is turned on or 
restarted. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Start Page Options from the Utilities menu. 

A dialog box appears. 

Printer s tort p11ge: 

® On 
O OH 

(concel } QO 

3. Click the On or Off button. 

4. Click OK. 
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Restarting a LaserWriter printer 

Restaning the printer clears irs memory, removing the fonts 
srored there and making room for other font<; Lhat you may want 
to transfer tO the printer. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Restart Printer from the Utilities menu. 

A dialog box appears. 

Lt Are you sure you want to 
restnrt your Pos tScript printer? 
Doing so will erase all fonts In 
the printer's memory. 

~ (Restart ) 

3. Click Restart. 

Transferring a PostScript file to a LaserWriter 

You can use the LaserWriter Font Utility to send a file in PostScript 
format to a Laser\Xfriter. (PostScript is a programming language 
that describes the characters, symbols, and images in a file to be 
printed or displayed.) 

1. Open the LaserWriter Font Utility icon. 
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2. Choose Download PostScript File from the Utilities 
menu. 

A dialog box appears. 

3. Click the name of the file you want to download to the 
printer, and then click Open (or double-click the 
name). 

A second dialog box appears, asking you w name a file that 
saves a record of the PostScript acciviry. This file has the preseL 
name "PostScript Log." 

I=Trauel disk ... j =Tnouel disk 

D 7 .0 beta draft 
D 7.0 figs 
D octluwlndow 
D nmsterdom 
D RrtldeO$ 
D Disk to Burr 

[ [jP.Gt I 
( Desktop J 

[ New CJ J 

Saue PostScript output as: [ Cancel J 

~ Snue IJ Post~cnpt Log 

The name of a printing log, which 
records PostScript aCLivity 

4. Type a name for the printing log, then click Save. 

The file is sent ro the printer and a record of Lhe PostScript 
acLiviLy is saved in the priming log. 

You can open the printing log to see the sequence of 
PosrScripL commands when the file was scm. 



Chapter 13 

Using Your Macintosh 
on a Network 
In this chapter 
• What you can do on the network 

• SeLLing up your Macintosh on a network 

• Gaining access to files on shared disks 

• Working with flies and folders on other computers 

• Sharing your own files 

• Using access privileges 

• Linking programs 

• Using communications products with System 7 

What you can do on the network 
You can do several things wi th your Macintosh once iL is 
connected ro a network: 

• Gain access Lo informat ion on mher computers. 

Working at your own computer, you can connect to other 
computers and gain access to files that are stored there. 
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• Allow access w information on your own computer. 

You can designate the contents of speci fic folders and hard disks 
on your computer as "shared files" that other people can gain 
access to over the network. 

• Prim documents on network printers. 

You can print documents on network primers as you would on 
printers that are connected directly w your computer. 

n ; Chapter 13: L:sing Your ~lacinrosh on a 1\etwork 

• Link your programs to programs on other computers. 

You can link your programs to programs on other computers in 
order ro share features between those programs. For example, 
you could link a word-processing program to a dictionary 
program to check the meaning and spelling of the words in 
a document. 

• Update files over the network automatically. 

~~ 
.. 

2 ~ 

You can auLOmatically update documents created in programs thai 
use the Macintosh system software's publish-and-subscribe 
feature (see the documentation that came with your programs for 
information about this fe;trure). 



Setting up your Macintosh on a network 
Before you Gin usc your Macimosh on a network, you have to 
physically connect vour computer to the network, install 
networking software, make sure that your computer can 
communicate with the network, and idenri~' your computer and 
yourself to others on the network. 

I f }'OU have a network administrator, he or she may have already 
set up your Macintosh on the network. Before you proceed, ask 
your network administrator whether these tasks have been 
completed. 

Connecting to a network 

Your Macintosh has built-in AppleTalk networking software that 
allows your computer to connect to a nenvork quickly and easily. 

If you're using a LocaiTalk network (a type of AppleTalk network) , 
then all of the software and hardware you need is already built 
imo your Macimosh. You can conneG your computer to the 
network by plugging Local'l;tlk-cumpatible cables into the back of 
your computer. If you need more information, sec the 
documentation that came with your cables. 

l f you're using an Ethernet or a Token Ring network, your 
JVIacinrosh needs borh an Ether'Htlk or a 'loken·ntlk expansion card 
installed in one of irs expansion slors and the appropriate software 
to communicate with the network. (See the documentation that 
came with your expansion card if you need more inl(mm tion.) 

The EtherTalk and the Token11tlk software arc provided on the 
system software disks that came with your computer. If a ne[\vork 
expansion card was already installed in your computer when you 
installed system software, the software for it was installed 
auromatically. If you installed rhe expansion card after you 
installed the system software, you need to install the network 
software separately (see ··Installing a Customized System" in 
Chapter 8, "Setting Up Your Macimosh System''). 
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Turning on AppleTalk 
The llrst time you turn on your computer after you have 
connected it to a network, you need ro make sure rhat 
Applehlk is turned on. 

1. Choose the Chooser from the Apple menu. 

2. Click the Active button to turn on Apple'Hllk. 

- Chooser 

~ 
1 Select e file server· • : Arttftctel Intelligence jQ "-;/ 
' Artiste ~ Applthk. g t 'w'rlh·r i Comer Pocket 

§ Jl) i 
General Purpose 
Greg·s Macintosh 

lm-9f'w'ritH Lu..,-'tiritt'f" 

I 
Ktl\y Margola·s Macintosh 
Monterey 

AppleTelk Zones· N:les Dev:s's Mec:ntosh 
Engineering 01 Sonoma 

reph:cs Venture 
~ Merkel:ng 

I Production 

[!J Publtcellons 

1-Research ---
ol AppleTelk 

PI 
act ire before rou can 
IISC :1 llCI\\'Ork. 

3. Close the Chooser. 

AppleTalk remains on umil you turn it off in the Chooser. 
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Selecting a network connection 

If ~~ou ' re using a LocaiTalk network, go ro the next section. 
"Naming Your Macimnsh ancl lts Owner." 

If you want ro use an EtherTalk or a TokenTalk network 
connection type or switch between two or more types of network 
connections, you have to select which connection you want in the 
i\erwork conrrol panel. 

1. Choose Control Panels from the Apple menu and 
double-click the Network icon to open it. 

IIJ 
Networ-k 

·;· {/you can't.fi'nd tbe Network control panel: The Network 
comrol panel, EthcrTalk software, and TokcnTalk software 
were installed only if you already had built-in Ethernet or an 
Erhdt:tlk or 'lbkenTalk expansion card in your computer 
\Yhen vou installed the s\·stem soft\Yare. If rou have built-in 

- - -

Ethernet or an expansion card installed no\\· and no .:--.Jer\\'Ork 
comrol panel appears in the Control Panels folder, usc the 
Installer program to install EthcrTalk or TokcnTalk software. 
(See '·Install ing a Customized System" in Chapter 8.) ·:· 



2. Click the icon of the network connection you want to 
use. 

l:O · Networl< · 

S-elect •n Applf'Talk eonnl!'etion · 

~ ~ -... Ether Talk 

A dialog box warns you that you may be disconnected from 
any network services (such as prin ters or file servers) that you 
arc using with your current network connection. This means 
that you must reconnect to Lhe neLwork services on the new 
network. 

3. Click OK. 

:"!ext, you need ru select the network zone your computer will 
usc. 

4. Double-click the icon of the network connection you 
chose in step 2. 

The default zone rhar's preselecred by 
vour nerwork administrator 

l I 

Sales Group~ Please select 
Finance this comput er's 
Product Support AppleTa ll< z one. 

1-o 

€ OK ~ ( Cancel ) 

;. Click the name of the zone you want to use. 

Zones arc set up by a network adminisLraLor and are used to 

distribute the devices on a network among groups for easier 
access. 

6. Click OK. 

7. Close the Network control panel. 

You can now usc the network conncclion you selenecl. 
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Naming your Macintosh and its owner 

Before you begin to use the network, you must give your 
Macintosh a name and name yourself as irs owner. The name you 
give your Macimosh appears in the Chooser of other computers 
on the network so that people on the network can gain access ro 
files on your computer. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup icon. 

m 
Shat·ing Setup 

·!· Ifyou call'tfind or can't open tbe Sharing Setup icon: Make 
sure that the Sharing Setup icon is in the Control Panels 
folder. and rim the file Sharing Extension file and the 
Network Extension file are in the Extensions folder inside Lhe 
System Folder. If nor, place them there and restart your 

computer. ·:· 
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2. Type your name in the box labeled Owner Name and 
press Tab. 

l;;o Sharinq Setup -

[!g) Network Identity 

Own~r NbMf; \Mttiiitff¥1.1.1 I 
OW'ntr PUIWOr'd. !•••••••• I 
M.cint osh riitl\9: I~Jon:=•~thon=~.ro= ... ~ .• ~M::,-e7in7tos-:-h-------,J 

3. Type your password in the box labeled Owner Password 
and press Tab. 

Your password can be up to eight characters long. Aft.er you 
press Tab, your password is replaced by bullets ( • ) so mhers 
can't read it. 

4. Type a name for your Macintosh in the box labeled 
Macintosh Nan1e. 

This is the name others will see on the network. 

5. Close the Sharing Setup control panel. 



Gaining access to files on shared disks 
You can retrieve and swrc inlormation on other computers 
connected to your network. For example, a coworker can 
place some ftles for you on a shared disk called a file server­
a computer on the network dedicated to storing shared files. 
Private Macimosh computers on your network might also 
have shared disks. 

Before you begin 

Before you store or retrieve information on rhe network, do the 
following: 

• Find out the name of the shared disk you want to 
access and the name of the computer that it's on. 

• If your network has zones, fmd out the name of the 
zone the computer is in. 

• Find out if you are registered on the computer or if it 
allows guest access. 

A Macintosh owner or network administracor can limit access 
to files on a shared disk. A'ik the Macintosh owner or network 
administra tOr whar type of access you have to the files. 

• If you're a registered user, find out the name and 
password you need to use. 

Find out exaclly how your name and password are spelled, 
including capitalization. 
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Connecting to a shared disk 

1. Choose the Chooser from the Apple menu. 

2. Make sure that AppleTalk is active. 

3. Click the AppleShare("' icon in the upper-left section 
of the Chooser window. 

AppleShare icon 
File servers and other 
compurt:rs with shared tlisks 

Chooser 

.... 
~ 
~ 

~ 
lm•'w'ritli'r 

~- 10 

AppW Tll< ... 9t'W'r'lttr I·!~') 

® f· · 
L.utr~ntH f{} 

AppleTolk Zones· 

Engi neering 1Q 

! Select o rne server. 
ArtHiclol Intel ligence 
Artiste 
Corner Pocket 
Generc 1 Purpose 
Greg·s Mcc1ntosh 
K1tty Mcrgolo"s Macintosh 
Monterey 
N1 les Dcvis"s Macint osh 
Sonoma 
Ventura -

IQ 

Mcrkeling 
Production 
Publtcol1ons 
Research 

I IQl 

(E] 
01 AppleTal l< ® Active 

0 lnoct1ve 

·:· Jftbe AppleSbare icon does not appear: Make sure Lim 
the AppleShare file is in the Extensions folder in your 
SysLcm Folder. ·:· 
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4. If your network has zones, click the zone the computer 
is in. 

If you don't see a box labeled AppleTalk Zones, skip this step. 

;. Click the name of the computer you want to use. 

•!• If tbe name you want isn't listed: Make sure you have 
selected the correct zone. If the zone is correct, make sure 
the computer is turned on. ·:· 

6. ClickOK 

7. Click Guest or Registered User. 

~ 
Connect to t he file seruer ' Rrtlst e • os: 

click here ifn Gues t 
you arc not ® Registered user 

registered on 
rhe computt:r Nome: I Jonathon Jones I 

that you'rt: Pnssw ord: I I (Scrambled) 

connecting to. 

[ Cancel J (Se t Password ) K-YJ 

If you arc a gucsL, click Guest and go to step 10. If the Guest 
option is uimmed, guests do nm have access to this compuLer. 



8. If you are a registered user, make sure the name in the 
box is correct. 

Capitalization does not need to match. 

9. JYpe your password. 

Capiralizarinn needs Lo march. 

10. Click OK. 

·:· Ifyourpassword is not accepted: Make sure Lllal Caps Lock 
is nor on. 'lype your password again, raking care not ro 
make Lyping errors. ·:· 

11. Click a shared disk to select it. 

~ .!.1!:1!!1!! 

"":' "" nom• ''' w'""' ""'IL! y J 
Rdom's Folder 0 
Bollerpltlle 0 
Ri! hnPr Rr t 0 <> 
l:hecked Items ( (81 ) will be opened at 
system sl6rlop lime. 

I Ctmcel l I OK ~ 

·e not available to you, 
or you're already connected to them. 

Shnred disks 
and folders 

12. Click OK. 

After you cl ick OK, rhe icon of rhe shared disk appears on 
your desktop. 

13. Close the Chooser. 

Disconnecting from a shared disk 

When you're finished using a shared disk, close any open files 
or programs on rhe shared disk and then disconnect in one of 
Lhe following ways: 

• Select rhe shared disk icon and choose Put Away from rhe 
File menu. 

• Drag the shared disk icon ro rhe Trash. 

• Jf you are finished working for Lhe day, choose Shut Down 
from Lhe Special menu. Shutting down automatically 
disconnects from the shared disk. 
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Using an alias to connect quickly to a shared disk 

By making an alias for a shared disk, you can connect ro that disk 
by simply opening the alias. 

1. Connect to a shared disk. 

2. Select the shared disk icon. 

3. Choose Make Alias from the File menu. 

4. If you wish, rename the alias, then drag it to a 
convenient location. 

;. Next time you want to cotlllect to the shared disk, 
open the aUas you created in step 3. 

If you originally connected to the shared disk as a registered 
user, a message appears. Type your password. 

If you conneC[ed ro the shared disk as a guest, this message 
docs nor appear. 

The shared disk icon appears on your desktop. 
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Connecting automatically when you start up 

You can connect automatically ro one or more shared disks 
whenever you turn on your compmcr. 

1. Connect to the computer that has the shared disk you 
want to open. 

2. Click the checkbox ne.x1 to the name of the shared disk. 

Click one of 
these 

buttons to 
indicate 
whether 

you'll have 
to emer your 
password at 

startup. 

~ B.r1i..tle. 
Select the Items you want to use: 

I ~;~ Rdom·s rolder 
Boilerplate 0 
Richner flr t oto 
Checked Items ( r2$J) will be open ed at 
~ystem ~tartup time. 

( 

• soue My Name Only 
0 Saue My Nome and Password 

) ~ OK ~ 

Check a box to connect 
automatically when you 
turn your computer on. 



3. If you're connecting as a registered user, click the 
button that indicates whether you want the shared disk 
to save your name only, or both your name and your 
password. 

To iJrevenr unauthorized people from gaining access to the 
shared disk, click "Save My Name Only." When you stan up 
your computer, you'll need m enrcr your password to connect 
ro the shared disk. 

4. Click OK. 

; . Close the Chooser. 

Working with illes and folders 
on other computers 
Once you arc connected to a shared disk, you can use the files 
and folders on it as if rhey were on your own computer. 

You may nor be able ro open some items on a shared disk because 
the owner hasn't given you access ro those items. For information 
on how ro check your access privileges, see "Working With 
Privileges That Others Have Set'' later in this chapter. 

Creating a new folder on another computer 

You can creme a new folder on a shared disk (as long as you 
have the correct access privileges). If you arc a registered user, 
you become the otv11er of any folder that you create. If you are 
connected as a guest, you share ownership of the folder with 
all guests and registered users. 

The icons of folders that you own have a clarkcnccl tab. 

LJ 
When you own a folder. you can determine who can usc it and 
in what way. See "Using Access Privileges'' later in this chapter 
for more information. 
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Changing your password 
If you are a registered user, you may be able ro change rhe 
password you usc to access a shared disk. (Your network 
administrator can resrricr this capability.) 

1. Connect to the computer that has the shared disk 
you want. 

2. Click the Set Password button. 

~ 
Connect t o the file seruer " Artiste• as: 

Q Guest 
® Regis tere~ User 

Name: I Jonathon Jones I 
Password: I I (Scrambled) 

( Cancel J [ S~t Password J € OK ) 

Click here w change 
your password. 

If a message tells you rhar you cannor change your password, your 
net work administrator has turned off this feature. 
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3. Type your current password. Then press Tab and type 
a new password. 

A buller ( • ) appears fur each leuer you rype. 

Old passw ord: IT - I 

New password: I I 
[ Concel J (~) 

4. Click OK. 

; . Click OK in the dialog box that appears. 

6. Retype your new password and click OK. 

Your new password is now in effect. 



Giving folder ownership to someone else 
You Glll give away ownership of any folder you own. Once you clo 
so, however, the new owner can restrict your access ro rhar folder. 
Make sure you have copies of any tiles you may need before you 
give ownership of a folder to someone else. 

1. Connect to a shared disk. 

2. Click to select a folder that you own. 

3. Choose Sharing from the File menu. 

4. Type the name of a registered user or group in the box 
labeled Owner. 

;. Close the dJalog box. 

!\message asks you to confirm that you want to change rhe 
owner of the folder. 

6. Click OK. 

The user or group thar vou named assumes ownership 
immediarelr. 

Sharing your own flies 
You c:-~n share flies stored on your Macimosh wiLh others on the 
network. For example, members of your work group can connect 
to your com puLer and open a tile from their own computers. 
(They do nor have rube using System 7.) Or, if you have both a 
deskLop Macintosh and a Macintosh Powerl3ook computer, you 
can transfer flies from one computer ro the mher wiLhouL using 
tloppy disks. 

You control ,,·hat you share and \\·irh whom you share it: 

• You share only folders you specify. 

• You share only with the people you specify-one person, 
a group or people, or everyone on the network. 

• You can see everything on your own computer from another 
com purer on the network. 

How ftle sharing works 

There are three steps to sharing a folder or disk: 

• turn on tile sharing 

• select a folder or disk to share 

• dccicle whom you want to share it wi th 

The folder or disk you share is nor accessible ro anyone bur you 
until you choose whom you want to share it with. 
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Turning file sharing on 

1. Choose Control Panels from the Apple menu and 
open the Sharing Setup icon. 

~ 
Sh-aring Setup 

Make sure the boxes in the Network Identity section of 
the control panel are ftlled in. 

2. In the section labeled File Sharing, click the 
Start button. 

:o Shar ing Setup • 

~ Network Identity 

Ownff Nim9 . on.othor. Joro;oi 

O'wntr Pass..,ord: ~1•:::•::;••;:•:::•:::••::::::!1 __________ ~ 
Macmtosh Name: IJoMthOn .Jont.s 's Ma-cint os-h I 

Cl. k I I F---1 File Sharing ;c· 1nc L__j 
Shtu.s----·----- _ 

to stan file [ St art I fru. sl>.>rin9!; off. Click St.rt to •llow oth<r ...... II 
sharing. l to ~ss shwtd (o~rs. 

~ Program linking 
;-.Sbtus-------------, 

[ Start 1 J Pt-091".., hnkV'I)IS off. Click startto alloY otlltr I 
l uurs to hnk to your sh~red proor~ms. 1 
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3. Close the Sharing Setup control panel and the Control 
Panels folder. 

If you wanr to give everyone on the network access to the items 
you share, conrinue with the next section, ·'Turning On Guest 
Access." Otherwise, go to the following section, "Selecting a 
Folder or Disk to Share." 

Turning on guest access 

If you want all users connected to the network to have access ro 
your shared folders and disks, you need to turn on guest access. 

Even when guest access is turned on, no one bur you has access 
ro any of your folders or disks until you specifically share them. 
You can always limit access to any folder. 

To turn on guest access: 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

e 
Users & Groups 



2. Open the <Guest> icon. 

:o . Users & Groups _eJ; 
3it~ 

[] I 0 
& 

.Jooalhon JoMS r.hl~s [)av1·s 

<Guest> icon 
0 

¢ 1¢121 

3. Click the checkbox labeled "Allow guests to connect" to 
place an X in it. 

1~0 <Gu es l > 

LJ File Shoring 
,;~!,::;;;, 'lil allow guests 

to ron 1~ect to l __ l8l_•tlo"'~JU<•t• to O<>NI<<t 

your computer. 
click to place an 

X in this box. 
~ Program linking 

0 Alloy quoru to linl< to P<091'<>m< 
on th1s Ma.c~ntosh 

~0E 

4. Close the window and click Save in the dialog box. 

You can still resrricr access ro any fCJider or disk you share, 
as described in the sccrion ··using Access Privileges," later in 
rhis chapter. 

Continue wi th rhe next section ru seleG a folder or disk ro share. 

Selecting a folder or disk to share 

You can share any folder, hard disk, or CD-ROM elise connected to 

your com purer (you can nor share Aoppy disks). You can share up 
to ten folclcrs or disks at a rime. (This number does nor include 
folders wit hin the folders or disks you share.) 

1. Make sure ftle sharing is turned on. 

2. Select a folder, hard disk, or CD-ROM disc to share. 

3. Choose Sharing from the File menu. 

4. Click the box labeled "Share this item and its contents" 
to place an X in it. 

20 

u"h~r4!' ; 

For Rll Eyes 

Joo•thon ..Jonts's Macintosh· 

For All Eyu 

Click hen: -t-n Sh ... • thn Hom on<~ Hs conttnts 

to share 1 he 
item l'ou\·c 

scicetcd. 

s.. 
Foldtrs 

Ov ne-r : ! Hv..t .;.;.-1 [8l 

Use-r /Group : r F:-'!!.! •I ~ 
EvenJorw ~ 

Ste ~kt 
F'i'lu ett.ngn 

~ :8) 

t8i z 
~ ~ 

[J Make .all C.tJI"r entkJ enclos~d fold~rs hk~ th1s one 

0 Can~t be- mov~d. r~nam~d or del~t~d 

f or information about the or her checkboxes in this winclO\\·. 
see ''Using Access Privileges" larcr in this chapter. 

CUIIIhllleS ... 
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S. Close the window and click Save in the dialog box. 

AL this poim, only you have access to the item you shared 
and Lhe files and folders inside it, unless you turned on guest 
access. If you haven't rurned on guesL access, continue with 
Lhe senion "Naming a HegisLered User" to name the specific 
people you want to share your folder or disk with. (The 
sertings you choose in the checkboxes for Users, Groups, 
and Everyone can take effect only if you allow guest access 
or rcgisLcr users in Lhe Users & Groups control panel.) 

If you shared a folder, its icon appears on your desk Lop with 
a darkened tab and network cables: 

LJ 
:~ : 
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When people on the network are connected to your shared 
folder, its icon appears with faces in the center: 

rniJ 
:~ : 

D. Important: Before you put programs inside shared folders 
or disks, remember that copyright laws may prevent Lhose 
programs from being shared. Check the applicable licensing 
agreements and follow their specifications. 6 

Turning off access to a shared folder or disk 

Any shared folder or disk can be made private again. 

1. Select the shared disk icon. 

2. Choose Sharing from the File menu. 

3. Click the box labeled "Share this item and its contents" 
to remove the X. 

Your changes take effect immediately. If people are connected 
to your computer, you see a message asking if you wam LO 

proceed. 



Naming a registered user 
You can register as many as 100 people and groups combined, but 
for best network performance you should name no more than 50. 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

001 
Users &. Groups 

2. Choose New User from the f'ile menu. 

An icon labeled New User appears. lts name is selected 
for editing. 

·:· Jfyou can't.find tbe New lf.~er command: Make sure the 
Users & Groups window is active. ·:· 

3. l)rpe the name of a person you want to register. 

Make sure you notify the person of the exact name you type. 
(Capitalization does not have to match.) 

~o User s & Groups B:E 
31t.-nu 

0 

0 0 y 

Jonathon Jon~s <Guut> ~ 

New user icon 

0 
;II I<; '21 

4. To register more users, repeat steps 2 and 3. 

Tb assign passwords or to m1me groups of users, continue with 
the next two sections. If you want ro start sharing immediately, 
go to "Selecting a User or Group to Share a Folder or Disk" later 
in this chapter. 
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Setting a registered user's password 

You can assign passwords for registered users to verify their 
idemities when they wam to gain access Lo your computer. 

1. Open a user icon in the Users & Groups control panel. 

The user's name 

;o~ Niles Douis = 

Us~r Pus word : 

Q File Shoring 

{8] Allov us"' to connf'Ct 

{8) Allow us•r to ch.,._ password 

Group• 

[-- ~ 

~ Progrern Linking 

0 Allow us:K to ld to programs 
on t h11 MKW\to.sh 

'lype a password 
for this user 
here. 

2. Type a password in the User P'assword box, then 
press Tab. 

The password can be up LO eighr characters long. When you 
press Tab, rhe password is replaced by bullets for privacy. 
Make sure to inform the user of the exact password, including 
capitalization. 

3. Close the window, and then click Save in the dialog 
box. 
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Naming a group of users 

You can name several registered users as a registered gruujJ. 

1. Open the Users & Groups control panel and choose 
New Group from the File menu. 

An icon labeled New Group appears. The name is selected 
for editing. 

[] 
.Jonathon J OOf's 

0 
Nilu D•vu 

0 1 1 1 Group icon 
<llwst > 

0 
8arb HUQ~S 

0 
EIWn fit:w~tt,. 

Draa user icons 
ro the group icon. 



2. Type a name for the group. 

3. Drag user icons to the new group icon. 

The icons are not moved inside the group icon, as they would 
be if it were a folder. Dragging the icons creates a member 
icnn inside the group icon. You don't need ro drag your own 
icon to the group icon because you have access to the emire 
coments or your computer (unless you speci~· otherwise). 
You clon·t need to include the <Guest> icon in any group. 

'lo allow this group to gain access m a shared folder or disk, 
go to the section ·'Selecting a User or Group to Share a Folder 
or Disk." 

Seeing who's in a group 

• To see the names of all group members, open the 
group icon. 

ID Testing Team 0; 
3 1t.,ms 

0 

~ ~ m 
Elltn FU:yo~ttr Barb~s Ni1~ 0 .. vis 

0 
QL______ IC:: '2l 

You can open any member icon to see or change the sett ings 
vou've made for that user. 

• To see all the groups that a user belongs to, open the 
user 's member icon or user icon. 

1 

Tilt: user's name 

!;;o::--:-=:; Niles Oou is 

Uu r PuS'W' ord ~ 

0 File Shor ing 
.~ 

[8J Allo'W' user to coMKt 

(8] Allow un r to Chlng't pi S:S:word 

Groups: 

~----F=H-- The groups I his 
user !Jclougs 10 

~ Progmm Linking 

0 Al low un r to 11nk to programs 
on thts t'l&omto.sh 
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Selecting a user or group to share a folder or disk 

You can give one registered user or group exclusive access to 
a shared folder or disk on your computer. 

1. Select a folder or disk to share. 

2. Choose Sharing from the File menu. 

3. Click the box labeled "Share this item and its contents" 
so an X appears. 

4. Choose a user or group from the User/Group 
pop-up menu. 

:;1 1 For All Eyes 

Q ....... , Jon•t.hon .Jonu's M~Wltoah 

For All Ey H 

[8) Sb.v"• thn. it('m .vJd tls cont9f'ltS - S.+ 
roldtf"s r.~ 

Ovnor : I Jon.othon .....,., •I 181 l8l 
Us:~r / Group : • <None- > 181 l8l 

T~ting Tum l8l 181 
Cncbr J-tek Tum 

O M<~<tollwr Lunch Group hkt ttn:; onto 

O c.n'\t..mo Uilt:; D.Jv1:;: 

' £1l.pn Flt..-w~tw 
Joo-ithon Jonf>:f. 

H•h 
Ch>n9<s 

rn 
l8l 
181 Rcgistl'rcd usl'rs 

and groups appear 
in this menu. 
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;. To share the item with 011ly the user or group you've 
chosen, make sure there isn't an X anywhere in the 
third row of checkboxes (to the right of Everyone). 

:o 
U 'w'her~ · 
~. 

For All E!1es 

Jon.tthon Jonu'.s Macmto.sh : 
ror All r~,~~, 

[8) St\a.r t- th1:; 1ttm and t~ oontll'n~ 

SH 5H M.a.'·• 
Fokif.rs FtiM Ch<1ngor:; 

Own•r : I .Jon1thon JonH "" I ~ 
Un r /Group · I Borb Huohos • I 181 

EVtrljOM 0 

181 
181 
0 

0 t1.tl.~ 411 wrrtntll) tnetos.t<l foldtt"s hke- thts ont 

0 C¥\'t ~ mov-.d, f.n.wnf'd or dfollttfod 

181 
181 
0 

6. Close the window and click Save. 



Preventing users or guests 
from accessing your computer 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

E 
Users &. Groups 

2. To deny access to a specific user, open the user icon. 

To den1 
access 

to this user. 
click to 

remove the X 
in this box. 

The user"s name 

1e0 · ·Niles DOUIS 

Uur PMsword. jl I! II I II +I 

D File Shoring 
~ 
-{8} Allow ustr to c~t 

[@ A11ov us•r to chang~ pus:'W'ord 

Groups 

T~sting TNM 0 
Cr -'C~ .. ,. JaC~ T t>ilm 
Lunch Grc.up 

~ l'rogrom Linking 

0 Allov unr to link to p:r ognms 
on ttns f-1.\c~ntosh 

0 

To deny access to guests, open the <Guest> icon. 

"li 1 dcm· access 
tu guests, 

click lO I"CillO\"l' 

the X in this box. 

1~0 <Guest> 

D File Sharing 
,~. 

-{8] Allow- gu@st:s to c~t 

~ Program Linking 

0 Allow IJUf'Sts. to link to prOQr·~oms 
on this M.lointo$h 

BJ~ 

3. Make sure there isn't an X in the checkbox allowing 
guests to connect. 

4. Close the window and click Save. 

If ~~ou deny access to a user who is curremly connected, he 
or she is disconnected immecl iarelv. Thar user is no longer a 
member of am· grou ~s. and can connect only as a guest. 

I r \'( Ht deny :Kcess ro guesrs . any guests currenrh- connected 
are clisconnecrecl immecliarelv. 
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Removing a user from a group 

1. In the Users & Groups control panel, open the 
group icon. 

2. Drag the member icon to the Trash. 

3. Choose Empty Trash from the Special menu. 

Removing a user or group from your list of 
registered users 

You can remove a registered user or group ar any rime. When 
you remove a user, he or she will no longer be a member of 
any registered groups. 

1. Open the Users & Groups control panel. 

2. Drag the user or group icon to the Trash. 

3. Choose Empty Trash from the Special menu. 

If rhe user is curremly conneCLed, he or she is disconnected 
immediately. 

You cannot throw away Lhe < Guesr> icon or the owner icon. 
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Giving away ownership of a folder or disk on your 
computer 

You can give away ownership of a shared folcter or disk on your 
Macinrosh ro a registered user or group. 

Because you are rhe owner of your Macimosh, the new owner of 
a folder or disk on your computer cannot restrict your access to 
ir. However, the new owner can change the access privileges 
rhar other people have ru rhe folder or disk. If you give away 
ownership of a folder or disk, make sure LO remove any folders 
or documenrs rhat you don·L wam others ro see or change. 



1. Select a shared folder or disk. 

2. Choose Sharing from the File menu. 

3. Choose a name in the Owner pop-up menu. 

m For All Ey es 

D "h@'rP: Jon-lthon JOf'lto::::·~ Mac:~ntosh: 

~ 
For All ('J~S 

[8] Share this itt>m ¥ld its contents 

s.. s .. M~~· 

Foldtr'S Fll<s ChanQeS 

Own~r : <AhJ Ustt"> 181 181 181 
Un r / Group : Te-s ting Tt!'im [8J [8J [8J 

Craektrj.&ek Tum 
[8J [8J [8J lunch Oroup 

0 M~kt~ll cur Nf~s Davis likt this ont 

D Can~ t bfo mo· ~11~~ f'it~\lfattr ~ I 
• J onathon .Jonts 

If you selecr <Any User>, rhen anyone on rhe nerwork can 
change rhe access privileges or ownership of rhe i1em. 

4. Close the window and click Save in the dialog box. 

5. Click OK again to confirm that you want to change 
ownership. 

Turning file sharing off 

You can rurn Ale sharing off ar any rime. When Ale sharing is off, 
people on rhe nerwork cannot access folders or disks on your 
computer, and you cannor access your computer from anorher 
com purer on rhe network. 

When you rurn file sharing back on, the ircms you shared before 
are available again automatically. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup icon. 

~ 
Sh.:~rin9 Se-tup 

conliltues ..,_ 
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2. In the section labeled File Sharing, click the Stop 
button. 

A dialog box appears in which you can speci~r a delay before 
file sharing is turned off. If you specify a delay, users who are 
connected ro your computer arc warned to save their work 
and clisconncn. 

Holl! many minutes until file 
shoring is disabled? 

[1111] 
{ Cancel J H DK D 

3. Type the number of minutes you want to elapse before 
file sharing is turned off. 

'lo rurn file sharing off immediately, rype the number 0. 

4. Click OK. 

If someone is using files on your Macimosh when file sharing is 
turned off, any changes he or she has not saved will be lost. 
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Monitoring file-sharing activity 

When fi le sharing is on, you can see \vho is connected to your 
computer and what folders or disks you've shared. 

• Choose Control Panels from the Apple menu and open the 
File Sharing Monitor icon. 

~ 
Filt- Sharing Monitot· 

ID 

Users connected w your 
computer are listed here 

File Shorinq Monitor 

~ Jonat hon Jones's M acintosh 
- --

,... Q Shared I t ems GlJ Connect ed 
S.ck\J 's foldtr 0 {] <Gu<sv 
~t Your R~ports Htreo D NOn O~vis 
For An Ey•s 

0 

Users 

Folders and 
disks being 

shared 
are listed 

here. 
File Sharing Rcliuity; 

( !JIS<onnP.r.l l 
ld1o &"J 

' select his or her name 
and then click here. 

~ 

'o 



Disconnecting someone who 
is connected to your computer 
You can disconnect users who are currently connected to your 
Macintosh in the File Sharing Monitor comrol panel. 

1. Select the user or users you want to disc01mect. 

2. Click Disconnect. 

3. Type the number of minutes that you want to elapse 
before users are disconnected. 

How mony mlnu t es until selected 
users are disconnec t ed? 

-(~-C-on-ce-1 ~) rrn~o~K ~n 

If you sped~· a delay, users are warned to san~ their \\Urk 
and disconnect. It's a good idea to give people enough rime 
ro save changes they have made. To disconnect a user 
immediately, type 0. 

4. Click OK. 

A message remains on the screen umil the rime is up. Click 
Cancel if you don't want to disconnect the users. 

5. When the designated amount of time has elapsed, 
close the File Sharing Monitor. 
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Gaining access to your computer 
from another computer 

You can connect to your own Macintosh from another compmer 
on the network and access everything on the disks attached to 
your computer. 

1. Make sure that file sharing is turned on. 

2. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

E 
Users & Groups 
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3. Open the owner icon (the one with the bold outline). 

4. Click the boxes labeled "Allow user to connect" and 
·~ow user to see entire disk" to place an X in them. 

:~Jonothon Jones ;;;;;;;;;;;;;;; 

With an X in this box, 

you can connect to your =R 
computer from another . File Shor ing 

C()JnpUter. Allow usorlo comtel 

[8) Allow USW' to ch.atle)t pauword 
With an X in this b~JX, Allow • ..,. to ..... tr. dW< 

you can see ever}rthmg c;,.oups~'----------..,., 
on your computer. I ~ 

When these boxes are checked, you can see and use 
everything on your disks while you're using anmher 
computer. 

To restrict your access, click a checkbox to remove the X. 



;. Close the window and the Users & Groups 
control panel. 

6. Leave your computer turned on. 

To gain access ro your computer, connect to it as a registered 
user. Type your owner name and password as they appear in the 
Sharing Setup control panel of your computer. Then connect as 
you normally would. 

·!· !Jyou are unah/e to connect to your computer: Make sure 
that your computer is turned on, that file sharing is turned on, 
ancl that you have the correct access privileges. Make sure that 
you type your password exactly as it is entered in the Sharing 
Setup control panel, including capitalization. ·:· 

Changing your password 

You can change the password you use ro gain access ro your own 
computer from another computer. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup icon. 

~ 
Sharing Setup 

2. Type a new password in the box labeled Owner 
Password and press Tab. 

Sharing Setup 
Type 9 Network Iden tity your ne\\' 

~~~~~~~~~~~~~-- password Owntr N¥M: 

ow ..... Pusvot'd: ~··••••• here. 
MKintos.h Namt . IJon•thon Jont.s'$ Macintosh I 

Remember the capitalization. Your password is replaced by 
bullets ro keep it private. 

3. Close the Sharing Setup control panel. 

Your nC\\' password is now in effect. 
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Using access privileges 
Access privileges let you control what other people can do wirh 
the information you share on a network. For example, you might 
\vanr ro let people see a file but prevent rhem from changing it.. 

Understanding access privileges 

You can set access privileges for any shared folders on your own 
computer and any folders you create on another Macinrosh. 
Owners of other computers can ser access privileges that resui ct 
what you can do with their shared disks. 

Three categories of people can have access privileges lO shared 
disks and folders: 

• 'J he oume1: The owner of a folder can change the access 
privileges to that folder. You become the mvner of a folder 
auromatically when you create it. You can keep ownership or 
give it a'i\·ay. 

• A registered user or group. A registered user has special 
access to shared disks over the network. A registered group is 
a group of registered users. 

• Eue1yo11e. This category includes the owner, registered users, 
and guests. 
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There arc three types of access w shared items: 

• See Folders allows people to sec, open, and copy the folders 
within a folder or disk. 

• See Files allows people ro see, open, and copy the files within 
a folder or disk. 

• Make Changes allows people to make changes to a folder or 
disk- copy, delete, or change any of its contents. 

The table indicates which privileges you need in order to take 
cerrain actions \rith items in a shared folder or disk. 

Make 
Action See Folders See Files Changes 

-

Copy or move tiles ro a folder D D [2] . 

Copy a file from a folder D [2] D ' 

Copy a tc>lder from a folder [2] D D 
Create a I( >klcr in a folder [2] . D [2] 

Dele1c a tile from a folder D [2] . [2] ' 

Delete a folder from a folder [2] ' D r2J . 
Open and usc a t11c in a folder D [2] D 
Save ch;mges ro a fi le in a folder D [2] ... [2] 



Setting access privileges to folders and disks 

You can seL access privileges for shared folders or disks on your 
own com purer and for folders Lhar you own on or her computers. 

1. Select the folder or disk. 

2. Choose Sharing from the File menu. 

The dialog bo;.; you see may he slightly differenr from the 
one pictured. 

i:O 

D Yh~reo: 

~-

For 011 Eyes 

JoNthon .Jonts '.s 11iemtosh _ 
For All Et.~H 

[8] Sh;,re- thiS lltm aM 1ts cont•nl s. 

S('~ Set M<3okt 
Ffl~s Ch~OQ('5: F'o1dt rs 

O'lt'n ~r : I .Jon.tthon Jonts ... I (8] r8l f8]-

f8] r8l W-- Usc tht.:sc boxes ro ser 
tv"~.,. r8J r8l r8JJ 1 access pnvdcgcs. 

Us~r /Group: I <Nont> • I [8] 

0 Makt an c.urrtntkj tnc:lostd fold+r.s lik• this oot 

0 can 't W. rnovfod, rtn~ or dtkltd 

• If you 've scleCLed a folder inside a shared folder, Lhe 
checkbox ar rhe rup is labeled "Same as enclosing folder." 

• If you've selected a folder on anmher computer, the 
Owner and lJser/Group areas are rexr boxes, nm 
pop-up menus. 

• If ~·ou \ re selected a folder you do nor 0\\'11, all the 
checkboxes ancl rheir labels are dimmed. 

3. Choose a registered user or group to share the 
item with. 

Choose from the lisr of users and groups in Lhe pop-up menu, 
or Lype the name of a registered user or group in Lhe box. 

4. To set access privileges, click the appropriate checkbox. 

• 'fh seLLhe same privileges for the folders within this folder 
or disk, place an X in the box labelecl "Make all currently 
enclosed folders li ke this one." If you're working \Yith an 
iLem that conrains a large number of folders, such as a 
CD-ROM elise. this action mav rake a few minuLes 
to complete. 

• To prevent the folder from being changed, place an X in 
Lhc box labeled "Can'r be moved, renamed, or deleted." If 
you check this box, no one-not even you-can change 
Lhc li1ldcr. 

• If vou want the folder LO have Lhe privileges set for rhe 
folder or disk enclosing it. place an X in the checkbox 
labeled "Same as enclosing folder ... This box only appears 
for folders inside shared folders. \\/hen vou move such a 
folder to another folder, iLs access privi leges change to 
relleCI Lhose of Lhe enclosing folder. 

;. When you're finished setting access privileges, close 
the Sharing dialog box and then click Save. 

The access privileges rake effecr immediarelv. 
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Access privilege strategies 
Access privileges can be combined in several ways. A few common 
and useful strategies are summarized here. 

• Allow everyone on the network all access privileges. 
As long as you've turned on guest access, everyone on the 
network can open, read, and change the files and folders. 

See See Make 
files folders Changes 

Owner [8] [8] [8] 

User/Group [8] [8] [8] 

Everyone [8] [8] [8] 

• Keep a folder or disk private. 'I() keep a folder or disk on 
your own computer private, do nor share it. To keep your 
folder on another computer p1ivate, use these settings. You 
have full access bur no one else can see, open, or usc its 
conrems. 

See See Make 
folders Files Changes 

Owner [8J [8] [8] 

User/Group 0 0 0 
Everyone D 0 0 

206 Chapter 13: Using 't'<Jur Macintosh on a Network 

• Allow access to one other person or group. This set of 
privileges allows the owner of the item and one registered 
user or group to use the item. 

See See Make 
Folders Files Changes 

Owner [8] [8] l8l 
User/Gr oup [8] l8l l8l 

Evet'yone 0 0 0 

• Keep a folder private but allow others to place ffies or 
folders into it. People on the network can deposit files or 
folders into this folder bur cannot see, remove, or change its 
contents. (This configuration is sometimes called a drup bo.'\:.) 

See See Make 
Folders Files Changes 

Owner [8] [8] l8l 
User/Group 0 0 [8] 

Everyone 0 0 l8J 

• Set up a folder as a bulletin board. People can open and 
read the files in this folder but cannot change them. 

See See Make 
Folders Files Changes 

Owner [8] [8] l8J 
User/Group l8l [8] 0 

Everyone [8] l8J 0 



Working with privileges that others have set 

When you arc using the By Icon or By Small leon view, the 
appearance of shared folders indicates the access you have. 

Icon Meaning 

.-. 

[_J 
,• ·• 

u 
CE 
r -m 

A darkened tab indicates that vou own the folder 
and can set its access privileges. 

A plain tab indicates that you G il l open and use the folder. 

A st rap indicates that you c;mnot open and use the folder. 

A strap with an arro\\' indicates that you can put files 
or folders into the folder, but you cannot open it or 
use any files or folders within it. 

Checking your access privileges 
When you open a folder on a nor her computer, icons under the 
title bar indicate the privileges that you do not have. 

f:e:e: 
You can't 
make changes. 

You can't 
see fi les. 

You can't 
see folders. 
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Linking programs 
Some ~lacinrosh programs can exchange information directly 
with other programs. For example, one program might be able to 
instruct another program to add a row to a spreadsheet or change 
the fonr size of a paragraph. 

Programs implement linking in various ways and not all programs 
have this capability. See the clocumemation that came wirh your 
programs for more information. 

Linking to a program on another computer 

You can only link to programs that are shared. 

1. Within your program, choose the menu command that 
allows you to link programs. 

The menu location and command name depend on rhc 
program you· re using. You use a dialog box ro find rhe 
program that you want to link ro. 
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Computers available 
for progt~lm linking 

Choose o program to link to: 

I- Mocintoshes Programs 

Artis te r CADWorks -
Dione's Meclnlosh The Bollom Line 
Monterey WordRighler -' ' .. 
Niles Devls's Macintosh b Ventura 

'--
RppleTolk Zones 

Engineer! ng 0 .. 
Marketmg :•:•. 
Production 
Publications ·' 
Research ro [ Cancel ) ([ 

g 
the selected computer 

g I 

111 

{} 

01( 
, 

2. If your network has zones, select a zone in the lower­
left section of the dialog box. 

3. Select the Macintosh you want to connect to in the 
upper-left section of the dialog box. 

4. Select the program you want to link to. 



5. Click OK. 

In must cases, you need ru iclemify yourself as a guest or 
a registered user. 

~ 
Connect to shored disk " Artist e" as: 

Q Guest 
@ Registered User 

Name: !Jonathon Jones J 

Possword: II I 

[ Cancel ] (( OK ll 

6. Click Guest or Registered User. 

If you are a guest, click Guest and go to step 9. If the Guest 
option is dimmed, guests do nor have access ro this computer. 

7. If you are a registered user, make sure that the name 
is correct. 

8. Type your password. 

9. Click OK. 

The two programs are now linked. 

Disconnecting a program link 

To disconnect a link to a program on another computer, qu it the 
program you used to create the link. 

Allowing other people to link to your programs 

You can allow people on the network to link to programs on your 
computer. 

• First you turn on program linking. 

• Then you make a program available for linking by sharing it. 

• Finally, you either allow guest access or allow specific people 
ru link. 

These steps are outlined in the following sections. 
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Turning program linking on 

When you turn program linking on, your computer is visible ro 
others on rhe network whenever they attempt to link a program. 
13efore you turn program linking on, make sure that ApplcTalk 
is active and that you have named your Macintosh. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup icon. 

2. In the section labeled Program Linking, click the 
Start button. 

I;_; Sharing Setup e Network Identity 

~~-~ Ovnff" Pu.svord: I•••••••• I 
M.aemtosh fllriM: ~~Jon:=,=.thon==:.Jont=s~'s-M:-:-..,-lt\'7to-s7h-------,l 

Owntf"N~. 

LJ File Shoring 
--Statu.s _ ~ --, 

( Start ] I Filo sh"'lrl9 tS off Cli<k St .... t to •llow oth<r .. .,., , 
to_.,. sh>rtd foldtrs. I 

Click to turn ~ Program link ing 

on program ,...Siotus- ---------· 
linking. Stert '! Pr09"'"' l10kin9 ts off. Chel: St.,.t to •How owr 

us.tr!i to link to your :m&rtd proor¥nS 

3. Close the Sharing Setup control panel. 

Once program linking is Lurned on, you musL selecL programs 
to share before network users can link to them, as described 
in the next section. 
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Selecting a program for linking 

I3efore a network user can link ro your program, you need to 

share it. 

1. Select a program to share. 

If the program is open, you must quit before you can share it. 

2. Choose Sharing from the File menu. 

3. Click the box labeled 'Wow remote program linking" 
to place an X in it. 

~~WordRighter---

a 
'(./'" 'w'or<RlQhttf' 

K1nd : appUo.at1on program 

With an X in this box, _fhoro: ;:~u;:"sh~;;ldtr : 
this program is vordR>Jht ... 

available fOr linking Proqr•m llokin9 

on the network. Allowr ..... t• 1"'"'7.,. 11r11m9 

If the box is dimmed, rhe program docs not suppon linking, 
and you cannot share it. 

4. Close the window. 

AL Lhis point, no one but you can link to your programs until 
you rurn on guest access or name registered users. 



Allowing guests to link to your programs 

You can leL everyone on Lhe ne('\-urk link to your shared 
programs. 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

2. Double-click the <Guest> icon. 

3. Click the box labeled '1\.J.low guests to link to programs 
on this Macintosh" to place an X in it. 

With an X in rhis 

<Guest> E!J: 

0 File Shoring 
~ 

1:81 A11ov QUHts to COMK.t 

box, guests can link~ 
10 programs 011 Program Unl<lng 

vour \ lacinrosh. Atloow ~·"to '" to P'"'P'•"" 
· on this MlOtntosh 

4. Close the window. 

Guest users can now link ro any of the programs you're 
sharing, as long as Lhc programs are open. 

Naming specific users to link to your programs 

You can idemify Lhe regisLered users and groups you \\·am to link 
to your programs. 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

2. Open the icon of a user. 

3. Click the box labeled '1\.J.low user to link to programs 
on thjs Macintosh" to place an X in it. 

1 

The user's namc 

i§i;I:JJi!!~~~~NNiliiilelSs~DIIuis 
Use-r P•ssvord : c==J 

0 rue Sharing 
~. 

[8J Allow unr to conntet 

[8] "How ultf' to c:h.anqt pJ~Uword 

Oo-oups 

I ~ 
\'\lith an X in this box,~ 

this user can link to Program Llnl<lng 

I'Qll l' programS. Allo"' ustr to lkl~ l• PfO<Jr•ms 
' on thts M.lielntosh 

4. Close the window and click Save in the rualog box. 

;. To give more registered users access to your programs, 
repeat steps 2 through 4. 
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Using communications products 
with System 7 

Using the Communications 'lbolbox 

If you are already fami liar with rhe Communications Toolbox, 
nore rhe follo'iYing guidelines for irs use with Macintosh System 7. 
See the manual that came with your communications program for 
more detailed information. 

• The Communications 'Iholhox has been integrated into 
System 7. 

• To usc communications tools with System 7. drag them to the 
Daensions folder in your System Folder (or to the System 
Folder icon). 

• \\'here\·er a program or irs documentation refers to the 
"Communications folder ... substiture the "Extensions Folder ... 
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Using Data Access Language 

If you are already familiar wirh Dara Access Language (DAL), nore 
the following instructions for its use with System - . For detailed 
information about using your DAL application, see the manual 
that came with the program. 

·ru use programs that search for the "hosts.CLl" Gle, do the 
following: 

1. Make a copy of the DAL Preferences file (in the 
Preferences folder in the System Folder). 

2. Rename the duplicate file: Hosts.CLl. 

3. Move the renamed file outside the Preferences folder, 
but leave it inside the System Folder. 

Use your program as you normally do. Whenever you make 
changes to one of these files, you must update the duplicate file. 



Chapter 14 

Expanding Your 
Macintosh System 
In this chapter 
• Connecting hard disks and other SCSI derices 

Installing a device driver 

Serring the SCSl !D number 

Attaching a SCSI device 

• Connecting a prinrer 

• Connecting a modem 

• Connecting an external Aoppy disk drive 

• Connecting a trackball or other ADI3 device 

• Connecting headphones or speakers 

• Connecting a microphone 

• Connecti ng add itional monitors 

• Installing expansion cards 

NuBus'" power requirements 

• Expanding memory 

Connecting hard disks and other SCSI 
devices 
Every Macimosh computer has a sockeL, or port. for connecting 
devices that use the Small Computer System Interface (SCSI, 
pronounced "skuh-zee"). The SCSI port permits high-speed 
communic:uion between the computer and the device. The SCSI 
icon appears above the pun on the computer's back panel. 

U I~ II Ill 9 ,-; - o 1 -t i ~ I 

0000000000000 ... 
o o o o o o o o o o o o 'ff- SCSI pon 
~:; ~ ~ !_~ !! ! 12ill9 lh l - lh 1; II 

~SCSI icon 

6 Important: f ollow the instructions in this section and the 
instructions that came with your hard disk or other SCSI 
device when connecting it to vour Macintosh. 6 
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SCSI devices commonly used with the Macintosh include hard 
disks, CD-HOM drives, scanners, primers, and tape backup drives. 

13y connecting SCSI devices to one another (in a "daisy chain"), 
you can have up to seven such devices, including an internal hard 
disk, connected to your Macintosh. Each device must have its 
own, unique 10 number. 

Setting up a SCSl device to use with your Macinrosh involves 

• installing any necessary device drivers 

• seuing the device's SCSI 10 number 

• physically attaching the device to your Macinrosh 

Installing a device driver 

To install a device driver: 

• Drag the device driver icon to the System Folder on 
your startup disk. 

Any device drivers needed for a SCSI device are usually on a 
Aoppy disk that comes with the device. (If no device drivers come 
with the device, then it doesn't need any.) You may have to resran 
your Macimosh to activate the device driver; which the computer 
needs to communicate with-or "drive"- the device. 
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Setting the SCSI ID number 

See the instructions that came with your SCSI device for 
information on setting its SCSI ID number. 

A Warning: Each SCSI device connected to your Macintosh 
must have its own, unique ID number between 1 and 6 so 
that your computer can distinguish it from other attached 
SCSI devices. Using two or more devices with the same ID 
number can cause them to malfunction. You could lose data 
as a result. • 

Give greater ID numbers to the devices you use more often. Your 
Macintosh uses the numbers to set priorities when it 
communicates with its SCSI devices (the greater a device's ID 
number, the higher its priority). 

lf you have an Apple SCSI device, set the SCSI ID number as 
fo llows: 

1. Make sure the device is switched off. 

2. Choose a number between 1 and 6 that hasn't been 
assigned to any other SCSI device connected to your 
Macintosh. 

Each device in a chain of SCSI devices connected to your 
computer must have its own ID number that distinguishes it 
from other devices in the chain. The ID number must be 
between 1 and 6 (if you have an internal hard disk, its ID 
number is preset to 0, and your Macintosh itself has the ID 
number 7). 



3. Insert a straightened paper clip into the small hole 
directly below the ID number indicator (usually on the 
back panel of the SCSI device). The small hole gives 
you access to the ID number switch. 

ID number switch 

4. Push the ID number switch repeatedly until the 
number you want appears in the ID number indicator. 

Attaching a SCSI device 

'Jo connect a SCSI device to your Macintosh: 

1. Thrn off your Macintosh. 

2. Make sure the SCSI device is switched off. 

A Warning: Do not connect or disconnect any device while the 
device or your Macimosh is wrned on. Doing so could 
damage the device, your computer, or both . .&. 

3. Make sure the device has its own, unique ID number 
between 1 and 6. 

4. Use a SCSI cable to connect the device either to the 
SCSI port or to the last SCSI device already in the 
chain. 

If the device is the first one in the SCSI chain (or the only one 
you're connecting), use a SCSI system cable to connect it to 

the SCSI port. 

If the device is not the fi rst one in the chain, use a SCSI 
peripheral interl~tce cable to connect it to the last SCSI device 
already in the chain. 

6 Important: The total length of a SCSI chain should not 
exceed6 meters (20 feet). !:::. 

COillilllleS ... 
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5. Make sure that the first device and the last device in the 
SCSI chain each have a terminator and that no other 
external SCSI device has one. 

To ensure accurate transmission of information, a terminator 
must be at each end of a SCSI chain. 

An internal hard disk, which is always the first device in the 
chain, has a built-in terminator. The Macintosh Classic, 
Macintosh LC, and Macintosh Ilfx have built-in terminators 
(whether or nor they have internal hard disks) . 

• If you have an internal hard disk, or if your Macintosh has a 
built-in terminator. you only have w make sure that the last 
device in the chain has a terminatOr and that no other 
external SCSI device has a terminator. 

• If you do nor have an internal hard disk or a Macintosh 
with a built-in terminator ;md are connecting your 
Macintosh to two or more external SCSI devices, you need 
terminators in the nrsr device and the last device, and none 
in between. 

• If you 're connecting your Macintosh to a single SCSI device 
(whether or nor you have an internal hard disk), make sure 
the device has a terminator. 

If you have a Macintosh IIfx, usc the black cable terminaror that 
came with your computer. Do not use any other terminators with 
or instead of the black cable terrninator. Also, you or your 
authorized service provider should disconnect or remove any other 
terminators built into your SCSI devices. Using terminators orher 
than or in addition to the black cable terminator may cause your 
SCSI devices to malfunction, and you may lose data as a resulr. 
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A SCSI device may have a built-in terminator. If a device that 's at 
the end of the SCSI chain does not have a built-in terminatOr, you 
need to auach an external cable terminator to iL 

SCSI tenninawr 

'lo find our if your SCSI device has a built-in terminator, go to the 
instructions tim came with the device. (External SCSI devices 
from Apple Computer do nor have built-in terminators.) Have 
your Apple-authorized service provider remove any extra built-in 
terminators. You can attach or remove cable terminators yourself. 

~ Important: Always turn on any eA'ternal SCSI devices 
connected ro your Macintosh before turning on the computer 
itself. Otherwise, your computer cannot recognize the SCSI 
devices. 6. 

Check the setup book rhat came with your Macintosh for any 
additional information on connecting SCSI devices. 



Connecting a printer 
Every Macintosh has a printer port, which you usc ro connect a 
printer ro your compmer. 

Primer port 

g-, --Primer pon icon 

The primer port accepts either a direct cable connection (to 
primers such as the lmageWriter II) or a network cable connection 
(to printers such as the LaserWriter liNT). Certain prin ters (such 
as the Personal LaserWriter SC) are connected through the SCSI 
port as a SCSI device. 

Follow the instructions that came with your printer when 
connecting it ro your Macintosh. 

A printer can also be connected to the modem porr. You use the 
Chooser program to indicate the port you used to connect your 
printer. (See Chapter 12, "Priming;' for more information.) 

Connecting a modem 
Every lvlacintosh has a modem port, which you usc to connect an 
external modem to your computer. (A modem is a device that 
allows your computer to communicate with other computers over 
standard telephone lines) . 

Modem port 

~~!odem port icon 

Follow the instructions that came wi th your modem when 
connecting it to your Macintosh. 

You can connect a modem to the printer port (if you're nor using 
it for a primer), but your Macimosh gives the modem porr priority 
over the printer port when it checks for data transfer activity. This 
priority bener ensures that any communications link your 
comruter establishes through the modem remains inracr. 
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Connecting an external floppy disk drive 
Some Macintosh computers have a disk dtive pan, "·hich you use 
ro connect an external floppy disk drive. 

W Disk drive pon icon 

Follow the insmiCtions that came with your external floppy disk 
drive when connecting it to your Macintosh. 

If your Macintosh does not have a disk drive port, you can buy an 
external floppy disk drive that attaches to the SCSI pan. 
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Connecting a trackball or other ADB device 
Ever>' Macintosh computer has at least one Apple Desktop Bus 
(ADB) porr, which you use to connect the mouse, the keyboard, 
and other in put devices such as a trackball, a bar-code reader, or a 
graphics tablet. 

·:· Ry tbe way: The :t' icon is often called the Apple Desktop Bus 
(ADI3) icon. You may sec this term in other places in the 
manuals that came with your com purer. ·:· 

~ADRr<>n 
~~ J\DB pon icon 

By connecting ADB devices to one another (in a '·daisy chain·'), 
you can have up to three such devices connected ro a single ADB 
port. The exact number depends on how much power the devices 
require. 

6. Important: The total power used by all Apple Desktop Bus 
devices connected to your Macintosh must not exceed 
500 milliamperes (mA). Information about the power 
requirements of your mouse and keyboard arc in the setup 
book that came with your Macintosh. Sec the instructions that 
came "·ith any other ADB device if you need information on 
its power requirements. 6 



Connecting headphones or speakers 
Every .\lacinrosh computer has a sound OU[put port, which you 
use to connect speakers, an amplifier, headphones, or other audio 
output devices to your computer. The sound output port accepts 
a standard stereo mini plug, like that used to attach headphones to 

a portable stereo audio cassette player. 

@-~"""'"'"""' pon 

q )))--Sound outptl[ icon 

Connecting a microphone 
Certain Macimosh models (such as the Macintosh LC) have a 
sound input port, which you usc to connect a microphone or 
other sound source to your computer. The sound in pur port 
accepts a standard miniplug. 

(@)-- so .. nd '"""' poo 

Q-sound input icon 

See the setup book that came with your Macinrosh for additional 
information on the sound input port. 

Sec Chapter 11, '1\dapting Your Macintosh to Your Own Use,'' for 
information about recording sound on your Macintosh. 

Chapr<.:r 1·1: Expanding Your Macintosh System 219 



Connecting additional monitors 
Mosr i\lacinrosh computers accept video cards rim lcL you 
connect additional monitors. Your first monitor may be built-in 
(as in the Macintosh Classic) , connected to a built-in mnniror pon 
(as in the Macintosh Ilci), or connected to a video card installed in 
a NuBus slot (as in the Ivlacinrosh ITfx) . See the setup book rim 
came with your computer for information on installing video 
cards. 

·:· Note: The monitor port is also sometimes referred to as the 
rideo port. ·:· 

When you set up acid it ional monitors: 

• ~lake sure rim rhe venrilarion openings on rhe com purer and 
the monitor arc clear and unobstructed. 

• Some large monitors can nor safely be placed on top of the 
1\ lacinrosh. Check the instructions that came with the monitor 
for setup information. 

• If there is interference on your screens or on a telerision or 
radio near your ~lacinrosh, more the affected equipment 
farther aparr. 

See Chapter J .1 , "1\dapting Your ~1acinrosh tO Your 0\vn Use,·· for 
information on configuring multiple monitors in the Monitors 
control panel. 
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Installing expansion cards 
All \lacimosh computers except the ~lacinrosh Classic accept 
primed circuit boards (called cards) for video and graphics 
applications, networking and communications, additional 
processing power, and other purposes. The cards fit into 
connecrors, called e.\jJcmsion slots, inside rhe computer. 

~ Important: Sec your setup book for information on installing 
expansion cards. Some cards may need to be installed by an 
authorized Apple service JXO\·ider. ~ 

Like all electronic componenrs. expansion cards generate hear. If 
~~ou install several cards in your \lacimosh. leave as much room as 
possible bet\\ ccn cards and between cards and ot her internal 
components. 

~lacintosh expansion slors come in t\YO rypes: 

• i\uBus slots, ,,·hich accept \'uBus expansion cards 

• Processor-direct (or memory cache) slots 



All Macintosh II models have at least one NuBus slot. (An optional 
slot adapter is required in the Macintosh llsi.) In the models that 
have a processor-direct or memory cache slur (such as the 
~lacimosh LC and the Macintosh llci). only one such slot is 
available. 

A Warning: Before your remove the lid, be sure ro turn off 
your ~'lacinrosh. Install an expansion card only in the slot 
designed to accept iL. Failure to clo so could damage the card 
and your computer. NuBus cards fit in any NuBus slot, but a 
processor-direct or memory-cache care! is often designed only 
for a specific i\llacintosh model . .& 

NuBus power requirements 

The combined power consumption of all installed Nul3us cards 
must not exceed the limits specified for ~~ou r Macintosh model. ff 
vou have rwo or three \JuBus cards installed or arc concerned 
about the amount of power consumed by a particular card, make 
sure that your Nul3us cards· power mnsumption is \\'ithin 
specified limits. 

1. Find out the power consumption (in amperes) of each 
NuBus card you have installed by checking its technical 
specifications. 

\JuBus cards clrm\· power from three t~'pes of current: 

• +5 volr 

• + 12 mit 

• - 12 volt 

2. Calculate the total power consumption in each type of 
current of all installed NuBus cards. 

3. Find out the maximum power consumption for all 
NuBus cards specified tor your Macintosh by checking 
the setup book that came with your computer. 

.A Warning: Do not exceed the maximum power consumption 
for all Nul3us cards specillcd for your computer. Doing so 
could damage your cards, your Macintosh, or both . .& 
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Expanding memory 
The random-access memory (RANI) in your Macintosh can be 
expanded by adding Single In-Line Memory modules (or SIMMs) 
to those already installed or exchanging installed modules for 
ones that have greater storage capacity. (Some Macintosh models 
also accept memory expansion through the installation of a 
memory card.) 

222 Chapter 14: Expanding l'<>ur Macintosh System 

Make sure that SIMMs you purchase for memory expansion are 
the correct ones for your Macintosh. See the setup book that 
came with your computer for more information. 

A Warning: Memory expansion on the main circuit board 
should be installed only by an Apple-certified technician. 
Consult the service and suppon information that came with 
your computer for instructions on how to contact an Apple­
authorized service provider or Apple for service. Modification 
of the circuit hoard by anyone except a qualified technician 
voids your warranty and could damage your computer . .A. 



Chapter 15 

Care and Maintenance 
In this chapter 

• I land ling system components 

Monitor 

Keyboard 

Floppy disks and drives 

Power supply 

• Cleaning system components 

Cleaning the mouse 

• Maintaining the proper operating environment 

• Changing the clock battery 

• Service and support 

Handling system components 
Follow these guidelines when setting up and using your 
Macintosh computer and its components: 

• Handle all components with care. 

• Place components on a sturdy, fiat surface. 

• Carefully follow all setup instructions. 

• Always hold a cable by its connector (the plug, nmthe cord) 
when connecting or disconnecting it. 

• Never force a connector into a port. If connector and port do 
not join with reasonable ease, they probably do not match. 
Make sure that the connector matches the port and that you 
have positioned the connector correctly in relation to the 
port. 

• 'H.1rn off your Macintosh and all its components before 
connecting or disconnecting any cables to add or remove any 
component. Failure to do so could seriously damage your 
equipmem. 
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• Take care nor ro spill any food or liquid on rhe computer, 
keyboard, mouse, or or her componenrs. If you do, turn your 
!llacinrosh off immediately and unplug it before cleaning up 
the spill. Depending on what you spilled and how much of it 
gor into your equipment, you may require service. Consult 
the service and support information that came with your 
computer for instructions on how to conracr an Apple­
authorized service provider or Apple for assistance. 

.A. Warning: Plug the power cords for the Macimosh and its 
components only into three-prong, grounded outlets. The 
computer's grounding-type plug is a safety feature. Do nor 
defeat rhe purpose of this plug. Disconnect the power plug if 
it becomes frayed or otherwise damaged . .._ 

Monitor 

Follow these procedures whether your Macintosh has a built-in or 
a separate monitor: 

• Tl.lrn clown the screen contrast control if you leave the 
Macintosh wrned on for extended periods. This prevents 
the image on the screen from "burning in" and damaging the 
screen. 

You can also use a '·screen saver" program, which dims or 
varies the image on the screen when the Macintosh has been 
idle for a specified period of time. These programs are 
available from independent suppliers and user groups. 
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• Make sure that the ventilation openings on the computer and 
the monitor are clear and unobstructed. 

• Some large monitors cannot safely be placed on top of the 
Macintosh. Check the instructions that came with the monitor 
for setup information. 

• If there is interference on the monitor's screen or on a 
television or radio ncar your Macintosh, move the affected 
equipmem farther away . 

Keyboard 

Take care not to spill any liquid on the keyboard. If you do, turn 
off your Macimosh immediately. 

• If you spill liquid that is thin and clear, unplug the keyboard, 
turn it upside down to let the liquid drain out, and let it dry 
for 24 hours at room temperature. I f, after you take rhese 
steps, the keyboard doesn't work, consult the service and 
support information that came with your computer for 
information on how to contact an Apple-authorized service 
provider or Apple for assistance. 

• If you spill liquid that is greasy, sweet, or sticky, unplug the 
keyboard and contact an Apple-authorized service provider 
or Apple for assistance. 



Floppy disks and drives 

Sture disks at 
temperawres 
bet 1\t:L:Il 'i0°F 
and 12't f. 

l21°F (52"C) 

~ 
51n ' ( I0°C) 

Do not touch the 
exposed pan of the 
disk behind the 
metal shwter. 

Do not usc 
an er·aser 
on a d1sk label. 

Keep disks all"av 
from magnets. 

Keep disks drv. 

\I; 

~ 
Avoid exposing 
disks to extremelv 
hot temperatures. 

Power supply 
The power supply in your :VIacintosh is a high-voltage componenr 
and should nm be opened for any reason, even when the 
computer is off. If the power supply needs service, consult Lhe 
service and support information thar came \\·irh your com purer 
for information on how to contact an Apple-authorized service 
provider or Apple for assistance. 

Cleaning system components 
To clean the outside of your Macintosh and its components: 

• Use a damp, soft, lint-free cloth LO clean Lhe computer's 
exterior. Avoid gerring moisture in anv openings. 

• Don't use aerosol sprays, solvents, or abrasives. 

• 'lo clean the screen, put household glass cleaner on a soft 
cloth and wipe the screen. Don't spray the cleaner directly on 
the screen, because the liquid might clrip into the monitor or 
computer. 
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Cleaning the mouse 

The mouse conrains a small ball that musr roll smoorhly for the 
mouse m work properly. You can keep this ball free of din and 
grease by using the mouse on a clean , lint -free surface and 
cleaning it occasionally. 

You need a few corron swabs, alcohol, and a dean, sofr, lint-free 
cloth. 

1. Turn off your Macintosh. 

2. Thrn the mouse upside down and remove the plastic 
ring on the bottom that holds the ball. 

The plastic ring comes in two types. You remove one by 
turning it counterclockwise; you remove rhe other by pulling 
the ring downward until it pops our. 
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3. Turn the mouse right side up with one hand and catch 
the ring and the ball with your other hand. 

4. Clean the three small rollers inside the mouse with a 
cotton swab moistened with alcohol. 

Rotate the rollers to clean all around them. 



;. Wipe the mouse ball with a clean, soft, dry, and lint­
free cloth. 

Don't usc any liquid to clean the ball . 

6. Gently blow into the mouse case to remove any dust 
that has collected there. 

7. Put the ball and the ring back in place. 

Maintaining the proper operating 
environtnent 
In general , any conditions in which you arc reasonably 
comforrable should he fine for vour Macintosh. 

• See the setup book Lhat came with your computer to Rncl out 
the range of temperature and humidity that your Macintosh is 
designed to operate \\·ithin. 

• Protect the ~·lac intosh and its components from direct 
sunlight and rain or other moisture. 

• Keep all ventilation openings clear anclunobsrrucred. Without 
proper air circulation, components can overheat, causing 
damage or unreliable operation. 

Changing the clock battery 
Every Macintosh computer has a clock that runs continuously. 
When the computer is turned off, a banery keeps the clock 
running. 

If your clock begins to keep time inaccuratelv, consult the service 
and support in format ion that came with your computer for 
instructions on how to contact an Apple-authorized service 
provider or Apple for assisrance. 
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Chapter 16 

Tips and Troubleshooting 
In this chapter 

• Gerring the best-looking fonts 

• · 1 ~1k i ng a "snapshot'' of the screen 

• When you run in ru trouble 

l ;tkc your time 

Start nverRcbuilcl your desktop regularly 

l{ebuild your desktop regularly 

Solutions to co111mon problems 

Getting the best-looking fonts 
·ro have fonts look their best on the screen, install bit mapped 
fnnrs in the sizes you usc most often. And for the closest match 
between displayed fonts and printed fonts, install the 
corresponding bitmappecl fonts when you install PostScript 
outline fonts. 

Your Macintosh looks for either outl ine fonts or bitmapped fonts 
to use depending on 

• whether the font is clisplayecl on the screenm prin ted on a 
primer, and 

• whether (i f the font is primed) the printer is equipped tn 
handle PostScript (a programming language that describes the 
charaCLers, syrnhnls, ancl images appearing on each page of a 
document) 
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When you prim a documenr on a Pos1Script primer (such as the 
LaserWriter liNT), the system software looks for the fonrs you use 
in the following places, in order: 

1. PostScript outline fonrs in the printer's permanent memory 
(R0~1) 

2. PostScript outline foms in the primer's temporary memory 
(RAM) 

3. PostScript outline fonts in any hard disk connected to the 
primer 

' 1. PostScript outline fonrs in your System folder 

5. 'li·uel~-pe outline fonts in your System Folder 

6. bitmapped fonts in your System folder in the correct size 

7. bitmapped foms in your System folder in a differenr size that 
can be reduced or magnified ru roughly approximate the 
correct size 
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When you print a document on a primer that docs nor recognize 
PostScript (such as the Personal LaserWriter SC), and when the 
Macintosh displays fonts on the screen, the system software looks 
for rile fo111s as follows: 

1. biunappcd fonts in your System Folder in the correct size 

2. TrueType outline fonts in your System Folder 

3. birmappecl fonts in your System Folder in a different size rhar 
can he reduced or magninecl to roughly approximate the 
u >!Teet size 

Taking a "snapshot" of the screen 
You can capture the image on the screen by pressing ~-Shifr-3 . 

The image is saved as a graphics file, which can be opened in 
many programs that handle graphics (including rhe TeachTe:-.1 
program that 's supplied wi th the system software). 

The graphics Ales arc named '·Picture 1, .. "PicLUre 2, .. and so on. 
The number of screen images you can rake is lim ired only by 
available disk space. 

When you run into trouble 
f or sperinr troubleshooting infonnarion related ru a particular 
procedure, go to the chapter that describes the procedure. 



Take your time 

When you sec an error message, you don't have to take action 
immediately. The message srays on the screen until you click the 
OK burton or turn off rhe Macintosh. 

To help diagnose and correct the problem, gather as much 
information about the siLUation as you can before starring over: 

• Make a note of exactly whar you were doing when rhe 
problem occurred. Wrire clown the message on the screen and 
its ID number (if any) as well as the programs you were using 
and the names of any items you know have been added ro rhe 
System Folder since the system software was installed. This 
information wi ll help a service person diagnose rhe problem. 
If you need repair service, consult the service and support 
information that came with your computer for instructions on 
how to contact an Apple-authorized service provider or Apple 
for assistance. 

• Check the screen for any clues. Is a menu selected? What 
programs and document icons are open? Note anything else 
that seems relevant. 

• If you were typing text and w·ere nm able to save iL before the 
problem occurred, you can write clown the parts of the text 
still vis ible on the screen so that some of your work will be 
easy to replace. 

• Ask other Macintosh users about the problem you're having; 
they ma~' have a solution for iL 

Start over 

Often you can eliminate a problem simply by clearing rhe 
computer's memory and starting over. 

If you can, save any open documents before restarring the 
Macintosh. If your system is "frozen" and does nor respond to any 
input, or if you have a "bomb" message on the screen, saving may 
not be possible. You can try pressing :l€-Oprion-Esc to quit the 
program in use when the problem occurred; if this works, you can 
then save the documents open in other programs before 
restarting. 

To restart your Macimosh, try the following steps: 

1. If you can, choose Restart from the Special menu or 
from the dialog box that's on screen. 

2. If you can't choose Restart, hold down the :l€ and 
Control keys while you press the Power On key. 

3. If nothing happens, look for the reset and interrupt 
switches on the front or side of your Macintosh and 
press the reset switch (the one marked with a triangle). 

Nor all Macimosh models have reset and interrupt switches, 
which are usually installed as a unit when the computer is Arsr 
set up. 

Pressing the reset switch is like turning rhe power switch off 
and on. (The interrupt switch is intended for use by 
programmers who have debugging software installed.) 

COillilllleS ~ 
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4. If pressing the reset switch does nothing or if your 
Macintosh does not have a reset switch, turn off your 
computer using the power switch, wait at least 10 
seconds, then turn it on again. 

; . If the power switch doesn't turn off the computer, 
unplug your Macintosh. 

If you suspect rhar rhe problem is wirh a peripheral device, such 
as a primer or external hard disk, rurn ir off for 10 seconds or 
more, rhen turn it on again and rest.an the Macinrosh. 

Rebuild your desktop regularly 

A process known as "rebuilding the desktop" helps your 
Macimnsh keep track of clara on your stanup disks. 

• To rebuild the desktop of a startup disk, hold down the 
Option and :J€ keys while starting up your computer. Keep 
holding down the keys unril you see a message asking 
whether you want to rebuild rhe desktop. Click OK. 

• Rebuild the desktop of your startup disks once a monrh or so. 
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Solutions to common problems 

The computer is turned on but the screen is dark 

The J\tlacinrosh or the monitor is not gerti ng power, or the screen 
is adjusted too dark. 

• Check that the power cord is plugged in and fi rmly connected 
to the computer and that rhe electrical ourlet has power. 

• If you have a separate monitor, check rhar rhe monitor is 
turned on. 

• Check the screen's brightness conrrol and rum ir up if 
necessary. 

• If you use a screen saver program, press a key or move rhe 
mouse to turn ofT the screen saver. 



\Vben you start up, an icon appears in tbe middle 
of tbe screen and tbe desktop doesn't appear 

The system soft\\arc is not insralled on rour hard disk or your 
hard disk is not \\urking properly. 

\\"hen y·ou 1 urn 0 11 1 he 1\lacintosh. one of these icons appears in 
the middle of the screen: 

• Tile ·'happy ~l ac in t osh ' ' icon indicates that yrour Macintosh 
has found a srarrup disk (which has the system software 
installed in rile System Folder) ancl is stan ing up. 

8] 
• The disk icon wirh a blinking question mark indic:ues that 

your J\ lacintosh c1nnot find a stan up disk. If you inserred a 
floppy disk. m if you have a hard disk installed, vour 
,\ lacilll osh doesn't recognize that disk as a stan up clisk. 

m 

Cse the system software disk labeled Disk Tools to stan up 
rour ~ Iacinrosh. (See "Starr ing l 'p \\"ith a Floppy Disk .. in 
Chapter 8 . .. Scning Lp Your ~ ladnwsh Sy·stem ... and .. '!b ring 
and 1\epairing Disks" in Chapter 9, "liard Disks and floppy 
Disks, .. for insrrucrions on starring up " ·ith a floppy disk and 
repairing damaged disks.) 

• The disk icon with an X appears when your Macintosh ejects a 
floppy disk that is nor a startup disk. 

UKJ 
• The .. sad Macintosh·· iron appears when your Macimosh 

cannor starr up because of a problem wi th the system 
software or possibly the computer hardware. 

~ 
c::::::::l 

Eject any floppy disks by turning off the computer and then 
holding clo"·n the mouse button while you turn the computer 
on again. 'li·y starring up \\·irh a diiTerem startup disk. lf the 
"sacl.\lacinrosh .. icon appears again. consult the sctYice and 
suppon information 1 hat came with your com purer for 
instructions on how to contact an Apple-al1!horized serrice 
pro\·icler or Apple for assi~tance. 
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The pointer doesn't move when you move tbe mouse 

The mouse is not connected properly or its signals are not 
reaching t.he comput.er. 

• Turn orr the computer using the power switch, then check 
that the mouse cable is connencd properly. 

• Clean rhe mouse. (See Chapter 15, "Care and Maintenance.") 

• Hesrarr rhe Macintosh with a different startup disk. If the 
pointer srill cloesn·t move, consult t.he service and support 
information that came with your computer for instructions on 
how w conran an Apple-authorized service provider or Apple 
for assistance. 
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Ijping on the keyboard produces nothing on tbe screen 

The insertion point hasn't been set., no rext is selected, rhe 
keyboard is nor connected properly, or irs signals are not reaching 
the computer. 

• Make sure the program you wam m type in is rhe active 
program. 

• Place rhe poimer in the active window and cl ick to ser an 
inserLion poinr or drag to select text (if applicable) . 

• Turn off t.he computer, rhen check rhar rhe keyboard cable is 
connect.ecl properly ar both ends. 

• If the connections are secure and typing still yields no results, 
shur down and turn off the Macintosh, rhenunplug rhe 
keyboard cable. Connect the cable to the orher Apple Desktop 
Bus port. on the computer and the orher ADI3 port on the 
keyboard. (l'bu may have to unplug the mouse ro do rhis.) If 
typing still shows nothing on the screen , rhe problem is mosr 
likely in the keyboard itself. 

• Rest.an the Macintosh '\Vith a different startup disk. If typing 
sti ll doesn't produce text on the screen, consult the service 
and support. information thar came with your computer for 
instructions on how ro conracr an Apple-aurhorizecl service 
provider ur Apple for assistance. 



r\ dialog box witb a bomb appears 

Your system has a sofl\varc problem. 

• Write clown what ~·ou were doing when the message 
appeared, and \\Tite clown the number on the message. if 
there is one. 

• Restart your i\ilacimosh (see "Sran Over·· earlier in this 
chapter). 

• Check the stanup disk and program you were using when the 
message appeared. Make sure that all programs, desk 
accessories, and system extensions you're using are 
compatible with the system software. Reinstalling the system 
software may correct the problem. 

• Somet imes incompatible system extensions or control panels 
can cause system soft ware problems. Restart while holding 
down the Shift key; this disables all syst em extensions. I f 
startup is normal with this method, then remove all 
extensions and put them back inro the System Folder one at a 
time, starting up after you add each extension. This procedure 
should iclent ify any incompatible extensions. 

'nJe pointer "freezes" on tbe screen 

Your system has t1 soft,rarc problem. 

• Press :t€-Option-Esc to close the program in usc when the 
problem occurred. If this works. you can then s;l\·e 1 he 
documcms open in other programs before rcsraning. 

• Restart your ~lacimosh (see "Stan Over .. earlier in this 
chapter) . 

• Check the start up disk and program you were using when the 
message appeared. ~lake sure that all programs. desk 
accessories, and system extensions you 'rc using are 
compatible wi th 1 he system software. Reinstalling the system 
software may correct the problem. 
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lour program quits une:>.pectedly 

The program needs more memory than your !'vlacinrosh has 
available, or the program requires a floating-poinr unit (FPU) and 
vour Macintosh doesn't have one. 

• Quit from the programs that you have open and then open 
the program you want to use. or restarr your Macintosh. 

• Check the documentation that came \\'ith the program ro find 
our if the program requires a Macintosh ~·irh an fPU, and 
check rhe setup book that came ~·ith your Macimosh to find 
our if your computer is equipped with an FPU, or if an FPU 
can be installed. Consult your authorized service proricler for 
information aboll[ installing an FPU in your compll[er. 

2.)6 (haprer 16: Tips and Troubleshootiug 

You see a message lbal an application program can't be found 

The dialog box below appears if you try lO open a file created 
using software tim is not on your system. 

e The document " Vour File" could not be 
opened, b ec11use the application program 
th11t cre11ted it could not be found. 

roo 

~ormall ~', you see this message if you try ro open a file that came 
from another Macimosh \\'ith software that is differem from yours. 

• Purchase the correct software to use the file and insta ll it on 
your system, or find our if the original owner of the file can 
convert it to a form that vour svstcm·s software can use. 

• Don't try to open files in your System Folder. Most of the 
System Folder Illes Ctre used b~, your computer for inrernal 
purposes, and are nor imenclecl to be opened. 

• Rebuild your deskrop. Rebuilding your desktop helps your 
Macintosh keep track of files. See ·'Hebuild Your Desktop 
Regularly, .. earlier in this section. 



Summary 

Working on the 
Macintosh Desktop 
In this chapter 

• Using the mouse 

• Working with icons 

• Working wi th windows 

• Working with menus 

• Keyboard shortcuts in the Finder and in directory 
dialog boxes 

• Working with disks 

• Working with programs 

Using the mouse 

Point 

• Point to an object on screen by moving the mouse so 
that the pointer is over that object. 

When the pointer is an arrow, the rip of the arrow must be 
over the object. 

Click 

• Click an object on screen by pressing and quickly 
releasing the mouse button while the pointer is over 
that object. 

Clicking an object selects it. 
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Drag 

• Drag an object on screen by pointing to that object and 
holding down the mouse button while you move the 
mouse. 

Dragging an object from one disk Lo another copies it, 
dragging an object from one place LO another on a single disk 
moves it within that disk wirhour making a copy, and dragging 
an object to the Trash throws it away. 

Press 

• Press by holding down the mouse button without 
moving the mouse. 

Pressing a menu name opens the menu. 
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Double-click 

• Double-click an object on screen by pointing to the 
object and clicking twice in rapid succession, without 
moving the mouse. 

Double-clicking is a common shoncuL for opening an icon or 
the selected item in a directory dialog box. 

Shift-click 

• Hold down the Shift key while clicking. 

Shift-clicking is a way to select more Lhan one icon or item 
in a list 



Working with icons 
Icons on the Macintosh desktop represent disks (floppy disks and 
hard disks) and files (programs and documents). When you open 
an icon, its window appears, showing you what's "inside" the disk 
or file. 

Selecting icons 

To do this 

Select an icon 

Deselect an icon 

Select multiple icons 

Deselect an icon in a 
group of selected icons 

Select multiple icons 
that are near each other 

Select contib'lious icons 
in a list 

Select te.'\1 in. an icon's 
name 

'Jake these steps 

Click the icon. 

Click anywhere except the sdccted icon. 

While holding clown the Shift key, dick 
each icon. 

While holding down the Shift key, dick 
the icon. 

1. Place the pointer ar one corner of the 
group of icons. 

2. Drag diagonally to select the icons, then 
release the mouse button. 

1. Plarc the pointer to the left of the top icon 
or the bottom icon. 

2. Drag up or down the list, releasing the mouse 
button when thc pointer is left of the last icon. 

1. Click the icon's name to select it. 
2. Place the pointer at one end of the te.xt 

to be selected. 
3. Dr&g to select the text, then release the mouse 

button. 

Opening an icon 

You open an icon by selecting it and choosing Open from the File 
menu or using the keyboard shortcut :1€-0 or :!€-Down Arrow. Or 
you can double-click the icon. 

Moving, copying, and renaming an icon 

1b do this 

Move an icon 

Copy an icon onto 
another disk 

Copy an icon on the 
same disk 

Rename an icon 

'lake these steps 

Drag the icon to where you want it. 

Drag the icon to the icon of the other disk (or to 
an icon or window that belongs to that disk). 

1. Click the icon to select it. 
2. Choo~c Duplicate from the File menu, or 

press 3€·0. 
3. l f you wish, rename the icon and drag it to a 

new location. 
You can also make a copy by holding down the 
Option key while you drag the file's icon to 
where youwam the copy. 

!. Select the icon's name by clicking the name 
(not the icon). 

2. 'type a new name and press the Return key. 
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Storing icons in a folder 

Drag the icons to the folder until both the icons and the folder are 
selected, and then release the mouse button. 

Removing an icon 

You remove an icon from the desktop or any Finder window by 
dragging it ro the Trash. To erase the contents of the icon from 
your disk, you choose the Empty Trash command from the Special 
menu. 

The Trash displays a warning before its contents are discarded. 
You can't throw away a locked file or an item that's currently in 
use. 
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Working with windows 
A window appears when you open an icon w show you what's 
"inside" the icon. 

Making a window the active window 

You make a window active by clicking inside it. You may have to 

move or resize other windows if the one you want to make active 
is covered by other windows. You can also make a window acrive 
by dicking its icon (even though it's dimmed) and choosing Open 
from the File menu, or by double-clicking the dimmed icon. 



Moving a window and changing its size 

1b do this 

Move a window 

Resize a window 

Close a window 

Take these steps 

~ 
~--"' 

d
. 

n-. 
. 1al 

Ell~ 
-~ 

lvailable 

Drag the window's title bar (at the 
top of the window) to the new 
location. 

Orag the size box (in the 
lower-right corner). 

Or click the zoom box (in the 
upper-right corner). 

Click the close box (in the 
upper-left corner). 
Or choose Close from the File 
menu. 
Or press 3€-W. 

Scrolling through the contents of a window 

i~D 
12 ittmJ 

tm 
Sys tfom Folder 

D 
For ChannU'IQ 

D 
From Andy 

g 
D 

Not~s-Ki tl? 

Q 
D 

Trees 
II .:'SMBlndtsk 

0: 
7.5 M8 i v.u \iblt 

LJ 
Apphe~hont t Scroll box (shows 

relative location 
in window) 

;!;ll 

11!:! 

r~~l! 
Sarah's r~port '~;!; 

;:;;j 

D 
R:f-por ts/Liu 

D 
~ 

Tu ehTt x t 

r orMimi 

lOT 

I Scroll arrow (used 
to view the conrem 
beyond the 
window's borders) 

·:·;· 

1

:·':! 
;i:!;! 

~ 
101121 

I Every window has two scroll bars, one for vertical 
scrolling and one for horizontal scrolling. (A gray 
scroll bar indicates more conlcnt beyond window's 
borders; a clear bar indicates all comcm is visible.) 

• Click the up, down, left, or right scroll arrow. 

• Click the vertical or horizontal scroll bar (when it's 
gray). 

• Drag the vertical or horizontal scroll box along its 
scroll bar. 
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Opening higher-level folder windows 
You can open a higher-level folder window (whose contents 
include the active window) from a pop-up menu in the active 
window's title. 

1. Hold down the~ key as you press the active window's 
title. 

A pop-up menu of the higher-level folders (and disk) appears. 

2. Drdg to choose a higher-level folder (or the disk), and 
then release the mouse button. 

The folder (or disk) window you chose appears as the active 
window. 

Open pop·up menu with the 
name of the active window 
at the top ("Old reports") 

~~~~~~!!I.~~~~~~~~~~=~-Active window showing 
F' the contents of the folder 

named "Old repnrL~" 

D J~rem~J · st.tus 6/20 

This folder contains the folder "Old reports." 

If you hold down the Option key as well as the ~ key, the old 
window closes when the new window appears. 
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Using the outline form in list views 
Any list view you choose from the View menu (that is, any view 
except the icon and small icon views) shows the contents of the 
active window in outline form. You can see the contents of a 
folder without opening the folder in it<; own window. 

m 

Open folder (with contents 
indented helow) 

JH doto/ 2 • 
Narn. 

:El:i 
Sin· Kind 

v L.J Ad idus - fold~..- ~ 
D listvi~w 7K document 

~ 
Q scr~t>n shots -- fo1dttr 

I D scmnt t4K docum•nt Open folder inside 
0 casp.;r maps - - fold•r another folder 
D cr edit union account 17K dooumMt . j 
D R••d M• tK r • .,hr •• t d~ ~Wil l contents 

I> 0 Sor .. ns 3K alias tnclell!ecl below) 
<3; Te-achT~xt 43K applioaUon pr ~ 

'¢ '''\'/::::::i::::::~\''''''' '''''' ;:::\i:':i:i:f'i'il:':;:;::::.;\.;;:;w;:;:::,:::;:::,:::;:;:;:c;::::::::::::)i.l.;; l2l 

A downward-pointing triangle indicates that the folder's 
contents are displayed; a right-pointing triangle 
indicates that the folder's contents are not displayed. 

Click the triangle next to a folder name to display or hide the 
folder's contents in the active window. 

If you double-click a folder, it opens in its own window, and its 
outline view closes. 

·:· Shortcuts: When a folder is selected in an outline view, 
pressing ~-Right Arrow displays the list of its contents and 
~-Left Arrow hides the list of its contents. ·:· 



Working with menus 
Macintosh menus come in two types: pull-down menus and 
pop-up menus. The menus in the menu bar are pull-down menus. 

Dimmed command 
(not available) 

The Help menu, which 
you use to display 
information about items 

the screen 

The 

menu, which 
shows the 
programs that 
are currently 
open 

Menu commands 
affect whatever you've 
sclenect- in this case, 
"Hard disk #2." 

Pop-up menus often appear in dialog boxes tl1a[ you use to set 
options or preferences. You can recognize a pop-up menu by a 
small solid triangle, poiming clown, next to its name. The name 
shows the current option or preference. 

Pop·up menu (closed) 

1iiiii~~~-Sij-::::::i_ Ciicking the triangle 
App. prZograms = w althrop displays the menu 

D Art ideas (but does not allow 
D art- 1 o/4 [ 1: Je< t ) you to choose a 
D Car info · , ) 
D Caspar maps [ Desk top ) menu I tern . 
D credit union accou t ··------··----····-

D Enuelopes n Open )J 
o Glossary • . 
o JH as writer [ Cancel J 

Clicking the menu title or the icon displays 
the menu and selects the title (allowing you 
to choose a menu item by dragging to it). 
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Choosing an item from a menu 
l b choose a command from a menu, point to the menu name, 
press to "pull down" or "pop up" d1e menu, drag to the item you 
want to choose so thaL it's highlighted, and then release the 
mouse button. 

Choosing an item from a submenu 

Some menu items are submenus. A submenu name has a small 
solid triangle next to it, pointing to the right. The submenu opens 
when the submenu name b highlighted. 

To choose an item in a submenu: 

1. Point to the menu name and press to pull down or pop 
up the menu. 

2. Drag to the menu item so that the submenu appears. 

@ [j)(i)fl[i){l 

v>U ffi 
u~ 
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3. Drag sideways to the submenu, drag down to the 
submenu item you want to choose so that it's 
highlighted, and then release the mouse button. 

@ [j)(i)fl [i){l 

v>Uffi 
u~ 

Underline 
mmunnmm 
~llJf.::J([)(!)[!!J 



Keyboard shortcuts in the Finder and 
in directory dialog boxes 
Key 

Up, Down, left, 
or Right Arrow key 

Tab key 

Character 
key (a, b, c ... ) 

:J:€- Down Arrow 

:J:€-Option-Down Arrow 

:J:€- Up Arrow 

:J:€-Option-Up Arrow 

Return or Enter 

Action 

Selecrs rile next ircm in rhe direction of rhe 
arrow 

Selects the next item alphabetic:111y (except in a 
directory dialog box anu the Chooser) 

Selects the first item whose name begins with 
that characrer (or the character following 
closest to it in the alphabet) 

Opens the selected icon 

Opens rhe sclectccl icon anu closes the current 
folder 

Opens the folder that contains the current folder 

Opens the folder that contains the currenr 
folder and closes the currenr folder 

In the Finder: Selects the selected icon·s name 
for editing or saves the edited name 

In a dialog box: the same as clicking the button 
with the bold outline around it 

Working with disks 
See Chapter 9, "Hard Disks and Floppy Disks," for more 
information about using disks. 

Inserting a floppy disk 

1. Hold the disk between thumb and forefinger, with the 
label facing upward and the metal shutter pointing 
away from you. 

2. Gently push the disk into the floppy disk drive, label 
side up and metal shutter first. 

Copying the contents of a disk 

1. Click the disk icon to select it. 

2. Dr.tg the disk icon to the icon that represents the disk 
where you want the copy made until both disk icons 
are selected. 

3. Release the mouse button. 

Respond to any messages that appear by clicking the 
appropriare buuons. 

·!· Note: You cannot copy the set of System 7 software disks 
this way. Certain files on the disks cannot be dragged to a 
new disk. ·:· 

Summary: Working on the ~lacintosh Desktop 245 



Removing a floppy disk from the disk drive 

1. Click the disk icon to select it. 

2. Choose Put Away from the File menu. 

3. When the floppy disk drive ejects the disk, remove it 
from the disk drive. 

You can also drag rhe disk icon to the Trash. This action ejects the 
disk; it does not erase the disk. 

Locking and unlocking a floppy disk 

1. Hold the disk between thumb and forefinger, with the 
label facing upward and the metal shutter pointing 
away from you (as if you were going to insert the disk 
into a drive). 

2. Find the square hole in the lower-left corner of the 
floppy disk. 

3. Lock the disk by sliding the tab on the back side of the 
disk so that the square hole is open. 

Unlock the disk by sliding the tab back so that the 
square hole is blocked. 
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Working with programs 
For specific information about a panicular program, go to the 
manuals that came with the program. 

Saving your work 

• Choose Save from the File menu, or hold down the 
~ key as you press the S key. 

Switching programs 

• Click anywhere in a window to make it the active 
window and its program the active program. 

You can also choose the program from rhe Application menu. 

Closing a document 

• Click the close box of the document window near the 
left end of the title bar, or choose Close from the File 
menu. 

Hesponcl to any messages that appear by clicking the 
appropriate buttons. 



Quitting a program 

• Choose Quit from the File menu, or bold down the 
:t~: key as you press the Q key. 

Respond to any messages that appear by clicking the 
appropriate burtons. 

Backing up your files 

1. Click to select the icon of the document or program 
you want to back up. 

2. Drag the icon to the disk icon where you want to store 
the backup copy until both icons are selected, then 
release the mouse button. 

Respond ro any messages that appear by clicking the 
appropriate buttons. 

Making a copy of a file 

1. Click to select the file icon. 

2. Choose Duplicate from the File menu. 

Saving another version of a document 

1. Open the document. 

2. Make the changes you want in the new version. 

3. Choose Save As from the File menu. 

4. Type the name of the new version. 

5. Click Save. 
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Appendix A 

Keyboards and 
Character Sets 
This appendix shows the layout of the the Apple Keyboard II, 
the Apple Keyboard, and the Apple Extended Keyboard II. 

··~,ping !\'on-English CharacTers and Special Symbols" is ar 
the end of this appendix. 

Apple Keyboard II 
for instructions on adjusting the height of this keyboard, go to 
Chapter 8. '·Seuing Up Your Macimosh System.'' 

2.J8 

Power key: Thb ke~ has a special 
funoion on some modtls. It can tum the 

computer on. :md on certain models. turn it off 
<L~ an alternarire ro the Shut !)own command. 

Pressing this key 11 hilc holding do\\ n the 
a:: (romm:md) and control kers restarts the comnuter 

, ·-j,J 
!j C\ 

~ 

Tab key: ,\ \ores the insertion point 
horizont:1lly to the next stopping 
place (such as a tab stop or data 

field in a dialog box or prug1~1 lll). 

1~. I_U @ lLI 2 ..____ 

Caps Lock key: A locking Shift key 
for letters only (numbers and 

symbols arcn 't affected). 

Shift key: Produces uppercase letter~ 
(or tht: upper character on the key). 

Control key: Like ~ rhe key 
works in combination with other 

keys to provide shortcuts 
or modify other actions. 

Option key: Produces an optional 
~et of ~pecial chm~rcter~ when 

pressed in combination 
\\ ith other key~: also 

lll<XI i fie~ other actions. 

i t.1b j lw ~ a J 
---' 

caps G_. lu L lock 

shift ~ X 

l ctr/ ~ I option ] lj :it. 
- -'-

/ 
~ (Conunand) kev: \'\'orb wirh 

other key~ as an alternatire 10 

choosing a menu comn~<ulcl or 
(in ~umc prugr:llllb) canceling 

an opcmtion in progress. 
such as printing. 

L 



:I::]] 

Delete key: Deletes an~' material 
currcnrly sclccred, or ll'hatevcr 

character is to the left of the 
insertion point 

Retum key: ~!m·cs the insert ion 
point to the beginning of the next 
line. In a dialog box, pressing 
Return is the same as clicking 
the outlined button 

II 
iJ!f 

Numeric keys: These kevs 
produce number-; and 
mathematical symbols: 
some programs allow you to 

use these keys as function 
kevs Lo initiate an act ion. 

------~ 
_j l ~ J l_U t1J li__l l_U lU l~ l;J l delete I l clear J bJ lJ l:l 
_!J lJ lJ l~J lJ ~I lJ lU Lll ~ J. 
lr J t G J ~ li_j LJ liJ LJ LJ l return l. 

J GJ lJ ~ GJ lJ u U__j l shift J 

I ~ 

.pc 1\.cy The funu.iun 
of this key depends on 

the program you ·re using. 

bJ -- LJ lJ l!J 

y 
the insertion point, as an 
alternative to using the mouse. 
In some programs. the arrow 
kcvs have other funcrions. 

li 
~ 
[, 

~ 

J LJ [_9 J l~J 
u lJ [_6 J l~l 
J [2 j lJ J u _ J. u 

y 
current selection. just as 
the Delete kcv docs. In 
some programs. Clear 
has other functions. 

j 
Enter key: In a dialog 
box, pressing Enter is the sa Ill<: 
as clicking th<: outlined burron (or 
pressing Herurn); some programs 
1·equire that you use Emer (nuL 
Rerurn) to confirm i11fonnarion 
vou hare pro1·ided. 
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Apple Keyboard 
This keyboard has no heighr adjusrment. 
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Power key: This key has a special 
function on some models. It can turn the 

computer on, and on cenain models, turn it off 
as an alternative ro the Shut Down command. 

Pressing this key while holding clown the 
~ (command) and control keys restans the computer 

" 

Escape key: The funnion of this key 
depends on the program you're using. 

Tab key: Moves the insenion poim 
ho1izontally 10 the next stopping 
place (such as a tab swp or field 

in a dialog box or program). 

bJ lU l!J 1LJ l 
Control key: Like the :H: key, works 

in combination with other keys to provide 
shortcuts or modify other actions. 

Shift key: Produces uppercase letters 
(or the upper character on the key). 

Caps Lock key: A locking Shift 
key for lcuers only (numbers 
and symbols aren't affected). 

Option key: Produces 
special characters when 
pressed in combination 

with other keys; also 
modifies other actions. 

0 

~ kJ kl ~ 
l control 1 hJ. hJ ~ 
l shih lkl w 
1;:1 k 1opdonJ u 

' 

------- y ith 
another key as an alternative to 
choosing a menu command or 
(in some progmms) Gtnceling 

an operation in progress, 
such as printing. 

l 



I::] 
IJ lJ lU lJ 

Delete key: Deletes any material 
currently selected, or whatever 

chararrcr is ro rhe lt:fr of rhe 
inscrrion point 

Return key: \>loves the 
inserrion point to the beginning 
of the next line. In a dialog box, 
pressing Return is the same as 
clicking rhe outlined bunon -

---lLJ lU hJ. l;J l delete IJ l clear l LJ. 'LJ 
J1J ~ lJ.LJ kJ ~ ~I~ h_ ~ ~ ~ 

l ~ ~ ~ j lJ lJ LJ lJ l_J LJ U return 

LJ lJ lJ ~ u 
' 
lJ lJ}Lhi" J l 

j LJ bJ bJ 
' 

LU l!J rlo 
-

y 
point, as an alternative to using 
the mouse. In some programs, 

the arrow keys have 
other functions. 

--
Clear kev: Deleres rhe 

current selection, just as 
rhe Delete key does. In 

some programs, Clear has 
other functions. 

~~ ~ 
t u 

Numeric keys: These keys produce 
numbers anclmarhemarical 
symbols; some programs allow 
you ro usc 1 hcse keys as function 
kevs w initiate an action. 

~ 

lJ 
bJ 
bJ 

u 
I y: In a dralog box. pressing 
Enter is the same as clicking the outlined 
bunon (or pressing Rewrn); some 
programs require that you use Enter 
(nor Return) to confirm information 
vou have provided. 
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Apple Extended Keyboard II 
J\ reversible plastic template tim comes with this keyboard firs 
over the row of function kers. You can label the function keys by 
\\Tiring on the template (in pencil, nor pen or marker). 

For instructions on adjusting the height of this keyboard, go to 

Chapter 8. ··setting Up Your ~lacintosh System.·· 
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Function keys: Some programs alloll' you 10 use 
function keys w give commands. You ran assign 

commands or action sequences to function 
kevs with spcrialutility programs. 

'·' 
Escape key: The function of this key --+---+ 

depends on the progmm 10u·rc using. 

Tab key: 1\lores the insertion poim 
horizonrally 10 the next stopping 
place (such as a tab swp or field -~ 

4 
~ _ 

4 
- ~. 

4 
-· ~ 

4 
---

4 
in a dialog box or program). I t, . T, , T. T, . T. 

Caps Lock key: t\ locking Shift key 
for letters only (numbers and -t---+ 

symbols aren't affected). 

Shift key: Produces uppercase letters 1 1 
(or the upper character on the key). 

Control key: Like the ~ Ke1•. works -1- - --J..: 

in combination with other keys to provide 
shortcuts or modify ot ht:r anions. 

Option key: Produces special 
characters when pressed in 

combinmion with other keys; 
also modifies other actions. 

~ (Command) key: Combines 
11ith another kel' as an alternative 

for choosing a menu command or 
(in some programs) canceling 

an operation in progress, 
such as printing. 



Numeric keys: 
Delete key: lleletes anv 

material curremly selected. 
or whatever character is w 

rile left of the insenion poinL 

Special keys: The funoion 
of these ke1•s depends on 
the operating system and 
program l'ou're using. 

These kevs 
produce numbers 
and mathematical 
svmbols. 

Power key: This key has a special 
funcrion on some models. It can turn the 

computer on, and on certain models. wrn it off 
as an alternative to the Shut Do1Yn command. 

Pressing this key ll'hile holding down the 
~ (command) and control kevs restans the computer. 

Return key: ,\loves rhe insertion 
poim ro the beginning of the next 

line. In a dialog box. pressing 
Return is the same as clicking the 

outlined button. 

~ l bJ I~ 

ltJ 
ld l ltJ ibJ II ~ 

Arrow keys: .\love the 
insenion point. as an 

alternative rousing 
the mouse. In some 
programs. the <HTOII' 

kers hm·e other 
functions. 

Clear key: 
Deletes the 
currenr selecrion. 
just as the Delete 
kcr docs. In some 
programs. Clear has 
or her functions. 

[] 
,) 

enter J 

Enter key: In a Jialog l>ox. 
pressing Enter is the same :ts 
clicking the outlined bunon 
(or pressing l{eturn): some 
programs require that I'OU usc 
Enter (nor Rewrn) ro confirm 
information mu ha1·e provided. 
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Typing non-English characters 
and special symbols 
You can rype a variety of non-English charaClers (with diaoilical 
marks) and special symbols by pressing the modifier keys (such as 
Shift, Option, and Control) in combination with certain letter and 
number keys. 

The Key Caps program, which is installed wirh the system 
software, shows you Lhe characters produced when you type 
cenain keys and key combinalions in the fonts you have (choose 
Key Caps from the Apple menu, then choose rhe fonr from rhe 
Key Caps menu). 
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Characters appear here when you press keys 
on the keyboard or click them in the window. 

li!D I . Key Caps 

I 

l ·!..~:::::·::.t:~):::~:: ,·<~) :;~:J.:1::~.J::~:·I.:~::.!·,~~::;~~·i!.:~~:r.~.I:~J:. ·~·J~·:,::·~: ,:::~::~ ~::o, J::· ~·;::·:·. !·::.::!:::.:::::·:::·:·:::·.:.···: , 
!:! § 1 2 3 4 5 6 7 8 9 0 - - :[I:TIJ!: 0 • I . • p: 

-'r-'r-'r-'r-'..-..>..r".J.,--.1,-.1,-l,'-~L,Cl:J..._...:.....j' T~II~J 1 8 9 _ 
-'-r-'-T..l...T....,."-T.J....T-l..f-I_:;-'-;-J'-1--I..,...l- --l ;:.ff/~'1:; •:;;:;,,'1\ f ' ·i'j'f' 1 s 6 + I ' 

-.--'--r-'---I--J....._'--'-L.....J-'-l....:....L..,....J-..:...+~--1 : ,· :: 0:: ·:·,· ~~ 2 

Characters available in the 
J.lonaro font (on rhe Apple 

Extended Keyboard II) 



1m Key Cops 

[II I o I o I o I o II o I o I o lo II o I o I o I o II o I o I o I 
---1-

; . . •, 

~~~~~~~~~,L~J,~ [][]JQ 0 • I • 
+--J.T:...JT:...J.,...t.r:Lr-..t,..:-lr-JL,-l.,.:....L,.:....L,---l.,_J__:_< --1 : [I.J.!l 7 6 9 
1----'-.;:....L-'i-'-.......... --'-T..J....T..J....T-.L..J-....,__,...;;_...L-T-'-----i . > .... ,. 'I 5 6 • 

......... ·:!' ·o :: r: , 0 2 3 .• :: 

The highlighted key represents the Special characters available 
key held clown nn the keyboard- in the Monaco font when 
in this case, the Option key. the Option key is pressed. 

To type a character with a diacritical mark (such as an acure accent 
or an umlaut), you press the Option key with a specific lerrer key, 
then you type the character. 

Diacritical mark 

Grave accent ( ' ) 

Acute accent ( ') 

Circumflex ( "" ) 

Tilde (-) 

Umlaut c·· ) 

The letter c with a cedilla (~) 

Key combination 

Option- ' , then type the charauer 

Option-e. rhen rype the characrer 

Option-i. then type the character 

Option-11, rhen type the character 

Option-u, then type the character 

Option-c 

If the character appears C!Jier Lhe cl iacrit ical mark (rather than 
with it), then the marked characrer is nor available in the font 
you're using. 
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AppendixB 

Exchanging Disks and Files 
With MS-DOS and Apple II 
Computers 
Apple File Exchange is a file format conversion program that is 
supplied on the system software floppy disks. The program and 
three special translator files arc stored in the Apple File Exchange 
Folder. 

You can use the program ro initial ize a disk in MS-DOS or ProDOS 
(Apple li) formar and converr files to and from ~IS-DOS or 
ProDOS. (Apple File Exchange cannOL open converted files; you 
need LO usc an application program thar recognizes the convened 
nles to open them.) 

N> 

c~ 
t2~-­
~l 

App lt? F ilt? Exchange 

Initializing a disk in MS-DOS 
or ProDOS fonnat 
1. Locate the Apple File Exchange icon and open it. 

Apple File Exchange is supplied on the system software disks. 

The program's window opens. The contents of the active 
window arc listed on the left side and an empty hox appears 
on the right side. 

2. Place a blank disk in your floppy disk drive. 

A dialog box appears, reporting that the program can·r read 
the disk and a'>king if you want ru initialize ir. This dialog box 
shows the names of formats available in Apple File Exchange. 
including Macintosh, 1\'IS-DOS, and ProDos. 

(You can initialize a disk that is nm blank by inserting it, 
cl icking the Drive button until irs name appears in the 
window, and choosing Erase Disk from the File menu.) 

3. Click MS-DOS or ProDOS. 



4. If necessary, click the capacity (in K) of the disk you 
inserted. 

If you want to initialize a high-density disk in MS-DOS format, 
1440K is the only option and is already selected. If you 
insened a double-sided disk, click 720K. 

bl flpple File £Hchange cannot 
read this disk. Do you wish t o 
Initialize It ? 

@ 1440K IMIICin tosh 
II 

Pro nos 

(Initialize ) ~ Eject 

S. Click the Initialize button. 

~ 

Disk capacity is [he 
same for l'vlacimosh 
and MS-DOS 
high-clensi[}' disks. 

When initialization is completed, a dialog box appears, asking 
you to name the disk. 

6. Type a name for the disk, then click OK. 

MS-DOS fi le names can have up 10 eight characters, followed 
by an optional period ancl up to three characters. 

The dialog box closes, and the name of the disk vou initialized 
appears, above an empty window. This disk"s icon doesn·t 
appear on your Macintosh screen (because the Macintosh 
cannot recognize a disk in I'AS-IJOS or ProiJOS format). 

7. Choose Quit from the File menu when you are finished 
using Apple File Exchange. 

Apple File Exchange cannm in it ializc a high-clensit y disk in 720K 
format, nor can it read a double-sided disk that has been 
iniLializecl in the high-density (1.4 MH) format. 

·:· 5.25-incb dis/..•s: Some Macintosh models can usc an external 
5.25-inch Aoppy disk drive that can read files from MS-DOS 
disks. An internal adapter or expansion card is required to 
connect a 5.25-inch disk drive to the Macintosh. Apple File 
Exchange can translate Illes from these disks and store files on 
them. ·:· 
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Converting flies to and from MS-DOS 
or ProDOS fonnat 
Apple File Exchange provides two methods of file conversion­
text and binary. You use text translmion for text files, and binary 
translation for other Ales. 

In addition, Apple File Exchange can usc special translaror files 
designed to convert files into formats that specific programs can 
usc. One of these special translator files is provided with Apple 
File Exchange: DCA-RFT/Mac\Vrite, which converts documems 
between MacWrite® format for the Macintosh and Document 
Conrem Architecture/Hevisable form Text formal (used by many 
word-processing programs) for MS-DOS. 

~· · 

I 

file selected 
for translation 

..----....... ---- ---- - Menus of 
translaror Ales 

" · Apple rue Euchon~c 1 · • ~ .. . '· · ., J DirectorY 

~ j(g) MSOOS.jjhl ti tle Or disk 
,f OJ I D BUD 

~1: II ........... 
•T:fTTi ro GIT.90 

I »lrens lete» ll Q BUO~~:~~w o Disk" I mag 
Cl lnbels 

C) llummer 

509 4K bytes auailabl c 

~: 1 nrlue ] 

(New Folder) i ( LJe( l ] 

I Remnue I 

21K 
b ytu$ 

select ed Disk name 
(g) MSOO S.jjh 

1324K bytes alJallablc 

~~~ 
(Ni!w r aider) I~ 
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Follow these steps to translate a file: 

1. Locate the Apple File Exchange icon and open it. 

Apple File Exchange is supplied on the system software disks. 

The program's window opens. The contents of the active 
window are listed on the left side and an empty box appears 
on the right side. 

2. Insert the floppy disk that contains the files you want 
to translate. 

3. Use the Open, Drive, and Eject buttons to display the 
files you want to translate and the disk or folder where 
you want to store the translated IDes. 

4. Click the names of the files or folders you want to 
translate. 

To select multiple files or folders, hold down the Shift key and 
click each name. You may have ro scroll to locate the names of 
some files or folders. 

The appropriate translation menus (one for translating from 
Macintosh format and another for translating ro Macintosh 
format) appear on the menu bar when you select either 
MS-DOS or ProDOS files. 



5. Open the translation menu you want by pressing its 
name. 

6. Make sure that the translators for the types of files 
you've selected have checkmarks; if not, choose them 
so that checkmarks appear next to them. 

An active translator has a checkmark. The default translatOr 
has a diamond (indicating that it's always active) . Choosing an 
active translator makes it inactive. 

7. Compare the size of the files or folders selected for 
translation with the space available on the destination 
disk. 

The toral space required appears between the lists; the space 
available on the destination disk appears below its name. 

If the size of the selected items is greater than the space 
available on the destination disk, deseleCL some of the items 
(by Shift-clicking them), remove some files on the destination 
disk (using the Remove button), or change w anorher 
destination disk (using the Eject burton). 

8. Click the Translate button. 

If Apple File Exchange finds two or more active translatOrs­
other than Text or Default-capable of translating a selected 
file, it presents a dialog box asking you to select the translator 
you want. 

If the names of files or folders on the destination disk are the 
same as those of flies or folders being translated, Apple File 
Exchange presents a dialog box asking you to rename the file 
being translated. 

If a translator requires you w select options before a file is 
translated, it presents a dialog box in which you select the 
options. 

9. Respond to any dialog boxes presented by selecting a 
translator, renaming the file, or selecting options. 

The selectee! tiles or folders are translated. Messages report 
the sta[US of copying. 

If Macintosh files are being translated into MS-DOS files , the 
names of translated files may be shortened to conform to the 
naming convemions of !VIS-DOS. 

co/1/inues ~ 
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10. When all translations are finished, choose Quit from 
the File menu. 

·:· Converting MS-DOSfiles on a file server: Some file servers 
can sLOre infixmation created by both i\llacimosh computers 
and MS-DOS computers. For example, the AppleShare PC 
program allows MS-DOS computers ro srore and translate files 
on an AppleShare file server. Consult your authorized Apple 
dealer or represemative for more information about using a 
file server and MS-DOS files. ·:· 

Other file-conversion options 

Apple File Exchange's File menu provides several other options ro 
assist you with fi le conversions. 
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The program keeps a log of all files translated, 
showing rhe date, rime, and type of conversion. 

Show 'User l og 
UosH 
S<H'(~ ll~t~r !.09 fl~ .. , 
( lt~!H Usm· Lot.l 

The active translators and the 
options for each translatOr can 
be saved in a special fi le with the 
"Save settings as" command. You 
can then use these opt ions any 
time by choosing the "Restore 
settings from" command and 

Rest ore settings from ... 
Saue settings as ... 

~opening the file. 

Page Setup ... 
t>rin t IJs<~r l.og .. , 

Ht~n!WH~ lh~sHrwHon f'ilt'S .. , 
>~'Show Only El igible Files WE 

Era se Dislc ... 

Quit WQ 

You can rename destination 
(trJnslated) files. 

The names of files that 
can't be convened bv the 
active translators are· 
dimmed when this item 
is checked. 

You can reinitialize a disk in all\' 
available t()l'mat \\'ith this comnland. 

More information about Apple File Exchange options 

'lb see explanations of the translatOrs Apple File Exchange uses, 
choose About the Apple File Exchange from the Apple menu. 
Select a translator in the list that appears, then click the About 
button for information about rhar item. (Click Done ro return to 
the program 's window.) 



AppendixC 

Where to Get More 
Information About 
Your Macintosh 
As you increase your knowledge of compmers and develop new 
uses for your Macintosh, you may wanr to know what orhcr 
. VIacintosh users in your area are doing with their computers, or 
you may wanr ro learn more about programming, hardware 
design, or or her technical topics. 

The in format ion in this appcndLx provides a starr ing point for you 
ro expand your Macinrosh knowledge and comacts. 

Macintosh user groups 
Whatever your level of computer experience, )'OU can get lors of 
support by joining a Macintosh user group. Macinrosh user 
groups are composed of people who work with Macimosh 
computers and who enjoy sharing wlm they know wirh orhers. 
Activities may include demonstrations of new pruducrs, question­
and-answer sessions, and classes on using popular programs or 
learning ro write your own programs. Many user groups have 
special beginners' meetings . 

Fur the name of t he Macintosh user group nearest you, call 
800-538-9696. For names of user groups outside the United States, 
or if you're imerested in starting your own user group, conracr: 

Berkeley Macintosh User's Group or 
1442-A Walnut Street, # 62 
Berkeley, CA 94709 
U.S.A. 
510-549-BMUG (510-549-2684) 

Boston Compurer Society 
One Center Plaza 
Boston, J\llA 02108 
U.S.A. 
617-367-RORO 
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Technical infotmation 
A variery of technical documentation is available for the 
Macintosh. Apple Computer releases technical information 
through three primary outlets: the Apple 'lechnical Library and 
the Apple Communications Library, both published by Addison­
Wesley Publishing Company, and the APDA developers' source. 

Apple Technical Library 

The Apple 'technical Library includes comprehensive technical 
documenration for all Macintosh computer models and the 
mulrivolume guide to the Macimosh operating system for all 
models, Inside Macintosh. 

Other books in the Apple Technical Library cover designing 
expansion cards and programming device drivers for the 
Macintosh , writing application programs for the Macintosh, and 
designing the user imerface for Macintosh programs. 

You'll find d1e Apple 1echnlcal Library in most well-stocked 
bookstores. 
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Apple Communications Library 

The Apple Communications Library offers complete technical 
information about Macintosh communications products and the 
Macintosh in a network environment. The library includes an 
imroducrory volume, Under:'ltanding Computer Networks, and 
the comprehensive guide ro the AppleTalk network system, Inside 
AppleTalk. 

The books in the Apple Communications Library are avai lable ar 
booksrores. 

APDA 

APDA offers convenient worldwide access to over 300 
clevelopmenr tools, resources, training products, and information 
for anyone interested in developing applications on Apple 
platforms. Customers receive the quarterly 1'1PDA :tools Catalog 
featuring all of our most popular and most current versions of 
Apple and third-party developmem tools. Ordering is easy; there 
are no membership fees and application forms are nor required 
for most of our products. APDA offers convenient payment and 
shipping options, including site licensing. 



To order product or get additional information, contact: 

APDA 
Apple Computer, Inc. 
P.O. Box 319 
Buffalo, NY 14207-0319 
U.S.A. 

800-282-2732 (United States) 
800-637-0029 (Canada) 
716-871-6555 (International) 
Fax: 716-871-6511 
AppleLink: APOA 
America Online: APDA 
CompuServe: 76666,2405 
Internet: APDA@applelink.apple.com 

Assistance tor hardware and software developers 

If you plan to develop hardware or software products for sale 
through retail channels, you can get valuable support from the 
Developer Support Center by calling 408-974-4897 or using 
AppleLink (DEYSUPPORT). 

Developers outside the United States and Canada should contact 
their local Apple office or distributor for information on local 
developer programs. 

Infotmation about copying software 
If you want or need more information about when it is OK ro copy 
software and when it isn't, or about related consumer issues, you 
can contact the Software Publisher's Association (SPA) and ask for 
their free brochure. Call or write: 

Software Publisher's Association 
1730 M Street NW, Suite 700 
Washingron, DC 20036-4510 
800-338-7478 
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Glossary 

A 

access privileges The ahiliry ro see folders. see files, or make 
changes ro a shared disk or folder. Access privileges arc 
granred by the owner of the shared item and are used ro 
determine what other nCt\\"Ork users can do with the disk or 
folder and its contents. 

active program The program you· rc currently using. You can 
have several programs open at a time, bur only one of them 
is the acrive program. Open programs appear in the 
Application menu m the right end of the menu bar, with a 
check mark next to the name of the active program. The 
menu icon changes ro indicate which program is the active 
program. 

active window The \\'indo\\' that's on LOp of all others on the 

:o=oee's !llslc ......,PJ~ 
5 it•ms 36 M8 in disk 

~ IQ 
Tt.lGhTt xt lo 

IC 

~ lacintosh desktop. The active 
window has solid lines running 
across irs ti tle bar and it ·'belongs" 
to the active program. 

ADB See Apple Desktop Bus. 

Alarm Clock A desk accessory program (an Apple menu item) 
that works like a digital alarm clock. 

alert box A box that appears on the screen to give a warning or 
other message, somet imes accompanied b~' an a len sound. 

!.\ This process w ill erose oil 
ill Information on this !lisle. 

(-c~ n ErBse )J 
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alias A file that stands for and poinrs ro a file, folder, or disk that 
you usc as if it were the original. When you 

~ o~e~ an alias, you're actually opening its 
Teach Tex t ~lias Ortgmal. 

Apple Desktop Bus (ADB) Input circui try built into most 
c:y,::::) Apple computers. You use ADB ports (marked 
~ with the ADB icon) to attach the keyboard, the 

mouse, and mher devices, such as graphics tablets 
and bar-code readers. Sec also bus. 

Apple menu The menu at the left end of the menu bar, 

About This Macintosh ... 

0 Alarm CIOCIC 
!iij Calculator 
% Chooser 

indicated by the Apple symbol. 
You choose items from this 
menu to get information about 
programs' memory use and 
open items placed in the Apple 
Menu Items folder (in the 
System Folder). 

AppleShare file server A Macintosh computer running 
AppleShare file Server software that allows network users to 

store, retrieve, and share files and application programs on 
that computer. 
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ApplcTalk network A combination of devices, cables, and 
software that operate according to the protocols (rules) 
developed by Apple Computer. A communications 
environment in which many different kinds of computers, 
peripherals, and software can work together. Uses LocalTalk, 
EtherTalk, or TokenTalk network connection types. 

Application menu 

Hide Finder 
Ulde Others 
Slum• fill 

./~Finder 
~ TeachTeHI 

The menu at the right end of the menu bar 
(its icon changes to indicate which 
program is the active program). You 
choose items from this menu to hide 
windows belonging to open but inactive 
programs and to make an open program 
the active program. See also active 
program. 

application program A program that you use to do you r work 
on the computer, such as word processing, database 
management, graphics, or telecommunication. 

B 

back panel The back of the computer, where you find the 
power switch and pons for attaching external devices. 

back up To make a copy of a disk or of a file on a disk. Backing 
up your files and disks ensures that you won't lose 
information if the original is lost or damaged. 



balloons Small boxes containing text identifying objcm on the 

·.·.· ··.·.·.·.·.·.·.·.· ··.·.·.·.· . . ·.·.·.·.:-:· :~ 

X He lp menu 
<· 
:;: Us e t his menu to get 

:;: information that he lps 
~~: you US() your computer . 

:::-,:::: ,,,,,,,,,,, ,,,,,,,,,,, ,,,,,,, ,,, ,,,, , ,,,,,,,,,, ,,, , ,, ,,,, ,}:}~~:n::::I 

screen and explaining their 
use. You can hide or show 
balloons by choosing the 
appropriate command 
from the Help menu. 

bit Binary digit. The smallest unit of information that a computer 
can hold. The value of a bit (either 1 or 0) represents a 
two-way choice (on or off, true or false, black or white). 

bitmap A set of bits that represents a graphic image. 

bitmappccl character A character in a font that 's rendered as a 
bitmap and drawn as a pixel pattern on t.he screen. Sec also 
font, pixel. 

bitmapped font A font in a single poim size made up of 
bitmapped characters (also called fixed-size font). Some 
form stored in the Macintosh System file are bitmapped 
foms. Compare outline font, TrueType font. 

buffer A "holding area" in memory \vhere information can be 
swrecl by one program or device and then read by another. 
For example, some printers have built-in memory to swre 
text that comes from the computer faster than it can be 
pri nted. This memory, which frees the computer for other 
work while the printer is printing, is called a print buffer 

bus Circuits inside the computer that transmit information from 
one pan of a computer system to another. For example, the 
Apple Desktop Bus transmits information about mouse 
movement or keyboard input. In a network, a bus is a line of 
cable with connectors that link devices together. 

button An image, sometimes resembling a pushbutton, that you 

n OK D [ Cancel l 
l Options J [ Help J 

click to designate, confirm, or 
cancel an action. Compare 
mouse button. 

byte A unit of information consisting of a fixed number of bits. 

c 

One byte usually consists of a series of eight bits. Sec also 
kilobyte, megabyte. 

cache See memory cache, clisk cache. 

Cancel button A button that appears in most dialog boxes. 
Clicking it cancels any command or options you might have 
chosen and closes the dialog box. 

central processing unit (CPU) The "brain" of the computer; 
the microprocessor that performs the acrual computations. 
See also processor, coprocessor. 

character Any symbol that has a widely undersroocl meaning 
and thus can convey information (letters, numerals, 
punctuation marks, and mher symbols) . 
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checkbox A small box associated with an oprion in a dialog box 
or window. You click the checkbox ro turn the option on or 
off. An oprion is "on" when there's an X in the checkbox. 

chip Sec integrated circuit. 

choose To give a command by dragging through a menu and 
releasing the mouse button when the command is 
highlighted. 

Chooser A program that lets you designate devices, such as 
printers and shared disks on a network, for your Macinrosh 
to use. 

Clear A command in the Edit menu that removes selected 
material without placing it on the Clipboard. You can use 
the On do command immediately after using Clear if you 
change your mind. Compare Cut. 

click To position the pointer on an object on the screen, and 
then ro press and quickly release the mouse button. 

Clipboard An area in the computer's memory tim functions as 
a holding place for what you last cur or copied. Information 
on the Clipboard can be pasted into documents. 

close box The small box on the left end of the title bar of 
an acrive window. Clicking it closes the 

~ window. 

~ 
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color wheel Available on computers with color capabili ty, the 
color wheel dialog box lcts you adjust hue, saturation, and 
brightness of the highlight color and other color choices. It 
is also used to adjust shades of gray. 

command An instruction that causes the computer to perform 
some action. 

configuration (I) The \vay you have your computer set up. 
(2) The combined hardware components-computer, 
monitors, keyboard, and peripheral devices- that make up a 
computer system. (3) The software settings that allow 
various hardware components of a computer system to 
communicate with each other. 

control panels Programs that let you change various Macintosh 
features, such as sound, mouse movement, and keyboard 
options. Control panels are located inside the System 
Folder. 

coprocessor An auxi liary processor designed to relieve the 
demand on the main processor by performing a few specific 
tasks. Generally, coprocessors handle tasks that would be 
performed much more slowly by the main processor, such 
as mathematical calculations. 

Copy A command in the Edit menu that copies selected material 
and places il on the Clipboard, wirhour removing the 
material from the original document. See also Clipboard. 



copy-protect To make a disk difficult if not impossible to copy. 
Software publishers sometimes copy-prmcct their disks ro 
prevenr them from being illegally duplicated. Sec also lock. 

CPU See central processing unit. 

current application Sec active program. 

current startup disk The disk that contains rhc System f older 
the computer is currently using. The srarrup disk icon 
appears ncar the upper-righr corner of the desktop. 

cursor See pointer. 

Cut A command in the Edit menu that removes selected material 
and places it on the Clipboard : from there you can paste it 
elsewhere. Compare Clear. Sec also Clipboard. 

cut and paste 'lo move text, graphics, or orher material from 
om: place in a document to another place in the same or a 
cli ffcrcnr document. 

D 

default A value, action, or scrring that a computer system 
assumes, unless you give it a differcnr instruction. (Also 
called preset.) 

deselect To change a selected item, such as an icon, so that it is 
no longer selected. In the Finder. you cleselecr highlighted 
icons by pressing the Shift key and clicking the icon you 
wam to deselecr, or by selecting something else. 

desk accessories Small application programs that you can add 

Rbout This Macintosh ... 

0 Rlarm Cloclc 
§l Ca lculator 
~Chooser 
~ C ontro l Pa n els 
~ Key Ca ps 
rJ No te Pad 

ro your systen1. Desk 
accessories (DAs) are often 
installed in the Apple menu. 
Those provided with the 
Macintosh include rhe Alarm 
Clock, the Calculator, the 
Chooser, comrol panels, Key 
Caps, and the Scrapbook. 

desktop Your working environment on the computer (the menu 
bar and rhc background area on rhc screen), on which you 
work with icons and windows. 

* f1le [ dil VIeW Lab~ l Sp t!l' iul ., e -
Mecmtosh 110 

C::J "$ 1t•m~ 39 MB W141S~ 3'1\f-fl h•ll~l;o 

:o !~stem fo lder f!ll Hulr.tos,.•o 

. ····-8\l tff'IS 3 9t"e1t1411\. 34 I I"'G ~Vl.il.tl!. 

t:::l 0 

LiJ [Q] ~ l9J tt.r.:l Dut.h.o 

~pit Mtno.~11tms [.>e'tt 1H1011J Contrti PW~otls f M tr 

I! ~ ~ [§] 00 X· 

,~ ... 

destination The disk or folder that receives a copied or 
translated me, as in destination disk. 

~lcnu 
bar 

Desktop 
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dialog box A box rhar conrains a message, often requesting 
more information from you or allowing you to select 
options. 

dimmed Gray or filled in with a parrern of dors, indicating that 
an icon is already open or a menu, menu item, or other 
oprion is not available. 

an 
~Dimmed command 

H!HH:nnn Dimmed folder icon 
m~mHHHH 

·njiillll!ilj;: Dimmed program icon 

directory A list of the comenrs of a f<>luer or a disk. 

directory dialog box A dialog box that lets you see the 
content<; of disks and folders so that you can save a 
documem in a particular folder or disk, or open a document 
that's in a particular folder or disk. A directory dialog box 
appears when you choose Save or Open from a program's 
File menu. 

disk A flar, circular object with a magnetic surface that 
computers use ro srore files (programs and documents). 
The files are stored as magnetic signals, similar to the way 
sounds are recorded on rape. See also floppy disk, hard 
disk. 
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disk cache A portion of the computer's random-access memory 
(RAM) that is set aside for programs to store frequently used 
instructions. You use the Memory control panel to adjust 
the size of the disk cache. Compare memory cache. 

disk capacity The maximum amount of data a disk can hold, 
usually measured in megabytes (MB) or kilobytes (K). 

disk drive The device that holds a disk, retrieves information 
from it, and stores information on it. 

document Whatever you create with an application program. 
See also file. 

double-click To position the pointer on an object, such as an 
icon, and then to press and release the mouse button twice 
in quick succession without moving the mouse. 

drag To position the pointer on an object, press and hold the 
mouse button, move the mouse, and release the mouse 
button. 

driver A program that the computer uses to direct the operation 
of a peripheral device, such as a printer or scanner. (Also 
called a resource. ) 

drop folder A shared folder with access privileges that don't 
allow network users to open it but do allow network users 
to place files or folders inro it. 



E 

Easy Access A comrol panel that you use to adjust the keyboard 
so that you can control the pointer from the numeric 
keypad, type keyboard shortcuts without having tO press the 
keys ar the same time, and type very slowly. You also can 
make these keyboard adjustmems without opening the 
control panel. 

Edit menu A menu that is available in most programs and lists 
editing commands-such as Cut, Copy, and Paste. 

eject 'Ju remove a disk from a disk drive. 

error message A message displayed on the screen that tells you 
of an error or problem in a program or in your 
communication with the computer system. 

Ethernet A high-speed, widely used network type. 

EthcrTalk A type of network connection (provided by EtherTalk 
software installed in your Macintosh) that allows you rouse 
AppleTalk network services on an Ethernet network. 

Everyone A category of users for whom you can set access 
p1ivilegcs to shared folders and disks. The category refers w 
anyone who connects to a computer as a guest or registered 
user. 

expansion card A removable circuit board that plugs into one 
of the expansion slots in some models of Macintosh 
computers. Expansion cards enable the computer to use a 
special device or to perform an additional function. 

expansion slot A long, recrangular socket on the main circuit 
board of some Macintosh models into which }'Oll can install 
an expansion care! that gives the computer additional 
capabilities. 

extension Sec system extension. 

F 

me Any named, ordered collection of information stored on a 
disk. Application programs and documents are examples of 
files. You create a file when you type text or draw graphics, 
give the material a name, and save it on a disk. 

File menu A menu that lists commands that affect whole 
documents and other files-commands such as Save, Print, 
and Quit. 

ftle server A computer with special software that allows network 
users ro store and retrieve files on the hard disks or or her 
srorage devices attached w iL. 

file sharing The capabiliry of sharing files among computers on 
a nerwork. 
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Finder Part of the system software, the Finder is the program 
Lhat creates the Macintosh desktop and keeps track of your 
Ales. 

floppy disk A disk made of flexible plastic that stores com pULer 
data. The 3.5-inch disks used in tvlacimosh floppy disk drives 
are floppy disks housed in rigid plastic shells for suppon 
and protection. floppy disks come in three Lypes: high­
density (1.4 MI3 capacity), double-sided (800K), and single­
sided (400K). 

folder A comainer for documents, programs. and other folders 
on the cleskLOp or in directory windo\\·s. 

font A collection of leLLers, numbers, and symbols in a distinctive 
typographic design. See also 

This is New York font. bitmapped font, outline 

This is Geneva font. 
font, TrueType font. 

format See initialize. 

G 

guest A person Lim connects to anorher compuLer on a neLwork 
without having to give a name or password. 

guest access A type of access to a computer that permits any 
nef\vork user to connecL Lo the computer for the purpose of 
Ale sharing or program linking. Each Macimosh owner can 
conrrol whether guesL access is allowed on LhaL computer. 
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group A set of registered users on a network for whom you seL 
access privileges as a unil. Groups are a conveniem wav for 
a person \\·ho is sharing files w control access privileges for 
a number of users at once. 

H 

hard disk A disk made of metal and permanently sealed in a 
disk drive or cartridge. A hard disk can hold much more 
informalion than a floppy disk, and a hard disk spins much 
fasLer. 

highlighted Visually distinct, usually because Lhe colors are 
reversed. 

I,] 

1-beam A Lype of pointer shaped like the capiLal letter I, used 
for entering and editing Lext. See also 

~ insertion point. 
stationl!yi- l-beam 

icon A small pictorial representation of a file, disk, menu, option, 
or other objecL or feature. 

B I bJ 
Document Trash Floppy Disk 



initialize "lb prepare a disk ro receh·e information b~· organizing 
its surface into tracks and seCLnrs: also kno\m asfomwt. If 
mu initialize a disk \rirh information on it. the inl(mnat ion 
is erased. 

inpLit Information transferred inro a computer fro111 some 
external source, such as the ke~'board, the mouse. a disk 
drive, or a modem. Compare output. 

insertion point 

I 
statiorf.J 

The place in a document where text \'OU type 
will be added; you set it by clicking at the spm 
where you want to make the insertion. The 
insertion point is marked with a blinking 
vertical bar. 

l ln~crt ion poilll 

Installer A program rim \'Ou use ro install or update ~~our 
system software or to add resources such as networking 
soft \\'arc. 

integrated circuit (lC) An electronic circuit entirely contained 
in a single piece of semiconducting material. usually silicon. 
Often referred to as a dnjJ. 

interface The way a computer communicates \\·irh external 
de,·iccs. such as a printer (through irs printer port. or 
printer interface). or with you (through irs user interface or 
human interface). 

K 

K See kilobyte. 

keyboard equivalent See keyboard shortcut. 

keyboard shortcut A combination of key presses that \·ou can 
use to give a command or set an option. Ke~·board shortcuts 
always involve the usc of m least one modifier key, such as 
the ~ key or the Option ke~'. 

Key Caps A desk accessor~· that sho\\'s you the characters 
available for each font in vour svstem. 

kilobyte 102'-1 byres. Sec also byte, megabyte. 

L 

label A \\Urd or short phrase that you cctn assign ro an icon by 
using the Label menu. (Yi>u can also assign the color that's 
associated \\·irh a label if your J\lacinwsh displays color.) You 
can change label.~ an ci t heir associated colors in the Labels 
control panel. 

LocalTalk A built-in net\n>rk connection rhar allows a ~Iacinrosh 
com purer ro panicipate on an AppleTalk network. 

Loca!Talk cable system A system of rabies. cable extenders, 
and connector boxes that connect computers and network 
clericcs roan ApplcTalk net\\'ork system. 
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lock To prevent files or disks from being changed or deleted 
(bur they can still be opened or copied). 

M 

main logic board A circuit board that holds RAM, ROM, the 
microprocessor, cusrom integrated circuits, and orher 
components that make the computer work. 

main memory See random-access memory. 

megabyte (MB) 1024 kilobytes, or 1,048,576 bytes. See also 
byte, kilobyte. 

member A registered user on a network who belongs to a 
group. 

memory A hardware component of a computer system that can 
store information for later retrieval. See also main 
memory, random-access memory, read-only memory. 

memory cache Memory that is set aside to increase the 
efficiency and operating speed of the computer. Compare 
disk cache. 

menu A list of items from which you can choose. Menus 
commonly appear when you press menu names in the 
menu bar or in a dialog box. You choose a command by 
dragging through the menu and releasing the mouse button 
when the command you want is highlighted. See also 
pop-up menu. 
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menu bar The white suip across the top of your screen that 
contains the names of the menus available LO you. 

• File Edit Uiew Lobe l Specio l 
... ......... .... ...... ... .. .. 

:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::H:::::::::::::::::::::::::::::::::::II::::::::::::: 

menu name A word, phrase, or icon in the menu bar or in a 
dialog box that gives you access to the menu. Pressing the 
menu name opens the menu. 

modem Short for modulator/demodulator A device tim links 
your computer to other computers and information services 
over telephone lines. 

modem port A socket on the computer's back panel marked by 
a telephone icon, used to connect a modem to your 
Macintosh. 

monitor See video monitor. 

mouse A device that controls the pointer on the screen. 

mouse button The mechanical button on top of the mouse. In 
general, pressing the mouse button initiates some action on 
whatever is under the pointer on rhe screen, and releasing 
the button confirms the action. 

Mouse Keys An Easy Access feature that lers you use keys on the 
numeric keypad to control rhe pointer. 

MS-DOS Microsoft Disk Operating Sysrem, a commonly used 
computer operating system. 
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network A collection of devices such as computers and printers 
that are connected together. A network is a tool for 
communication that allows users to store and retrieve 
information, share printers, and exchange information. 

network administrator A person responsible for setting up, 
maintaining, or troubleshooting your network. 

network service A capability such as file service or prim service 
provided by special software on the network. 

network user A person whose computer is connected to a 
network. 

Note Pad A desk accessory that lets you enrer and eel it small 
amounts of text. 

N uBus An address bus and data bus used in the Macintosh II 
family and some orher Macintosh computers. NuBus lets 
you add a variety of components to the computer system, 
through expansion cards installed in NuBus expansion slots 
inside the compmer. See expansion slot. 

numeric keypad A calculator-style keypad, to the right of the 
alphabet keyboard, that you can use to type numbers. Some 
applicar.ion programs designate the keys on the numeric 
keypad as function keys. 

0 

open To make available. You open files in order to \VOrk with 
them. Opening an icon usually causes a window ro appear, 
revealing the document or application program the icon 
represents or showing you the coments of a folder or disk. 

operating system A program that organizes the internal 
activities of the computer and its peripheral devices. An 
operating system performs basic tasks such as moving data 
to and from devices and managing information in memory. 

outline font A font that describes each character mathematically 
as a set of formulas. The mathematical description adjusts 
itself to render the characr.er in different sizes. See also 
TrueType font, bitmapped font, font. 

output Information transferred from the computer's 
microprocessor to some external device, such as the screen, 
a disk, a printer, or a modem. Compare input. 

owner The owner of a Macintosh is named in the Sharing Sewp 
control panel. On a network, the owner of a shared folder 
or disk is named in the Sharing dialog box, identifying the 
person who can set or change rhe access privileges assigned 
to the shared item. 

owner name The name of the owner of a shared folder or disk 
that appears in the Sharing dialog box. The owner can be 
the Macintosh owner, a registered user, or a registerecl 
group. The owner can set or change the access privileges of 
rhe shared item. 
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password A unique word or set of characters that must be 
cnrcrcd before a network user can gain access to a 
computer that he or she is registered on. 

Paste A command in the Edit menu that places the contents of 
the Clipboard-whatever was last cut or copied-at the 
location of the insertion point. Sec also Clipboard. 

peripheral device A piece of hardware-such as a monitor, disk 
drive, printer, or modem- used \Vith a computer and under 
the computer's control. 

PlCT A ftle format used by a number of graphics and page layout 
programs. 

pixel Picture element. The smallest clot that the computer and 
monitor can display, or the representation on the screen of 
the value of a bit. Also, a location in video memory that 
corresponds ro a pixel on the screen. See also bit. 

pointer An arrow or other symbol on the screen that moves as 
you move the mouse. 

pop·up menu A menu (usually in a dialog box) in which the 
selected option is shown next to a 

I Tabloid ...,.. I solid triangle and inside a box with a 
shadow around it. The rest of the 
menu '·pops up" \\'hen you press the 
box. Compare pull-down menu. 
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port A socket on the back panel of the computer \\'here ~·ou can 
plug in a cable to conneCt the computer to another de\'ice. 

printer port A socket on the com puter's back panel marked 
with a primer icon. used to connect a printer or an 
AppleTalk network connector to the rnn1purcr. 

privilege Sec access privileges. 

processor The computer hardware component that performs 
the computations directed by software commands. In 
microcompmers such as the Macintosh, the processm is a 
single imegrated circuit called a microprocessor. See also 
central processing unit. 

program A set of instructions describing actions for a comput er 
ro perform ro accomplish a task, conforming to the rules 
and conventions of a particular programming language. 
Computer programs arc collectively referred to as software. 
See also application program. 

program linking The ability of an application program to 
exchange information clirecrly with another program over a 
network. 'lu use program linking, both programs must have 
the capability. 

pull-down menu A menu (usually in the men u bar) whose 
name or icon is shown. You "pull clown·· the menu by 
pressing rhe name or icon. Compare pop-up menu. 
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RAM Sec random-access memory. 

random-access memory (RAM) The pan uf a computer 's 
memory available for programs and documents. also known 
as main memory. The comems of RAM arc I< lSI when the 
computer is turned off. Compare read-only memory. 

Read Me document A document that is included un some 
application program and system soft\\'arc disks to provide 
~ ·ou ,,·ith late-breaking information about the product. 

read-only memory (ROM) Memorv \\'hose conrenrs the 
computer e<tn 1·ead, but not change. Information is placed 
into read-only menHX~' only once, during manu facturing. 
The contelllS of I~OM are not erased when the computer's 
po\\'cr is turned off. Compare random-access memory. 

registered group A gmup of registered users that is listed on a 
computer on a net work. 

registered user i\ net\\'ork user ,,-hose name and password arc 
listed on a computer on the net\\'Ork. L'suall ~·, registered 
users have greater access privileges to shared foklcrs and 
disks 1 han do guest users. 

resource i\ nle that is contained in the System r:olcler and that 
the computer uses for irs operations. Svstcm files ancl 
device drivers arc examples of resources. 

RGB monitor A tvpc of color monitor that receives separate 
signals I(H· each primary color (red. green. and blue) and 
uses these signals to display color images. 

ROM See read-only memory. 

s 
save lo store information by transferring it from main memory 

(RAM) to a disk. \\fork that is not saved disappears ,,·hen ,-ou 
turn off the computer or if the pO\rer is interrupted. 

scanning order The order in \\·hich the Macintosh searches the 
disk drives for a startup disk. See also startup disk. 

Scrapbook i\ desk accessory in which you can save frequently 
used picrurcs or passages nf rex r. The Scrapbook can store 
multiple in1ages. You can cut or copy images fro111 the 
Scrapbook and paste them inro documents crcareclwith 
most applicarion programs. Compare Clipboard. 

scroll To move a document or directory in irs ,,·indow so that a 
cl ifferem parr of it is visible. You scroll using rhe scroll 
alTO\\'S, scroll bars, or scroll box. 

SCSI See Small Computer System Interface. 
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SCSI cable tenninator A device used in a SCSI chain w 
maimain the integrity of the signals going through the 
chain. With some devices, such as the Apple internal hard 
disk, the terminator is built in. 

SCSI chain A group of SCSI devices linked to one anmhcr 
through SCSI peripheral cables and linked ro the SCSI port 
on the compurer through a SCSI system cable. 

SCSI port The sucker on the back panel of the computer to 

which you connect SCSI devices. 

select 'lh designate which object wi ll receive the next action you 
take. Selecting is usually clone by clicking or dragging. 

selection The selected object or objects. A selected object is 
usually highlighted. 

serial ports The connccrors for peripheral devices thar receive 
data in a serial format (that is, one bit ar a rime). The primer 
and modem purrs on the Macintosh arc serial purrs. 

shared disk A hard disk, CD-ROM disc, or other medium whose 
contents can be retrieved over the network. A disk can be 
shared by a file server or a Macintosh computer that has file 
sharing turned on. 

shared folder A folder that is available to some or all network 
users over rhe network. 
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Shift-click 'Io click the mouse button while holding down the 
Shift key, used to extend or shorten a selection and to select 
more than one item. 

Shift-drag To drag while holding clown the Shift key, used w 
select two or more groups of objects by holding down the 
Shift key while you drag diagonally to enclose each group of 
objects in a rectangle. 

SlMM Single In-line Memory Module, a circuit board that 
contains eight RAM chips. SIMMs are connected to SIMM 
sockets on the computer's main circuit board. Sec also 
random-access memory. 

size box A box on the bottom-right corner of the active 

\1ii!!J 

window. Dragging rhe size box resizes the 
window. 

Slow Keys An Easy Access feature that lets you ser a delay before 
each keystroke is accepted by the computer. 

Small Computer System Interface (SCSI) A specification of 
mechanical, electrical, and functional standards for 
connecting peripheral devices such as hard disks, printers, 
and optical disks to small computers. 

sound output port A socket on the back panel of the 
Macintosh marked with a speaker icon, used to connect 
headphones or speakers to your Macintosh. 



source The disk or folder that holds the original of a me to be 
copied or translated, as in source disk. 

startup disk A disk with all the necessary program files- such as 
the Finder and System files comained in the System 
Folder-to set the computer into operation. 

startup drive The disk drive from which you start up your 
computer system. The disk in this drive must contain a 
System Folder. 

stationery A documenr that serves as a template. When you 
open a stationery document, a copy of the document is 
created and opened. The original remains unchanged. 

Sticky Keys An Easy Access feature that lets you type 
combination keystrokes without actually pressing the keys 
simultaneously. 

system extension A program that expands the capabilities of 
system software (for example, device drivers). System 
extensions are stored in the Extensions folder in the System 
Folder. 

System file The me that Macimosh computers use LO stan up 

n 
8 

System 

and to provide systemwide information, 
including fonts, sounds, and kC)'board layouts. 
The System file must be in the System Folder. 

System Folder A folder containi ng the programs that Macintosh 
computers use to start up and operate. A 

(~' 1 disk that comains a System Folder is a 
Sys tem f older Startup disk. 

system software Software components that support application 
programs by managing system resources (such as memory) 
and inpm and output devices. Also known as the operating 
system. 

T 

Teach Text A program provided with the Macintosh system 
software that functions as a limited word-processing 
program, used primarily to open Read Me documents. 

tem1inator Sec SCSI cable terminator. 

3.5-inch disk A Aexible, plastic disk measuri ng 3.5 inches in 
diameter encased in a rigid plastic shell. These disks come 
in three types: high-density ( 1.4 MI3 capacity on the 
Macintosh), double-sided (800K), and single-sided (400K) . 
See also floppy disk. 
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title bar The bar at the rop of a window that shows the name of 
the window. When the window is acrive, the title bar is 
highligl1lecl with horizomallines. 

Duane Title bar 

LJ 
To Do 

Token Ring A widely used network type originally developed by 
International Business Machines Corporation. 

Token1alk A type of network connection that allows you to use 
AppleTalk services on a Token Ring network. 

Trash An icon on the desktop that you use ro discard 
programs, documents, and folders. 

I 
Trash 

TrueType font A type of outline font supplied \Vith the 
Macintosh system software. Sec also outline font. Compare 
bitmapped font. 
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u 
unlock To allow a locked disk or document to be changed, 

deleted, or renamed. See also lock. 

user group A computer club where computer users exchange 
tips and information. 

User/Group A category of users for whom you can set access 
privileges to shared folders and disks. Can be any user or 
group that is registered on the com purer containing the 
shared folder or disk . 

user interface See interface. 

user name The name chosen by a Macimosh owner or network 
aclminisLraLOr Lo identify a user. After this identification is 
complete, the user is a registered user and can connecr to 
that computer as such. 

v 
version A number indicating a program's chronological position 

relative to previous and subsequenr releases of the program. 

video monitor A display device that can receive video signals by 
direct connection. Also known as a monitor 



virtual memory Hard disk space ser aside and used as an 
exrension of rhe compurer"s main memory. 

virus A program designed " ·irh malicious inrenr 10 damage files. 
Virus programs can be spread though nef\rorks and 
bulletin board services as well as un disks. Virus-detection 
and -elimination programs are available through dealers 
and user groups. 

volume Space on a hard disk or a file server that 's cleft ned and 
named as a place to store files. A hard disk is usually a single 
volume, but ir can be partitioned inro several volumes. 

W, X, Y 

window A rectangular area thar displays informarion on rhe 
desktop. You creare and riew documenrs rhrough windows, 
and you view rhc conrcnrs of disks in winclo\\'s. 

z 
zone Zones are set up by a network administrator and arc used 

ro group the devices on rhe nerwork for easier access. 

zoom box A small box in rhe top-right corner of rhe ririe bar of 

E!J§ 
34.1 MB availabl• 

rhc active window. Clicking the zoom box 
resizes rhe window so tim you can sec all 
Of its COIHCillS (if !XJSSiblc); clicking it 
again retu rns rhe window ro irs previous 
size. 
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Index 

A 
About This Macintosh (Apple menu) 154 
acccm marks, typing 254-255 
accessing. See also opening 

Illes on orher computers 183-187 
Jv1acimosh while away from it 202-203 

access privileges (networks) 187-189, 
204-211 

checking 207 
seuing 205-206 
strategies for 206 

activating. See also disabling; opening 
Alarm Clock 1.33-134 
Apple'Etlk 59, 162, 180 
CloscView 152 
nle sharing 190 
Finder /j 5- 46 
Help Balloons 80 
Mouse Keys 136 
program linking 210 
Slmv Keys 137 
software programs 42, 98, 246 
Sticky Keys 137 
32-bit addressing 159 
Trash icon 14-15 
virtual memory 157- 158 
windows 1"1-15, 45-t7, 2~0 

active desk accessory 98 
acrive software program 246 

identifying 45-47, 98 
multiple 45-47, 98 
opening documents in 46, 50, 70 
quick reference for 246 
switching between 45-47, 98 

active window, closing 14-15,33,45-47,240 
adapting Macintosh to your own use 

125- 159 
ADB devices 218 
i\])8 port 218 
adding 

alen sounds 140 
device drivers to System Folder 214 
files to folders 71- 72 
folders to folders 114 
fonrs to System Folder 172 
items to Apple Menu 117, 126 

adjusting 
blinking of menu items 143 
disk cache 156 
keyboard 91, 135-136, 137 
mouse operations 134-135 
speaker volume 139 
virtual memory 157-158 

agreements about sofnrare use 96, 192. 263 

Alarm Clock, sening 13.)-1.)4 
alert sounds 

customizing 1:)9-141 
disabling U9 
installing 140 
recording anclt't;moving 140-141 
Sticky Keys and 137 

aliases 72-7-l, 116-117. See also documenrs; 
files; folders 

connecting to shared disks 1\'ith 186 
creating 116 
definition of 73 
getting infor111ation about (Gct 1nfu) 117 
locating original or ,,-
locking 108 
opening 116 
opening at startup 126 
purpose of 116 
trouble with 116 

APDA 262-2G.) 
Apple Communications Library 262 
A!Jplc Desktop Bus devices 

connecting 21 8 
power requirements of 218 

Apple Desktop Bus pon 211:! 

283 



Apple Extended Keyboard II 91, 2)2-2)3 
Apple file Exchange 2)6-260. See also 

net\YOrks 
convening tiles to and from MS-DOS or 

ProDOS " ·irh 258-260 
initializing ~IS-DOS or ProDOS disks with 

256-257 
Apple I ID SC Setup program 

icon for 102, 112 
initializing hard disks \Yith 102-10.) 
testing hard disks with 112 

Apple Keyboard 250-2)1 
Apple Keyboard II 91. 248-249 
Apple menu 

About This Macintosh 154 
Alarm Clock 133- 134 
Chooser 57-59, 161- 164, 180 
Control Panels 105, 128- 1)1, 156- 159, 

182 
installing items in 117, 126 
Key Caps 254-255 
removing items from 117, 126, 127 

Apple Menu Items folder 11 7, 126 
Apple Programmers and Developers 

Association 262-263 
AppleShare 184. See also AppleTalk: net\\'Orks 
AppleTalk 179. See also AppleSharc; net works 

activating 59. 162. 180 
choosing primer for 1G3-16-J 
inactive 58, 162 
zones 58- 59, 163, 184 

Apple '1echnical Library 262 
Apple 11 computers, exchanging disks and 

files ,,·ith 256-260 

28'1 Index 

Application menu 42, 46-47, 98-99, 243 
Finder command 46 
Hide Others command 99 
icon fCH· 42. 98 
Show All command 99 

application programs. See software programs 
arranging icons on cleskrop 113 
arranging your office 89 
arrmY keys 22, 245, 249.251 ,253 
arrows, scroll arrows 17. 20- 21. 2'!1 
aHaching. See connecting 
audio pons 140, 219 
i\/UX 93. 102 

B 

background rrinring 164, 169-170 
backing up files 61- 62, 108, 247. See also 

copying 
backspacing with Delete key 43 
backup disks 96 
Balloon Help 80-81 
baHery, clock 227 
beeps. See a lens 
bitmapped fonrs 171- 172. 229-230 
black and white 147. 148 
blinking insertion point, changing 1 i-1 
blinking menu items, adjusting 143 
blinking question mark disk icon 233 
bomb error message 231, 235 
borders. \\·indm\·. changing colors of l4R 

brightness 
of color wheel 147- 148 
of screen 1) l, 22 ~, 232 

Ilrighrness conrrol panel 151 
Brighmcss icon 1) 1 
bulletin boards. See also net\\Orks 

folders as 205 
Yiruses and 9-

bus. See Apple Desktop Bus 
BY Label command ( Vie\Y menu) l-16 

c 
cables 

handling 223 
l.ocamdk-comparible 179 
SCSI peripheral interface cable 215 
SCSJ system cable 215 

cable terminarors, built -in 216 
cache. See disk cache; mcmor)' 
calendar. seHing 129- 1.3'1 
canceling 

initialization l0-1 
printing J :-o 

Caps Lock key 2~8. 250. 252 
cards 

expansion cards 220-222 
memorr expansion cards 222 
\u 1:3us expansion cards 220-221 
video cards 220 

Cl )E\Is 126. !:i'ee also Control Panels 
CD-RO~ I discs. sharing O\'Cr networks 

191- 192 
chains. See daisy chains 



changing 
alen sounds 139- 1·11 
Apple menu 126 
blinking rates 1·13 
clock battery 227 
colors 

in color wheel 147-1 ~B 
in Label menu 128- 129 
in Monitors control panel149 

clcskrop parrern 142-143 
clocumenrs 50-56 
icon names 66- 67 
icons, appearance of 145- 146 
kev!Joard lavout 136 
keyboard operation 135- 136, 137 
keyboard shorrcurs ,,·irh Sricky Kevs 13-
!.abel menu items 128-129 
memory u:.cd IJy !lOft ware 99-100 
mouse operations 134-135, 136-137 

paper size 16-1 
passwords 188. 203 
screen brightness 151 
speaker volume 139 
svsrem startup 12G 
windo\\' color 147- 1'18 
wi nclow d isplavs 144-14 5 

characrer keys ·137, 245 
characters, non-English and special symbols 

·r ' ·r-- )'1-- )) 

charaner sers 248-255. See also fonrs; 
kevboards 

Chooser (Apple menu) 57-W. 161-165 
activating Applcl:tlk wirh 180 
connecring ro shared disks \Yirh IB-1 
chousing primer \\ith 161- 165 
nerworks and 163-164 

choosing 
irerns from menus 244 
irems from submenus 244 
printers 57- 59, 161- 165 

cleaning system componenrs 225-227 
Clean Up command (Special menu) 12, 113 
Clear command (Eclir menu) 55 
clearing memory 2.) I 
Clear key 2~9. 251. 253 
clicking. See also choosing: mouse: opening; 

pointer: sclC'cting 
clicking with mou~e 9 .. 237-238 
clicking with numeric keypad 136 
double-clicking 50, 56, 238 

changing speed of 135 
with keypad 136 

Shift-clicking 5·1 
Clipboard 54 
clock 

hauery, changing 227 
serring 129-130 

close box for windows 23. 33. 2'11 
Close command (File menu) 246 
CloseView 152-153 
Close \\Iindow command (File menu) 25. 33 

dosing. !:Jee also quitring 
documenrs -~-

Trash 25. r 
windows 23-25. 33. 2-tl 

Color control panel 1·1- , 1 1B 
color documenrs. priming 167 
color, moniror. turning on U9 
colors, changing 

desktop partern ·142 
highlight 147- I ~R 
icons 146 
in m lon\heell2H-129. 147-l4H 
in Labels control panel (Label menu) 

128-129 
windows l·i-- I 18 

Command key 22. 2-18, 250. 252. See also 
kerboard shoncuts 

commands. See also menus or specific 
COIII/II a II d 

choosing from menus 12 
din11ned 2-1) 
help for RO- K I 
shorrcurs f<1r·. See kevboarcl shorrcurs 

communication. See networks 
con1mun ications products, Svstcm 7 and 212 
Communications 'loolbox 212 
components. See also peripheral devices or 

spec[/ic COIIIfJO!Ielll 

connecting 21)-220 
handling 223- 225 

computers. See spec(jlc computer or topic 
computer riruses 9-

lnckx :ZH'i 



configuring 
Macintosh for networks 179- 182 
multiple monitors 1 )0-1 )1 

connecting 213-220 
ADB dcvie<.::i 218 
external floppy disk drive 218 
hard clisks 21 3- 21 6 
headphones 219 
LocaiTalk cables 179 
microphone 219 
modem 21 7 
monitors 220 
primers 217 
safety tips for 223 
SCSI devices 213-216 
speakers 219 
to network 179-180 
to shared disks 184-185 
trackballs 218 

connectors, handling 223 
contrast control 151 
Control key 248, 250, 252 
Control Panels (Apple menu) 105 

Brightness control panel 151 
Color control panel 147, 148 
Date & Time 129 
File Sharing Monitor control panel 200 
General Controls 142 
Keyboard comrol panel 135-137 
Labels comrol panel 128- 129 
Memory control panel 156-159 
Monitors control panel 149- 151 
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Control Panels (conlinued) 
Mouse conrrol panel 134-135 
Network comrol panel 180- 181 
Numbers 138 
Sharing Setup conrrol panel 182, 190, 210 
Sound comrol panel 139-141 
Sranup Disk control panel 105- 106 
Users & Groups comrol panel 190- 191, 

193, 194-195, 196, 197, 198, 
202-203, 211 

Views conrrol panel 144-145 
controlling pointer from keyboard 136- 137 
converting 

documents to stationery pads 122 
DOS and ProDOS disks and files 258- 260 

copying 
disk comems lOB, 245 
documents 

to backup disk 61-62, 108, 247 
to or from shared disks 187 
with Duplicate command 66, 247 
with Save As command 68-69, 247 
with shortcut 247 

graphics 145 
icons 61-62, 239 

from one disk to another 61-62, 
238 
on same disk 239 
onto another disk 239 

restrictions on 263 
software licensing agreement 96, 192, 263 
software onto hard disk 31- 33, 38-39 

copyright laws 96, 192, 263 
correcting mistakes. See editing 
creating 

aliases 72- 74, 116 
documents 43 
folders 71, 11 4 
on shared disks 187, 189-191 
stationery remplares 75- 77, 122-123 

currency 138 
current startup disk. See stan up disk 
cursor. See pointer 
customizing 125- 159 

alerr sounds 139-141 
Apple menu 126, 127 
blinking rates 143 
colors or grays 12R-129, 148 
desktop pauern 142- 143 
highlight colors 147-148 
icon appearance 145-146 
keyboard 135- 137 
keyboard shoncurs 137 
Label menu 128-129 
men u items, blinking of 143 
mouse operations 134-135 
screen 151-153 
System Folder 126-1 27 
system sof1ware 92, 94-95, 126-127 
system startup 126 
window display 144-145 

Cut command (Edit menu) 54. See also 
deleting; editing; erasing; Paste 
command 

CU[ting texr 54 



D 
daisy chains 214- 216, 218 
damaged disks 108 
darkened icons. See highlighted icons 
Data Access Language (DAL) 212 
date and time 129- 134 
Date & Time conrrol ranel 129 
default network zones 1Sl 
Delete key 43, 51, 55, 249, 251, 253 
deleting. See also Clear command; Cut 

command; editing; erasing; 
removing; Trash 

flies from System Folder 127 
fonts from System Folder 127, 172 
items from Apple menu 127 
items from disks ('li-ash) 36-37 
System f-olders, extra 39 
text 54-55 

deselecting icons 239 
clesignar ing startup disk 105-106 
desktop. See also files; Finder; folders or 

spec(fic desklop eleme111 
acti vat ing wincluws on 240 
arranging icons on 113 
changing how icons are displayed on 

(View menu) 124, 242 
changing icon names on 66-67 
changing window display on 144- 145 
cleaning up 12, 113 
copying icons on 239 
creating folders on 71, 114 

desktop (conlinued) 
description of 5, 18-19 
disks and 245-246 
displaying window comems on (View 

menu) 124, 242 
dragging icons on 238 
failure ro appear 233 
folders and 19, 70-72, 114, 240, 242 
hiding and showing windows on 98 
icons and ·1s, 237-240 
inrroduction to 7-25 
key commands and 22, 245 
menus and 19, 243-244 
moving icons on 239 
moving items to 118 
moving windows on 23-25. 241 
naming folders on 114 
naming icons un 66-67 
opening higher-level folder windows on 

242 
opening icons on 13, 239 
pauern, changing 142-143 
printing {lies from 167 
printing window contents from 168 
quick reference for 237-247 
rebuilding 232 
removing hard disk icon from 109 
removing icons from 36- 37, 240 
renaming icons on 104, 239 
selecting icons on 237-238. 239 
shortcuts for 245 
software and 246-247 
·n·ash and 19, 36- 37, 238, 2-tO 
\Yindows and 14-21. 23- 25. 2-t0-242 

dcvc:lopers, assistance for 262-263 
device drivers 

installing 126, 162-167. 21-J 
networking 127 
primer 162, 163, 165-167 
removing from System Folder J 27 
scanner 126 

device numbers. See SCSI ID numbers 
devices. See peripheral devices or spec(fic 

de11ice 
diacritical marks, typing 254-255 
dialog boxes 115, 245. See also menus 
dimmed commands 243 
directory dialog boxes. See also menus 

purpose of 115 
shoncuts for 245 

disabling 
Alarm Clock 134 
alen sound 139 
CloscView 152 
Empty 'fi·ash warning 154 
tile sharing 199 
Mouse Keys 136 
Slow Keys 137 
Sticky Keys 137 

disconnecting 
from shared disks 185 
network users 201 

discs. See CD-KOI'vl discs 
disk cache, adjusting 156. See also memory 
disk drive pon 218 

lml<.:x 287 



disk dri1es. See also floppy disks drii'C~: hard 
disks 

:1ccessing ,,·irh Drive bull on I 02 
care and maintenance of 225 
connecring 218 

diskerres. See floppy disks 
I )isk First Aiel program 111 

disk icons 18. 233 
blinking question mark on disk 1)) 

X on disk 233 
disks 28- 39, 101- 111. See also CD-R0!\11 

discs; lloppv disks; hard disks; 
icons; initializing; startup disk 

backup disks 96 
care and mainrenancc of II 0. 225 
copving 2·15 
damaged 97, 108 
direcrories of 11 '.i 
/Jisldbols 96, 102, Ill. 112 
cjecting } 1, 62. 109. 2-16 
exchanging wirh ~IS-DOS and Apple II 

computers 256- 260 
5Xi-inch (ro!S-DOS) 257 
handling 225 
initializing 101-104 
in MS-DOS or ProDOS format 256-257 
inserring into drive 28. 245 
inrroducrion ro 28- :19 
locking/unlocking 35. lOG-lOS. 2-16 
opening. See icons, opening 
Printing disk 165 

2~~ lmln 

disks (continued) 
priracy and 206 
protecting informarion on 106 
quick rdercnce f(>r 2~5-2-16 
reference for 101- 112 
saving files on. See saving 
shared lH, 1H3-192 
srarrup disk. purpose of 5 
s"·itching be[\Yeen ] 03 
resring and repairing 110- 112 

Disk 7oo/s disk 96, 98, ·111, 112 
displaying 

folder contents 242 
fonrs 17-1 
menus 2-13 
numbers and currency 1:)8 

documents. See also files: icons: software 
progt<tms; tcxr 

adding ro folders -,_-2 
alias - 2-7-1.108, 116- 11-
backing up 108, 2-17 
changing 50-52, 53, 5-l-56 
closing '17, 216 
copying wirh Duplicare command 66 
creating 43 
creating templates for 122- 123 
empty 43 
erasing 1.vith Trash %- 37 
gelling information about (Get Info) 

76-77, 123- 12-1 
lockect, searching for 121 
locking w-- 108, 123 
naming -13-H. 65 

documents (continued) 
opening 

at sranup 126 
bv cloublc-clicking SO. 23R 
\Yith Open command 1.:). 1-l. 17 

organizing 63--7. 113- 12-1 
priming 59-60. 161-1:-6 
purpose of 19 
saving 

aliases of 72-74 
as starionery pads 76, 122 
differenr versions of 68-69 
on differem disk 61-62 
trouble wirh 108 
with Duplicate command 66 
,,·irh Save As command 68- 69, 2117 
with Sa\e command -1j--1-1. 53. 2~6 

sc;Jrching for 118- 121 
sharing over nenvorks 187-201 
stationery pad /)- - -;. 122- 123 
unlocking 121 
"umitled'' ~3 

OOS. See ~ I S-DOS 

double-clicking )0, 56, 238. See also clicking; 
mouse 

changing speed of 135 
1\'ith numeric keypad l:\6 

double-sided floppy disks (800K). See also 
disks; tloppy disks 

description of 28-29 
inirializing 103-1 0~ 

ckm nloading l(mts 1-5- 1- 1. See alsu fonts 



dragging 
icons 10- 11, 2.)H 

from Trash r 
on a si ngle disk 2:\H 
to a nut her disk IOtl. ~:\H 
to desktop IIH 
to System Folder 126---127 
to Trash 2:\tl 
with keypad 1:)6-1.)­

over texr 'i I 
size hox I (> 

,,·indow title bar 2)-2~ 
Dri\'e button, switching disks ll'ith 10:1 
drivers. See device drivers 
Duplicate command (File menu) 66, 217 
duplic lling donuncnts (H- (>(>. 2-l"". See also 

copl'ing 

E 
Easy Inst:1ll option (Installer) 9:) 
editino ..... 

desktop pattern I ·12- l-t,) 
text -12. )0-)2, )~-)(> 

Edit menu 
Clear command 'i'i 
Cut cunHna11d ) -1 

Paste command )'i 
tlOOK lloppv disks. See double-sided lloppv 

disks: Ooppy disks 
Ejen Disk mmmancl (Special menu) 109 

eject ing disks 
shortcut for 109 
'' ith Ejerr Disk command 109 
ll'irh Put i\ll'a\' command j -1. 62 . 109. 2-16 
ll'ith Tr;bh '109 

clecrrical grounding 22-i 
electronic bullcrin boards 9"7. 206. See also 

nel\\'Orks 
empt\' dOCUJllelllS -!j 
En1pty Trash command (Special t\llcnu) 37 

disabling 15·1 
Erase Disk command (Special menu) 105 
erasing 

lloppy disks 

ll'XI 

during inirializarion 30-.)1. 101, I0-1 
with Erase Disk command 10) 
ll'ith Trash 36- .)7. 2-10 

with Clear command 'i'i 
ll'ith Clear key 2'i9, 2) 1, 2):\ 
ll'irh C. u1 command 'i-1 
\\'ith Delcre kev '55. 2~9. 251. 253 

error messages 2:1 1. 2:\5. See olso 
troubleshooting 

Escape key 2-19. 250, 252 
ErhcrTalk networks 179-180. See also 

nel\\urks 
exchanging disk and files ,,·irh 1\ \S-DOS ancl 

Apple \I computers 2'i6- 2GO 
expanding 

.\ \acintosh S\'Stcm 213- 222 
memon· 222 

expansion cards 220- 221 

expansion slots no-n I 
Extended Ke,hoarclll 2'i2- 2'i.1 
external de\·ices. See olsu peripheral devin~s 

or spec(j/c det ·ice 
connecring 21.3-216 
turning off 6 
l llming on -1 

external flop1w disk dri\'ts. See also disk 
drives; floppv disk drives 

connecting 218 
ejecting disks from I 09 

external hard disks. See also disks: hare! clisks 
mnnecring 215- 216 
ensuring recogn ition of lOG 
SCSi lD llllrniJer for 11 0 
turn ing ofT 6 
1urn ing on ·1, 106 

CI'Cstrain. avoiding 90 

F 
!:11 igue. avoiding 90 
File menu 

Close command 2"16 
Close \Vinclo\\' command 25. 33 
Duplicare command 06, 2-17 
Find Again command 119-120 
find command 118-121 
Cet lnh) command -6. 100. 10/. l C U:\ 
.\lake Alias m mmand -.). 116 
\ell' Fuklcr com mand - J. 11-1 

lmk:x ~H9 



file menu (continuetO 
New User command 193 
Open command 13-14, 17,33 
Page Setup command 164-165 
Print command 59-60 
Print Window command 168 
Put Away command 34, 37, 62, 109, 118, 

185 
Save A~ command 68-69, 122 
Save command 43--44, 53 
Sharing command 205 

Ales. See also clireCLories; clocumems; folders; 
icons; software programs; system 
software; text 

accessing on other computers 183-187 
adding 

to folders 71 - 74 
to system software 94 

aliases for 72- 74, 108, 116--117 
arranging on desktop 113 
backing up 61-62, 108, 247 
closing 47 
convening to and from MS-DOS or 

ProDOS 258--260 
copying 61-62, 66, 239 
creating 43 
damage from viruses 97 
directories of 115 
erasing with Trash 36- 37, 240 
exchanging with MS-DOS and Apple II 

computers 256- 260 
Anding 118- 121 
folders and. See folders 
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flies (continued) 
getting information about (Get Info) 

76-77, 123- 124 
graphics 230 
installing in Apple menu 117, 126 
locked 121 
locking 107- 108, 123 
moving 

on desktop 239 
to desktop 11S 

MS-DOS 256- 260 
naming 43--44, 65, 66-67 
networks and 177-212 
opening 

at startup 126 
by double-clicking 50, 238 
with Open command 13, 14, 17 

organizing 63- 77, 113-124 
PostScrirr 176 
priming 63, 161-176 
ProDOS 256--260 
protecting 106 
removing 

from disk 36- 37, 240 
from System Folder 127 

renaming on desktop 66-67 
saving. See saving documents 
searching for 118-121 
sharing over networks 187-201 
storing in more than one folder 72-74 
unlocking 121 
"untitled" 43 
viewing on networks 204 

file servers. See also networks 
aliases and 116 
converUng MS-DOS files on 260 
definition of 1S3 
system software and 93 
viruses and 97 

file sharing 183, 187-201. See also networks 
activating 189-190 
disabling 199- 200 
software licensing agreement 96, 192, 263 
monitOring activity of 200 

File Sharing Monitor control panel 200 
filing system. See desktop; files; Finder; 

folders 
Find Again command (File menu) 119- 120 

shortcut for 119 
Find command (File menu) 118-121 

shortcut for llS 
uses for 121 

Finder. See also desktop 
activating 45--46 
icon for 45, 98 
rrinting documents from 167 
printing window contents from 168 
purpose of 45--46 
shortcuts for 245 

Finder command (Aprlication menu) 46 
finding flies or folders 

with aliases 116--117 
with Find command 118-121 

5.25-inch disks (MS-DOS) 257 
fixed-size fonts 171- 172 



floppy disk drives. See also disk drives; floppy 
disks 

care anti maintenance of 225 
connecting 218 
ejecting disks from .34, 62, 109. 246 
external 109, 21 8 
inserting disk into 28, 245 
SuperDrive 28, 34 

floppy disk icon 18, 32 
floppy disks 101- 112. See also disks; floppy 

disk drives; hard disks 
as startup disks 92, 96 
capacities of 29 
care and maintenance of 36, 225 
compared with hard disks 32 
copying contents of 31- 34, 108, 245 
cla m;~gecl 108 
description of 29, 32 
double-sided (BOOK) 28- 29 
ejecting 

shoncur for 109 
with Eject Disk command 109 
with Put Away command 34, 62, 
109, 246 
with 'Il·ash 109 

erasing 
during initialization 30-31, 104 
with Erase Disk command 105 
with Trash 36- 37, 240 

5.25-inch (DOS) 257 
full 108 
h"ndling 225 
high-density (1.4MB) 28-29. 35 

floppv disks (colllinued) 
initializing 30- 31, 101- 104 
in MS-DOS or ProDOS format 256- 257 
inserting into drive 28, 245 
labeling 28 
locking/unlocking 35, 106-108, 246 
naming 104 
older Macinrosh compmers and 29 
1.4MB 28-29, 35 
quick reference for 245-246 
reference for 101- 112 
removing from drive 246 
renaming on desktop 104 
saving fi les on. See saving 
resting and repairing 110- 112 
types of 28- 29 
untitled 104 

folders. See also files; icons; software; System 
Folder 

access privileges and 187-188, 205-206 
adding tiles ro 71- 74 
aliases and 72-74, 116 
Apple Menu Items folder 117, 126 
as bulletin boards 206 
creating 

on desktop 71, 114 
on shared disks 187- 189 

directories of 115 
dragging icons to 240 
erasing with Trash 36- 37 
finding with Find command 118- 121 
higher-level, opening 242 
locking 108 

folders (COlli i11ued) 
naming 71, 11·1 
nesring 11 4 
networks and 187-189, 205- 206 
opening 1.), 2-12 
organizing icons in 70- 72 
ourline views of 242 
owned 187- 189, 198, 204 
privacy and 206 
purpose of 19, 114 
searching for ll8- 121 
shared 191- 192 
Startup Items folder 126 
sroring files in more rhan one 72- 74 
"untitled" 71 
viewing contents of 242 
viewing on networks 201 

fonrs l71-"176 
adding to System Folder 172 
appearance of 229- 230 
hirmappecl 171-172, 229-230 
definition of J 7 J 
displaying 174 
downloading 173-174 
installing J 72 
omline 171-172. 173, 229-230 
PostScript 173 
printing 229-230 

list of 174 
samples of 174 

removing from System Folder 127. 1 n 
software programs and 174 
transferring to Laser\Vriter 173-177 
'li·ueType 171. 230 
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forms. See stationery pads 
··frmming·· Macintosh icon 233 
fro7.en system 2.) 1. 2} ) 
full disks 108 
function keys 22, 2S2 

G 
General Controls (Apple Menu) 

changing blinking of inserrion point \Yith 
1-H 

clunging desktop pan ern wirh I ~2-1 -l.) 

changing menu item blink rate with l ~j 

seu ing time and date with 129- 134 
Get lnfu conumnd (File menu) 76, 100. 107. 

117, 123 
aliases and 117 
reference for 123- 12-i 
shortcut for 12.)-12--1 

graphics 
copying 1·1)- 1'16 
pasting 1-t6 

graphics Illes 2.)0 
graphics programs 1't5 
gray-scale prinring 167 
gray shades. customizing 149 
grounded omlcrs 22-1 
Group icon 19S 

292 Index 

guest net 1\"0rk users 

H 

access pri\'ileges for 190-191. 20-t 
connecting ro shared disks 184-185 
denying access to 197-198 
linking to programs 211 
sharing owned folders with 187 

halftone printing 167 
handling svsrem components 223-225 
.. happy Macintosh·· icon 5, 233 
hard disk drives. See hard disks 
hard disk icon 1R, 32 
removing from desktop 109 
hard disks 101-112. See also disks: fioppy 

disks 
as startup disks 92, 105-106 
.MJX and 9.3 
compared with fioppy disks 32 
descript ion of 32 
external 32 

connecting 213-216 
!'"lacintosh recognition of 106 
SCSI m number for 110 
turning off 6 
turning on -i 

hard disk space as memory 157- 158 
initiali7.ing 102- 103. 175 
installing soft\\·arc on 31-33. 38- 39. 96 

hard disks (cullt il!ued) 
internal. built-in termin;uor for 216 
naming 10:) 
precaurions for 110 
reference for I 01- 112 
SCSI 10 numbers of 102- 10.? 
sharing over networks l l3j, 191- 192 
testing 110-112 
mlume names of 103 

hardware developers. assistance for 262- 263 
hardware. serring up 87- 91 
HD SC Setup. See Apple HD SC Serup 

program 
headphones, connecting 219 
Help icon SO 
l lclp menu 2--1 .1 

Hide Balloons command 81 
Show Balloons command 1-\0, 165 

l lelp Sysrem 80- 1-\ I, 2-i:) 
Hide Balloons command (Help menu) Sl 
Hide Others command (Applicarion menu) 

99 
high-clcnsit)' disks ( l.--1 ~111). See also fioppv 

disks 
description of 2S-29 
initializing 30- :$ I . I 0:)- 1 0~ 
locking/unlocking 35 

highlight colors. changing 1-17-1-tl-l 
highlighted icons 9. 13. 31 
highlighted text ) I 



I, J 
!-beam poimer -)() 
IR\1-cornpati!Jie dis k~ and files . . X!e MS-DOS 
icons 2.19-2-tO. See also clc::-ktop: disk~: Ilk:,: 

l(>ldcr:. 
ADil pnn 211:! 
adding to folders -, 
Alarlll Clock L)3 
alias 7) 

Apple liD SC Setup 102. 112 
AppleSharc ltl t 
Application menu -12. 98 
arranging on desktop J I) 
a.-,:-.ign ing mlors to l-16 
Brightne:-,s l'i l 
Ca lcnda r 129-1 :1-t 
changing appearance of I 15- I 16 
changing name of 66-(t 
clicking 9. 2r-2:1~ 
CloseVie\\ l'i2 
copying 61. 2.~9 
lbdeuing 2.19 
device driver 21-t 
dimmed 98 
disk lH 
di~k dril'e pon 218 
dnublnlicking 50. 238 

icon:> (WIIIilllted) 

dragging 10- ll. 2)8 
from Trash r 
on a single disk 238 
to another disk JOo. 2:io 
to desktop 11 S 
to Sy~tem Folder 12<>-1 T 
to 'li·ash 2:\8 
\\'ith keypad 136-1:\-:­

FiiHler -1) . 9H 
noppv disk I H . . )2 
folder.'> and -o--2. 191. 2-10 
getting int(>nmtion about (Get tnfc>) -6. 

too. w-. 11- . 12.1-12-t 
Group 195 
"happy .\l:lrimo.,h" 5. 2:i:\ 
hard disk 1-'i. IS .. 12 
lklp HO 
highlighted 9. 13. 31 
Ke~·board 1.)-) 

bbcling l-l6 
l.:thd~ 12H 
.\ kmor~ 156. 15- -1'i8 
lllodem pon 2 ,­
,\lonitors 1-t9 
namir1g 66-6-;-
:--Jetllork lt\0 
\e1r Group 19 t 
opening 13. 'iO. 2.3S. 2.)9 
org:mii'ing -u--2 

icon:-. (COIIIilllled) 

pointing to 8 
pn.:~-;ing 9 
printer )tl. 162 
Printer pnn 21-
purpme of IS. 2.)9 

que:-.tionmark (?)disk 'i. 92. 2.)5 
quick reference for 259-2-tO 
removing 2·10 
renaming 66-67, 10· 1. 239 
·-sad ~l ari nrosh" 253 
SCSI 21.) 
:>electing 2.)9 

br clicking mouse 9. 2_r - 25H 
by clicking 11·ith kerpad 156 
morl' than one by Shift-clicking 23~ 

:-.harcd folders 192 
Sharing Setup 182. 190 
Sound 1_)9 
sound inptu 1-lO. 219 
:.uund output 219 
St:ll ion cry pad 122 
·ti'ash t ,_ 15. 19. 2-1 . :i<>-r 
tl'pe:-. of IH 
Views 1-H-1 ~5 

X disk 2:)3 
II ) numbl'rs. See SCSIID numbers 
images. See also icons 

illl'l'l'tl'd 1 ) ,) 
reduced 16-t 
snap.-.hots of 230 

Index .?9.1 



ImageWriter printers. See also p1imers; 
priming 

connecting 217 
Page Setup dialog box for 164 
Select light on 168 

initializing disks 101-104 
floppy disks 30-31, 101- 104, 256- 257 
hard disks 102- 103, 175 
MS-DOS or ProDOS disks 256- 257 

!NITs 126 
inserring 

tloppy disk imo drive 28, 245 
text 51-52 

insenion point. See also pointer 
changing blink rate of 144 
definition of 50 

Installer 92- 95 
Customize opr.ion 94-95 
Easy Install option 93 
Minimal software option 95 
networks and 93 
uptlating primer drivers on networked 

computers wir.h 165- 167 
installing 

alert sounds 140 
CloseView 152 
drivers 126, 162-167, 214 
expansion cards 220-221 
flies in System Folder 125-126 
fonts 172 
items in Apple menu 117, 126 
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installing (continued) 
printer drivers 

in System Folder 163-164 
on networked compmers 165- 167 

software on hard disk 31-33, 38- 39, 96 
system sof[\vare 92- 95 

custOmized system 94-95 
small system 95 
standard system 93 

interference, ratlio and TV xiii, 220, 224 
inrernal floppy disk drive. See floppy disk 

drives; SuperDrive 
internal hard disks. See disks; hard disks 
imernational keyboards 136 
interrupt and reset switches 231 
inverting images on screen 153 

K 
Keyboard control panel 135- 137 
keyboard files, removing from System Folder 

127 
Keyboartl icon 135 
keyboards. See also keyboartl shortcuts; keys 

adjusting 
for slow typing 137 
position of 90, 91 

Apple Extended Keyboard II 252-253 
Apple Keyboard 250- 251 
Apple Keyboard II 248-249 
care and maintenance of 224 

keyboards (continuecO 
character sets and 248-255 
customizing 135- 136, 137 
description of 248-255 
international use of 136 
layout, changing 136 
non-English characters and 254-255 
special characters and 254-255 
spills on 224 
trouble with 234 

keyboard shoncurs 
CloseView and 153 
customizing with Sticky Keys 137 
ejecting floppy disks 109 
Find Again command (:1€-G) 119 
Fintl command (:1€-F) 118 
Finder and directory tlialog boxes 245 
Get Info command (:1€-I) 123 
Prim (:1€-P) 167 
purpose of 53 
Quit command (:1€-Q) 60 
Save (:1€-S) 53, 246 

Key Caps (Apple menu) 254-255 
keyboard commands 22 
keypad, numeric 

controlling pointer with 136-13 7 
description of 249, 251, 253 



keys. See also keyboards; keyboard shoncurs; 

L 

keyrad 
arrow keys 22, 2-!5, 249.251,253 
Caps Lock 248, 250, 252 
character keys 137, 245 
Clear 249, 251, 253 
Command 22 , 248, 250, 252 
Control 24tl, 250, 252 
Delete 5"1 , 55,249, 251 , 253 
Enter 249, 251 , 253 
Escape 249, 250, 252 
funcrion keys 22, 252 
layout of, changing 136 
modifier ke)'S 22, 137, 254-255 
numeric keys 249, 251, 253 
Option 113, 248, 250, 252 
Power On 4, 249, 251 , 253 
repetition ratt: of 135-136 
Return 249, 251 ,253 
Shih 22,53, 2~8,250,252 
"Htb 245, 248, 250, 252 

labeling. See also naming 
flurry disks 28 
icons 146 

Label menu, changing items in 128- 129 
Labels icon 128 

l.aser\\'rirer Fom Utility 1-3-1-6 
downloading roms with 173-174 
finding our about fonts with 17-t 
initializing hard disks with 175 
restarting l.aserWriter with 176 
transferring PostScript files with 176 
wrning sample page on or off with 175 

l.aserWriter printers. See also primers; 
printing 

background priming with 169-"170 
connecting 217 
Laser\Xfriter Fom Utility and 175-176 
Lascr\Xfriter liNT 217 
1\:rsonal Laser\Vtiter SC 58. 162, 217 
Print dialog box for 167 
restart ing 176 
u~tnsferring fonts to 173-174 
transferring PostSClipt files to 176 

linking programs over networks 208-211 
Locamtlk networks 179. See also networks 
locating files or folders 118-121 
locked Illes, searching for 121 
locking 

files 107-108, 123 
floppy disks 35, 107, 246 
folders 108 
mouse bunon with keypad 136 

M 

\lacimosh. See also sfJec({ic model or topic 
adaptingwyourown use 125-159 
basic skills for 1-83 
care and maimenanct: of 223-227 
connecting componems to. See 

connecting 
expanding 213-222 
naming for network use 182 
nctworksand 177-212 
obtaining additional information about 

261- 263 
operating environment for 227 
reference for 81-263 
restarting 231 
selling up 87-100 
starting ft-5 

"talking" to 12 
trouble with. See troubleshoming 
lllrning on and orr 'l- 6 
viruses and 97 

Macintosh Classic 
monirors and 220 
turning on/olr 11, 6 

Macintosh desktop. See desktop 
Macintosh LC 

expansion slot in 221 
sounclinputand 140 
turning on/off 4, 6 
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\lacinrosh II 
\uBus slors and 221 
wrning on 'off 6 

\lacimosh llci 
expansion slor in 22 I 
monitors and 120 

1\lacintosh IIfx 
cable terminator for 216 
monirors and 220 

\ lacintosh I lsi, slor <1daprer for 221 
,\ lacintosh user groups 2o1 
magnifying screen images 152- 153 
maintenance 223-2T 

cleaning componenrs 22)- 2T 
tloppr disks 36 
kq board 22-t 
monitor 22-t 
spills. dealing \rith 22-t 

!I lake Alias command (file menu) -2. 116 
.\lake Changes access pririlege 20 1 
managing memory 1 )+-159 
manu:1l paper feed J-o 
memOIT 15+-159 

checking use of 1 )+-I.:;.:; 
clearing 231 
disk cache 15() 
expanding 222 
h;ml disk space as 15--I ')8 
managing 15·1-159 
memory cache expan~ion sims 220-221 
\ lemon· mnrrol p:tnel 156- 159 

~9(i Index 

memory (Witlinued) 
memory expan~ion carlb 220- 221 
nel\\-orks :1ncl 155 
RA.\1 151- 159 
sofm·are programs and 99-100 
.)2-bir addressing 158-159 

· using as RAM disk 159-160 
video and l-t9 
virtual memory 157-158 

\ !emory icon 156. 157- l)H 
memos. See stationerv documents 
menu bar. appearance of 5 
menus 18---19. 2-t3-2-t-l 

changing blinking rate of items in 1-d 
choo:,ing item:, from 12. 2 1 1 
dimmed icom in 98 
displaying 2-t3 
opening 258 
pop-up 115. 2-t3- 2-t-t 
pull-clmm 2-d-2-t-t 
purpose of 1t>--19 
quick reference for 2-t3-2-t-t 
submenus 2-t-t 
rirles 2-t,') 

viewing options in (pressing) 9 
working with 243-244 

1nicrophones 140- 141, 219 
modem port 5R. 162. 217 
modem pon icon 2J 7 
modems. connecting 2 C 
modi ncr keys 22. 13-. 25+-255. See al.\o keys 

moniror.~. See (f/so screen 
add if ional J 50- 15 I. 220 
care and maintenance of 22-t 
configuring multiple 150-151 
connecting 220 
icons for J -19-150 
lD numbers for 150 
imerfcrcnce on 220 
large 220, 22 1 
position of H9 
trouble'' ith 2)2- 2)5 
turning on/off -1. G 

\ lunitors control panel 1-19-151 
\ lonitors icon 1-19-150 
monitor suppon, built-in I 19 
mouse 

bun on 
changing double-dick speed of 13) 
locking and releasing with 
keypad J.)G 

cleaning 226- 2r 
clicking (:.electing) objem ,,·ith 9. 

2,)'7- 2,)8 
controlling \\'ith keypad 136-lJ­
customizing operation or 13·1- 135 
double-clicking (opening) objects with 50, 

)6,238 
dragging objects with 10- 11. 2)8 
holding 10 
pointing at objens '' ith 8. 2r 
pressing objens wi!h 9. 238 



mouse (continued) 
quick reference for 2r - 238 
Shift -clicking (selecting) objects 1\'ith '>'t, 

238 
techniques for S-11 , 23""'- 238 
trouble moving poinrer with 23-+ 

\ louse control panel 1)'t- 135 
1\ louse Keys, conrrolling poinrer with 

136-137 
moving 

icons (dragging) 10-11. 23~ 
items ro clcskrop 118 
text 5-t- )) 
windm,·s 23-2-+, 2-+ 1 

~ IS-DOS 256-260 
convening nics to and from 25&-260 
initializing disks for 256-257 

multipk monitors, configuring 150-15"1 

N 
naming 

documctHs -t)-H, 65 
floppy disks 104 
folders 71, 114 
groups of network users 194-195 
hard disks 10) 
icons 2.)9 
~lacintosh and o\\·ner for network use 182 
registered network users 193 
users to link programs 211 

ner\\"ork administrator 1-9. 181. 183 
:.:el\mrk comrol panel (Apple menu) 

1 ~0- 1 81 

nem"Ork drivers. remoring from System 
Folder 1r 

~enmrk icon ISO 
networks 1T -212 

accessing ,\ lacimosh while a\\"ay from it 
202-203 

access privileges and 1R7-189, 204-211 
i\pple"I~tlk 5H-59, 163, 179-180, 184 
capabilities of 177-178 
choosing primer for 163- 165 
configuring ,\lacimosh for 1-9-182 
connecting ro 1-9- 180 
copyright la\\"s and 192 
disconnecting user~ on 201 
Erher·l:tlk 179- 180 
groups of users on 194-198 
guest users on 18-+-185. 18- . 190-191, 

19-- 198, 20-+. 211 
Installer and 93 
installing primer dri,·ers on !6)-167 
l.ocal'lillk 179 
memory and 155 
naming Macintosh and its owner 182 
passwords and 182. 185. 187. 188, 203 
printers and 58-59 
privacy ancl 192, 206 
registered groups on 189. 20-t-205 

net 'rorks (coni inued) 
registered users on lib, 18-, 189. 192, 

193, 19-+, 20-+-205 
restricting access to 197 
selecting network connection 180 
setting up ~lacimosh for 1-9-182 
shared disks ancl 18. 182-1S9 
sharing files and folders on 187-192 
soft ware programs and 207-211 
'lbkcn'!alk 179, 180 
viruses and 97 
zones 58- 59. 18"1 

default 181 
selecting 59. 163. 181. 18-+ 

:'\c,,· Folder command (File menu) -1. 11-+ 
:\C\\' Group icon 19-+ 
:'\ew !Jser command (File menu) 193 
non-English ch:mtcters 25'1-255 
Nul3us expansion cards and slots 220-221 
Numbers control panel 138 
numeric keypad. controlling poimer \rith 

136-1r 
numeric keys 2·t9. 251, 253 

0 
office, arranging 89 
on/off switch -1. 6 
1.-+ ~IB noppy disks. See floppy disks: high­

densit\' disks 
Open command (File menu) 1)-1-+ . C 33 

Index 29-



opening 
aliases 116 
documems 50, 70 
files 

at sranup 126 
by double-clicking 50, 238 
with Open command 13, 14, 17, 70 

folders 13, 242 
icons 50, 238, 239 
menus 238 
software programs 42, 98, 246 
stationery pads 122- 123 
System Folder 17 
Trash 37 

open software programs. See active software 
program 

operating em·ironment for ~lacimosh 227 
operating systems. See also system sofrware 

NUX 93, 102 
~IS-DOS 256-260 
ProDOS 256-260 
System 6 95, 171. 212 
System 7 95, 96, 15-1, 212 

Option key 113, 248, 250, 252 
organizing files 113- 124 
organizing your work 63- 77 
outline fonts 171-172, 173, 229- 230 
outline views of folders 242 
owned folders 187- 189, 198, 20-t 

transferring O\Ynership of 189, 198 
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p 

Page Setup (File menu) 164-165 
paper. See also printing 

feed. manual 170 
sizes, changing 16-t 
supply, monitoring 170 

passwords. See also networks 
changing 188, 203 
setting 194 
typing 182, 187 
unaccepted 185 

Paste command (Edit menu) 55 
pasting 

graphics 146 
text 55 

pattern of desktop. changing 142-143 
pe1ipheral devices. See also spec({ic det~ice 

connecting 213-221 
handling 223- 225 

pe1ipheral interface cable. See SCSI 
peripheral interface cable 

Personal LaserWriter SC 58, 162, 217 
phono jack adapters 140 
pictures. See graphics 
poinrer 

arrow 8 
comrolling from keyboard 136- 137 
controlling with mouse 8-11, 237 
!-beam 50 
trouble moving 234. 23'5 

pointing at objects with mouse 8, 237 
pop-up menus 115, 243-244. See also menus 
pons 

ADB pon 218 
definition of 213 
disk drive poll 218 
modem port 58, 162, 217 
moniLor port 220 
plimcr pon 58, 162, 179, 217 
SCSI port 213, 215 
sound input pon 141, 219 
sound outpllt pon 219 

PostSC!ipt 173 
files, transferring to LaserWriter 176 
fonts 229- 230 
primers 230 

power 
requiremcms 

of ADB devices 218 
of ~uBus e:xpansion cards 221 

trouble with 232 
turning on/off 4-6 

Power On key 4, 2-t9, 251, 253 
power supply 225 
power switch 4, 6, 232 
preparing disks for usc. See initializing 
pressing objects with mouse 9, 238 
Print command (File menu) 59-60, 167 

shortcut for 167 
p1imed circuit boards. See cards 



primer drivers. See also sysrem sofrware 
insralling in System Folder 163-16-t 
insralling on net\\Orkcd compurers 

16)-16-
prinrer fonrs. See fonrs 
primer pun 58, 162, 179. 217 
Printer porr icon 217 
primers. See also priming or specijlc printer 

choosing 57-59. 161-16) 
connecting 217 
drivers for 162, 163, 165-167 
icons for )8, 162 
Image\Xfrirer 162, 16-t. 167, 168, 21 7 
Laser\\"rirer 58. 162. 16-t. 16- . r5- 1-6. 

n-
nerworks and 58-59 
PosrScript 2.)0 
telling com purer \rhich to use 57-59. 

161- 16·1 
rrou!Jie wirh 168 

Printer L'pdatc documenr (Printing disk) I<)) 

priming )9- 60.161-1-6.Seeolso prinrers 
background 16-t , 169- 170 
canceling 170 
color or gray-scale clocumems 167 
fonrs 1-1 - 176. 229- 230 
from Finder I 6-
learning about 59-60 
manual paper feed 1-0 
monitoring starus or 170 
oprions for 16-t-165. 16-. 16S 

priming (continued) 
reduced images 16-t 
reference for 161-C6 
sample pages 1- 5 
seuing print time 1-o 
several documenrs 170 
while using computer for other work 164. 

169-170 
~·indow contents 168 

Printing disk 165 
Prim~loniwr 1M 169-170 
Print \\IindO\\' command (File menu) 168 
problems. See troubleshooring 
processor-direct expansion slurs 220-221 
ProDOS 2)6- 260 

conrerring files ro and from 2)8-260 
initializing disks for 256-1 ')­

programs. See software prog1~1ms 
prorecring disks. See locking 
pull-down menus 2-t3-2-H. See also menus 
Pur A~·:1y command (File menu) 

Q 

disconnecting from shared disks ~·ith 185 
ejecting disk \\'ith .3-t, 62, 109 
moving items to deskwp with 118 
resroring Trash items with 37 

question mark (?) disk icon 5, 92, 233 
Quit command (File menu) 60, 2r 
quiuing ~oft ware programs 60. 2-t-

R 
~~1dio interference xiii. 220. 22-t 
RA\1 (random-access memory). See also 

memory 
checking use of 154-155 
expanding 222 
managing 154- 159 

RAM disk 159- 160 
rearranging icons on desktop 113 
recording sounds 140-141 
recovering items from Trash 3 7 
reduced images, printing 164 
registered network groups. See also nemmks 

access pririleges for 20-t- 206 
giring fo!der mmership to 189 

regisrered network users. See also nem-orks 
access privileges for 20-t-206 
connecring to a shared disk 18-t- 185, 18 
gi\'ing folder ownership to 189 
naming 193-195. 196. 198 
removing membership of 19--198 

reinstalling sysrem sofm·are 92- 95 
releasing mouse button with keyp;~cl 136 
removing. See also deleting; erasing 

alert sounds 1-tO 
disk from drive 3-t. 62, 109. 2ci6 
files from Svsrem Folder 127 
fonts fro:n System Folder 172 
icons from desktop 240 
items from Apple menu 117. 126, 1 r 
Sysrem Folders. extra 39 
users from a nen\'ork 19-- 198 
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renaming icons 66-6- , l0-1, 239 
repairing disks II 0- 112 
reset and imcrrupt switches 231 
resizing windows 16-17, lt5, 241 
Restart commanct (Special menu) 231 
restarting 

Laser\'i"riter 176 
i\lacimosh 231 

restricted network access 187, 197 
restrictions on copying softiYare 96, 192, 263 
Rewrn key 249, 251, 253 
rules about copying sofnyare 96. 192, 263 

s 
··sad ~lacimosh .. icon 233 
sample pages, prinring 175 
Save As command (File menu) 6S-69, 122, 

2D 
comrarecl ,,·irh Sa,·e commanu 69 

Sal'c command (File menu) ~3-1~. 53, 2-16 
compared with Save As command 69 
shortcut for 53, 2'16 

saving documents 
as aliases 72-74 
as stationery pads 76, 122 
different ,·ersions of 6S-69 
on cliffcrcm disk 61-02 
trouble \Yith 108 
with Duplicate commanu 66 
with Save As command 68-69, 2-17 
with Save command 43-44, 53, 246 

)00 Index 

scalable fonts 1-l- C2 
scanners, drivers for 126 
screen. See of so monitors 

brightness control 151, 224, 232 
burn in, avoiding 151, 22•1 
capwring .. snapshot"' of 230 
changing colors and gray shades on 

147-149 
cleaning 225 
comrast comrol 151 
damage to 151 
dark 232 
interference on 220. 22~ 
invcning images on 153 
magnified images on 152-153 
trouble \Yith 232. 23+-235 

screen saver programs 151. 22-1 , 232 
scroll arrows 17, 20- 2 I, 24 1 
scroll bars 17. 20-21. 2~ 1 
scroll box 21. 2't J 
SCSI cables 215 
SCSI chains 21-1-215 
SCSI devices 213-216 

builr-in terminarors for 216 
chains or 214- 215 
connecting 213- 216 
turning on 216 
types of 21-1 

SCSI hard disk. resting 112 
SCSI icon 213 
SCSI ID number indicator 215 

SCSI II) numbers 
hard disks 102-103, 110 
monitors 150 
setting 214-215 

SCSI ID number switch 215 
SCSI peripheral inrerface cable 215 
SCSI port 213, 215 
SCSI terminators 216 
searching for mcs and folders ·1 H~-1 2 1 

See files access privilege 204 
Sec Folders access privilege 204 
selecring 

disks or raiders to share 191-192 
icons 

by clicking mouse 9. 2r. 238 
by clicking \\'ith keypad 1:$6 
by Shift-clicking 238 

multiple items 54, 238 
programs for linking 210 
rexr 

by double-clicking 56 
by dragging and highlighting 51-52, 
54- 56 
by Shirt-clicking 54 

Select light (ImageWriter primer) 168 
setting 

Alarm Clock 133- 134 
alen sounds 139-1~1 
date and time 129- 13-t 
network access privileges 20-1-20-
nctwork paSS\YOrds 1S8. 19-1, 203 
numbers ami currency 13H 
print rime 170 
SCSIID numbers 21·1-215 



~cuing up 87- 100 
for net works 179- 182 
hardware 87-91 
system software 92- 96 

shared disks 18. 183- 192. See also nerworks 
access privileges and 187, 204-207 
connecting ro 184- 187 

at startup 186-187 
wi th aliases 186 

copying Ales to or from 187 
copvrighrs 96, 192, 263 
creating folders on 187- 189 
disconnecting from 185 
limited access to 183 
privacy and 192, 206 

sharing fi les and folders on 187-189 
shared fi les 189-203. See also networks 
shared folders 191- 192. See also networks 
Sharing command (File menu) 205 
Sharing Setup comrol panel 182, 190. 2LO 
Sharing Setup icon 182. 190 
sharing sofrware 96. 192, 26) 
Shift-clicking 

ro select multiple items 238 
to select rext 54 

Shift key 22. "53, 248. 250. 252 
Shmr All command (Application menu) 99 
Sho\\· Balloons command (Help menu) 

80, 165 
Shut Down commancl (Special menu) 

disconnecting from shared disks \\·irh 185 
shutting down .\lacintosh with 6 

silcm alens U9 
SIMMs (Single In-Line 1\lemory modules) 222 
size box fon\·indmYs 16-17,45. 2·11 
slots. See expansion slots 
Slow Keys 137 
Small Computer System Interface. See SCSI 
small system software, install ing 95 
smiling Macimosh icon ), 233 
soft\\'are developers, assistance for 262-263 
software programs. See also documents; Ales; 

menus· svstem software ' . 
activating 42, 98, 246 
active 4)-47, 50, 70, 98, 246 
aliases for 116 
backing up 96 
copying rest rictions 96, 192. 263 
documenrs and. See documents 
folders and 114 
fonts ancl 174 
graphics programs 1·15 
installing 

in Apple menu 11 7, 126 
on hard disk 31-.)3, .JH-.39, 96 

licensing agreement 96, 192, 263 
locking 107- 108 
memory usage. changing 99-LOO 
nem-orks and 207- 211 
opening -12, 98, 246 
purpose of 19 
quick reference for 246-247 
quitting 60, 247 
saving documents in. See documents. 

saving 

software programs (coJJtinued) 
screen saver J 51. 22t 232 
seuing up 27. 59 
switching -1)--1-. 98. 2-16 
trouble with 2.3 -5- 236 
types of -16 
upgrading 96 
virus-derenion/elimination 97 
\\"C)rking 1rith several at once 98 

Sound control panel 139-141 
Sound icon U9 
sound input devices 1~0-14 1 
sound input pon 141, 219 
sound ourput port 219 
sounds 

customizing 139-1-11 
recording 1'10- 1-11 
removing from System Folder 127 

speakers, connccring 219 
speaker volume. changing 139 
Special menu 

Clean Gp command 12, 113 
Eject Disk command 109 
Emptv'1htsh command 37, 154 
Erase Disk command 105 
Restart command 231 
Shut Down command 6. 185 

special Sl'mbols 25~-255 
spills, dealing wirh 224 
starting up Macintosh 4-5 
startup. See startup disk: srstem srarrup 
Startup Disk conrrol panel 105 
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startup disk. See also disks; System Folder; 
system software; system startup 

bypassing internal hard disk as 106 
floppy disks as 96 
hard disks as 105- 106 
purpose of 5, 32 
rebuilding deskrop of 232 
removing extra System raider from 39 
search sequence for 106 
sening up 92- 96 
System Folder and 39 
virtual memory and 157 
viruses and 97 

Startup Items folder 126 
starionery pads 75- 77, 122- 123 

creating 75- 77 
icon for 122 
opening 122-123 
saving 76, 122 

Sticky Keys 137 
straightening up files 113 
submenus 244 
SuperDrive 28, 34. See also disks; floppy disk 

drives 
switches. See on/off switch; reset and 

interrupt switches; SCSI ID switch 
System 6 95, 171 , 212 
System 7 95, 96, 154, 212 
system cable. See SCSI system cable 
svsrem extensions 126 
System file, installing alert sounds in 1-10 

j02 Index 

System folder. See also startup disk; system 
software 

adding alert sounds to 140 
adding fonts to 172 
Apple J\ lenu ltems folder 117 
cusromizing 126- 127 
danger of using more than one 95 
dragging items to 126-127 
fonts and 170-176 
installing device drivers in 162-163, 214 
installing files in 126-127 
installing primer drivers in 162- 163 
on sofnYare program disks 96 
opening 17 
purpose of 32, 92 
removing extra 39 
removing nles from 127 
removing fonts from 127, 172 
setting up 92-96 
Start up Items folder 126 

srsrem software. See also sofware; startup 
disk; System Folder 

customizing 126-127 
fonrs and 171-176 
installing, reinstalling, updating 92- 96 

customized system 94-95 
small system 95 
standard system 93 

nerworks and 93 
purpose of ·16 
trouble \rith 233 
vin ual memor~· and 156 

system startup. See also starwp disks 
connecting to shared disks during 

T 

186- 187 
customizing files for 126 
floppv disks and 96 
rrouble wirh 233 

Tab key 245, 248, 250, 252 
"talking" to Macintosh 12 
technical information, obtaining 262-263 
television inrerference xiii. 220, 224 
templates (stationery pads) 75-77, 122- 123 
terminarors. See cable terminators 
testing and repairing disks 110-112 
texr. See also documents 

accent marks and special characters 
2'54-255 

CUlling 5~ 
dragging orer 51 
editing ~2, 50- 52. 5~-56 
erasing 

wirh Clear command 55 
\Vith Clear key 249, 251 , 253 
wirh Cut command 54 
with Delete key 55, 249, 251, 253 

highlighted 51 
!-beam poinrer and 50 
inserting 51- 52 
lllO\~ng 54-55 
pasting 55 



tC:Xt {CO /Ifilllled) 

sclcuing 51-52. 5-f- 56 
by double-clicking 56 
by dragging and highlighting 51- 52, 
5-t-56 
by Shift-clicking 5-I 

typing ·13 
32-bit addressing 158. See also memory 
3.5-inch disks. See floppy disks 
time 

sening Alarm Clock 133-134 
sening system clock 129- 132 

tips and rroubleshoming 229-236 
ririe bar for windows 23-24 
'lilketi!:!lk networks 179, 180. See also 

networks 
tracking speed (mouse), changing 135 
transferring 

fonts to l.ascrWritcr 173-177 
PostScript tiles ro LaserWriter 176 

translating J\IS-DOS and ProDOS files 
258- 260 

Trash 30-.)7 
acrivating 1-1-15 
closing 25, 37 
deleting items with 36-37, 240 
disconnecring from shared disks ~·ith 185 
dragging icons to 238 
ejecting floppy disks with 109 
emptying r: \Yarning, 15-1 
opening r 
purpose of 19 
recorcring items from r 

troubleshooting 229- 236 
aliases 116 
Apple menu items 117 
dark screen 232 
deskrop fails ro appear 233 
disks 110-112 
error messages, responding to 231 
expansion cards 220-221 
frozen system 231 
monitors 232 
network passwords 185 
pointer does not move 234, 235 
priming 168-169 
saving files on floppy disk 108 
software program quits unexpectedly 236 
system software 233 
system starrup 233 
typing produces nothing on screen 234 

'li'Ltc'lype foms 171 , 230. See also foms 
turning Alarm Clock on/off 133-1 34 
turning Apple1i!lk on 180 
turning CloseView on/off 152 
turning external devices on/off 4, 6 
turning external hard disks on 106 
turning file sharing off 199-200 
turning file sharing on 189-190 
turning Macimosh on/off 4-6 
turning moniror on/off 4, 6 
turning SCSI devices on 216 
turning Slow Keys on/off 137 
turning Sticky Keys on/off 137 

turning 32-bir addressing on 158 
turning virtual memory on 15-
TV interference :xiii. 220, 22~ 
r~·o-s ided disks. See double-sided floppy disks 
typefaces. See fonrs 
ryping. See also keyboards; keys; text 

non-English characters and special 

u 

symbols 254- 255 
pracrice for 43 
slow, adjusting keyboard for 137 
trouble with 234 

unlocking 
files 121 
floppy disks 35, 106- 108, 246 

untitled 
disks 1 O·t 
folders 71 
windows 42, -!) 

updating system software 92, 95 
user groups for Macintosh 261. See also 

registered network user groups 
Users & Groups control panel (Apple menu) 

accessing your remote computer with 
202- 203 

linked programs and 211 
naming users with 193. 194- 195 
restrining access ~·ith 197 
SC!ling paSS\\'Ords \\'ith 19-t 

Inclc:x 303 



v 
vatiablc-size fonts 1-1-172 
video. built-in. See monitor suppon 
video cards 149,220-221 
1·ideo pon. See pons. moniror 
ViCIY menu 124. 1-t-t-1-i). 2-!2 
Vie\\·s control panel 14+-1 '15 
Vie~;~·s icon 144 
rirrualmemory 157-158. See also memory 
riruses 97 
rolume. changing 139 
volume names of hard tlisks 103 

.10~ Index 

w 
windows 

activating 14- 15, ~5-47. 2~0 
border color, changing 1-18 
closing 23- 25, 33, 241 
color. changing 148, 1-!9 
customizing display of 1 ~-t-1 ~5 
displaying contents of (View menu) 124 
hiding and showing 99 
highlight color, changing 148 
moving 23-24, 241 
printing contents of 168 
purpose of 18- 19 
quick reference for 240-2-12 
scroll bars 241 
scrolling 17, 20-21, 241 
size, changing 16-17, -15, 241 
title bar 23-24, 241 
untitled 42, 43 
vie\\·ing comems of 14-21 
viewing in outline form 242 
zoom hox and 16-17. 241 

work groups, viruses and 97 
work space. See desktop 

X, Y 
X tlisk icon 233 

z 
zones, AppleTalk 58- 59 
zoom box 16-17, 2-il. See also \\·indows 



The Apple Publishing System 
This Apple manual was" tittm and edited on a desktop publishing system 
using Apple ;\larinwsh compLners and QuarkXPress. Proof pages 11ere creawd 
on Apple LaserWriter printers and on the Q;\IS ColorScript 100 mlor printer. 
Final pages were produced in QuarkXPress and output directlv to separated 
film on a PostScript'" -clriven im:tgcserrf'r. Line art and chapter opmers 1\'ere 
cremecl 1\'ith Adobe Illustrator. Screen shots were created and modified 11·ith 
system software, Exposure, and SuperPaim. 

·rc:-a type is Apple's corporate font, a condensed version of Garamond. 
Ornaments arc custom symbols designed for Apple Computer and 
incorpormcd into the Applelcon font. Some clements, such as computer 
voice, arc sct in Apple Courier, a fixed-width font. 

PostSnipt, the l.ascr\X'riter page-description language, was developed hy Adobe 
Systems l ncorpot~ucd. 




